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ENGLISH
About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ This device is not suitable for people who have a visual impairment
due to the touchscreen keyboard.

« Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact a LG
Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

+ Some content and illustrations may differ from your device, depending
on the areg, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use
of media.

- Additional charges may incur for data services, such as messaging,
uploading,downloading, auto-syncing and location services. To void
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient
use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This mobile phone model LG-H840 has been designed to comply with applicable
safety requirements for exposure to radio waves. These requirements are based
on scientific guidelines that include safety margins designed to assure the safety
of all persons, regardless of age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the phone transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG phone
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model phone tested for use at the ear is
0.981 W/kg (10 g) and when worn on the body is 1.440 W/Kg (10 g).



+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the
body. When a carry case, belt clip or holder is used for body-worn operation, it
should not contain metal and should position the product at least 5 mm away
from your body. In order to transmit data files or messages, this device requires
a quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.

Product care and maintenance
+ Always use genuine LG batteries, chargers and accessories approved for use
with this particular device model. The use of any other types may void any
approval or warranty applying to the device and may be dangerous.
+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when
repair work is required.

Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

+ Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.

Do not drop.
+ Do not subject this unit to mechanical vibration or shock.

+ Switch off the phone in any area where you are required to by special
regulations. For example, do not use your phone in hospitals as it may affect
sensitive medical equipment.

+ Do not handle the phone with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your phone.

+ Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.
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Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not charge the phone when it is on soft furnishings.

The phone should be charged in a well ventilated area.

Do not subject this unit to excessive smoke or dust.

Do not keep the phone next to credit cards or transport tickets; it can affect
the information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the phone.

Do not expose the phone to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your phone is an electronic device that generates heat during normal
operation. Extremely prolonged, direct skin contact in the absence of adequate
ventilation may result in discomfort or minor burns. Therefore, use care when
handling your phone during or immediately after operation.

If your phone gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

The liquid in your wet phone, changes the colour of the product label inside
your phone. Damage to your device as a result of exposure to liquid is not
covered under your warranty.
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Efficient phone operation

Electronics devices
All mobile phones may receive interference, which could affect performance.

+ Do not use your mobile phone near medical equipment without requesting
permission. Avoid placing the phone over pacemakers, for example, in your
breast pocket.

+ Some hearing aids might be disturbed by mobile phones.

Minor interference may affect TVs, radios, PCs etc.

+ Use your phone in temperatures between 0 °C and 35 °C, if possible. Exposing
your phone to extremely low or high temperatures may result in damage,
malfunction, or even explosion.

Road safety

Check the laws and regulations on the use of mobile phones in the area when you
drive.

+ Do not use a hand-held phone while driving.

+ Give full attention to driving.

Pull off the road and park before making or answering a call if driving
conditions so require.

RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

« If you are listening to music whilst out and about, please ensure that the
volume is at a reasonable level so that you are aware of your surroundings. This
is of particular importance when near roads.
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Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to areasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E « Excessive sound pressure from earphones and headphones can cause
hearing loss.

Glass Parts

Some parts of your mobile device are made of glass. This glass could break if your
mobile device is dropped on a hard surface or receives a substantial impact. If the
glass breaks, do not touch or attempt to remove it. Stop using your mobile device
until the glass is replaced by an authorised service provider.

Blasting area

Do not use the phone where blasting is in progress. Observe restrictions and
follow any regulations or rules.

Potentially explosive atmospheres
- Do not use your phone at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your mobile phone or accessories.
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In aircraft
Wireless devices can cause interference in aircraft.

Turn your mobile phone off before boarding any aircraft.

+ Do not use it on the ground without permission from the crew.

Children

Keep the phone in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your phone for emergency calls. Check with your local
service provider.

Battery information and care
+ You do not need to completely discharge the battery before recharging. Unlike

other battery systems, there is no memory effect that could compromise the
battery’s performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the

battery life.

+ Do not disassemble or short-circuit the battery.

- Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

Guidelines for safe and efficient use 10



+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ If you need to replace the battery, take it to the nearest authorised LG
Electronics service point or dealer for assistance.

+ Always unplug the charger from the wall socket after the phone is fully
charged to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal’s teeth or nails, come into
contact with the battery. This could cause a fire.

+ Power Consumption (Networked Standby Mode) : 0.32 W

Guidelines for safe and efficient use 11



Custom-designed
Features



Modular Type

You can use the modular functionality provided by your device to use
various features provided by various accessories.

Remove the module from the module slot of the device. Then you can
just replace the battery, or you can install another accessory into the
module slot to use the specific features provided by the accessory.

E - See Removing the battery and Installing the battery for details.
+ Available accessories, which are called LG Friends, are optional.
- To purchase optional accessories, contact an LG Customer Service
Centre.
+ Available accessories may vary depending on the area or service provider.

m

+—— Module

Always On Display

You can display the date, time, signature or other information on the screen
even when the main screen is turned off. Always On Display is a useful
feature in order to check the time frequently and display your own signature.

E + The battery may drain faster when you use Always On display. Turn off
this feature to use the battery longer.
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1 Tap O > Settings > Display > Always-on display and then drag (J
to activate it.

« This feature may be turned on when you purchase the device.

+ The default setting may vary depending on the area and service
provider.

2 Tap Set what to show and select items to display on the turned-off
screen.

- Time: Always display the current time, even if the screen is turned
off.

- Signature: Display your signature in place of the current time on
the turned-off screen. Use the Set signature option to enter a
signature and change the font.

5 - Make sure to check the signature not to exceed the input field.

Daylight mode

You can use the enhanced IPS Quantum Display feature to view the
screen clearly in outdoor daylight when the sun shines bright.
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135° Wide-angle lens

You can use the wide-angle lens to take photos of a range that is wider
than the actual field of vision. This feature is useful when you take a
photo or record a video of a landscape or a wide area from a narrow area.
You can capture a sprawling skyline, a packed stadium concert, an entire
beach, and all that your eyes can see, and more.

E + See Switch to dual camera for details.

Dual cameras

You can use the dual cameras on the back of the device to take a variety
of photos and videos of from a tight close-up scene to a vast scene.
Simply pinch or spread your fingers on the screen.

E « See Switch to dual camera for details.
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Pop-out Picture

You can make your photo as if in a frame: you can take both a normal
and wide-angle photo at the same time. Make your photo popping and
standing out against these four background frame effects: Fisheye, B&W,
Vignette, and Lens blur.

E « See Pop-out Picture for details.

Steady recording

You can use the steady recording feature to minimise extreme motion
blur when you take a photo or record a video. This feature automatically
stabilises your photo or video while you are in motion. Tap '@ to activate
this feature.
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Smart Bulletin

You can add a Home screen that collects and displays useful information
for you.

View main news from Smart Bulletin at a glance. You do not need to add
an additional widget or run an app.
1 Tap O > Settings > Display > Home screen > Smart Bulletin and
then drag (Jm to activate it.
+ The Smart Bulletin can be found on the left-most canvas of the
Home screen.
2 Configure Smart Bulletin by using the available menu items.

- To rearrange menu items displayed on the Smart Bulletin, tap and
hold =, then drag up or down.

- To display or hide a menu item on the Smart Bulletin, drag (3

5 - To change the Smart Bulletin configuration, tap 83 on the Smart
Bulletin.

Smart Notice

You can use Smart Notice to get useful information that matches your
time and location. This widget analyzes your environment and daily usage
patterns to provide information that is useful at a specific time and location.

Use Smart Notice as:

- Automatic reminders to add frequently used unsaved numbers to
contacts.

- Automatic reminders to make a call to a number you did not call back
after sending a reject message.

- Automatic reminders of the birthday of a contact saved in the
calendar and the contact list.
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+ Automatic reminders to clean up temporary files, downloaded files,
and apps that have not been used for a specific period of time.

+ Automatic reminders to customise device settings according to the
pattern and place you are using the device.

- Automatic reminders to save power when battery consumption is
high.

Starting Smart Notice
You can add the Smart Notice widget when it is not added by default or is
deleted from the Home screen. Take the following steps to add the widget:

1 On the Home screen, tap and hold on an empty space, then tap
Widgets.

2 Tap and hold Smart Notice, then drag it to another position on the
Home screen.

+ The Smart Notice widget appears on the Home screen, and its
automatic reminder functions start along with an overview of them.

- Tap €63 on the widget screen to change Smart Notice settings
according to your preferences or to select the items on which you
want Smart Notice to provide automatic reminders.

5 + The Smart Notice feature may be turned on when you purchase the
device.

+ The default setting may vary depending on the area or the service
provider.
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Smart cleaning
You can delete temporary files or apps that are no longer used.
1 Tap O> Settings > General > Smart cleaning.

7 Use desired functions.

[ Sem——————

[ ———

oy ——

Custom-designed Features



Quick Share

You can share a photo or video to the app you want immediately after
taking them.

1 Tap O > @) then take a photo or record a video.
2 Drag the Quick Share icon that appears after taking a picture or
recording a video, and select an app to share it.

Alternatively, tap and hold the Preview icon that appears after taking
a picture or recording a video, and drag it to the Quick Share icon.

E + The app displayed by the Quick Share icon may vary, depending on the
type and frequency of access of the apps installed on the device.
« You can use this feature only when you take a picture or record a video
in the Auto mode. See Auto mode for details.
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QuickRemote

QuickRemote overview

You can control many electronic devices in different locations by using
your device as a remote control.

E « This feature uses infrared (IR) signals and operates very similar to a
remote control. When using QuickRemote, keep the IR sensor at the
top right of the device uncovered.

« This feature may vary or may not be supported, depending on the areg,
service provider; or device manufacturer.

Registering a device for remote control
You can register a device you want to control remotely with your device.
1 Tap O> LG > QuickRemote.

2 Tap =to specify locations where you want to use the remote
control.

3 Tap + and select the type and manufacturer of the device you want
to remotely control.

/. Follow the on-screen instructions to make sure that the
QuickRemote feature works properly on the device.
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Creating a universal remote control

When the device you want to control with your device does not exist
in the list, you can create a customised universal remote control by
arranging your frequently used buttons according to your preferences.

1 Tap O> LG > QuickRemote.

2 Tap =to specify locations where you want to use the remote
control.

3 Tap -+ > Universal remote.

N

Enter a remote control name and tap OK.

5 Tap and hold the button you want, then drag it to the position you
want.

6 Tap NEXT.

"/ Follow the on-screen instructions to register the buttons, then tap
SAVE.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety options on this advanced
feature of notepad, such as image management and screenshots, which
are not supported by the conventional notepad.
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Creating a note

1 Tap O> QuickMemo+.

2 Tap @ to create a note.
+ . Saveanote.
+ €5 :Undo the last action.
+ ¢ :Redo the last action you undid.
T :Enter a note by using the keypad.
- /2 :Write notes by hand.
+ & :Erase handwritten notes.

« {7):Zoom in or out, rotate or erase the parts of a handwritten
note.

+ ¢ :Access additional options, including sharing and locking notes,
changing the note pad style and inserting content.

3 Tap </ tosave the note.

Writing notes on a photo
1 Tap O> QuickMemo+.

2 Tap[O]to take a photo, then tap OK.
- The photo is automatically attached into the notepad.

3 Freely write notes on the photo.

4 Tap/ to save the note.

Custom-designed Features 23



Writing notes on a screenshot

1 While viewing the screen you want to capture, drag the status bar
downwards and then tap Capture+

The screenshot appears as the notepad background theme. Memo
tools appear at the top of the screen.

7 Take notes on the captured screen.

To crop and save a portion of the screen, tap[,]and specify a
portion with the crop tool.

To attach a screenshot to the notepad, tap T

3 Tap < and save the notes to the location you want.

Saved notes can be viewed in either QuickMemo+ or Gallery.

To save notes in the same location all the time, select the Use as
default app checkbox and select an app.

Managing folders
You can view notes grouped by the type of the notes.
1 Tap O> QuickMemo+.

2 At the top of the screen, tap = and select a menu item:

E

All memos: View all notes saved in QuickMemo+.
My memos: View notes created by QuickMemo+.
Photo memos: View notes created by [O].
Capture+: View notes created by Capture+.
Trash: View deleted notes.

New category: Add categories.

£33 - Rearrange, add or delete categories. To change the name of a
category, tap the category.

+ Some folders do not appear when launching QuickMemo+ for the first
time. Disabled folders are enabled and appear when they contain at
least one related note.
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QSlide

You can start apps by using QSlide to use them while other apps are
running. For example, use the calculator or calendar when a video is
playing.

When an app is running, tap : > QSlide.

E « This feature may not be supported by some apps.

* L J:Turn off the QSlide mode to switch to full-screen mode.

+ =0 :Adjust the opacity of the QSlide window. If the QSlide window is
transparent, it will not respond to touch inputs.

+ X :Close the QSlide window.
A Adjust the size of the QSlide window.
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LG Health

LG Health overview
You can manage your health and maintain good exercise habits by
keeping track of the exercises you do.

Getting started with LG Health

You can configure LG Health when launching the app for the first time or
after initialising it.

1 Tap O> LG Health.

2 Follow the on-screen instructions to complete configuration.

Using LG Health

You can view main information on LG Health and manage the amount of
physical exercise and health information.

1 Tap O> LG Health.
2 Do the following:

+ = :View your exercise log on the day you want to check.

- © :Begin tracking an exercise. The route and amount of your
physical exercise are recorded for each exercise type.

« + :Setyour daily exercise goals including calories and steps, or set
various LG Health settings.
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5 + Health-related information provided by LG Health is designed for user
convenience and cannot be used for purposes of disease prevention,
treatment, diagnosis or other medical issues.

+ LG Health may vary or may not be available, depending on the country
and service provider. LG Health functions that are available and apps
that can be added to LG Health may vary, depending on the country.
This is due to differing laws and regulations.

Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.

1 Tap O > Settings > Sound & notification > Do not disturb and then
drag (Jm to activate it.

7 Tap Sounds and vibrations and select the mode you want:

« Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.

- Total silence: Disable both the sound and vibration.

Ringtone ID

You can set the device so that it plays an automatically composed ringtone
for each incoming call from the selected contacts. This function is useful
because you can know who are calling you by only hearing the ringtone.

1 Tap O > Settings > Sound & notification > Ringtone ID and then
drag (Jm to activate it.

7 Tap Compose ringtones for and select the desired option.

E + The default ringtone plays for incoming calls from contacts except for
the selected contact.
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Fingerprint recognition

Fingerprint recognition overview

Register your fingerprint on your device first before using the fingerprint
recognition function.

You can use the fingerprint recognition function in the following cases:
+ To unlock the screen
« Toview the locked content in Gallery or QuickMemo+

When confirming a purchase or signing in to an app, identify yourself by
simply touching the fingerprint sensor.

E + Your fingerprint never changes for your whole life, and everyone has a
unique fingerprint. Therefore, your fingerprint can be used by the device
for user identification. Very similar fingerprints from different users
may be recognised by the fingerprint sensor as the same fingerprint.

To enhance the device security, set the screen lock to a pattern, PIN or
password.

- If your fingerprint is unrecognised or if you forget the backup PIN,
bring your device to the nearest LG Customer Service Centre and both
register a fingerprint and create a new backup PIN.

Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease. To maximise recognition
accuracy, check the following before using the device.

+ The device's Power/Lock key has a fingerprint sensor. Ensure that the
Power/Lock key is not damaged by a metallic object, such as coin or
key.

- When water, dust or other foreign substance are on the Power/Lock
key or your finger, the fingerprint registration or recognition may
not work. Clean and dry your finger before having the fingerprint
recognised.

Custom-designed Features 28



- Afingerprint may not be recognised properly if the surface of your
finger has a scar or is not smooth due to being soaked in water.

If you bend your finger or use the fingertip only, your fingerprint
may not be recognised. Make sure that your finger covers the entire
surface of the Power/Lock key.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

The device may generate static electricity if the surrounding air is dry.
If the surrounding air is dry, avoid scanning fingerprints, or touch a
metallic object such as a coin or key before scanning fingerprints to
remove static electricity.

Registering fingerprints

You can register and save your fingerprint on the device to use

fingerprint identification.

1 Tap O > Settings > General > Fingerprints & security >
Fingerprints.

L;'] « To use this feature, make sure that screen lock is set. If a screen lock
is not set, set the screen lock. See Configuring screen lock settings for
details.

2 Locate the Power/Lock key on the back of the device and gently put
your finger on it to register the fingerprint.

E + Gently press the Power/Lock key so that the sensor can recognise your
fingerprint. If you press the Power/Lock key with an excessive force, the
screen lock function may start or the screen may be turned off.

- Ensure that your fingertip covers the entire surface of the sensor of
the Power/Lock key.
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3 Follow the on-screen instructions.
+ Repeat scanning the fingerprint by moving your finger little by little
until the fingerprint registers.
4 When the fingerprint registration is done, tap OK.

- Tap ADD MORE to register another fingerprint. If you register
only one fingerprint and the corresponding finger is not in a good
condition, the fingerprint recognition may not work well. As the
preventive measure against this kind of situation, register multiple
fingerprints.

Managing fingerprints
You can edit or delete registered fingerprints.

1 Tap O > Settings > General > Fingerprints & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it,
tap ).
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Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your
fingerprint. Activate the desired function:

1 Tap O > Settings > General > Fingerprints & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
« Screen lock: Unlock the screen with a fingerprint.

- Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.

Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device from a TV.

71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items from the Gallery or Music app, tap&J or :
> Play on other device, then select a TV you want to connect to.

E + For Chromecast, Google Play services should be up to date.

Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.
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Connecting the devices

Connect both your device and another device that support DLNA
function to the same wireless network.

E - Make sure that File sharing (DLNA) is activated on both the device and
the connected device.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting
the Nearby devices tab in each app.

Use content from nearby devices as if you were using it on your device.

Sending or receiving files

You can share files between your device and another LG device, or a
tablet or computer.

Sending files

From the Gallery, File Manager or Music app, tap : > Share or <&, then
select a device on the file sharing list.

Receiving files
Drag the status bar downward, then activate File sharing.

If your device does not support the file sharing feature, tap O > Settings
> Networks > Share & connect > File sharing > SmartShare Beam.
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Sending files to a computer
You can quickly send large files to your computer.

7 Install LG Bridge on your computer.
2 Start LG Bridge on the computer, then sign in using your LG account.

3 Tap O > Settings > Networks > Share & connect > LG AirDrive,
then sign in using your LG account.

I_;'] + You can download LG Bridge from the LG Mobile website (www.lg.com).

Viewing content from your cloud

You can directly view the content saved on your cloud account, without
downloading it to your device.

1 From the Gallery, Music or File Manager app, select = > Cloud.
2 Select a cloud account and sign in.

3 Save or play content in your cloud.

Dual Play

You can display your device screen on a display device connected via a
wireless connection and use different apps on your device at the same
time.

Use a Screen sharing for the connection.

E « This feature is not available for some content.
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Product components and
accessories

Make sure that none of the following items are missing:

+ Device + USB cable
- Battery « Charger
+ Ejection pin + Quick Start Guide

- Stereo headset

A .

The items described above may be optional

The items supplied with the device and any available accessories may
vary depending on the area and service provider.

« Always use genuine LG Electronics accessories. Using accessories made

.

by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional basic items, contact the LG Customer Service

Centre.

« To purchase optional items, contact the LG Customer Service Centre

.

.

for available dealers.
Some items in the product box are subject to change without notice.

The appearance and specifications of your device are subject to change
without notice.
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Parts overview

Microphone

Earpiece ————
.

IR sensor

1— Stereo headset jack

Front camera lens —77—=0 @ ——

=\

] 7]7

Proximity/Ambient light
sensor

Volume keys (+/-) —|

Module eject key —|

LED indicator

Touch screen

*— SIM/Memory card tray

Module —\\ /J

r Charger/USB cable port

RGB sensor

Rear camera lens (Normal)

Flash

Laser detection —
auto-focus

L IO

(CI)

Rear camera lens
(Wide-angle)

Power/Lock key
(Fingerprint sensor)

NFC antenna (built-in)

Microphone
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+ Proximity/Ambient light sensor

- Proximity sensor: During a call, the proximity sensor turns off the
screen and disables touch functionality when the device is in close
proximity to the human body. It turns the screen back on and
enables touch functionality when the device is outside a specific
range.

- Ambient light sensor: The ambient light sensor analyses the
ambient light intensity when the auto-brightness control mode is
turned on.

- Laser detection auto-focus

- Detects the distance from the camera to your subject for automatic
focusing.

- Quickly focuses on closer or farther objects when you use the rear
camera to take photos.

+ Volume keys
- Adjust the Volume for ringtones, calls or notifications.

- Gently press a Volume key to take a photo. To take continuous shots
of photos, press and hold the Volume key.

- Press the Volume Down (-) key twice to launch the Camera app
when the screen is locked or turned off. Press the Volume Up (+)
key twice to launch Capture+.

- Power/Lock key (Fingerprint sensor)
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
- Gently put your finger on the key when you want to unlock the
screen with your fingerprint.
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E - Some functions may be restricted for access, depending on the device
specifications.

« An NFC antenna is built into the back of the device. Do not damage the
NFC antenna.

+ Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen feature.

- Screen-protective film or accessories may interfere with the proximity
sensor.

« If your device is wet or is being used in a humid place, the touch sensor
or buttons may not function properly.

Turning on or off the power

Turning on the power
When the power is turned off, press and hold the Power/Lock key.

- When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual.

Turning off the power
Press and hold the Power/Lock key, then select Power off.

Power control options

Tap and hold the Power/Lock key, then select an option.
- Power off: Turn off the device.

- Power off and restart: Restart the device.

+ Turn on Airplane mode: Block telecommunication-related functions,
including making phone calls, messaging and browsing the Internet.
Other functions remain available.
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Installing the SIM card

Properly use the SIM (Subscriber Identity Module) card provided by your
service provider.

1 Insert the ejection pin into the hole on the card tray.

2 Pullout the card tray.

3 Put the SIM card on the card tray with the gold-coloured contacts
facing downwards.
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4 Insert the card tray back into the slot.

Precautions when using SIM card
- Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

- Be careful not to damage the SIM card when you insert or remove it.

E + Of several types of SIM cards, only the Nano-SIM cards work with the
device.

« For problem-free performance, it is recommended to use the phone
with the correct type of SIM card. Always use a factory-made SIM card
supplied by the operator.

Inserting the memory card

The device supports up to a 2 TB microSD. Some memory cards may
not be compatible with your device, depending on the memory card
manufacturer and type.

+ Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory
card, or corrupt the data stored in it.
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1 Insert the ejection pin into the hole on the card tray.
2 Pullout the card tray.

3 Put the memory card on the card tray with the gold-coloured
contacts facing downwards.

Memory card

SIM card

4 Insert the card tray back into the slot.

+ The memory card is an optional item.

+ Frequent writing and erasing data may shorten the lifespan of memory
cards.

Removing the memory card

Unmount the memory card before removing it for safety.

1 Tap O> Settings > General > Storage & USB > A.

7 Insert the ejection pin into the hole on the card tray.

3 Pull out the card tray and remove the memory card.

A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.
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Battery

Removing the battery

« Turn off the device before removing the battery. Failure to do so may
damage the device.

1 Press the module eject key to partly eject the module from the device.

j@.— Module
Module eject key J
[\
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3 Hold the battery and module with both hands and separate them
from one another in the direction of the arrow.

+ Do not bend the battery when removing it. The plastic cap on the
battery may be damaged.

I

Installing the battery

« Device specifications may vary depending on the area or service
provider. To purchase additional batteries or compatible optional items,
contact an LG Customer Service Centre for support.

« Be sure to use authentic accessories provided by LG Electronics. Using
third-party accessories may damage the device or cause malfunctions.

1 Align the indicated arrows correctly and insert the battery into the
module according to the order indicated in the image.
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2 Grab the lower part of the module as shown in the figure below, then
gently slide the module into the device until they are tightly fastened.

E + Never press the module eject key when inserting the module into the
device.

Precautions when using the module

- When inserting the battery into the device, make sure that the
battery is attached to the module. Inserting the battery without the
module attached may damage the device.

+ When replacing the battery, take extra care to ensure that no foreign
substance or water enters the device.

+ Do not put the device in a hot and humid location when the battery
module is removed.

- Ensure that the inside of the device does not contact a metallic object
or water and does not get damaged.

- Leaving the device with the module separated for an extended period
of time may deform the device or damage the metallic contacts. This
may result in device malfunction.

+ Never separate the module from the device without pressing the
module eject key. This may damage the device.

+ Never remove the module when the device is in use.

- If a gap occurs between the module and device while you are using
the device, firmly insert the module into the device.
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- If you insert a module that is not compatible with your service
provider, for example, a module bought from other service provider or
in an area that is not covered by your service provider, your device may
not operate normally.

+ Be careful not to hurt your fingers when inserting or removing the module.

- Make sure to insert the battery and module correctly. If you insert
them incorrectly, the device may not operate properly or may get
damaged.

+ Failure to follow the instructions in the user quide may damage the device.

Charging the battery
Before using the device, fully charge the battery.

Connect one end of the charging cable to the charger, insert the other
end of the cable into the cable port, and then plug the charger into a
power socket.

A + Make sure to use the USB cable provided as a basic accessory.

+ Make sure to use an LG-approved charger, battery and charging cable.
Charging the battery with a third-party charger may cause the battery
to explode or may damage the device.

+ Using the device when it is charging may cause electric shock. To use
the device, stop charging.
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This device is supplied with the battery inserted. When using the device
for the first time, check the battery level and fully charge the battery
before using the device if necessary.

i

.

Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

.

Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer. This may take a
longer time than charging the battery in the common way.

.

Do not charge the battery by using a USB hub that is unable to
maintain the rated voltage. Charging may fail or unintentionally stop.

Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.

To minimise battery consumption, follow these tips:

« Turn off the Bluetooth® or Wi-Fi network function when not using
them.

- Set the screen timeout to as short a time as possible.
+ Minimise the screen brightness.

+ Set ascreen lock when the device is not used.

- To use a downloaded app, check the battery level.
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Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping

Lightly tap with your fingertip to select or run an app or option.

Tapping and holding

Tap and hold for several seconds to run a hidden function.

Basic Functions

47



Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging
Tap an item, such as an app or widget, then move your finger to another
location in a controlled motion. You can use this gesture to move an item.

Swiping
Tap the screen with your finger and move it quickly without pausing. You

can use this gesture to scroll through a list, a web page, photos, screens,
and more.

Basic Functions 48



Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

A .

.

5

Do not expose the touch screen to excessive physical shock. You might
damage the touch sensor.

A touch screen failure may occur if you use the device near a magnetic,
metallic or conductive material.

- If you use the device under bright lights, such as direct sunlight, the

screen may not be visible, depending on your position. Use the device
in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

« Do not press the screen with excessive force.

« Gently tap with your fingertip on the option you want.

« Touch control may not work properly if you tap while wearing a glove or

.

.

by using the tip of your fingernail
Touch control may not work properly if the screen is moist or wet.

The touch screen may not function properly if a screen-protective
film or accessory purchased from a common online or offline store is
attached to the device.
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Home screen

Home screen overview

The Home screen is the starting point for accessing various functions
and apps on your device. Tap O on any screen to directly go to the Home
screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

To search for an app, use Google search.

Home screen layout

You can view all apps and organise widgets and folders on the Home
screen.

Status bar — NS

¢ Jo— Widget

= Page icon
Home touch buttons —3 < J

E + The Home screen may vary, depending on the service provider or
software version.

- Status bar: View status icons, the time and the battery level.

- Widget: Add widgets to the Home screen to quickly access necessary
information without bothering to run apps one by one.

- Folder: Create folders to group apps by your preferences.
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- Page icon: View the total number of Home screen canvases and the
currently displayed canvas which is highlighted.

+ Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

+ Home touch buttons
- <] :Return to the previous screen. Close the keypad or pop-up

windows.

- (O :Tap to go to the Home screen. To launch Google, tap and hold.
- [J: View a list of recently used apps or run an app from the list. Use

the Clear all option to delete all recently used apps. In some apps,
tapping and holding the button will access additional options.

Editing Home touch buttons
You can rearrange Home touch buttons or add frequently used functions
to Home touch buttons.
Tap O > Settings > Display > Home touch buttons > Button
combination and customise settings.
- Several functions, including QSlide, the notifications panel or
Capture+, are provided. A maximum of five items can be added.
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Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status
bar.

il - No signal

:Data is being transmitted over the network
© Alarm is set

a[Jn : Vibrate mode is on

€) :Bluetooth is on

« s :Connected to a computer via USB
B Battery level

4 :Flight mode is on

X :Missed calls

- @ :Wi-Fiison

X :Mute mode is on

Q :GPSison

(49 :Hotspot is on

- B :No SIM card

I_;r] + Some of these icons may appear differently or may not appear at all,
depending on the device's status. Refer to the icons according to the
actual environment in which you are using the device.

- Displayed icons may vary, depending on the area or service provider.
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Notifications panel
You can open the notifications panel by dragging the status bar
downwards.
Use quick access icons in the notifications panel to easily and quickly turn
a function on or off.
Drag left or right on the list of quick access icons to select the function
icon you want.

- If you tap and hold the icon, the settings screen for the corresponding

function appears.

l— Access the Settings app.
09:00 7 & @eg— Selectauser.

View quick access icons. —s & < @ % @

Select a device to share —3— -1 Adjust the brightness.
the phone screen. D b 44
View notifications. — ° el L Pormit receipt of files from

nearby devices.

Notification panel settings
You can select items to display on the notification panel.
Tap ¢ on the notification panel.
- To rearrange quick access icons, tap and hold an icon, then drag it to
another position.
- Select icons you want to display on the list.

+ Available menu items may vary depending on the area or service
provider.
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Switching the screen orientation

You can set the screen orientation to automatically switch, according to
the device's orientation.

On the notification panel, tap Rotation from the quick access icon list.

Alternatively, tap O > Settings > Display and activate Auto-rotate
screen.

Editing the Home screen

On the Home screen, tap and hold on an empty space, then start the
desired function.

To rearrange the Home screen canvases, tap and hold on a canvas,
then drag it to another location.

To add widgets to the Home screen, tap Widgets and drag a widget
to the Home screen.

To change Home screen settings, tap Home screen settings and
customise options. See Home screen settings for details.

To view or reinstall the uninstalled apps, tap Uninstalled apps. See
Uninstalled apps for details.
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Viewing the background theme

You can view only the background image by hiding apps and widgets on
the Home screen.

Spread two fingers apart while holding down on the Home screen.

- To return to the original screen which displays apps and widgets, pinch
your fingers on the Home screen or tap <]

Searching for apps on the Home screen

You can easily search for apps installed on the Home screen by entering
the desired app's name in the Google widget.

The installed apps list appears on the Google search screen.

Moving apps on the Home screen
On the Home screen, tap and hold an app, then drag it to another
location.

- To keep frequently used apps at the bottom of the Home screen, tap
and hold an app, then drag it to the quick access area at the bottom.

- To remove an icon from the quick access area, drag the icon to the
Home screen.
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Using folders from the Home screen

Creating folders
On the Home screen, tap and hold an app, then drag it over another app.
+ Anew folder is created and the apps are added to the folder.

Editing folders
On the Home screen, tap a folder and then run the desired function.
- To edit the folder name and colour, tap the folder name.

- To remove an app from the folder, tap and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

Home screen settings
You can customise Home screen settings.
1 Tap O > Settings > Display > Home screen.
2 Customise settings:
- Select Home: Select a Home screen mode.
+ Wallpaper: Change the Home screen background theme.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

- Theme: Select the screen theme to apply.

- Sort apps by: Set how apps are sorted on the Home screen.

+ Grid: Change the app arrangement mode for the Home screen.

- Hide apps: Select or deselect apps to hide from the Home screen.

- Smart Bulletin: Use the Home screen to view information
customised to your needs.
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Screen lock

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

« Screen lock prevents unnecessary touch input on the device screen and
reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.

Configuring screen lock settings
There are several options available for configuring the screen lock
settings.

1 Tap O > Settings > Display > Lock screen > Select screen lock and
then select the method you prefer.

2 Customise lock settings:
+ None: Deactivate the screen lock function.
+ Swipe: Slide on the screen to unlock the screen.

+ Knock Code: Tap the spaces of the screen in accordance with a
pattern to unlock the screen.

- Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
- Password: Enter an alphanumeric password to unlock the screen.
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5 - To set screen lock using a pattern, first create a Google account or
backup PIN. If you enter an incorrect pattern more than a specified
number of times consecutively, you can unlock the screen by using your
backup PIN or Google account.

- Ifascreen lock is set using a PIN or password and you enter an
incorrect PIN or password more than a specified number of times,
password entry is blocked for 30 seconds.

Lock screen settings
You can customise the following lock screen settings.
1 Tap O > Settings > Display > Lock screen.

2 Customise settings:
- Select screen lock: Select a screen lock method.

Smart Lock: Select trusted items so that if one of them occurs, the
device is automatically unlocked.

Screen swipe effect: Set screen transition effects to apply when
the screen is unlocked. This option appears when the screen lock
method is set to Swipe.

Wallpaper: Change the lock screen background image.

« Shortcuts: Add an app shortcut and directly access the app from
the lock screen by dragging the app outside the large circle. This
option appears if the screen lock method is set to Swipe.

- Weather animation: Display weather animations for the current
location on the lock screen.

- Contact info for lost phone: Display emergency contact
information on the lock screen.

Lock timer: Set the amount of idle time after which the device
automatically locks.

- Power key instantly locks: Instantly lock the screen when the
Power/Lock key is pressed.

E + Available setting items may vary, depending on the selected screen lock
method.
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KnockON

You can turn the screen on or off by double-tapping the screen.

Turning on the screen
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning off the screen
Double-tap on an empty space on the Home screen.
Alternatively, double-tap an empty space on the status bar.

E « This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Knock Code

You can unlock the screen by creating your own Knock Code. When the
screen is locked, you can directly access the Home screen by tapping the
screen in a specified sequence.

Creating a Knock Code

1 Tap O > Settings > Display > Lock screen > Select screen lock >
Knock Code.

7 Tap the squares in a pattern of your choice to create a Knock Code
and tap NEXT.

3 Input the created Knock Code again for verification, then tap
CONFIRM.

4 Set abackup PIN to use when the Knock Code is forgotten.
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Unlocking the screen with a Knock Code
Unlock the screen by inputting the Knock Code you have created.

Input your Knock Code on the touch screen when the screen is turned
off.

5 + You can use your Knock Code, together with the KnockOn feature.

- If you enter an incorrect Knock Code more than a specified number
of times consecutively, unlock by using your backup PIN or Google
account.

+ Make sure to use your fingertip when tapping the screen.

Secure start-up

Secure start-up overview
When you turn on the device, the screen is locked for security. Unlock

the screen by entering the current unlock method, such as a Knock code,
pattern, password or PIN. Until the screen is unlocked, you cannot receive

most phone calls, text messages, alarms, notifications, and more.

Precautions of Secure start-up

« If the password is entered incorrectly more than a specific number of
times, the device will automatically initialise. Be sure to remember the

password.

If you forget your decryption password, you must initialise the
device to use it again. Initialisation will delete all data saved before
initialisation.

Encryption takes place when the device boots for the first time

after an initialisation. Stopping encryption before it is complete may

damage data. For example, do not remove or insert the battery while

encryption is in progress. \Wait until the encryption is complete.
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Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

1 Tap O > Settings > General > Fingerprints & security > Encrypt SD
card.

7 Read the on-screen overview of memory card encryption and then
tap CONTINUE to continue.

3 Select an option and tap ENCRYPT NOW:
- New data encryption: Encrypt only data that is saved on the
memory card after encryption.
+ Full encryption: Encrypt all the data currently saved on the
memory card.

+ Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.

E + To encrypt the memory card, make sure that a screen lock is set using
a PIN or password.

+ Once memory card encryption starts, some functions are not available.

« If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check whether the battery level is sufficient before starting encryption.

+ Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, initialise the
card.

+ You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.
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Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down (-) key at the
same time for at least two seconds.
+ Screenshots can be viewed from the Screenshots folder in the Gallery.

Via Capture+
On the screen where you want to take a screenshot, drag the status bar
downwards, then tap Capture+.

5 + When the screen is turned off or locked, you can access Capture+
by pressing the Volume Up (+) key twice. First, tap (O > Settings >
General and then turn on Shortcut keys.

+ See Writing notes on a screenshot for details.

Entering text

Using Smart keyboard
You can use Smart keyboard to enter and edit text.

With Smart keyboard, you can view text as you type without bothering
to alternate between the screen and a conventional keyboard. This allows
you to easily find and correct errors when typing.

5 = .
£ e
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Moving the cursor
With Smart keyboard, you can move the cursor to the exact position you want.

When typing text, tap and hold on the space bar and then drag left or
right until the cursor moves to the position you want in the text.

< Smart keyboard >

E - This option is available only on the QUWERTY keyboard.

Suggesting words
Smart keyboard automatically analyses your usage patterns to suggest
frequently used words as you type. The longer you use your device, the
more precise the suggestions are.

Enter text, then tap a suggested word or gently drag the left or right side
of the space bar upwards.

+ The selected word is automatically entered. You do not need to

manually type every letter of the word.

Smartphone Smart Smartphones
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Changing the QWERTY keyboard layout

You can add, delete or rearrange keys on the bottom row of the keyboard.

1 Tap O> Settings > General > Language & keyboard > LG Keyboard
> Keyboard height and layout > QWERTY keyboard layout.
Alternatively, tap £ on the keyboard and tap Keyboard height and
layout > QWERTY keyboard layout.

2 Tap a key on the bottom row, then drag it to another position.

I
] EJ np
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- This option is available on the QWERTY, QWERTZ and AZERTY
keyboards.

« This function may not be supported for some languages.

Customising the keyboard height

You can customise the keyboard height to maximise hand comfort when

typing.

1 Tap O > Settings > General > Language & keyboard > LG Keyboard
> Keyboard height and layout > Keyboard height.
Alternatively, tap £ on the keyboard and tap Keyboard height and
layout > Keyboard height.
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2 Adjust the keyboard height.

Selecting a landscape keyboard mode

You can select a landscape keyboard mode from several choices.

1 Tap O > Settings > General > Language & keyboard > LG Keyboard
> Keyboard height and layout > Keyboard type in landscape.
Alternatively, tap £ on the keyboard and tap Keyboard height and
layout > Keyboard type in landscape.

2 Select a keyboard mode.

Splitting the keyboard

You can split the keyboard in half and place each piece on either side of
the screen when the screen is in landscape mode.

Tap O > Settings > General > Language & keyboard > LG Keyboard >
Keyboard height and layout > Split keyboard.

Alternatively, tap £ on the keyboard and tap Keyboard height and
layout > Split keyboard.
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E « Rotate the device to landscape mode to split the keyboard to both
sides. To merge or split the keyboard, pinch together or spread apart
your fingers on the keyboard.

One-handed operation mode

You can move the keyboard to one side of the screen so that you can use

the keyboard with one hand.

1 Tap O > Settings > General > Language & keyboard > LG Keyboard
> Keyboard height and layout > One-handed operation.
Alternatively, tap £ on the keyboard and tap Keyboard height and
layout > One-handed operation.

2 Press the arrow displayed next to the keyboard to move the keyboard
in the direction you want.

Entering text by using voice
On the keyboard, tap and hold £¥ and then select .

E + To maximise the voice command recognition, speak clearly with the
correct pronunciation and accent.
- To enter text with your voice, make sure that your device is connected
to a network.

To select the language for voice recognition, tap ¥% > Languages on
the voice recognition screen.

« This function may be not supported, or the supported languages may
differ depending on the service area.
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Changing the keyboard

You can change the input language and the keyboard type for each
language.

1 Tap O > Settings > General > Language & keyboard > LG Keyboard
> Select languages.

2 Select alanguage and customise the keyboard type.

Copy and Paste

You can cut or copy text from an app, and then paste the text into the
same app. Or, you can run other apps and paste the text into them.

1 Tap and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.
3 Select either CUT or COPY.
- Cut or copied text is automatically added to the clipboard.
4 Tap and hold the text input window, then select PASTE.

5 « If there is no item that has been copied or cut, the PASTE option will
not appear.
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CLIP TRAY

If you copy or cut an image or text, it is automatically saved to the clip
tray and can be pasted to any space at any time.
T Onthe keyboard, tap and hold £ and select [ig]
Alternatively, tap and hold the text input window, then select CLIP
TRAY.
2 Select and paste an item from the clip tray.
+ A maximum of 20 items can be saved to the clip tray.

« Tap 2} to lock saved items in order not to delete them, even when
the maximum quantity is exceeded. A maximum of ten items can
be locked. To delete locked items, unlock them first.

- Tap ] to delete the items saved to the clip tray.

E + The clipboard may not be supported by some apps downloaded by the
user.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

- You can use SmartWorld, Play Store or the app store provided by
your service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.
« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.
+ SmartWorld may not be supported depending on the area or service
provider.

Uninstalling apps
Uninstall apps that you no longer use from your device.

E + Some apps cannot be uninstalled by users.

Uninstalling with the tap and hold gesture

On the Home screen, tap and hold the app to uninstall, then drag it over
Uninstall at the top of the screen.

« If apps were uninstalled within 24 hours from now, you can reinstall
them. See Uninstalled apps for details.

Uninstalling by using the settings menu
Tap O > Settings > General > Apps, select an app, then tap Uninstall

Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.
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Uninstalled apps

You can view the uninstalled apps on the Home screen. You can also
reinstall apps which were uninstalled within 24 hours from now.
1 Tap O > Uninstalled apps.
2 Activate the desired function:
- Reinstall: Reinstall the selected app.
- [ : Remove the uninstalled apps permanently from the device.

E + Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

+ This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.

Phone

Voice call

Make a phone call by using one of the available methods, such as
manually entering a phone number or making a call from the contact list
or the list of recent calls.

Making a call from the keypad

1 TapO> > Dial

2 Make a call by using a method of your choice:
- Enter a phone number and tap @.
+ Tap and hold a speed-dial number.

- Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @.
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- Toenter "+" when making an international call, tap and hold number O.

« See Adding contacts to the speed dial list for details on how to add
phone numbers to the speed dial list.

Making a call from the contact list
T TapO> @ > Contacts.

2 From the contact list, select a contact and tap Q..

Answering a call
To answer a call, drag @ to the outside of the circle on the incoming call
screen.
+ When the stereo headset is connected, you can make calls by using
the call/end button on the headset.
- To end a call simply by pressing the Power/Lock key, tap OO > Settings
> Networks > Call > Answer and end calls, then turn on End calls
with the Power key.

Rejecting a call
To reject an incoming call, drag @) to the outside of the circle on the
incoming call screen.
- To send a rejection message, drag the rejection message to the
outside of the circle.
- To add or edit a rejection message, tap () > Settings > Networks >
Call> Decline and reject calls > Decline with message.
+ When a call is coming in, press the Volume key or Power/Lock key to
mute ringtone or vibration, or to hold the call.

Viewing missed calls

If there is a missed call, the status bar at the top of the screen displays

L%
X~
To view missed call details, drag the status bar downwards. Alternatively,

tap O >[M> Call logs.
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Functions accessible during a call

During a call, you can access a variety of functions by tapping on-screen
buttons:

- Contacts: View the contact list during a call.
- End:End a call

- Dialpad: Display or hide the dial pad.

- Speaker: Turn on the speakerphone function.

+ Mute: Mute your voice so that your voice cannot be heard by the
other party.

- Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

+ ¢ :Access many call options.

5 + Available settings items may vary depending on the area or service
provider.

Making a three-way calling
You can make a call to another contact during a call.
1 During acall, tap : >Add call

2 Enter a phone number and tap @.

+ The two calls are displayed on the screen at the same time, and the
first call is put on hold.

3 To switch to another call, tap another number on the screen.
To start a conference call, tap Merge calls.

5 + You may be charged a fee for each call. Consult with your service
provider for more information.
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Viewing call records

To view recent call records, tap O > (8> Call logs. Then, you can use the
following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap Q..

- To delete call records, tap : > Delete.

E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.

Configuring call options
You can configure various call options.

1 TapO> W > Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message

You can create and send messages to your selected contacts or all of
your contacts using the Messaging app.

E + Sending messages abroad may incur additional charges. Consult with
your service provider for more information.

1T TapO> 1.

2 Tap @.

3 Specify a recipient and create a message.
- To attach files, tap Z.
+ To access optional menu items, tap .

4 Tap Send to send the message.

Reading a message
You can view exchanged messages organised by contact.

1T TapO> 1
2 Select a contact from the message list.

Configuring messaging settings
You can change messaging settings to suit your preferences.

1T TapO> 1
2 Tap : > Settings from the message list.
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Camera

Starting the camera
You can take a photo or record a video to keep the memorable moments.

Tap O>@.

« Before taking a photo, wipe the camera lens with a microfibre cloth. If
your finger touches the camera lens, you may get blurry photos.

« If the battery level is lower than 5%, charge the battery before using
the camera.

« Images included in this user guide may be different from the actual
device.

« Photos and videos can be viewed or edited from Gallery. See Gallery
overview for details.

Changing the camera mode

You can select a camera mode that suits your shooting environment to
take a photo or record a video easily and conveniently.

On the camera screen, tap : and select the desired mode.
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Switching between cameras

You can switch between the front and rear cameras to suit your shooting
environment.

On the camera screen, tap & or drag the screen either up or down or
left or right to switch between the front and rear cameras.

E + Use the front camera to take selfies. See Taking selfies for details.

Switch to dual camera

You can use the dual (second) camera on the back to take photos by
using either the normal or wide-angle camera lens.

Tap [A]/ [#w] to switch the normal and wide-angle camera lens.

Zoom in or out

You can use zoom in or out on the camera screen while taking a picture
or recording a video.

On the camera screen, pinch or spread two fingers to zoom in or out.

+ Then the wide-angle camera lens and normal camera lens on the back
of the device are automatically switched to take a photo or record a
video.
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Simple mode
You can take photos by simply tapping the screen.

1 Onthe camera screen, tap = >[ |
2 Frame your subject and then tap on the screen.

Auto mode

You can take photos or record videos by selecting a variety of shooting
modes and options.

1 Onthe camerascreen, tap : >[ g
2 To take a photo, tap [©] Or to record a video, tap [k

Switch between
the wide-angle
Select a camera camera lens and
mode. l normal camera lens.

e Start the Gallery.

Turn the flash on —e4
or off.

Switch between —}
front and rear
cameras.

Select a shooting
mode.

Change camera —I
options.

@Js— Record videos.

Back to the
previous screen.

Taking a photo
T Select a shooting mode, and tap the subject to focus the camera on.

2 Tap (@ to take a photo.
Alternatively, press a volume key.

E + When the screen is turned off or locked, start the camera by pressing
the Volume Down (-) key twice. To activate this function, tap O
> Settings > General and turn on Shortcut keys. To take photos
immediately after the camera is started by the Volume Down (-) key,
activate the Quick shot feature.
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Recording a video
7 Select a shooting mode, and tap the subject to focus the camera on.
2 Tapn
- To take a photo while recording a video, tap [0
- To pause the video recording, tap | |. To resume the video recording,
tap @.
3 Tap[]to end the video recording.

Pop-out Picture

You can take a photo or record a video by using both the normal and
wide-angle lens of the dual camera at the back of the device to shoot the
scenes as if they were put in the frame. The scenes shown in the small,
front screen are shot by using the normal camera lens, and the scenes
shown in the large, background screen are shot by using the wide-angle
camera lens. Change the front screen to a different shape or apply
various effects to take a sensuous photo or video.

7 Inthe Auto mode, tap MODE > [T}
2 Tap \/ and select the desired layout.

3 Select effects:

- &3 : Apply a convex lens effect to the area captured by the wide-
angle camera.

. :Apply greyscale to the area captured by the wide-angle camera.
+ [D]: Darken the edges of the area captured by the wide-angle camera.
+ [0]:Blur the area captured by the wide-angle camera.

/. Tap [Q]to take a photo. To record a video, tap [}
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Multi-view

You can take multiple photos or videos in the form of a collage by
using the front and rear cameras. Photos and videos can be saved with
different layouts.

1 Inthe Auto mode, tap MODE >H |
72 Tap \v/ and select a layout.
3 Tap Q7 to take photos, according to the on-screen instructions. To
record a video, tap [
+ Tap [Jto record a short video clip.
- To switch between front and rear (normal or wide-angle) cameras,
drag up or down, or left or right.
+ To take continuous shots of photos or videos at specific intervals,
tap and hold [G1or [
- Tap @) / ) to take pictures or record videos simultaneously or
sequentially.
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Snap Video

You can record short videos clips and assemble them into a 60-second short film.
1 Onthe camera screen, tap MODE > 57

2 Tap[n
« Tap the icon once to record a three-second video clip. Tap and
hold the icon to create a longer video clip (maximum length: one
minute).

Select Multi-view —1

layout. 0

Delete the
Preview the —1 selected clip.
selected clip. )
Timeline. I— Save the video.
i Delete all the clips.

Play all the clips.

3 Tap SAVE.

Panorama

You can create a panoramic photo by moving the camera in one direction
to photograph and stitch continuous shots of for a wide view.

1 Inthe Auto mode, tap MODE >~

2 Tap[6]and then slowly move the camera in one direction.
+ Move the device by following the direction of the arrow in the guideline.

3 Tap[]to end shooting.
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Slow-motion Video

You can create an entertaining video by changing the moving speeds
of subjects in your video. This feature allows you to record a video at a
faster rate of speed and then play it at the normal speed so that the
video appears to be slowed down.

1 Inthe Auto mode, tap MODE > .
2 Tap[nand record a video.
3 Tap[]to end the video recording.

Time-lapse
You can take a sequence of frames at set intervals to record changes

that take place slowly over time, such as cloud movements, celestial
motions, traffic, and more.

1 Inthe Auto mode, tap MODE > (=

2 Tap[nand record a video.
- To adjust the video playback rate, tap \/.

3 Tap[]to end the video recording.

I_;,] + While recording a time-lapse video, voices are not recorded.
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Burst shot
You can take continuous shots of photos to create moving pictures.
In the Auto mode, tap and hold (61

+ Continuous shots are taken at a fast speed while [G7is held down.

E + Up to thirty (30) continuous photos can be taken.

Connecting with LG friends cameras

You can connect the device to another camera to view photos or videos
saved on the camera.

« This function is available when using multi-view or snap.

« The LG Friends cameras that can be connected with the device are
optional accessories. Consult with LG Customer Service Centre for
purchasing.

« This function may not be supported or some options may differ,
depending on the area or service provider.

Customising camera options
You can customise a variety of camera options to suit your preferences.
In the Auto mode, tap 3.

E + Available options vary depending on the selected camera (front or rear
camera) and the selected shooting mode.
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Select an aspect ratio for photos or quality for videos.

AUTO

Obtain photos or videos in vivid colours, and get compensated
effects even when they are taken against the light. These
functions are provided by the high dynamic range (HDR)
technology equipped in the camera of the device.

Apply film effects to photos.
\\'\ Set the timer to automatically take photos after a specified period
OFF

of time.

Take photos with voice commands.
(Available choices: Cheese, Smile, Whisky, Kimchi, LG)

Reduce motion blur when taking a photo or recording a video:

- Use to reduce little blur while taking a photo or recording a video.

Display guide grids so that you can take photos or record videos
based on the horizontal and vertical reference lines.

b/ £

Set the locations where you want to save photos and videos.
These options appear when an external memory card is inserted.

- 5] Save to the internal storage.
- £7: Save to the external memory card.

[O]/[¥]

Customise auto-shooting settings. These options appear when
using the front camera.

+ [M]: Shoot using the Gesture Shot feature.

« [¥]:Shoot when the camera detects a face.

/9

Choose whether to use Gesture View to view the taken photo
immediately after taking a photo. These options appear when
using the front camera.

« g - Turn on Gesture View.

- 68 - Turn of f Gesture View.

g4d/ e

Flip images. These options appear when using the front camera.
+ £J€]: Do not flip the image.
- £ :Flip the image horizontally.
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Applying film effects

You can apply filters of various colours to photos.

T Inthe Auto mode or Manual mode, tap 63> [T
2 Select the desired film effect.

Manual mode

You can create photos featuring professional touch by using a variety
of advanced features. Adjust the white balance, focus, brightness, ISO,
shutter speed and other options.

T Onthe camera screen, tap : >[=]

2 Customise shooting options.

Adjust white 41 I— Adjust exposure
balance. level.

Adjust focus. Adjust shutter
speed.
Adjust brightness. Adjust ISO speed.

3 Tap Q7 to take the photo.
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Taking selfies

You can use the front camera to view your face on the screen and take
selfies.

+ When using the front camera, you can change in camera options how
selfies are taken. See Customising camera options for details.

Gesture shot
You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.
+ In three seconds, a photo is taken.

m’

E + To use this function, make sure that [M]is selected in camera options.

+ An alternative way to take gesture shots is to clench your fist and then
open it towards the front camera.

+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.

« Access to some functions may be restricted during multi-view
shooting.

Useful Apps 86



Interval shot
You can take continuous selfies.

While using the front camerg, tap and hold (6} Alternatively, show your
palm to the camera, then clench your fist twice quickly.

- Four photos are taken at about two second interval.

Taking auto-selfies
You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.
+ When the front camera detects your face, the frame turns white.
Then if you stop moving, the frame turns blue and the front camera
takes a photo.

E - Tap 83, then tap [®] until [+ ] appears to activate the auto-selfie
function.
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Gesture view

After taking a selfie with the front camera, you can preview the selfie
immediately by placing the screen close to your face.

E + To use this function, make sure that &4 is selected in camera options.
+ Only one preview is available each time a photo is taken.

« If you rotate the device while in preview screen, the screen switches to
camera mode.

Gallery

Gallery overview
You can view and manage photos and videos saved on your device.
1T TapO>m™.
- Saved photos and videos are displayed by the folder.
2 Tap afolder and select a file.
+ View the selected file in full-screen mode.

+ Swipe left or right on the displayed photo or video screen to view
the previous or next file.
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« Some file formats may not be supported, depending on the installed
software.

« Some files may not be opened due to encoding.
« Files that exceed the size limit may cause an error.

Viewing photos

VNGNS — Access additional
options.

previous screen. @ »

Add or delete —I- -~

favourites.

Delete images.
Share images.
Start the camera.

Edit images.

Editing photos
T While viewing a photo, tap £
2 Use avariety of effects and tools to edit the photo.
3 Tap / to apply changes.
/4 Tap SAVE to save changes.
- The changes are overwritten to the original file.
« To save the edited photo as another file, tap & > Save copy.
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Playing a video
Open with QSlide.

Add or delete — e— Access additional

favourites. I options.

Edit the video.

Adjust the sound —3% 8F=—— Lock or unlock the

volume. screen.
Rewind the video. Fast-forward the
video.
Pause or play the
video.

E « To adjust the sound volume, drag the right side of the video screen up
or down.

« To adjust the screen brightness, drag the left side of the video screen
up or down.

Editing videos
T On the video preview screen, tap £
2 Use avariety of effects and edit tools to edit the video.

Automatically
] createa 15-sec

video clip.

Select a section to
change the play

speed.

—————. g — Adjust the video
duration.

3 Tap SAVE to save changes.
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Deleting files

You can delete files by using one of the following options:
- Tap and hold a file from the file list, then tap Delete.
- Tap [y from the file list, then select files.

Sharing files
You can share files by using one of the following options:
+ While viewing a photo or video, tap «< to share the file by using the
method you want.

- Tap <& from the file list to select files and share them using the
method you want.

Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator:

1 Tap O > Tools > Calculator.

2 Use the keypad to make a calculation.
- To use the scientific calculator, tap : > Scientific calculator.
- To view calculation history, tap : > Calculation history.
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Weather

You can view the weather information for a particular area.
1 Tap O > Tools > Weather.

2 Tap - and add the city you want.

+ On the detailed weather screen, tap €/, or swipe the screen left
or right to view the weather for other cities.

Downloads

You can view, delete or share files downloaded via the Internet or apps.
Tap O > Tools > Downloads.
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Clock

Alarm

You can set an alarm to trigger it at a specified time.
1 Tap O > Tools > Clock > Alarm.

2 Tap @ to add a new alarm.

3 Configure the alarm settings and tap SAVE.

« If you select a previously set alarm, you can edit the alarm.

- To delete an alarm, tap [11] at the top of the screen. Alternatively, tap
and hold the alarm.

World clock

You can view the current time in cities around the world.
1 Tap O> Tools > Clock > World clock.

2 Tap @ and add a city.

Timer
You can set the timer to trigger an alarm after a specified period of time.
1 Tap O > Tools > Clock > Timer.

7 Set the time and tap Start.
- To suspend the timer, tap Stop. To resume the timer, tap Resume.
- To reset the timer settings, tap Reset.

3 Tap Stop to stop the timer alarm.
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Stopwatch
You can use the stopwatch to record a lap time.
1 Tap O> Tools > Clock > Stopwatch.
2 Tap Start to initiate the stopwatch.
- Torecord a lap time, tap Lap.
3 Tap Stop to suspend the stopwatch.
- To resume the stopwatch, tap Resume.
- To delete all the stopwatch records, tap Reset.

Voice Recorder

You can record and save your voice or others' voices from important
events. Recorded voice files can be played back or shared.

1 Tap O> Tools > Voice Recorder.
2 Tap(~).
- To pause recording, tap ().
3 Tap (=) to end recording.
+ The file is saved automatically and the pre-listen screen appears.

A Tap (>) to play the recorded voice.

E + To save the location details of recording, tap Location.

- To tag a current event information on the recording, tap Event. Then
select the event you want.

- Ifyou tap (5), recorded voice files appear You can play a recorded voice
file from the list.
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Music

You can play and manage music files saved on your device.
1 Tap O> LG > Music.

2 Select a category.

3 Select a music file.

Back to the previous
screen.

Switch to the playlist.

He— Access additional options.

Add or delete favourites. —& Search for music files.

Play in random order. —g E— Select a repeat mode.

Adjust the sound volume. —Z) E— Set sound effects.

J Tap to play the next file /
Tap to play from the beginning of the Tap and hold to fast
current file / Double-tap to play the forward.

previous file / Tap and hold to rewind. Pause or play.

E + Some file formats may not be supported, depending on the installed

software.

- Files that exceed the size limit may cause an error.

+ Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying
a music file. To download or copy a music file, first check the copyright
law for the relevant country.

+ This model supports Hi-Fi audio playback. Hi-Fi audio files display the
Hi-Fi icon.
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E-mail

E-mail overview

You can register an email account to your device and then you can check
and send emails from your device.

E « If you use mobile data, you may be charged for data usage fee
depending on your pricing plan. Consult with your service provider for
more information.

Registering email accounts

When you use the email app for the first time, register your email
account.

T TapO> LG > E-mail
2 Select an email service provider.

3 Enter your email address and password and then tap NEXT to
register your account

- To manually register an email account or to register email accounts
not found in the list, tap MANUAL SETUP.

Managing email accounts

To view or edit your email account settings, tap : > Settings.
+ To add an account, tap Add account.

- To delete an account, tap : > Remove account.

Opening another email account

If several email accounts are registered and you want to view another
account, tap = and select another one from the account list.
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Checking email
1 Tap=and select a mail box.

2 Select an email from the email list.
+ The email message appears.

Sending email
1 Tap @.

7 Enter the email address of a recipient.

3 Enter a subject and message.
- To attach files, tap =.

+ To access optional menu items, tap :.

4 Tap B> to send the email

Contacts

Contacts overview
You can save and manage contacts.
Tap O> LG > Contacts.

Adding contacts

Adding new contacts
T On the contact list screen, tap -}
7 Enter contact details and tap SAVE.
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Importing contacts
You can import contacts from another storage device.

T On the contact list screen, tap : > Manage contacts > Import.

7 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select contacts and tap IMPORT.

Adding contacts to the speed dial list
1 On the contact list screen, tap : > Speed dial.
2 Tap Add contact from a speed-dial number.

3 Select a contact.

Searching for contacts

You can search for contacts by using one of the following options:
- On the contact list screen, enter a contact name in the search box.
- Scroll the contact list up or down.

- From the index of the contact list screen, tap the initial letter of a
contact.

Contacts list

Editing contacts

7 On the contact list screen, select a contact.

2 On the contact detail screen, tap /2 and edit details.
3 Tap SAVE to save changes.
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Deleting contacts
7 On the contact list screen, tap and hold a contact.

7 Tap Delete contact.

Adding favourites
You can register frequently used contacts as favourites.
T On the contact list screen, select a contact.

2 On the contact detail screen, tap y.

Creating groups

T On the contact list screen, tap Groups > ¢ > New group.
2 Enter a new group name.

3 Tap Add members, select contacts, then tap ADD.

/A Tap SAVE to save the new group.

Calendar

Calendar overview
You can use the calendar to manage events and tasks.

Adding events
1 Tap O> Calendar.
2 Select a date and then tap @.

3 Enter event details and tap SAVE.

- If you tap a date from the calendar and the date contains events, a
pop-up window appears showing a list of the events. Tap an event
from the pop-up window to view the event details.
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Syncing events

Tap : > Calendars to display > : > Calendars to sync, and select a
calendar to sync.

E + When your events are saved from the device to your Google account,
they are automatically synced with the Google calendar, too. Then,
you can sync other devices with the Google calendar in order to make
those devices have the same events that your device has and to
manage your events on those devices.

Event pocket

You can use the event pocket to create events.

Tap &9 to open the event pocket and then drag content to a date in the
calendar.

- (©) :Manage images, text, notes and temporarily saved events. You can
also share text, images and notes from another app and save them to
the event box. If you tap POCKET when creating an event, the event is
temporarily saved to the event pocket.

- () :Add a Facebook account to view information on Facebook events.
Some devices may not support the Facebook event information
function.

+ (© :View tourism information about the surrounding area, such as
restaurants and convenient facilities, to plan an event.

- () :Manage tasks that have no deadline, such as events.
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File Manager
You can view and manage files saved on your device or cloud.
1 Tap O> Tools > File Manager.

7 Tap=and select the desired storage location.

Tasks

You can register tasks to your device to easily manage schedules.
1 Tap O > Tools > Tasks.

2 Tap @ to add a task.

3 Enter task details and then tap SAVE.

Evernote

You can write and collect important information and then share them
with other devices that support Evernote.

Tap O > Recommended > Evernote.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

Tap O > Tools > Cell Broadcast.
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FM Radio

You can listen to FM radio.
Tap O > Tools > FM Radio.

E « To use this app, first connect a headset to the device. The headset
becomes the radio antenna.

« This function may not be supported depending on the area.

LG Backup

You can back up, restore and move the data saved on your device.

1 Tap O> Management > LG Backup.
Alternatively, tap O > Settings > General > Backup & reset > LG
Backup.

2 Follow the on-screen instructions to select whether to back up data
in the preset backup folder on the device or to copy data to other
devices.

A « Initialising your device may delete backup files saved in internal storage.
To minimise data loss, copy important backup files from the LG Backup
folder in the internal storage to a computer or external storage.

E - Data in a Google account will not be backed up. \When you synchronise
your Google account, Google apps, Google contacts, Google calendar,
Google memo app data and apps downloaded from Play store are
stored on the Drive app automatically.
« Backup files are saved with the file extension *.|bf under the LG Backup
folder on the memory card or internal storage.

Fully charge the battery before backing up or restoring data to avoid
unintentional powering off during the process.
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RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to the LG Customer Service Centre as follows:

1 Tap O > Management > RemoteCall Service.
7 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associate's instructions to
enter a six-digit access number.

- Your device is remotely connected and remote support service
starts.

« To use this function, first you must agree to usage of the function.

« If you use mobile data, you may be charged for data usage depending
on your pricing plan.

SmartWorld

You can download a variety of games, audio content, apps and
fonts provided by LG Electronics. Customise your device to suit your
preferences by using Home themes, keyboard themes and fonts.

1 Tap O> LG > SmartWorld.
2 Enter your ID and password, then sign in.

3 Select and download content items.

Downloading SmartWorld app
If SmartWorld app is not installed, follow these steps to download it.

1 Tap O > Settings > General > About phone > Update Center > App
Updates.

2 From the list, select SmartWorld and tap Download.
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5 - If you use mobile data, you may be charged for data usage fee
depending on your pricing plan.
- This feature may not be supported depending on the area or service
provider.

Google apps

You can use Google apps by setting a Google account. The Google account
registration window appears automatically when you use a Google app
for the first time. If you do not have a Google account, create one from
your device. For details on how to use an app, see the Help in the app.

E + Some apps may not work depending on the area or service provider.

Chrome

Sign in to Chrome and import opened tabs, bookmarks and address bar
data from a computer to your device.

Docs

Create documents or edit documents created online or from another
device. Share and edit documents together with others.

Drive

Upload, save, open, share and organise files from your device. Files accessible from
apps can be accessed from anywhere, including online and offline environments.

Gmail
Register your Google email account to your device to check or send email.

Google

Use search function provided by Google to search web sites and files
stored on your device by entering keywords or via voice.
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Hangouts
Exchange messages. Make a video call with an individual or a group.

Maps
Find your location or the location of a place on the map. View
geographical information.

Photos
View or share photos or albums saved on your device.

Play Movies & TV

Use your Google account to rent or purchase movies. Purchase content
and play it anywhere.

Play Music

Purchase music files from Play Store. Play music files saved on your
device.

Sheets

Create spreadsheets or edit spreadsheets created online or from another
device. Share and edit spreadsheets together with others.

Slides

Create presentation material or edit presentation material created online or
from another device. Share and edit presentation material together with others.

Voice Search

Search information on Google by saying a keyword, instead of typing a
keyword.

YouTube

Search and play videos. Upload videos on YouTube to share them with
people around the world.
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Settings
You can customise the device settings in accordance with your
preferences.

Tap O > Settings.

E - Tap Q_and enter a keyword in the search box to access a setting item.

- Tap 3 to change the view mode. This user guide assumes that you are
using the Tab view.

Networks

Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
1 On the settings screen, tap Networks > Wi-Fi.
2 Drag (Jm to activate it.
+ Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network's Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap and hold the network and then tap Forget
network.
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Wi-Fi network settings
On the settings screen, tap Networks > Wi-Fi.

- Switch to mobile data:|f the mobile data connection function is
activated but the device cannot connect to the Internet via \Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

+ :Customise Wi-Fi network settings.

Wi-Fi Direct

You can connect your device to other devices that support Wi-Fi Direct
to share data directly with them. You do not need an access point. You
can connect with more than two devices by using Wi-Fi Direct.

1 On the settings screen, tap Networks > Wi-Fi > ¢ > Advanced Wi-Fi
> Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
+ Connection occurs when the device accepts the connection

request.
=
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=
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5 + The battery may drain faster when using Wi-Fi Direct.
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Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

71 On the settings screen, tap Networks > Bluetooth.

2 Drag (Jm to activate it.
+ Available devices appear automatically.
- To refresh the device list, tap SEARCH.

E + Only devices with the searching option enabled are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E + This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

72 Tap << > Bluetooth.

3 Select a target device for the file.
- Thefile is sent as soon as the target device accepts it.

E « File sharing processes may differ, depending on the file.
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Mobile data

You can turn on or off mobile data. You can also manage mobile data
usage.

Turning on mobile data

1 On the settings screen, tap Networks > Mobile data.

2 Drag (Jm to activate it.

Customising mobile data settings
71 On the settings screen, tap Networks > Mobile data.

2 Customise the following settings:
- Mobile data: Set to use data connections on mobile networks.

- Limit mobile data usage: Set a limit for mobile data usage to
block mobile data if the limit is reached.

+ ¢ :Customise mobile data settings.

Call

You can customise call settings, such as voice call and international call
options.

T On the settings screen, tap Networks > Call.

2 Customise the settings.

+ Some features may not be supported depending on the area or service
provider.
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NFC

You can use the device as a transportation card or credit card. You can
also share data with other device.
7 On the setting screen, tap Networks > Share & connect > NFC.

2 Drag (Jm to activate it.

« Touch your device with other device that supports NFC to allow
sharing data.

+ NFC antenna may be located differently depending on the device
type.

NFC antenna
(built-in)

Android Beam

You can share files by touching the back of the device to other device.
You can also share files including musics, videos or contacts and open a
web page or l[aunch an app from the other device.

1 On the settings screen, tap Networks > Share & connect > Android
Beam.

2 Touch the back of the device with other device.

E + NFC antenna may be located differently depending on the device type.
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File sharing

You can send and receive files between your device and other LG devices
or tablets.

7 On the settings screen, tap Networks > Share & connect > File
sharing.

2 Customise the following settings:

5

G5 SE: Change the device name.

Save to: Set the destination folder to save files sent from other
devices in.

File sharing: Permit receipt of files sent from other devices.

SmartShare Beam: Share files with other devices via SmartShare
Beam.

» See Sending or receiving files for details.

Media server

You can share media content on your device with nearby devices that
support DLNA.

71 On the settings screen, tap Networks > Share & connect > Media
server.

2 Customise the following settings:

Content sharing: Share content on your device with nearby
devices.

G5 SE: Set your device's name.

Content to share: Select the type of media content to share with
other devices.

Allowed devices: View a list of devices permitted to access
content on your device.

Not-allowed devices: View a list of devices not permitted to
access content on your device.
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Screen sharing

You can play the screen and sound of the device on a different device,
such as a TV, that supports the Miracast function.

71 On the settings screen, tap Networks > Share & connect > Screen
sharing.

2 Drag () to activate it.

3 Select a device from the list of nearby devices.

- If the desired device does not appear, tap SEARCH to refresh the
list.

- After connecting to the device, the device displays the screen of
your device.

E + Screen sharing turns off automatically if there is no sharing-compatible
device in the vicinity.

LG AirDrive

You can use your LG account to manage files saved on the device from a
computer. You do not need a USB connection.

71 On the settings screen, tap Networks > Share & connect > LG
AirDrive.

72 Useasingle LG account to sign in to LG Bridge on the computer and
LG AirDrive on the device.

+ LG Bridge software can be downloaded from www.lg.com.

3 Manage files on the device from the computer.
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Printing
You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.

71 On the settings screen, tap Networks > Share & connect > Printing.

E + If the desired printer is not in the list, install the printer driver from the
app store.

2 Drag (O™ to activate it.
3 Select a printer from the printer list screen.
- Toadd a printer, tap : > Add printer.
« To search for a printer name, tap : > Search.
- Tap : > Settings from the printer list screen.
4 Select afile and tap ¢ > Print.
+ The document prints.

E + If you do not have a Google account, tap ADD ACCOUNT to create an
account.
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USB tethering

You can connect the device to another device via USB and share mobile
data.

7 Connect your device and other devices via USB cable.

2 On the settings screen, tap Networks > Tethering > USB tethering
and then drag (Jm to activate it.

=

@

E « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ When connecting to a computer, download the USB driver from
wwwi.lg.com and install it on the computer.

« You cannot send or receive files between your device and a computer
while USB tethering is turned on. Turn off USB tethering to send or
receive files.

+ Operating systems that support tethering are \Window XP or higher;
or Linux.
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Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the internet by using your device's mobile data.

71 On the settings screen, tap Networks > Tethering > Wi-Fi hotspot
and then drag (Jm to activate it.

7 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi ID (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.

| @

« This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tethers#wifi
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Bluetooth tethering

A Bluetooth-connected device can connect to the internet by using your
device's mobile data.

71 On the settings screen, tap Networks > Tethering > Bluetooth
tethering and then drag (Jm to activate it.

2 Turn on Bluetooth on both devices, and pair them.

——
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E « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Networks > Tethering > Help.

Airplane mode

You can turn off the call and mobile data functions. When this mode
is on, functions that do not involve data, such as games and music
playback, remain available.

7 On the settings screen, tap Networks > More > Airplane mode.
2 Tap TURN ON in the confirmation screen.
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Mobile networks
You can customise mobile data settings.
1 On the settings screen, tap Networks > More > Mobile networks.
2 Customise the following settings:
+ Mobile data: Turn mobile data on or off.

- Data roaming: Browse the web, use emails, multimedia messages
and other data services overseas.

+ Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

+ Network operators: Search for network operators and connect
automatically to a network.

VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN
71 On the settings screen, tap Networks > More > VPN.

« Be cautious that if the screen lock is unlocked, all VPN information
saved on the device are erased.

72 Tap Add VPN network.

E « This feature is available only when the screen lock is activated. If
the screen lock is deactivated, a notification screen appears. Tap
SETTINGS from the notification screen to activate the screen lock. See
Configuring screen lock settings for details.

3 Enter VPN details and tap SAVE.
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Configuring VPN settings
1 Tapa VPN from the VPNS list.

7 Enter the VPN user account details and tap CONNECT.

- To save the account details, select the Save account information
checkbox.

Sound & notification

You can customise sound, vibrate and notification settings.

On the settings screen, tap Sound & notification and customise the
following settings:

- Sound profile: Change the sound mode to sound, silent, or vibrate
only.

+ Volume: Adjust the sound volume for various items.

- Ringtone: Select a ringtone for incoming calls. Add or delete
ringtones.

- Ringtone ID: Create a ringtone for an incoming call from a particular
contact. See Ringtone ID for details.

- Vibration strength: Adjust the vibration intensity.

- Sound with vibration: Set the device to vibrate and play a ringtone
simultaneously.

- Vibration type: You can select a vibration type or make your own
vibration pattern.

- Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on
particular days of the week. See Do not disturb for details.

+ Lock screen: Display or hide a notification message on the lock
screen. You can also hide private information.

+ Apps: Select the apps that can show their notification messages
on the screen, and set the priorities of those apps in regard to
notification messages.
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Notification LED: Indicate device status via LED.

- More > Notification sound: Select a notification ringtone. Set music

saved on the device as a notification ringtone.

More > Vibrate on tap: Set the device to vibrate when you tap certain
items on screen.

More > Sound effects: Select a sound effect to play when you tap
the dial pad, select an option, or lock or unlock the screen.

More > Message/call voice notifications: Set the device to read the
caller information or message content via voice.

Display

You can customise detailed settings for each screen type.

On the settings screen, tap Display and customise the following settings:

Home screen: Customise settings for the Home screen. See Home
screen settings for details.

Lock screen: Customise lock screen settings. See Lock screen
settings for details.

Home touch buttons: Rearrange Home touch buttons or change
their background colours. Hide Home touch buttons on the screen.

Font type: Change the font face.
Font size: Change the font size.
Bold text: Bold the text on the screen.

Brightness: Use the slide bar to change the device's screen
brightness.

+ Auto: Set the device so that the screen brightness is automatically

adjusted in accordance with the surrounding light intensity.
Always-on display: Always display information, such as the date, time
and notifications, even when the screen is turned off. For details, see
Always On Display.

Auto-rotate screen: Automatically rotate the screen according to the
device's orientation.
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- Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

More > Daydream: Display a screen saver when the device is
connected to the holder or charging. Select a screen saver type to
display.

+ More > Motion sensor calibration: Correct the angle and speed
of the motion sensor to improve the tilt accuracy and speed of the
Sensor.

E + When correcting the motion sensor, make sure to place the device on a
flat surface. Failure to do so may cause errors with the motion sensor
functions, such as automatic screen rotation.

General

Language & keyboard
You can customise language and keyboard settings for your device.
T On the settings screen, tap General > Language & keyboard.
2 Customise the following settings:

- Language: Select a language to apply for the device.

- Current keyboard: View the keyboard type currently in use. Select
a keyboard to use when entering text.

+ LG Keyboard: Customise LG keyboard settings.

- Google voice typing: Configure the options for text dictation by
Google.

- Text-to-speech output: Configure the settings for text-to-speech
output.

Pointer speed: Adjust the pointer speed of a mouse or trackpad.

- Reverse buttons: Reverse the right mouse button to perform
primary direct-manipulation actions.
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Location
You can customise how your location information is used by particular
apps.
71 On the settings screen, tap General > Location.
2 Customise the following settings:
+ Mode: Select a method to provide your location information.

+ My place: Set the device to analyse frequently visited places so
that it can automatically recognise a residential address.

- RECENT LOCATION REQUEST: View apps that recently requested
location information.

+ Low power location estimation: Estimate the device location by
using low power consumption.

- Camera: Save location information when taking photos or
recording videos.

- Google Location History: Configure the Google location history
settings.

Accounts & sync
You can add or manage accounts, including a Google account. You can
also sync particular apps or user information automatically.
1 On the settings screen, tap General > Accounts & sync.
2 Customise the following settings:
+ Auto-sync data: Sync all the registered accounts automatically.

- ACCOUNTS: View a list of registered accounts. To view or change
details of an account, tap the account.

- ADD ACCOUNT: Add accounts.
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Cloud

You can register a cloud account and view content saved on your
computer or cloud from the device.

1
2

On the settings screen, tap General > Cloud.

Customise the settings.

Users
You can add users to share your device with them.

1
2

On the settings screen, tap General > Users.

Customise the settings.

Accessibility
You can manage accessibility plug-ins installed on your device.

1
2

On the settings screen, tap General > Accessibility.

Customise the following settings:

Vision > TalkBack: Set the device to notify screen status or actions
via voice.

Vision > Message/call voice notifications: Set the device to read
the caller information or message content via voice.

Vision > Font size: Change the font size.
Vision > Bold text: Bold the text on the screen.

Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Screen colour inversion: Increase the display colour
contrast for people with low vision.

- Vision > Screen colour adjustment: Adjust the display colour.

Vision > Grayscale: Switch the screen to greyscale mode.

- Vision > End calls with the Power key: End a call by pressing the
Power/Lock key.
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- Hearing > Captions: Turn on the subtitle service when playing
videos for the hearing impaired.

- Hearing > Notification LED:Indicate device status via LED.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls and notifications.

« Hearing > Turn off all sounds: Mute all sounds and lower volume
on receiver.

- Hearing > Audio type: Select the audio type.

- Hearing > Sound balance: Adjust the audio output balance. Use
the slide bar to change the balance.

+ Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

- Motor & cognition > Touch and hold delay: Adjust the touch
input time.

- Motor & cognition > Touch and hold for calls: Answer or decline
calls by tapping and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

« Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

« Switch Access: Create key combinations to control your device.
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Shortcut keys

You can use the volume keys to directly launch apps when the screen is
turned off or locked.

7 On the settings screen, tap General > Shortcut keys.

2 Drag (Jm to activate it.

Press the Volume Down (-) key twice to launch the Camera app
when the screen is locked or turned off. Press the Volume Up (+)
key twice to launch Capture+.

+ Turn on Quick shot if you want to take photos immediately after
pressing the Volume Down (-) key to start the camera.

Google services

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap General > Google services.

Fingerprints & security
T On the settings screen, tap General > Fingerprints & security.
2 Customise the following settings:

- Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

- Content lock: Set the method to lock files in Gallery or
QuickMemo+.

+ Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for details.
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« Set up SIM card lock: Lock or unlock the USIM card, or change the
password (PIN).

Password typing visible: Display a password as you enter it.

+ Phone administrators: Allow privileges to restrict the control or
use of the device to particular apps.

+ Unknown sources: Allow the installation of apps from non-Play

Store apps.

Verify apps: Block the installation of harmful apps. Display a
warning message when a harmful app is installed.

Credential protection: View the type of the storage where the
security certificate will be saved.

Certificate management: Manage the security certificate saved
on the device.

- Trust agents: View and use trust agents installed on the device.

- Screen pin: Fix the app screen so that only the currently active app
can be used.

+ Usage access for apps: View details on usage of apps on the
device.

Smart settings

You can automatically change your device settings according to the
usage pattern and location.

E - To use Smart settings, make sure to set the residential address. See
Location for details.

71 On the settings screen, tap General > Smart settings.

7 Activate items you want to automatically change settings for.
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Date & time
You can customise date and time settings for your device.

71 On the settings screen, tap General > Date & time.

2 Customise the settings.

Storage & USB

You can view and manage internal storage on the device or storage space
of the memory card.

T On the settings screen, tap General > Storage & USB.

2 Customise the following settings:

- Internal storage: View the total storage space and free space
in the device's internal storage. View a list of apps in use and the
storage capacity for each app.

- PORTABLE STORAGE: View the total storage space and free
space in the memory card. This option appears only when a
memory card is inserted. To unmount the memory card, tap A.

Battery & power saving

You can view the current battery information or turn on power-saving
mode.

1 On the settings screen, tap General > Battery & power saving.

2 Customise the following settings:

- Battery usage: View the battery usage details. To view more
details, select a specific item.

- Battery percentage on status bar: Display the remaining battery
level as a percentage on the status bar.
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- Battery saver: Reduce battery consumption by cutting down
some device settings, such as the display brightness, speed and
vibration intensity. The status bar displays W= when power-saving
mode is on.

- Game optimizer: Adjust the video quality to reduce battery
consumption when playing games.

Memory

You can view the average amount of memory usage over a certain period

of time and the memory occupied by an app.
71 On the settings screen, tap General > Memory.

7 Tap w to set a time slot to retrieve data.

Smart cleaning

You can clean up temporary files or apps that are no longer used to free
up storage space.

On the settings screen, tap General > Smart cleaning.

E + See Smart cleaning for details.

Apps
You can view a list of installed apps. Shut down or delete apps, if
necessary.

T Onthe settings screen, tap General > Apps.

2 Select an app and perform actions.

Tap & pay
T You can make payments with your device instead of a credit card.

2 On the settings screen, tap General > Tap & pay
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Backup & reset

You can back up data saved on your device to another device or account.
Reset the device, if necessary.

71 On the settings screen, tap General > Backup & reset.

2 Customise the following settings:

5

LG Backup: Back up and restore all data saved on the device. See
LG Backup for details.

Back up my data: Back up your app data, Wi-Fi password and
other settings to the Google server.

Backup account: View the current backup account in use.

Automatic restore: Automatically restore backup settings and
data when reinstalling an app.

Network settings reset: Reset \Wi-Fi, Bluetooth and other
network settings.

Factory data reset: Reset all settings for the device and delete
data.

+ Resetting your device deletes all data on it. Enter your device name,
Google account and other initial information again.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap General > About phone and view
information.

Regulatory & Safety

You can view regulatory marks and related information on your device.

On the settings screen, tap General > Regulatory & Safety.
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LG Language Settings

Select a language to use on your device.
- Tap O > Settings > General > Language & keyboard > Language,
and select a language.

LG Bridge

LG Bridge overview

LG Bridge is an app that helps you manage the photos, songs, videos
and documents saved on your LG smartphone from your computer
conveniently. You can back up contacts, photos and more to the
computer or update the device software.

E - See LG Bridge help for details.
+ The supported features may vary depending on the device.

« LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
- Manage the files on the device from a computer via Wi-Fi connection
or mobile data connection.

+ Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

- Update the device software from a computer via USB cable
connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Inthe search bar, enter the name of your device.

3 Click Download Centre > LG Bridge, and download the setup file.

+ Click Details to view the minimum requirements for installing LG
Bridge.

Phone software update

LG Mobile phone software update from the
Internet

For more information about using this function, please visit
http//www.lg.com/common/index.sp, select your country and language.

This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

E + LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-the-Air
(OTA)

This feature allows you to conveniently update your phone's software
to a newer version via OTA, without connecting using a USB cable. This
feature will only be available if and when LG makes a newer firmware
version available for your device.

First check the software version on your mobile phone:

Settings > General > About phone > Update Center > Software
Update > Check now for update.

E « Your personal data from internal phone storage—including information
about your Google account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone's software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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FAQ

This chapter lists some problems you might encounter when using your
phone. Some problems require you to call your service provider, but most
are easy to fix yourself.

Message Possible causes Possible corrective measures

There is no SIM card in
SIM card error | the phone or it is inserted
incorrectly.

Make sure the SIM card is
correctly inserted.

Move toward a window or
into an open area. Check the
network operator coverage

Signal is weak or you
are outside the carrier

network.
No network map.
connection/ Check whether the SIM card is
Dropped more than 6~12 months old.
network Operator applied new If so, change your SIM or USIM
services. card at your network provider's

nearest branch. Contact your
service provider.

To change a security code,

confirm the new code by
Codes do not re-entering it. If you forget the code, contact

match your service provider.
The two codes you entered
do not match

No Not supported by service

applications provider or registration Contact your service provider.
can be set required.

gsp\)/\{iliiac?:d 1.Tap O > Settings.

causes a lot of Remove the application. 2.Tap General > Apps.
errors. 3. Tap the app > Uninstall
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Message Possible causes Possible corrective measures

Dialling error New network not authorised.
Calls not New SIM card inserted. Check for new restrictions.
available

Pre-paid charge limit
reached.

Contact service provider or
reset limit with PIN2.

Phone cannot
be turned on

On/Off key pressed too
briefly.

Press the On/Off key for at least
two seconds.

Battery is not charged.

Charge battery. Check the
charging indicator on the
display.

Charging error

Battery is not charged.

Charge battery.

Outside temperature is too
hot or cold.

Make sure phone is charging at
anormal temperature.

Contact problem

Check the charger and its
connection to the phone.

Plug the charger into a different

No voltage outlet

Charger defective Replace the charger

Wrong charger Use only original LG accessories.
Number not The Fixed dialling number | Check the Settings menu and
allowed. function is on. turn the function off.

) Delete some data, such as
Impossible to applications or messages from
receive/ send | Memory full gEr hone to make rr?ore
SMS & photos yourp

memory available.
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Message Possible causes Possible corrective measures
Files do not , Check the supported file
Unsupported file format PP
open formats.
If you use a protection tape
The screen or case, make sure it has not
does not turn - covered the area around the
Proximity sensor problem -
on when | proximity sensor. Make sure that
receive a call. the area around the proximity
sensor is clean
Check the settings status in
I the sound menu to make sure
No sound Vibration mode Lo
you are not in vibration or no
interruptions mode.
If the screen freezes or the
phone does not respond when
you try to operate it, remove
Hangsupor | Intermittent software the battery and reinsert it. Then
freezes problem power the phone back on.
Alternatively, try to perform a
software update through the
website.
See Installing the battery for
details.
Insert wrong battery Device specifications may
Check the module. vary depending on the area or
battery Insert damaged module service provider. To purchase
module or insert the module not additional battery modules

properly.

or compatible optional items,
contact an LG Electronics
Service Centre for support.

Appendix

136



Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google account or screen

lock information can use the device.

All you need to make sure your device is protected is:

+ Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google account on your device: If your device is wiped but
you have your Google account on it, the device can't finish the setup
process until your Google account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E + Do not forget your Google account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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More information

Open Source Software Notice Information

To obtain the source code under GPL, LGPL, MPL, and other open

source licences, that is contained in this product, please visit
http7//opensource.lge.com.

In addition to the source code, all referred licence terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM

for a charge covering the cost of performing such distribution (such

as the cost of media, shipping, and handling) upon email request to
opensource@lge.com. This offer is valid for three (3) years from the date
on which you purchased the product.

Regulatory information

For regulatory details, go to Settings > General > Regulatory & Safety
on your phone.

Trademarks

+ Copyright ©20716 LG Electronics, Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google™, Google Maps™, Gmail™, YouTube™, Hangouts™ and Play
Store™ are trademarks of Google, Inc.

« Bluetooth® is a registered trademark of Bluetooth SIG, Inc. worldwide.

+ Wi-Fi® and the Wi-Fi logo are registered trademarks of the Wi-Fi
Alliance.

- All other trademarks and copyrights are the property of their
respective owners.
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poLBY Aubio [ DOLBY AUDIO"

Manufactured under license from Dolby Laboratories. Dolby, Dolby Audio,
and the double-D symbol are trademarks of Dolby Laboratories.

Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.

To prevent direct exposure to laser beam, do not try to open the
enclosure or to make the direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LG-H840 product is in
compliance with the essential requirements and other relevant provisions

of Directive 1999/5/EC.

A copy of the Declaration of Conformity can be found at

http//www.lg.com/global/declaration

Contact office for compliance of this product
LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

This equipment may be operated in all European countries.
The 5150 - 5350 MHz band is restricted to indoor use only.
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so
correct disposal of your old appliance will help prevent potential
negative consequences for the environment and human health.
Your old appliance may contain reusable parts that could be used
to repair other products, and other valuable materials that can be
recycled to conserve limited resources.

3. You can take your appliance either to the shop where you
purchased the product, or contact your local government waste
office for details of your nearest authorised WEEE collection point.
For the most up to date information for your country please see
wwwilg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from
the municipal waste stream via designated collection facilities
appointed by the government or the local authorities.

3.The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FRANCAIS

A propos de ce guide de l'utilisateur

Merci d'avoir choisi LG. Pour une utilisation slire et adéquate, veuillez lire
attentivement ce guide de l'utilisateur avant d'utiliser cet appareil pour la
premiere fois.

Utilisez toujours des accessoires dorigine LG. Les éléments fournis sont
congus uniquement pour ce téléphone et peuvent ne pas étre compatibles
avec dautres appareils.

+ Dans la mesure ol son écran tactile est utilisé comme clavier, cet appareil

nest pas recommandé pour les personnes malvoyantes.
Les descriptions sont basées sur les parametres par défaut de appareil.

+ Les applications installées par défaut sur lappareil sont sujettes a des

mises a jour et a une prise en charge qui peuvent étre supprimées sans
préavis. Si vous avez des questions a propos d'une application fournie avec
lappareil, veuillez contacter un Centre de services LG. Pour les applications
installées par l'utilisateur, veuillez contacter le fournisseur de ce service.

La modification du systeme dexploitation de lappareil ou linstallation de
logiciels de sources non officielles peut endommager lappareil et entrainer
la corruption ou la perte de données. Ces actions enfreignent votre
contrat de licence LG et annulent votre garantie.

Certains contenus et illustrations peuvent différer de votre appareil en
fonction de la région, de lopérateur de téléphonie, de la version logicielle
ou de la version du systeme dexploitation, et sont sujets a modification
sans préavis.

Les logiciels, les sons, les fonds décran, les images et les autres
éléments multimédias fournis avec votre appareil font lobjet d'une
licence d'utilisation limitée. Si vous recopiez et utilisez ces éléments a
des fins commerciales ou toute autre, vous pouvez enfreindre les droits
dauteur. En tant qu'utilisateur, vous étes entiérement responsable en cas
d'utilisation illégale déléments multimédias.



Des frais supplémentaires peuvent sappliquer pour les services de
données comme la messagerie, le chargement et le téléchargement, la
synchronisation automatique ou les services de localisation. Pour éviter
lapplication de frais supplémentaires, choisissez un abonnement adapté a
vos besoins. Contactez votre opérateur pour plus d'informations.

Ce guide d'utilisation est rédigé dans les langues principales de chaque
pays. Il est possible que le contenu varie de maniére partielle en fonction
de lalangue utilisée.

Remarques instructives

A AVERTISSEMENT : Situations susceptibles de causer des blessures a
[utilisateur et a des tiers.

A AVERTISSEMENT : Situations susceptibles de causer des blessures |égeres
ou dendommager lappareil.

E REMARQUE : Remarques et informations complémentaires.

A propos de ce guide de ['utilisateur
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Recommandations pour une utilisation
siire et efficace

Veuillez lire ces recommandations. Leur non-respect peut savérer dangereux, voire
illégal.

En cas de panne, un outil logiciel intégré a votre appareil crée un historique des
pannes. Cet outil recueille uniqguement les données spécifiques a la panne, comme
lintensité du signal, la position de l'ID de cellule lors d'une perte d'appel soudaine,
et les applications chargées. Lhistorique nest utilisé que pour déterminer la raison
de la panne. Ces historiques sont chiffrés et, si vous devez retourner lappareil pour
réparation, ne peuvent étre consultés que par un centre de réparation agréé LG.

Exposition aux radiofréquences

Informations sur lexposition aux ondes radio et sur le débit d'absorption spécifique
(SAR, Specific Absorption Rate).

Le téléphone portable LG-H840 est conforme aux exigences de sécurité
relatives a lexposition aux ondes radio. Ces exigences sont basées sur des
recommandations scientifiques qui comprennent des marges de sécurité
destinées a garantir la sécurité de toutes les personnes, quels que soient leur age
et leur condition physique.

+ Les recommandations relatives a lexposition aux ondes radio utilisent une
unité de mesure connue sous le nom de débit d'absorption spécifique (DAS).
Les tests de mesure du DAS sont effectués a laide de méthodes normalisées,
en utilisant le niveau de puissance certifié le plus élevé du téléphone, dans
toutes les bandes de fréquence utilisées.

+ Méme si tous les modeles de téléphones LG nappliquent pas les mémes
niveaux de DAS, ils sont tous conformes aux recommandations appropriées en
matiere dexposition aux ondes radio.

- Lalimite de DAS recommandée par [ICNIRP (Commission internationale de
protection contre les rayonnements non ionisants) est de 2 \W/kg en moyenne
sur 10 grammes de tissu humain.

La valeur DAS la plus élevée pour ce modele de téléphone a été mesurée a
0,981 W/kg (10 g) pour une utilisation a loreille et a 1,440 W/kg (10 g)
quand il est porté au niveau du corps.



.

Cet appareil est conforme aux directives en matiére dexposition aux
fréquences radioélectriques lorsqu'il est utilisé soit dans sa position normale
contre loreille, soit a une distance minimale de 5 mm du corps. Lorsqu'un étui,
un clip ceinture ou un support est utilisé a des fins de transport, il ne doit
pas contenir de parties métalliques et doit garantir une distance minimale
de 5 mm entre le produit et le corps. Pour pouvoir transmettre des fichiers
de données ou des messages, cet appareil requiert une connexion de qualité
au réseau. Dans certains cas, la transmission de fichiers de données ou de
messages peut étre retardée jusqua ce qu'une telle connexion soit possible.
\eillez a bien suivre les instructions relatives a la distance de séparation pour
[établissement de la transmission.

Entretien et réparation

Utilisez uniqguement des batteries, chargeurs et accessoires LG authentiques
et agréés pour ce modele de téléphone. Lutilisation de tout autre type de
batteries, de chargeurs et daccessoires peut savérer dangereuse et peut
annuler tout accord ou garantie applicable au téléphone.

Certains contenus et illustrations peuvent différer de votre appareil sans
quaucun avis préalable ne soit nécessaire.

Ne démontez pas le téléphone. Si une réparation savere nécessaire, confiez-le
a un technicien qualifié.

Les réparations couvertes par cette garantie peuvent inclure, a la discrétion
de LG, des pieces ou circuits de remplacement neufs ou reconditionnés, sous
réserve que leurs fonctionnalités soient équivalentes a celles des piéces
remplacées.

Tenez votre téléphone éloigné des appareils électriques, tels que téléviseurs,
postes radio et ordinateurs personnels.

Ne placez pas votre téléphone a proximité de sources de chaleur, telles qu'un
radiateur ou une cuisiniére.

Ne le faites pas tomber.

Ne soumettez pas votre téléphone a des vibrations mécaniques ou a des chocs.
Eteignez votre téléphone dans les zones oli des réglements spéciatix

lexigent. Par exemple, n'utilisez pas votre téléphone dans les hopitaux, car

celui-ci pourrait perturber le bon fonctionnement des équipements médicaux
sensibles.

Recommandations pour une utilisation stre et efficace 6



Si vos mains sont mouillées, évitez tout contact avec le téléphone lorsqu'il est
en cours de charge. Ceci peut provoquer un choc électrique et endommager
votre téléphone.

Ne mettez pas un téléphone en charge a proximité de matiéres inflammables
car il pourrait chauffer et déclencher un incendie.

Pour nettoyer lextérieur du combiné, utilisez un chiffon sec. N'utilisez pas de
solvant, tel que du benzene, un diluant ou de lalcool.

Ne rechargez pas votre téléphone lorsqu'il est posé sur du tissu.

Rechargez votre téléphone dans une zone bien ventilée.

Nexposez pas le téléphone a de la fumée ou de la poussiere en quantité
excessive.

Ne placez votre téléphone a proximité de cartes de crédit ou de titres de
transport, car il pourrait altérer les données des bandes magnétiques.

Ne touchez pas [écran avec un objet pointu qui risquerait dendommager votre
téléphone.

Ne mettez pas votre téléphone en contact avec des liquides ou des éléments
humides.

Utilisez les accessoires tels que les oreillettes avec précaution. Ne manipulez
pas lantenne inutilement.

Evitez d'utiliser; de toucher ou de tenter de retirer ou de réparer du verre cassé,
ébréché ou fissuré. Un endommagement de [écran en verre causé par une
utilisation abusive ou incorrecte nest pas couvert par la garantie.

Votre téléphone est un appareil électronique qui génere de la chaleur

en fonctionnement normal. Lors d'une utilisation prolongée dans un
environnement mal ventilé, le contact direct avec la peau peut provoquer
une géne ou des br{lures bénignes. Manipulez donc votre téléphone avec
précaution lors de son fonctionnement ou immédiatement apres utilisation.

Sivotre téléphone est mouillé, débranchez-le immédiatement et laissez-le
sécher totalement. Ne tentez pas d'accélérer le séchage avec une source de
chaleur externe (four classique ou micro-ondes, seche-cheveux...).

Le liquide contenu dans votre téléphone mouillé modifie la couleur de
[étiquette produit se trouvant a l'intérieur du téléphone. Un endommagement
de lappareil consécutif a une exposition a des liquides nest pas couvert par la
garantie.
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Fonctionnement optimal du téléphone

Appareils électroniques
Tous les téléphones portables peuvent étre soumis a des interférences pouvant
affecter les performances des appareils électroniques.
+ Nutilisez pas votre téléphone a proximité déquipements médicaux sans
autorisation. Evitez de placer votre téléphone a proximité de votre stimulateur
cardiaque (par exemple, dans votre poche poitrine).

Les téléphones portables peuvent nuire au bon fonctionnement de certaines
protheses auditives.

Des interférences mineures peuvent perturber le bon fonctionnement des
téléviseurs, radios, ordinateurs, etc.

Utilisez votre téléphone dans des conditions de températures comprises
entre 0 °C et 35 °C dans la mesure du possible. Exposer votre téléphone a
des températures extrémement basses ou hautes peut endommager votre
appareil ou provoquer des dysfonctionnements, voire le faire exploser.

Sécurité au volant

\érifiez les lois et réglements en vigueur en matiere d'utilisation des téléphones
portables dans la zone ol vous conduisez.

Ne tenez pas le téléphone dans votre main alors que vous conduisez.

Concentrer toute votre attention sur la conduite.

Si les conditions de conduite le permettent, quittez la route et garez-vous
avant démettre ou de recevoir un appel.

Les radiofréquences peuvent affecter certains systemes électroniques de votre
véhicule motorisé, tels que le systeme audio stéréo ou les équipements de
sécurité.

Lorsque votre véhicule est équipé d'un airbag, ne génez pas son
déclenchement avec un équipement sans fil portable ou fixe. ll risquerait
de lempécher de souvrir ou provoquer de graves blessures en raison de
performances inadéquates.

Lorsque vous écoutez de la musique en extérieur, veuillez vous assurer que le
volume n'est pas trop élevé de facon a bien entendre ce qu'il se passe autour de
vous. Ceci est particulierement important a proximité des routes.
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Evitez toute nuisance auditive

Afin déviter des dommages auditifs éventuels, ne pas écouter a un
niveau sonore élevé pendant une longue durée.

Afin de protéger vos capacités auditives, nexposez pas votre ouie a de hauts
volumes sonores pendant de longues périodes. Nous vous recommandons de
ne pas allumer ou éteindre votre téléphone pres de votre oreille. Pendant les
communications ou lorsque vous écoutez de la musique, réglez le volume a un
niveau raisonnable.

+ Lorsque vous utilisez le kit main libre, baissez le volume si vous ne pouvez pas
entendre les gens parler autour de vous ou si la personne a coté de vous peut
entendre ce que vous écoutez.

+ Un volume sonore trop élevé provenant des vos écouteurs (oreillettes,
casques) pourrait entrainer déventuels dommages auditifs.

Parties en verre

Certaines parties de votre téléphone portable sont en verre. Ce verre pourrait

se briser en cas de chute sur une surface dure ou d'impact considérable. Dans ce
cas, évitez de toucher ou de retirer le verre brisé. N'utilisez plus votre téléphone
portable jusqu'a ce que ce verre soit remplacé par un fournisseur de service agréé.

Zone de déminage

N'utilisez pas votre téléphone lorsque des opérations de dynamitage sont en
cours. Respectez les restrictions, les reglements et les lois en vigueur.

Zones a atmospheére explosive
+ Nutilisez pas votre téléphone dans une station-service.

- Nutilisez pas votre téléphone a proximité de carburant ou de produits
chimiques.

+ Ne transportez pas et ne stockez pas de produits dangereux, de liquides ou
de gaz inflammables dans le méme compartiment de votre voiture que votre
téléphone portable et ses accessoires.
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En avion
Les appareils sans fil peuvent générer des interférences dans les avions.
- Eteignez votre téléphone avant dembarquer dans un avion.

+ Ne lutilisez pas au sol sans autorisation de [équipage.

Enfants

Conservez le téléphone dans un endroit sdr; hors de portée des enfants. Votre
téléphone comprend des petites pieces qui peuvent présenter un risque de
suffocation.

Appels d'urgence

Ilest possible que les numéros d'urgence ne soient pas disponibles sur tous les
réseaux de téléphonie mobile. Vous ne devez donc pas dépendre uniquement
de votre téléphone portable pour émettre un appel d'urgence. Renseignez-vous
aupres de votre opérateur.

Informations sur la batterie et précautions d'usage

« Il n'est pas nécessaire de décharger complétement la batterie avant de la
recharger. Contrairement aux autres batteries, elle n'a pas deffet mémoire
pouvant compromettre ses performances.

« Utilisez uniquement les batteries et chargeurs LG. Les chargeurs LG sont
congus pour optimiser la durée de vie de votre batterie.

+ Ne démontez pas et ne courtcircuitez pas |a batterie.

Les contacts métalliques de |a batterie doivent toujours rester propres.

+ Procédez au remplacement de la batterie lorsque celle-ci noffre plus des
performances acceptables. La batterie peut étre rechargée des centaines de
fois avant qu'un remplacement ne soit nécessaire.

+ Rechargez la batterie en cas de non-utilisation prolongée afin doptimiser sa
durée d'utilisation.

+ Nexposez pas le chargeur de la batterie au rayonnement direct du soleil.

+ Ne [utilisez pas non plus dans des lieux tres humides, tels qu'une salle de bains.
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La batterie risque d'exploser si vous la remplacez par un modele inadéquat.
Mettez la batterie au rebut conformément aux instructions.

Si la batterie est hors d'usage, veuillez la rapporter au service apres-vente ou
au revendeur LG Electronics agréé le plus proche.

Débranchez systématiquement le chargeur de la prise murale lorsque
le chargement de |a batterie est terminé pour éviter qu'il ne consomme
inutilement de [énergie.

La durée de vie réelle de la batterie dépend de la configuration du réseau,
des parametres du produit, de ['utilisation, de la batterie et des conditions
extérieures.

Tenez la batterie hors de portée des animaux et de leurs crocs ou griffes, ainsi
que des objets pointus en général. Le non-respect de cette consigne peut
entrainer un incendie.

Consommation électrique (en mode veille en réseau) : 0,32 W
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Fonctionnalités
personnalisées



Conception modulaire

Vous pouvez utiliser la fonctionnalité modulaire proposée sur votre appareil,
afin d'utiliser différentes fonctions assurées par différents accessoires.
Retirez le module de son emplacement sur [appareil. Vous pouvez, par la suite,
remplacer la batterie ou installer un autre accessoire dans lemplacement du
module pour utiliser les fonctions spécifiques de cet accessoire.

E - Consultez les sections Retrait de la batterie et Installation de la batterie,
pour plus de détails.

« Les accessoires disponibles appelés LG Friends, sont en option.

Pour acheter des accessoires en option, contactez un centre de service
client LG.

+ Les accessoires disponibles peuvent varier en fonction de la région ou de

lopérateur de téléphonie.

+—— Module

o

Always On Display

Vous pouvez afficher la date, [heure, la signature ou dautres informations sur
[écran, méme lorsque celui-ci est éteint. Cette fonctionnalité intéressante permet
de regarder ['heure souvent et dafficher votre signature sans avoir a allumer [écran.

E + La batterie peut se décharger plus vite quand vous utilisez [option Always
On display. Désactivez cette fonction pour prolonger la durée de la batterie.
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1 Appuyez sur Q> Paramétres > Ecran > Always-on display, puis faites
glisser (W pour lactiver.

« Cette fonction peut étre activée lors de achat de appareil

« Les paramétres par défaut de lappareil peuvent varier en fonction de la
région et de lopérateur.

7 Appuyez sur Définissez quoi afficher et sélectionnez les éléments a
afficher sur [écran éteint.

« Heures: Affiche toujours I'heure actuelle, méme si [écran est éteint.

- Signature: Affiche votre signature au lieu de 'heure actuelle sur [écran
éteint. Utilisez loption Définir signature pour entrer une signature et
maodifier la police.

5 « Vérifiez que la signature ne dépasse pas le champ de saisie.

Mode lumiére du jour

Vous pouvez utiliser la fonction avancée IPS Quantum Display pour afficher
[écran clairement, a la lumiére du jour, quand le soleil brille fortement.

Fonctionnalités personnalisées 14



Objectif grand-angle 135°

Vous pouvez utiliser lobjectif grand-angle pour prendre des photos d'une
portée plus large que le champ de vision réel. Cette fonctionnalité est
utile quand vous prenez une photo ou que vous enregistrez une vidéo
d'un paysage ou d'une zone large, depuis une zone étroite. Vous pouvez
immortaliser un horizon majestueux, un concert dans un stade bondé, une
plage entiére et tout ce que peuvent voir vos yeux, et bien plus encore.

E + Consultez la section Passer en mode double appareil photo, pour plus de
détails.

Double appareil photo

Vous pouvez utiliser les deux appareils photos a larriére de appareil pour
prendre de nombreuses photos et vidéos, d'une scéne rapprochée a une
scene étendue. Il vous suffit de resserrer ou décarter vos doigts sur [écran.

E « Consultez la section Passer en mode double appareil photo, pour plus de
détails.
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Photo encadrée

Vous pouvez présenter votre photo comme si elle était encadrée :

vous pouvez prendre une photo standard et une photo grand-angle,
simultanément. Faites ressortir vos photos en les intégrant sur ces quatre
effets de cadres avec arriére-plan : fisheye, noir et blanc, vignette et flou.

E « Consultez la section Photo encadrée, pour plus de détalils.

Stabilisation de 'enregistrement

Utilisez la fonction de stabilisation de lenregistrement pour minimiser le
flou extréme quand vous prenez une photo ou enregistrez une vidéo. Cette

fonction stabilise automatiquement votre photo ou vidéo alors que vous étes

en mouvement. Appuyez sur *9* pour activer cette fonction.

Fonctionnalités personnalisées
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Smart Bulletin

Vous pouvez ajouter un écran daccueil qui rassemble et affiche des
informations utiles.
Affichez les principales actualités de Smart Bulletin en un coup d'ceil.
Vous navez pas besoin d'ajouter un widget supplémentaire, ni douvrir une
application.
1 Appuyez sur O > Paramétres > Ecran > Ecran d'accueil > Smart
Bulletin, puis faites glisser (3 pour lactiver.
+ Smart Bulletin se trouve sur la page la plus a gauche de [écran d'accueil

7 Configurez Smart Bulletin en utilisant les éléments de menu disponibles.
« Pour réorganiser les éléments du menu affichés dans Smart Bulletin,
maintenez le doigt appuyé sur =, puis faites défiler vers le haut ou
vers le bas.
« Pour afficher ou masquer un élément de menu sur Smart Bulletin,
faites glisser (3

E - Pour modifier la configuration de Smart Bulletin, appuyez sur §33 dans
Smart Bulletin.

Smart Notice

Vous pouvez utiliser Smart Notice pour obtenir des informations utiles qui
correspondent a votre heure et votre position géographique. Ce widget
analyse votre environnement et vos habitudes d'utilisation quotidienne pour
fournir des informations utiles a une heure et une position spécifiques.
Smart Notice peut avoir les utilisations suivantes :
- Rappels automatiques pour lajout dans le répertoire de numéros non
enregistrés fréquemment utilisés.
+ Rappels automatiques pour appeler un numéro que vous navez pas
rappelé suite a lenvoi d'un message de refus.
- Rappels automatiques de [anniversaire d'un contact enregistré dans le
calendrier et la liste de contacts.
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+ Rappels automatiques pour le nettoyage des fichiers temporaires, fichiers
téléchargés et applications non utilisées pendant une période donnée.

- Rappels automatiques pour la personnalisation des parametres de
[appareil en fonction du lieu et de vos habitudes d'utilisation.

- Rappels automatiques déconomie dénergie lorsque la consommation de
la batterie est élevée.

Démarrage de Smart Notice

Vous pouvez ajouter le widget Smart Notice quand il n'a pas été ajouté par
défaut ou qu'il a été supprimé de votre écran daccueil. Suivez les étapes ci-
apres pour ajouter le widget :

T Surlécran daccueil, maintenez le doigt appuyé sur un espace vide, puis
appuyez sur Widgets.

7 Maintenez le doigt appuyé sur Smart Notice, puis faites-le glisser pour le
repositionner sur [écran daccueil.

+ Le widget Smart Notice apparait sur [écran daccueil et ses fonctions
de rappel automatique démarrent et une vue densemble de celles-ci
saffiche.

- Appuyez sur £33 sur lécran du widget pour modifier les paramétres de
Smart Notice en fonction de vos préférences ou pour sélectionner des
éléments au sujet desquels vous souhaitez que Smart Notice propose
des rappels automatiques.

« Lafonction Smart Notice peut étre activée lors de lachat de lappareil.

« Les parametres par défaut de lappareil peuvent varier en fonction de la
région et de lopérateur.
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Smart cleaning

Vous pouvez supprimer les fichiers temporaires ou applications qui ne sont
plus utilisées.

1 Appuyez sur O > Paramétres > Général > Smart cleaning.

7 Utilisez les fonctions souhaitées.

€ ——

[ —————

[ ———

oy ——
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Quick Share

Vous pouvez partager une photo ou une vidéo dans lapplication de votre
choix, juste apres lavoir prise.

T Appuyez sur Q> (@, puis prenez une photo ou enregistrez une vidéo.

7 Faites glisser licéne Quick Share qui saffiche aprés avoir pris une photo
ou enregistré une vidéo, puis sélectionnez une application pour la
partager.

Vous pouvez aussi appuyer sur l'icone dapercu en gardant le doigt dessus
apres avoir pris une photo ou enregistré une vidéo, puis la faire glisser sur
l'icone Quick Share.

E « Lapplication apparaissant sur ['icne Quick Share peut varier en fonction du
type et de la fréquence d'acces de lapplication installée sur lappareil.
- Vous pouvez n'utiliser cette fonction que lorsque vous prenez une photo ou
enregistrez une vidéo en mode auto. Consultez la section Mode auto pour
plus de détails.
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QuickRemote

Présentation de QuickRemote

Vous pouvez transformer votre appareil en télécommande pour de nombreux
appareils électroniques se trouvant a différents endroits.

E « Cette fonctionnalité utilise des signaux infrarouges (IR) et a un
fonctionnement tres semblable a celui d'une télécommande. Lorsque vous
utilisez QuickRemote, veillez a ne pas recouvrir le capteur IR situé en haut a
droite de lappareil

« Cette fonctionnalité peut ne pas étre prise en charge en fonction du
fabricant de lappareil, de lopérateur ou de la région.

Enregistrement d'un appareil pour une commande a
distance

Vous pouvez enregistrer [appareil que vous souhaitez commander a distance
avec votre téléphone.

T Appuyez sur O > LG > QuickRemote.

7 Appuyez sur == pour indiquer les lieux oli vous souhaitez utiliser la
télécommande.

3 Appuyez sur -+ et sélectionnez le type et le fabricant de lappareil que
vous voulez commander a distance.

4 Suivez les instructions a [écran pour vous assurer que la fonctionnalité
QuickRemote fonctionne correctement sur lappareil.

Fonctionnalités personnalisées 21



Création d'une télécommande universelle

Quand lappareil que vous souhaitez controler au moyen de votre appareil
nexiste pas dans la liste, vous pouvez créer une commande a distance
universelle personnalisée, en organisant les boutons que vous utilisez le plus
souvent en fonction de vos préférences.

1 Appuyez sur O > LG > QuickRemote.

2 Appuyez sur = pour indiquer les lieux o1 vous souhaitez utiliser la
télécommande.

3 Appuyez sur - > Télécommande universelle.

N

Saisissez le nom de la télécommande et appuyez sur OK.

5 Maintenez le doigt appuyé sur le bouton désiré, puis faites-le glisser
jusqu'a lemplacement désiré.

6 Appuyez sur SUIVANT.

7 Suivez les instructions a lécran pour enregistrer les boutons, puis appuyez
sur ENREG.

QuickMemo+

Présentation de QuickMemo+

Vous pouvez créer des notes créatives a laide de nombreuses options sur ce
bloc-notes aux fonctions avancées, comme la gestion des images et captures
décran, qui ne sont pas prises en charge par le bloc-notes conventionnel.
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Création d'une note
1 Appuyez sur O > QuickMemo+.
2 Appuyez sur @ pour créer une note.
+ . Enregistrement d'une note.
€5 :Annulation de la derniere action.
¢ :Rétablissement de la derniere action annulée.
+ T :Rédaction d'une note a laide du clavier.
-/ :Rédaction de notes a la main.
- & Effacement des notes manuscrites.

- {):Faire un zoom arriére ou avant, pivoter ou effacer les parties d'une
note manuscrite.

¢ :Accés a dautres options, comme partager et verrouiller des notes,
changer le style du bloc-notes et insérer du contenu.

3 Appuyez sur 7 pour enregistrer la note.

Annotation d'une photo
T Appuyez sur O > QuickMemo+.

7 Appuyez sur [O] pour prendre une photo, puis appuyez sur OK.
+ La photo est alors automatiquement jointe dans le bloc-notes.

3 Annotez librement la photo.

4 Appuyez sur </ pour enregistrer la note.

Fonctionnalités personnalisées 23



Annotation d'une capture d'écran
1 Tout en affichant [écran que vous souhaitez capturer, faites glisser la
barre détat vers le bas, puis appuyez sur Capturer+
+ La capture décran apparait comme théme d'arriere-plan du bloc-notes.
Les outils de mémo apparaissent en haut de [écran.
7 Prendre des notes sur [écran capturé.

- Pour découper et enregistrer une partie de [écran, appuyez sur [¢] et
délimitez une zone a laide de loutil de découpage.

- Pour joindre une capture décran au bloc-notes, appuyez sur T

3 Appuyez sur </ et enregistrez les notes a lemplacement de votre choix.

+ Les notes enregistrées peuvent étre visualisées soit dans
QuickMemo+ soit dans Galerie.

« Pour toujours enregistrer les notes au méme emplacement,
sélectionnez la case a cocher Utiliser cette application par défaut
pour cette action et choisissez une application.

Gestion des dossiers
Vous pouvez consulter des notes regroupées en fonction du type de notes.
1 Appuyez sur O > QuickMemo+.

2 Enhaut de [écran, appuyez sur = et sélectionnez un élément du menu :

Tous les mémos: Affichage de toutes les notes enregistrées dans
QuickMemo+.

Mes mémos: Affichage des notes créées par QuickMemo+.

Mémo photo: Affichage des notes créées par [O}

Capturer+: Affichage des notes créées par Capturer+.

Corbeille: Affichage des notes upprimées.
- Nouvelle catégorie: Ajout de catégories.

- §03 - Réorganisation, ajout ou suppression des catégories. Pour
renommer une catégorie, appuyez sur la catégorie en question.

E « Certains dossiers n'apparaissent pas lors du premier démarrage de
QuickMemo-+. Les dossiers désactivés sont activés et apparaissent lorsqu'ils
contiennent au moins une note annexe.
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QSlide

Vous pouvez démarrer des applications avec QSlide pour les utiliser pendant

lexécution d'autre applications. Par exemple, utiliser la calculatrice ou le
calendrier pendant la lecture d'une vidéo.

Lorsqu'une application est en cours dexécution, appuyez sur = > QSlide.

E - Cette fonctionnalité peut ne pas étre prise en charge par certaines
applications.

+ I 7:Désactivation du mode QSlide pour passer en mode plein écran.

+ =) :Réglage de lopacité de la fenétre QSlide. La fenétre QSlide ne
répondra pas aux gestes lorsquelle est transparente.

-+ X :Fermeture de la fenétre QSlide.
A Ajustement de la taille de la fenétre QSlide.

Fonctionnalités personnalisées
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LG Health

Présentation de LG Health

Vous pouvez gérer votre santé et adopter de bonnes habitudes en termes
d'exercice physique en enregistrant les exercices que vous effectuez.

Mise en route de LG Health

Vous pouvez configurer LG Health lors du premier démarrage de lapplication
ou apres sa réinitialisation.

T Appuyez sur O > LG Health.

2 Suivez les instructions a [écran pour terminer la configuration.

Utilisation de LG Health

Vous pouvez visualiser les principales informations sur LG Health et gérer la
quantité d'activité physique et les informations sur votre santé.

1 Appuyez sur O > LG Health.

2 Appuyez sur les icones suivantes :

- =2

:Consultez votre journal deexercices du jour que vous souhaitez vérifier.

@i Commencez denregistrer un exercice. Le parcours et la durée de
lexercice physique sont enregistrés pour chaque type dexercice.
-+ :Définissez vos objectifs dexercice quotidien, y compris les calories

dépensées et votre nombre de pas, ou définissez différents paramétres
de LG Health.
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E « Lesinformations relatives a la santé fournies par LG Health sont destinées a
l'usage de ['utilisateur et ne doivent pas étre utilisées a quelque fin médicale
que ce soit (prévention, traitement, diagnostic, etc.).

« LG Health peut varier ou ne pas étre disponible en fonction du pays et de
lopérateur. Les fonctions LG Health disponibles et les applications pouvant
étre gjoutées a LG Health peuvent varier d'un pays a lautre. en fonction des
lois et réglementations locales.

Ne pas déranger

Vous pouvez limiter ou désactiver les notifications pour éviter détre dérangé
pendant une période donnée.

1 Appuyez sur O > Paramétres > Son et Notification > Ne pas déranger,
puis faites glisser (33 pour lactiver.

7 Appuyez sur Sons et vibrations, puis sélectionnez le mode souhaité :

- Prioritaires uniquement: Ne recevoir des notifications sonores ou
des vibrations que pour les applications sélectionnées. Méme quand
Prioritaires uniquement est activé, les alarmes continuent démettre
des sons.

- Silence total: Désactiver a la fois les sons et les vibrations.

Ring ID

Vous pouvez régler lappareil pour qu'il émette une sonnerie composée
automatiquement lors des appels entrants du contact sélectionné. Cette
fonction est utile pour savoir précisément qui vous appelle juste en entendant
la sonnerie.

T Appuyez sur O > Paramétres > Son et Notification > Ring ID, puis
faites glisser (33 pour lactiver.

2 Appuyez sur Composer des sonneries pour, puis sélectionnez loption
souhaitée.

E « La sonnerie par défaut retentit lors des appels entrants des contacts, sauf
pour le contact sélectionné.
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Reconnaissance digitale

Présentation de la reconnaissance digitale

Commencez par enregistrer votre empreinte digitale sur votre appareil avant
d'utiliser la fonction de reconnaissance dempreinte digitale.

Vous pouvez utiliser cette fonction de reconnaissance dempreinte digitale
dans les cas suivants :

« Pour déverrouiller [écran

« Pour afficher le contenu verrouillé dans Galerie ou QuickMemo+

Il vous suffit de toucher le capteur dempreintes digitales pour vous identifier
afin de confirmer un achat ou de vous connecter a une application.

5

« Votre empreinte digitale reste identique tout au long de votre vie et chaque

personne a une empreinte digitale unique. Cest la raison pour laquelle

vous pouvez utiliser cette empreinte digitale pour vous identifier sur votre
appareil. Le capteur dempreintes digitales peut reconnaftre des empreintes
digitales trés similaires de différents utilisateurs en méme temps. Pour une
plus grande sécurité de votre appareil, associez le verrouillage de [écran a un
modéle, un code PIN ou un mot de passe.

« Sivotre empreinte digitale nest pas reconnue ou si vous oubliez le code PIN

de secours, apportez votre appareil au centre de service client LG le plus
proche pour y enregistrer une empreinte digitale et créer un nouveau code
PIN de secours.

Précautions relatives a la reconnaissance digitale
La précision de la reconnaissance digitale peut diminuer. Vérifiez donc les
points suivants avant d'utiliser lappareil pour loptimiser.
+ La touche Marche-Arrét/Verrouillage de l'appareil intégre un capteur
dempreintes digitales. Assurez-vous que cette touche na pas été
endommagée par un objet métallique, comme une piece ou une clé.

En présence deau, de poussiere ou autre substance étrangere sur la

touche Marche-Arrét/Verrouillage ou sur votre doigt, lenregistrement ou
la reconnaissance dempreinte digitale peut ne pas fonctionner. Nettoyez
et séchez votre doigt pour que votre empreinte digitale soit reconnue.
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L'empreinte digitale peut ne pas étre correctement reconnue si votre doigt
a une cicatrice ou que la peau est plissée apres un long moment dans leau.

Sivous pliez votre doigt ou n'en utilisez que le bout, votre empreinte
digitale peut ne pas étre reconnue. Assurez-vous de recouvrir toute la
surface de la touche Marche-Arrét/Verrouillage avec votre doigt.

Scannez un seul doigt pour chaque enregistrement. Scanner plusieurs
doigts peut affecter lenregistrement et la reconnaissance digitale.

L'appareil peut générer de [électricité statique lorsque lair est sec. Si lair
ambiant est sec, évitez danalyser les empreintes digitales ou de toucher
un objet métallique tel qu'une piece de monnaie ou une clé avant de
procéder a lanalyse des empreintes digitales et afin déliminer [électricité
statique.

Enregistrement des empreintes digitales

Vlous pouvez enregistrer votre empreinte digitale sur [appareil pour utiliser
lidentification digitale.

1 Appuyez sur O > Paramétres > Général > Empreintes digitales &
sécurité > Empreintes digitales.

E « Pour utiliser cette fonctionnalité, assurez-vous que le verrouillage de [écran
est activé. Si le verrouillage de [écran nest pas activé, activez-le. Consultez
la section Configuration des paramétres de verrouillage de [écran pour plus
de détails

2 Repérez la touche Marche-Arrét/Verrouillage a larriere de lappareil et
posez délicatement votre doigt dessus pour enregistrer votre empreinte
digitale.

E « Appuyez délicatement sur la touche Marche-Arrét/Verrouillage pour que le
capteur puisse reconnaitre votre empreinte digitale. Si vous appuyez trop
fort sur la touche Marche-Arrét/Verrouillage, la fonction de verrouillage de
[écran peut sactiver ou [écran séteindre.

+ Veillez a ce que le bout de votre doigt recouvre toute la surface du capteur
de la touche Marche-Arrét/Verrouillage.
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3 Suivez les instructions a [écran.

- Répétez la numérisation de lempreinte digitale en déplacant
progressivement votre doigt jusqua ce que lempreinte digitale soit
enregistrée.

4 Une fois lempreinte digitale enregistrée, appuyez sur OK.

+ Appuyez sur EN AJOUTER D'’AUTRES pour enregistrer une autre
empreinte digitale. Si vous nenregistrez qu'une empreinte digitale et
que le doigt correspondant niest pas en bon état, la reconnaissance
dempreinte digitale peut ne pas fonctionner correctement. Une
mesure préventive dans ce genre de situation consiste a enregistrer
plusieurs empreintes digitales.

Gestion des empreintes digitales
Vous pouvez modifier ou supprimer des empreintes digitales enregistrées.

T Appuyez sur O > Paramétres > Général > Empreintes digitales &
sécurité > Empreintes digitales.

2 Déverrouillez lappareil selon le mode de déverrouillage spécifié.

3 Surla liste des empreintes digitales, appuyez sur une empreinte digitale
pour la renommer. Pour la supprimer, appuyez sur i1
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Déverrouillage de 'écran avec une empreinte digitale

Vous pouvez déverrouiller [écran ou afficher le contenu verrouillé en utilisant
votre empreinte digitale. Activez la fonction souhaitée :

1

2

Appuyez sur (O > Paramétres > Général > Empreintes digitales &
sécurité > Empreintes digitales.

Déverrouillez 'appareil selon le mode de déverrouillage spécifié.

Sur [écran des parametres dempreinte digitale, activez la fonction

souhaitée :

- Verrouillage de l'écran: Déverrouillage de [écran avec une empreinte
digitale.

- Verrouillage du contenu: Déverrouillage de contenu avec une
empreinte digitale. Pour cela, assurez-vous que le verrouillage du
contenu est activé.

Partage de contenu

Lecture de contenu d'un autre appareil

Vous pouvez lire des photos, vidéos ou chansons enregistrées sur votre
appareil a partir d'un téléviseur.

1
2

Connectez le téléviseur et votre appareil au méme réseau Wi-Fi.

Affichez les éléments dans lapplication Galerie ou Musique, puis appuyez
surB2Jou : > Lire sur un autre appareil, puis sélectionner un téléviseur
auquel vous connecter.

E « Pour Chromecast, les services Google Play doivent étre a jour.

Affichage de contenu d'appareils a proximité

Vous pouvez consulter le contenu de différents appareils, tels qu'un
ordinateur, un NAS ou un appareil mobile, avec les applications Galerie ou
Musique.
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Connexion des appareils

Connectez votre appareil et un autre appareil qui prend en charge la fonction
DLNA, au méme réseau sans fil.

E « Assurez-vous que File Sharing (DLNA, le partage de fichier) est activé sur
lappareil et lappareil connecté.

Recherche d'appareils a proximité

Vous pouvez afficher une liste des appareils DLNA sur le méme réseau en
sélectionnant longlet Appareils a proximité dans chaque application.

Utilisez le contenu des appareils a proximité comme si vous le faisiez sur
votre appareil.

Envoi ou réception de fichiers

Vous pouvez partager des fichiers entre votre appareil et un autre appareil LG,
ou encore une table ou un ordinateur.

Envoi de fichiers

Depuis lapplication Galerie, Gest. de fichiers ou Musique, appuyez sur *
> Partager ou <<, puis sélectionnez un appareil dans la liste de partage de
fichiers.

Réception de fichiers
Faites défiler la barre détat vers le bas, puis activez le Partage de fichiers.

Sivotre appareil ne prend pas en charge la fonctionnalité de partage de
fichiers, appuyez sur O > Paramétres > Réseaux > Partage et connexion >
Partage de fichiers > SmartShare Beam.
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Envoi de fichiers a un ordinateur

Vous pouvez rapidement envoyer des fichiers volumineux vers votre
ordinateur.

1 Installez LG Bridge sur votre ordinateur.

2 Démarrez LG Bridge sur lordinateur, puis connectez-vous avec votre
compte LG.

3 Appuyez sur O > Paramétres > Réseaux > Partage et connexion > LG
AirDrive, puis connectez-vous en utilisant votre compte LG.

E « Vous pouvez télécharger LG Bridge depuis le site \Web LG Mobile
(wwwilg.com).

Affichage de contenu depuis votre Cloud

Vous pouvez directement afficher le contenu enregistré dans votre compte
cloud, sans le télécharger sur votre appareil.

1 Depuis lapplication Galerie, Musique ou Gest. de fichiers, sélectionnez
=> Cloud.

2 Sélectionnez un compte Cloud et connectez-vous.

3 Enregistrez ou lisez du contenu de votre cloud.

Dual Play

Vous pouvez afficher [écran de votre appareil sur un appareil daffichage
connecté par une connexion sans fil et utiliser différentes applications sur
votre appareil en méme temps.

Utilisez un partage décran pour la connexion.

E « Cette fonctionnalité nest pas disponible pour certains contenus.
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Composants du produit et accessoires

Assurez-vous quaucun des éléments suivants ne manque :

Appareil - Cable USB
Pile + Chargeur
Outil déjection + Guide de démarrage rapide

Casque stéréo

A

Les éléments décrits ci-dessus peuvent étre en option.

Les éléments fournis avec lappareil et les éventuels accessoires disponibles
peuvent varier en fonction de la région et de lopérateur de téléphonie.
Utilisez toujours des accessoires dorigine LG Electronics. Lutilisation
daccessoires d-autres fabricants peut avoir une incidence sur la
performance dappel de votre appareil et causer des dysfonctionnements.
Cela peut étre couvert par le service de réparation de LG.

En cas d'absence de l'un de ces éléments de base, contactez le vendeur
aupres duquel vous avez acheté lappareil.

Pour acheter dautres accessoires de base, contactez le centre de service
client LG.

Pour acheter des accessoires en option, contactez le centre de service client
LG pour connaitre les distributeurs disponibles.

Certains éléments de la boite du produit peuvent changer sans préavis.

L'apparence et les spécifications de votre appareil peuvent étre changées
sans préavis.
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Présentation des piéces
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+ Capteur de lumiere ambiante/de proximité :

- Capteur de proximité : Pendant un appel, le capteur de proximité
éteint [écran et désactive les fonctions tactiles lorsque lappareil est a
proximité du corps humain. Il rallume [écran et réactive les fonctions
tactiles lorsque lappareil se trouve a une distance spécifique.

- Capteur de lumiere ambiante : Le capteur de lumiere ambiante
analyse l'intensité de la lumiére ambiante lorsque le mode de réglage
automatique de la luminosité est activé.

+ Mise au point automatique a détection laser

- Détecte la distance entre la caméra et votre sujet pour la mise au point
automatique.

- Fait le point rapidement sur les objets les plus proches ou les plus
éloignés lorsque vous utilisez [appareil photo arriére pour prendre des
photos.

- Touches de volume

- Réglez le volume des sonneries, appels ou natifications.

- Appuyez légerement sur une touche de volume pour prendre une photo.
Pour des prises de vue en continu, appuyez de maniére prolongée sur la
touche de volume.

- Appuyez deux fois sur la touche Diminuer e volume (-) pour ouvrir
lapplication Photo lorsque [écran est verrouillé ou éteint. Appuyez deux
fois sur la touche Augmenter le volume (+) pour ouvrir Capturer+.

« Touche Marche-Arrét/Verrouillage (capteur dempreintes digitales)

- Appuyez brievement sur la touche lorsque vous souhaitez activer ou
désactiver [écran.

- Appuyez de maniere prolongée sur la touche lorsque vous souhaitez
sélectionner une option de controle de lalimentation.

- Appuyer légerement sur la touche lorsque vous souhaitez déverrouiller
[écran avec votre empreinte digitale.
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E « llacces a certaines fonctions peut étre restreint en fonction des
spécifications de lappareil.

+ Une antenne NFC est intégrée a larriére de appareil. Veillez a ne pas
lendommager.

« Ne posez pas dobjets lourds et ne vous asseyez pas sur lappareil. Cela
pourrait endommager [écran tactile.

« Le film de protection de [écran ou des accessoires peuvent géner le capteur
de proximité.

« Le capteur tactile ou les boutons peuvent ne pas fonctionner correctement
si votre appareil est mouillé ou utilisé dans un lieu humide.

Mise en marche / Arrét du téléphone

Mise en marche du téléphone
Alors que l'appareil est hors tension, appuyez de maniére prolongée sur la
touche Marche-Arrét/Verrouillage.

E « La configuration initiale seffectue lors de la premiere mise en marche de
lappareil. Le premier démarrage du smartphone peut étre plus long que
dordinaire.

Arrét du téléphone

Maintenez a touche Marche-Arrét/Verrouillage enfoncée, puis sélectionnez
Eteindre.

Options de controle de l'alimentation
Maintenez le doigt appuyé sur la touche Marche-Arrét/Verrouillage, puis
sélectionnez une option.

- Eteindre: Arrét de lappareil

- Redémarrer: Redémarrage de appareil.

« Activer le mode avion: Blocage des fonctions de télécommunication,

y compris les appels, la messagerie et la navigation Internet. Les autres
fonctions restent disponibles.
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Installation de la carte SIM

Utilisez correctement la carte SIM (Subscriber Identity Module) fournie par
votre opérateur de téléphonie mobile.

1 Insérez la broche d'injection dans le support de carte.

@

7 Retirez le support de carte.

3 Placez la carte SIM sur le support de carte avec les zones de contact
dorées orientées vers le bas.
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/A Réinsérez le support de carte dans son emplacement.

N\

N

Précautions a prendre lors de l'utilisation de cartes SIM
+ Ne perdez pas votre carte SIM. LG ne peut étre tenu responsable des
dommages et autres problémes causés par la perte ou le transfert d'une
carte SIM.
+ Veillez a ne pas endommager la carte SIM lorsque vous linsérez ou la
retirez.

E « Parmi les différents types de cartes SIM, seules les cartes Nano-SIM
fonctionnent sur cet appareil.
« Pour des performances optimales, il est recommandé d'utiliser le téléphone
avec le type de carte SIM approprié. Utilisez toujours une carte SMI
fabriquée et fournie par lopérateur.

Insertion de la carte mémoire

L'appareil prend en charge des cartes microSD jusqua 2 To. Certaines cartes
mémoire peuvent ne pas étre compatibles avec votre appareil, selon le
fabricant et le modéle de la carte mémoire.

A « Certaines cartes mémoire peuvent ne pas étre pleinement compatibles
avec lappareil. Si vous utilisez une carte incompatible, vous risquez
dendommager appareil ou la carte mémoire, voire encore corrompre les
données qui sont dessus.
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1 Insérez la broche d'injection dans le support de carte.
7 Retirez le support de carte.

3 Placez la carte mémoire sur le support de carte avec les zones de contact
dorées orientées vers le bas.

Carte mémoire

Carte SIM

/A Réinsérez le support de carte dans son emplacement.

+ Lacarte mémoire est un élément en option.

« Lécriture ou leffacement fréquents des données peut réduire la durée de vie
des cartes mémoire.

. e .
Extraction de la carte mémoire

Pour plus de sécurité, démontez la carte mémoire avant de lextraire.

1 Appuyez sur O > Paramétres > Général > Stockage et USB > A

7 Insérez la broche d'injection dans le support de carte.

3 Tirez le support de carte, puis retirez la carte mémoire.

A + Nextrayez pas la carte mémoire alors que lappareil est en train de
transférer ou d'accéder aux informations. Cela pourrait provoquer la perte
ou la corruption des données, voire endommager la carte mémoire ou
lappareil. LG ne saurait étre tenu responsable des pertes résultant de

labus ou de [utilisation impropre des cartes mémoire, y compris |a perte de
données.
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Pile
Retrait de la batterie

A « Eteignez lappareil avant de retirer la batterie. ous pourriez autrement
endommager lappareil

1 Appuyez sur le bouton déjection du module pour éjecter partiellement le
module de [appareil.

j@-— Module
/\\/L@
Clé de retrait du module J

\¢
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3 Tenez la batterie et le module dans vos mains et séparez-les ['un de lautre
dans le sens de la fleche.

+ Ne déformez pas la batterie lorsque vous |a retirez. Cela pourrait
endommager le cache en plastique de la batterie.

Iy

Installation de la batterie

A « Les spécifications de lappareil peuvent varier en fonction de la région et
de lopérateur de téléphonie. Pour lachat de batteries supplémentaires ou
déléments facultatifs compatibles, contactez un centre de service client LG
pour une assistance.
« Assurez-vous de n'utiliser que des accessoires dorigine fournis par LG
Electronics. Lutilisation d'accessoires provenant dautres fabricants peut
endommager lappareil ou causer des dysfonctionnements.

1 Alignez les fleches indiquées correctement et insérez la batterie dans le
module dans lordre indiqué sur limage.
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7 Saisissez la partie inférieure du module tel qu'illustré sur la figure
ci-dessous, puis faites délicatement glisser le module dans lappareil
jusqua ce qu'ils soient solidement fixés.

E + Nappuyez jamais sur le bouton déjection du module lorsque vous insérez le
module dans lappareil.

Précautions d'utilisation du module

- Lorsque vous insérez la batterie dans lappareil, vérifiez quielle est bien
fixée au module. Sivous insérez la batterie alors quelle nest pas fixée au
module, vous pourriez endommager lappareil.

+ Lors du remplacement de la batterie, veillez a ce quaucun corps étranger
ou de leau ne pénetre dans lappareil

+ Ne placez pas lappareil dans un lieu chaud et humide lorsque le module de
batterie est retiré.

+ Veillez a ce quaucun objet métallique ou de leau nentre en contact avec
lintérieur de lappareil pour le préserver de tout dommage.

Laisser lappareil séparé du module de batterie pendant une période
prolongée peut entrainer une déformation de l'appareil ou endommager
les contacts métalliques, ce qui peut entrainer des dysfonctionnements.

- Ne séparez jamais le module de appareil sans appuyer sur le bouton
déjection du module. Cela risquerait dendommager lappareil.

Ne retirez jamais le module en cours d'utilisation.

+ Encas décart entre le module et lappareil en cours d'utilisation de ce
dernier, insérez fermement le module dans lappareil.
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- Sivous insérez un module qui nest pas compatible avec votre opérateur,
par exemple, un module acheté chez un autre opérateur ou dans une
région non couverte par votre opérateur, il se peut que votre appareil ne
fonctionne pas correctement.

Veillez a ne pas vous blesser les doigts lors de linsertion ou du retrait du
module.

Veillez a insérer la batterie et le module correctement. Si vous ne

les insérez pas comme il faut, lappareil risque de ne pas fonctionner
correctement ou détre endommagé.

+ Sivous ne respectez pas les consignes figurant dans le guide d'utilisation, vous
risquez dendommager lappareil

Chargement de la batterie

Chargez entierement la batterie avant d'utiliser votre téléphone pour la
premiére fois.

Branchez une extrémité du cable de chargement sur le chargeur, insérez
lautre extrémité dans la prise de cable puis branchez le chargeur sur une
prise de courant.

A « Utilisez le cable USB fourni en tant quaccessoire de base.

« \eillez a utiliser le chargeur, la batterie et le cable de chargement agréés
par LG. Lutilisation d'un chargeur provenant dautres fabricants pour
recharger la batterie présente un risque dexplosion ou dendommagement
de lappareil

« Lutilisation de lappareil en cours de charge peut provoquer un choc
électrique. Arrétez le chargement pour utiliser [appareil.
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E « Cet appareil est fourni avec la batterie insérée. Lors de la premiere

utilisation de lappareil, vérifiez le niveau de la batterie et chargez-la
complétement avant d'utiliser lappareil si nécessaire.

« Débranchez le chargeur de la prise dalimentation lorsque lappareil est
entierement chargé. Cela évite toute consommation délectricité inutile.

« Il est également possible de recharger la batterie en branchant lappareil sur
un ordinateur de bureau portable au moyen d'un cable USB. Cela peut durer
plus longtemps que de recharger la batterie de la maniere classique.

+ Ne chargez pas |a batterie avec un concentrateur USB incapable de
maintenir la tension nominale. Le chargement pourrait échouer ou sarréter
involontairement.

Utilisation optimale de la batterie

La durée de vie de la batterie peut diminuer si vous faites fonctionner
simultanément un grand nombre d'applications et de fonctionnalités
logicielles de maniére continue.

Annulez les taches darriere-plan pour prolonger autonomie de la batterie.

Suivez les conseils ci-dessous pour limiter la consommation de la batterie :

Désactivez le Bluetooth® ou le réseau Wi-Fi lorsque vous ne les utilisez
pas.

Paramétrez un délai de mise en veille de [écran le plus court possible.
Réduisez a luminosité de [écran.

Réglez le verrouillage de [écran lorsque lappareil nest pas utilisé.

Pour utiliser une application téléchargée, vérifiez le niveau de la batterie.
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Ecran tactile

Vous pouvez vous familiariser avec les commandes tactiles de votre appareil.

Appuyer
Appuyez légerement avec le bout du doigt pour sélectionner ou exécuter une
application ou une option.

Appui de facon prolongée
Maintenez le doigt appuyé plusieurs secondes pour exécuter une fonction
masquée.
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Appuyer deux fois
Appuyez deux fois rapidement pour faire un zoom avant ou arriere sur une
page \Web ou une carte.

Faire glisser

Appuyez sur un élément, comme une application ou un widget, puis faites
glisser votre doigt vers un autre emplacement dans un mouvement controlé.
Vous pouvez utiliser ce geste pour déplacer un élément.

Glisser

Appuyez sur [écran avec votre doigt et déplacez-le rapidement, sans faire de
pause. Vous pouvez utiliser ce geste pour parcourir une liste, une page Web,
des photos, des écrans, etc.
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Rapprocher/écarter

Rapprochez deux doigts pour faire un zoom arriére, sur une photo ou une
carte. Pour faire un zoom avant, écartez les doigts.

>

Wi
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Evitez dexposer [écran tactile a tout choc excessif Cela pourrait
endommager le capteur tactile.

['&cran tactile peut ne pas fonctionner si vous utilisez appareil a proximité
d'un matériau magnétique, métallique ou conducteur.

L'écran peut ne pas étre visible en fonction de votre position si vous utilisez
lappareil dans des conditions de forte luminosité, comme sous les rayons
directs du soleil. Utilisez lappareil a lombre ou dans un endroit ot la lumiere
ambiante nlest pas trop lumineuse, mais suffisamment pour la lecture.

N'appuyez pas trop fort sur [écran.
Appuyez légerement du bout du doigt sur [option de votre choix.

Les commandes tactiles peuvent ne pas fonctionner correctement si vous
portez des gants ou tapez avec vos ongles.

Les commandes tactiles peuvent ne pas fonctionner correctement si [écran
est humide ou mouillé.

L'écran tactile peut ne pas fonctionner correctement s'il est recouvert d'un
film de protection ou si le téléphone est équipé d'accessoires achetés dans
une boutique en ligne ou un point de vente.
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Ecran d'accueil

Présentation de [‘écran d'accueil

Lécran daccueil est le point de départ de nombreuses applications et
fonctions. Appuyez sur O, sur nimporte quel écran, pour vous rendre
directement sur [écran daccueil.

Vous pouvez gérer toutes les applications et tous les widgets sur [écran
d'accueil. Faites glisser [écran vers la gauche ou la droite pour voir toutes les
applications installées en un coup d'ceil.

Pour rechercher une application, faites une recherche sur Google.

Disposition de ['écran d'accueil

Affichez toutes les applications et organisez les widgets et les dossiers sur
[écran d'accueil

Barre détat — TR

¢ feo— Widget

Icbne de page

Touches tactiles de [écran —3}
daccueil

5 « L8cran daccueil peut varier en fonction de votre opérateur et de la version
logicielle.

- Barre détat : Affichage des icones détat, de I'heure et du niveau de la
batterie.
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+ Widget : Ajout de widgets sur [écran d'accueil pour un acces rapide aux
informations utiles sans avoir a ouvrir les applications une par une.

Dossier : Créez des dossiers pour regrouper les applications en fonction de
vos préférences.

+ |cBne de page : Affichage du nombre total de pages décran d'accueil et de
la page en cours qui est en surbrillance.

- Zone dacces rapide : Ancrage des principales applications en bas de [écran
pour quelles restent accessibles depuis n'importe quelle page de [écran
daccueil.

« Touches tactiles de [écran d'accueil

- <] :Retour a lécran précédent. Fermeture du clavier ou des fenétres
contextuelles.

- (O :Appuyez pour revenir a [écran d'accueil. Pour ouvrir Google,
maintenez le doigt appuyé.

- [ Affichage d'une liste des applications récemment utilisées ou
exécution d'une application de la liste. Utilisez loption Tout effacer pour
supprimer toutes les applications récemment utilisées. Dans certaines
applications, appuyer et maintenir permet d'accéder a des options
supplémentaires.

Modification des touches tactiles de ['écran d'accueil
Vous pouvez réorganiser les touches tactiles de [écran d'accueil ou bien'y
ajouter des fonctions fréquemment utilisées.

Appuyez sur O > Paramétres > Ecran > Touches tactiles > Combinaison
de boutons et personnalisez les parametres.

« Plusieurs fonctions, dont Qslide, le panneau de notifications ou Capture+
sont fournies. Il est possible dajouter 5 éléments au maximum.
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Icones d'état

Lorsqu'il y a une notification de message non lu, dévénement du calendrier ou
dalarme, la barre détat affiche l'icone de notification correspondante. Vérifiez

[état de votre appareil en visualisant les icnes de notification affichées sur
barre détat.

2l Aucun signal

:Transmission de données en cours sur le réseau

© :Alarme activée

« u[Jn: Mode Vibreur activé

- € :Bluetooth activé

- s :Connecté a un PC via un cable USB
-l :Niveau de la batterie

4 :Mode Avion activé

X :Appels manqués

- @ Wi-Fiactivé

X : Mode Silence activé

- @ :GPS activé

- (4 : Point d'acces Wi-Fi activé

- @ : Aucune carte SIM insérée

E « Certaines de ces icones peuvent apparaitre différemment ou ne pas
apparaitre du tout en fonction de [état de lappareil. Reportez-vous aux
icones en fonction de lenvironnement réel dans lequel vous utilisez
lappareil.

« Lesicones affichées peuvent varier en fonction de la zone et de lopérateur.

Fonctions de base
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Panneau de notifications

Pour ouvrir le panneau de notifications, faites glisser la barre détat vers le bas.

Les icOnes d'acces rapide dans le panneau de notifications vous permettent
dactiver ou de désactiver rapidement et facilement une fonction.

Faites glisser vers la gauche ou vers la droite sur la liste des codes d'acces
rapide pour sélectionner l'icéne de fonction désirée.
+ Sivous maintenez le doigt appuyé sur l'icone, [écran parametres de la
fonction correspondante apparait.

,— Accéder a lapplication
Paramétres.

.
09:00 2 & @eg— Sélectionner un utilisateur.
Afficher les icones dacces —ef < @ 3 @
rapide. . _ —
ke
Sélectionner un appareil pour — % =1 Ajuster la luminosité
le partage de [écran du D b 00 oy
téléphone.
eephone ° s — L permettre la réception de
. fichiers envoyés depuis
Afficher les notifications. — =l dautres appareils

Supprimer les notifications.

Parametres du panneau de notifications
Vous pouvez sélectionner un élément a afficher sur le panneau de
notifications.
Appuyez sur /2 sur le panneau de notifications.
- Pour réorganiser les icones dacces rapide, maintenez le doit appuyé sur
une icdne puis faites-la glisser pour la repositionner.

+ Sélectionner les icones que vous souhaitez voir apparaitre sur la liste.

E « Les différents éléments de menu disponibles peuvent varier en fonction de
la région ou de lopérateur de téléphonie.
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Changement de l'orientation de ['écran

Vous pouvez régler le changement automatique de lorientation de [écran en
fonction de la position de lappareil.

Sur le panneau de notifications, appuyez sur Rotation depuis |a liste des
icones dacces rapide.

Vous pouvez aussi appuyer sur O > Paramétres > Ecran, puis activer
Rotation automatique de l'écran.

Modification de l'écran d'accueil
Sur [écran d'accueil, maintenez le doigt appuyé sur un espace vide, puis
exécutez la fonction désirée.

+ Pour réorganiser les pages de [écran daccueil, maintenez le doit appuyé
sur une page puis faites-la glisser vers un autre emplacement.

- Pour ajouter des widgets sur [écran daccueil, appuyez sur Widgets et
faites glisser un widget sur [écran d'accueil.

+ Pour modifier les parametres de [écran d'accueil, appuyez sur Paramétres
de l'écran d'accueil et personnalisez les options. Consultez la section
Parametres de [écran daccueil, pour plus de détails.

+ Pour afficher ou réinstaller les applications désinstallées, appuyez sur
Apps désinstallées. Consultez la section Apps desinstallées, pour plus de
détalils.
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Visualisation du théme d'arriére-plan

Vous pouvez visualiser uniquement image d‘arriere-plan en masquant les
applications et les widgets sur [écran daccueil.

Ecartez deux doigts tout en les maintenant appuyés sur lécran d'accueil

+ Pour revenir a [écran d'accueil qui affiche les applications et les widgets,
rapprochez vos doigts sur [écran daccueil ou appuyez sur <]

Recherche d'applications sur ['écran d'accueil

Vous pouvez facilement rechercher des applications installées sur [écran
daccueil en saisissant le nom de lapplication souhaitée dans le widget
Google.

La liste des applications affichées s'affiche dans [écran de recherche Google.

Déplacement d'applications sur 'écran d'accueil
Sur [écran d'accueil, maintenez le doigt appuyé sur une application, puis
faites-la glisser vers un autre emplacement.

+ Pour conserver vos applications fréquemment utilisées en bas de [écran
d'accueil, maintenez le doigt appuyé sur une application, puis faites-la
glisser sur la zone d'acces rapide dans la partie inférieure.

+ Pour supprimer une icéne de la zone dacces rapide, faites glisser l'icone
sur [écran daccueil.
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Utilisation de dossiers depuis ['écran d'accueil

Création de dossiers

Sur [écran d'accueil, maintenez le doigt appuyé sur une application, puis
faites-la glisser sur une autre application.

Un nouveau dossier est créé et lapplication y est ajoutée.

Modification de dossiers
Sur [écran d'accueil, appuyez sur un dossier, puis exécutez la fonction désirée.
+ Pour modifier le nom et la couleur du dossier, appuyez sur le nom du

dossier.

Pour supprimer une application du dossier, maintenez le doigt appuyé

sur lapplication et faites-la glisser en dehors du dossier. Si lapplication
désinstallée est la seule application présente dans le dossier; ce dossier est
automatiquement supprimé.

Parametres de ['écran d'accueil
Vous pouvez personnaliser les paramétres de [écran d'accueil.

1
2

Appuyez sur O > Paramétres > Ecran > Ecran d'accueil

Personnalisez les parametres :
- Sélectionnez Accueil: Sélectionnez un mode décran daccueil.

Fond d'écran: Modifiez le theme darriere-plan de [écran d'accueil.

Effet de défilement des écrans d'accueil: Sélectionnez leffet que
vous souhaitez afficher lorsque vous passez d'une page de [écran
daccueil a une autre.

+ Theme: Sélectionnez le theme de [écran a appliquer.

- Trier les apps par: Configurez la maniere dont les applications sont
affichées sur [écran daccueil.

Grille: Modifiez le mode dorganisation des applications de [écran daccueil.

+ Masquer applis: Sélectionnez les applications a masquer ou non sur
[écran daccueil.

Smart Bulletin: Utilisez [écran d'accueil pour y afficher des
informations personnalisées.
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Verrouillage de 'écran

Présentation du verrouillage de écran

Lorsque vous appuyez sur la touche Marche-Arrét/Verrouillage, [écran de
votre appareil séteint et se verrouille. Cela est également le cas lorsque votre
appareil reste inactif pendant une période donnée.

Sivous appuyez sur la touche Marche-Arrét/Verrouillage lorsque
le verrouillage de [écran nest pas activé, [écran daccueil apparait
immédiatement.

Activez le verrouillage de [écran pour plus de sécurité et empécher tout accés
indésirable a votre appareil

E « Leverrouillage de [écran évite les saisies non désirées sur [écran de lappareil
et réduit la consommation de la batterie. Nous vous recommandons
dactiver le verrouillage de [écran pendant que vous n'utilisez pas lappareil.

Configuration des parametres de verrouillage de
l'écran
Plusieurs options sont disponibles pour configurer les parametres de
verrouillage de [écran.
1 Appuyez sur O > Paramétres > Ecran > Ecran de verrouillage > Choisir
l'écran de verrouillage puis sélectionnez votre méthode préférée.
7 Personnalisez les paramétres de verrouillage :
+ Aucun: Désactivation de la fonction de verrouillage de [écran.
« Glisser: Déverrouillage de [écran d'un glissement de doigt.

- Knock Code: Déverrouillage de [écran en effectuant une combinaison
de frappes a [écran, conformément a un modele.

+ Schéma: Déverrouillage de [écran en tragant un schéma.

+ Code PIN: Déverrouillage de [écran a travers la saisie d'un mot de
passe numerique.

- Mot de passe: Déverrouillage de écran a travers la saisie d'un mot de
passe alphanumérique.
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« Pour activer le verrouillage de [écran a laide d'un schéma, vous devez
dabord créer un compte Google ou un code PIN de secours. Si vous tracez
un schéma incorrect plus que le nombre de fois spécifié a la suite, vous
pouvez déverrouiller [écran a laide de votre code PIN de secours ou compte
Google.

« Sile verrouillage de [écran est activé avec un code PIN ou mot de passe et
que vous saisissez un code PIN ou mot de passe erroné plus que le nombre
de fois spécifié, la saisie du mot de passe est bloquée pendant 30 secondes.

Parametres de |'écran de verrouillage
Vous pouvez personnaliser les paramétres suivants de [écran de verrouillage.

1 Appuyez sur O > Paramétres > Ecran > Ecran de verrouillage.

7 Personnalisez les paramétres :
« Choisir l'écran de verrouillage: Sélection d'une méthode de

verrouillage de [écran.

Smart Lock: Sélection de situations de confiance, si bien quen cas de
survenue de 'une delles lappareil est automatiquement déverrouillé.

Effet de défilement des écrans d'accueil: Configuration des effets de
transition de [écran a appliquer lorsque [écran est déverrouillé. Cette
option apparait lorsque la méthode de verrouillage de [écran est définie
sur glisser.

Fond d'écran: Modifiez limage darriére-plan de [écran de verrouillage.

Raccourcis: Ajout d'un raccourci dapplication et acces direct a celle-ci
depuis [écran de verrouillage en la faisant glisser en dehors du grand
cercle. Cette option apparait si la méthode de verrouillage de [écran est
définie sur glisser.

Animation météo: Affichage des animations météo correspondant a
votre position actuelle sur [écran de verrouillage.

Personne a contacter en cas de perte du téléphone: Affichage des

informations de la personne a contacter en cas d'urgence sur [écran de
verrouillage.
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+ Minuterie du verrouillage: Définissez la durée d'inactivité au bout de
laquelle l'appareil se verrouille automatiquement.

- Verrouillage instantané par bouton d'alimentation: Verrouillage
instantané de [écran lorsque vous appuyez sur la touche Marche-
Arrét/Verrouillage.

5 « Les parametres disponibles peuvent varier selon la méthode de verrouillage
sélectionnée.

KnockON

Vous pouvez activer ou désactiver [écran en le touchant deux fois.

Activation de l'écran
Appuyez deux fois au centre de [écran.

+ Sivous appuyez en bas ou en haut, il se peut que le taux de
reconnaissance diminue.

Désactivation de ['écran
Appuyez deux fois sur un emplacement vide de [écran daccueil.
Vous pouvez aussi appuyer deux fois sur un espace vide dans la barre détat

E « Cette option nest disponible que sur [écran daccueil de LG. Elle peut ne
pas fonctionner correctement sur un lanceur personnalisé ou sur [écran
d'accueil installé par ['utilisateur.

« Utilisez le bout du doigt pour appuyer sur [écran. N'appuyez pas avec vos
ongles.

« Pour utiliser la fonctionnalité KnockON, veillez a ce que le capteur de
proximité/lumiére ne soit pas obstrué par un autocollant ou autre corps
étranger.
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Knock Code

Vous pouvez déverrouiller [écran en créant votre propre Knock Code
(combinaison de frappes). Lorsque [écran est verrouillé, vous pouvez accéder
directement a [écran d'accueil en appuyant sur [écran selon une séquence
spécifique.

Création d'un Knock Code (combinaison de frappes)
1 Appuyez sur O > Paramétres > Ecran > Ecran de verrouillage > Choisir
l'écran de verrouillage > Knock Code.

2 Pour définir votre Knock Code, appuyez sur les carrés selon le schéma que
vous souhaitez puis appuyez sur SUIVANT.

3 Saisissez a nouveau votre Knock Code pour vérification, puis appuyez sur
CONFIRMER.

/A Définissez un code PIN de secours en cas doubli du Knock Code.

Déverrouillage de écran a l'aide du Knock Code

Vous pouvez déverrouiller [écran en saisissant le Knock Code que vous avez
déja défini.

Saisissez votre Knock Code sur [écran tactile lorsque [écran est éteint.

E « Vous pouvez utiliser votre Knock Code avec la fonctionnalité KnockOn.

« Sivous tapez un Knock Code incorrect plus que le nombre de fois spécifié
a la suite, vous pouvez déverrouiller lappareil a laide de votre code PIN de
secours ou compte Google.

« Assurez-vous dappuyer sur [écran du bout du doigt.
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Démarrage sécurisé

Vue d’ensemble du démarrage sécurisé

Quand vous mettez votre appareil sous tension, son écran est verrouillé, pour
une question de sécurité. Déverrouillez [écran au moyen de la méthode de
déverrouillage actuelle, telle que le Knock Code, le motif, le mot de passe ou le
code PIN. Tant que [écran nest pas déverrouillé, vous ne pouvez pas recevoir
la plupart des appels téléphoniques, des messages texte, des alarmes, des
notifications et plus encore.

Précautions pour le démarrage sécurisé
- Sivous saisissez le mot de passe de maniere incorrecte plus d'un certain

nombre de fois spécifique, lappareil se réinitialise automatiquement.
Veillez a ne plus oublier votre mot de passe.

Si vous avez oublié votre mot de passe, vous devez réinitialiser lappareil
pour le réutiliser. La réinitialisation supprimera toutes les données
enregistrées antérieurement.

Iy a cryptage lorsque l'appareil est démarré pour la premiére fois apres
son initialisation. Les données peuvent étre endommagées si le cryptage
est interrompu prématurément. Par exemple, ne retirez ou n'insérez pas la
batterie pendant que le cryptage est en cours. Attendez que le cryptage
soit terminé.
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Cryptage de la carte mémoire

Vous pouvez crypter et protéger les données enregistrées sur la carte
mémoire. Les données cryptées sur la carte mémoire sont inaccessibles
depuis un autre appareil.

1 Appuyez sur O > Paramétres > Général > Empreintes digitales &
sécurité > Crypter la carte SD.

7 Lisez la présentation a [écran concernant le cryptage de la carte mémoire,
puis appuyez sur CONTINUER pour continuer.
3 Sélectionnez une option et appuyez sur CRYPTER MAINTENANT :
« Cryptage du nouveau fichier: Cryptage uniquement des données
enregistrées sur la carte mémoire apres le cryptage.
+ Cryptage complet: Cryptage de toutes les données actuellement
enregistrées sur la carte mémoire.

Exclure les fichiers multimédia: Cryptage de tous les fichiers, sauf les
fichiers multimédias comme la musique, les photos et les vidéos.

Pour crypter la carte mémoire, assurez-vous que [écran de verrouillage est
activé a laide d'un code PIN ou mot de passe.

il

l'acces a certaines fonctions est limité une fois le cryptage de la carte
mémoire commencé.

Si vous éteignez l'appareil en cours de cryptage, le processus échouera et
certaines données peuvent étre endommagées. \érifiez donc que le niveau
de chargement de la batterie est suffisant avant de lancer le cryptage.

Les fichiers cryptés ne sont accessibles que depuis lappareil sur lequel ils
ont été cryptés.

« La carte mémoire cryptée ne peut étre utilisée sur un autre appareil LG.
Pour utiliser une carte mémoire cryptée sur un autre terminal mobile, vous
devez la réinitialiser.

« Vous pouvez activer le cryptage de la carte mémoire méme si aucune
carte mémoire nest insérée dans lappareil. Toute carte mémoire installée
ultérieurement sera automatiquement cryptée.

Fonctions de base 62



Captures d'écran

Vous pouvez réaliser des captures de [écran que vous consultez.

Par raccourci

Appuyez de maniere prolongée sur la touche Marche-Arrét/Verrouillage et
la touche Diminuer le volume (-) en méme temps pendant au moins deux
secondes.

- Les captures décran peuvent étre visualisées depuis le dossier Screenshots
sous Galerie.

Par Capture+

Sur [écran que vous souhaitez capturer; faites glisser la barre détat vers le bas
puis appuyez sur Capturer+.

E « Lorsque [écran est éteint ou verrouillé, vous pouvez accéder a Capturer+ en
appuyant deux fois sur la touche Augmenter le volume (+). Commencez par
appuyer sur () > Paramétres > Général, puis activez Touche de raccourci.

« Consultez la section Annotation d'une capture décran, pour plus de détails.

Saisie de texte

Utilisation du clavier Smart
Vous pouvez utiliser le clavier Smart pour saisir et modifier du texte.

Le clavier Smart vous permet de visualiser le texte en cours de saisie sans
avoir a basculer entre [écran et un clavier conventionnel. Il vous permet
également de repérer et de corriger facilement les erreurs en cours de saisie.
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Déplacement du curseur
Le clavier Smart vous permet de déplacer le curseur exactement la ol vous le souhaitez.

En cours de saisie, maintenez le doigt appuyé sur la barre d'espace, puis faites
glisser vers la gauche ou vers la droite jusqua ce que le curseur atteigne
lendroit désiré dans le texte.

< Smart keyboard

E « Cette option nest disponible que sur le clavier QWERTY.

Suggestion de mots

Le clavier Smart analyse automatiquement vos habitudes d'utilisation pour
vous suggeérer des mots fréquemment utilisés en cours de frappe. Plus vous
utiliserez votre appareil, plus les suggestions seront pertinentes.
Saisissez du texte, puis appuyez sur le mot suggéré ou faites glisser
|égérement le coté gauche ou droit de la barre d'espace vers le haut.
- Le mot sélectionné est automatiquement inséré. Il n'est pas nécessaire de
taper manuellement chaque lettre du mot.

Smartphone Smart Smartphones
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Modification de la disposition du clavier QWERTY
Vous pouvez ajouter, supprimer ou réorganiser des touches sur la ligne
inférieure du clavier.

1 Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier
LG > Hauteur et disposition du clavier > Disposition QUWERTY.
Vous pouvez également appuyer sur g sur le clavier puis sur Hauteur et
disposition du clavier > Disposition QWERTY.

2 Appuyez sur une touche sur la ligne inférieure, puis faites-la glisser vers
une autre position.

% jj[EJ III.

OO
] )

E « Cette option nest disponible que sur les claviers QWERTY, QWERTZ et
AZERTY.

« Cette fonction peut ne pas étre prise en charge dans certaines langues.

Personnalisation de la hauteur du clavier

Vous pouvez personnaliser la hauteur du clavier pour plus de confort lors de

la saisie.

T Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier
LG > Hauteur et disposition du clavier > Hauteur du clavier.

Vous pouvez également appuyer sur g sur le clavier puis sur Hauteur et
disposition du clavier > Hauteur du clavier.
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2 Ajustez la hauteur du clavier

Sélection d'un mode de clavier paysage

Vous avez le choix entre plusieurs modes de clavier paysage.

1 Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier
LG > Hauteur et disposition du clavier > Type de clavier en paysage.
Vous pouvez également appuyer sur £ sur le clavier puis sur Hauteur et
disposition du clavier > Type de clavier en paysage.

7 Sélectionnez un mode de clavier.

Division du clavier

Vous pouvez diviser le clavier en deux et disposer chaque partie de chaque
coté de [écran en mode paysage.

Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier LG >
Hauteur et disposition du clavier > Diviser le clavier.

Vous pouvez également appuyer sur ¢ sur le clavier puis sur Hauteur et
disposition du clavier > Diviser le clavier.

Fonctions de base 66



E - Faites pivoter lappareil en mode paysage pour répartir le clavier sur les deux
cotés. Pour fusionner ou diviser le clavier, rapprochez ou écartez vos doigts
sur le clavier.

Mode de fonctionnement a une main

Vous pouvez déplacer le clavier sur un coté de [écran afin de pouvoir ['utiliser

d’'une main.

1 Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier
LG > Hauteur et disposition du clavier > Utilisation avec une main.
Vous pouvez également appuyer sur £ sur le clavier puis sur Hauteur et
disposition du clavier > Utilisation avec une main.

2 Vous pouvez appuyer sur la fleche affichée en regard du clavier pour
déplacer le clavier dans le sens que vous souhaitez.

Saisie vocale de texte
Sur le clavier, maintenez le doigt appuyé sur ¥ puis sélectionnez §.

E « Pour maximiser la reconnaissance vocale, parlez clairement, en pronongant
correctement et sans accent.

« Pour pouvoir utiliser a saisie vocale, assurez-vous que votre appareil est
connecté a un réseau

- Pour sélectionner la langue de la reconnaissance vocale, appuyez sur X% >
Langues sur [écran de la reconnaissance vocale.

« Cette fonction nest peut-étre pas prise en charge ou les langues prises en
charge peuvent étre différentes, selon la région.
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Changement de clavier

Vous pouvez modifier la langue de saisie et le type de clavier en fonction de

la langue.

1 Appuyez sur O > Paramétres > Général > Langue et clavier > Clavier

LG > Sélectionnez les langues.

2 Sélectionnez une langue et personnalisez le type de clavier.

Copier-coller

Vous pouvez couper ou coller du texte depuis une application, puis le
coller dans la méme application. Ou vous pouvez encore exécuter dautres
applications et coller du texte dedans.

1 Maintenez le doigt appuyé sur le texte que vous souhaitez copier ou
couper.
7 Faites glisser @ /Wy pour définir la section a copier ou couper.
3 Sélectionnez COUPER ou COPIER.
- Le texte coupé ou copié est automatiquement placé dans le presse-
papiers.

/4 Maintenez le doigt appuyé sur la fenétre de saisie de texte, puis
sélectionnez COLLER.

E + Siaucun élément na été copié ou coupé, loption COLLER napparaitra pas.
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PRESSE-PAPIER

Si vous copiez ou coupez une image ou du texte, il sera automatiquement
enregistré dans la barre de captures et pourra étre collé ou vous le souhaitez
a tout moment.

1 Sur le clavier, maintenez le doigt appuyé sur £¥ et sélectionnez [ig}

Autrement, maintenez le doigt appuyé sur la fenétre de saisie de texte,
puis sélectionnez PRESSE-PAPIER.

2 Sélectionnez et collez un élément de la barre de captures.
+ Labarre de captures peut contenir 20 éléments au maximum.

- Appuyez sur Z¥pour verrouiller des éléments enregistrés pour qu'ils
ne soient pas supprimés, méme lorsque la quantité maximale est
dépassée. Il est possible de verrouiller 10 éléments au maximum. Les
éléments doivent étre déverrouillés avant de pouvoir étre supprimés.

- Appuyez sur [if] pour supprimer les éléments enregistrés dans la barre
de captures.

5 + Le presse-papiers peut ne pas étre pris en charge par certaines applications
téléchargées par [utilisateur.
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Installation et désinstallation
d'applications

Installation d'applications
Accédez a une boutique d'applications pour rechercher et télécharger des
applications.
+ Vous pouvez utiliser SmartWorld, Play Store ou la boutique dapplications
fournie par votre opérateur de téléphonie mobile.

E - Certaines boutiques dapplications peuvent vous demander de créer un
compte et de vous identifier.

« Certaines applications sont payantes.

« Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

+ SmartWorld nest pas toujours pris en charge, selon lopérateur et la région.

Désinstallation d'applications
Désinstallez les applications que vous n'utilisez plus sur votre appareil.

E « Certaines applications ne peuvent pas étre désinstallées par les utilisateurs.

Désinstallation en maintenant le doigt appuyé
Sur [écran d'accueil, maintenez le doigt appuyé sur lapplication a désinstaller;
puis faites-la glisser sur Désinstaller en haut de [écran.
- Sides applications ont été désinstallées il y a moins de 24 heures, vous
pouvez les réinstaller. Consultez a section Apps désinstallées, pour plus
de détails.
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Désinstallations depuis le menu Parametres

Appuyez sur ) > Paramétres > Général > Applications, sélectionnez une
application puis appuyez sur Désinstaller.

Désinstallation d’applications a partir des boutiques
d'applications

Pour désinstaller une application, accédez a la boutique d'applications a partir
de laquelle vous avez téléchargé lapplication et désinstallez-|a.

Apps désinstallées

Vous pouvez consulter les applications désinstallées sur [écran d'accueil. Vous
pouvez aussi réinstaller des applications qui ont été désinstallées depuis
moins de 24 heures.

1 Appuyez sur O > Apps désinstallées.

7 Activez la fonction souhaitée :
- Réinstaller: Réinstallation de lapplication sélectionnée.

- {i1] : Retirez les applications désinstallées de votre appareil, de maniére
permanente.

E « Les applications désinstallées sont supprimées automatiquement de
lappareil, 24 heures apreés leur désinstallation. Si vous souhaitez réinstaller
des applications désinstallées, vous devez a nouveau les télécharger depuis
la boutique dapplications.

« Cette fonction nest activée que sur [écran d'accueil par défaut. Si vous
désinstallez des applications alors que vous utilisez [écran EasyHome ou un
autre lanceur, elles sont supprimées de maniere immédiate et permanente
de lappareil
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Téléphone

Appels vocaux

Plusieurs options soffrent a vous pour passer un appel téléphonique : saisir
manuellement un numéro de téléphone ou bien appeler depuis |a liste de
contacts ou |a liste des appels récents.

Emission d'un appel depuis le clavier

T Appuyez sur O> (§> Composer.

2 Emettez un appel en utilisant la méthode de votre choix :
+ Entrez un numéro de téléphone et appuyez sur @.
+ Maintenez le doigt appuyé sur un numéro rapide.

+ Recherchez un contact en appuyant sur la premiere lettre de son nom
sur la liste de contacts et appuyez sur @@.

E « Pour saisir « + » pour les appels internationaux, maintenez le doigt appuyé
sur le chiffre O.

+ Reportez-vous a Ajout de contacts a la liste de numérotation rapide
pour plus d'informations sur [ajout de numéros de téléphone a la liste de
numérotation rapide.

Emission d'un appel depuis la liste de contacts
1 Appuyez sur O> (> Répertoire.

2 Sélectionnez un contact sur la liste de contacts et appuyez sur Q...
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Réponse a un appel

Pour répondre a un appel, faites glisser @ hors du cercle sur [écran d'appel
entrant.

+ Lorsque le casque stéréo est connecté, vous pouvez émettre des appels
en utilisant le bouton appel/raccrocher du casque.

- Pour raccrocher en appuyant simplement sur la touche Marche-Arrét/
Verrouillage, appuyez sur O > Paramétres > Réseaux > Appels >
Répondre et mettre fin a des appels, puis activez Mettre fin aux appels
a l'aide de la touche Marche/Arrét.

Rejet d'un appel

Pour rejeter un appel, faites glisser @) hors du cercle sur lécran d'appel
entrant.

+ Pour envoyer un message de refus, faites-le glisser a lextérieur du cercle.

- Pour ajouter ou modifier un message de refus, appuyez sur Q>
Paramétres > Réseaux > Appels > Décliner et refuser des appels >
Refuser avec un message.

+ Lorsque vous recevez un appel, appuyez sur la touche volume ou la touche
Marche-Arrét/Verrouillage pour couper la sonnerie ou la vibration, ou pour
mettre [appel en attente.

Affichage des appels manqués
Si vous avez manqué un appel, la barre détat en haut de [écran affiche X.

Pour afficher les détails sur lappel manqué, faites glisser la barre détat vers le
bas. Ou bien, appuyez sur O > (W > Journal des appels.
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Fonctions accessibles pendant un appel

Durant un appel, vous pouvez accéder a de nombreuses fonctions en
appuyant sur les boutons a lécran :

- Répertoire: Consultez la liste de contacts pendant un appel.
+ Fin:Raccrocher.

Clavier: Affichage ou masquage du clavier de numérotation.

Ht. parleur: Activation de la fonction haut-parleur.

votre Voix.

Bluetooth: Faites basculer lappel sur un appareil Bluetooth apparié et
connecté.

: :Acces a de nombreuses options dappel

« Les différents parametres disponibles peuvent varier en fonction de la
région et de lopérateur de téléphonie.

Conversation a trois

Vous pouvez émettre un appel vers un autre contact pendant un appel en
cours.

1 Durant un appel, appuyez sur : > Ajouter un appel

2 Entrez un numéro de téléphone et appuyez sur €.

« Les deux appels apparaissent en méme temps a [écran et le premier
appel est mis en attente.

3 Pour passer a un autre appel, appuyez sur un autre numéro a lécran.
Pour démarrer une téléconférence, appuyez sur Fus. appels.

5 + Chaque appel pourra vous étre facturé. Consultez votre opérateur de
téléphonie pour plus d'informations.
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Affichage des enregistrements d'appel

Pour afficher les enregistrements dappel récents, appuyez sur O > (9>
Journal des appels. Vous pouvez ensuite utiliser les fonctions suivantes :

+ Sélectionnez un contact pour afficher les enregistrements d'appel
détaillés. Pour appeler le contact sélectionné, appuyez sur Q...

- Pour supprimer les enregistrements d'appel, appuyez sur + > Supprimer.

E « Ladurée dappel affichée peut-étre différente du colt de lappel. Consultez
votre opérateur de téléphonie pour plus d'informations.

Configuration des options d'appel
Vous pouvez configurer différentes options dappel.

1 Appuyez sur O > > Composer ou Journal des appels.

2 Appuyez sur : > Paramétres d'appel puis configurez les options en
fonction de vos préférences.
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Messagerie

Envoi d'un message

\ous pouvez créer et envoyer des messages a vos contacts sélectionnés ou
appeler tous vos contacts avec lapplication de messagerie.

E « Lenvoi de messages a [étranger peut occasionner des frais supplémentaires.
Consultez votre opérateur de téléphonie pour plus d'informations.

T Appuyezsur Q>

2 Appuyez sur @.
3 Spécifiez un destinataire et composez votre message.
+ Pour joindre des fichiers, appuyez sur Z.
- Pour accéder a des éléments de menu optionnels, appuyez sur :.

4 Appuyez sur Envoyer pour envoyer le message.

Lecture d'un message
Vous pouvez afficher les messages échangés, en les organisant par contact.

1 AppuyezsurO> 1.
2 Sélectionnez un contact sur la liste de messages.

Configuration des parametres de messagerie

Vous pouvez modifier les parametres de messagerie en fonction de vos
préférences.

1 AppuyezsurO> ..
7 Appuyez sur = > Paramétres sur la liste de messages.
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Photo

Ouverture de l'appareil photo
Vous pouvez prendre une photo ou enregistrer une vidéo pour conserver des
instants mémorables.

Appuyez sur O > (@

E + Avant de prendre une photo, essuyez lobjectif de lappareil photo avec un
chiffon microfibre. Vos photos peuvent étre floues si votre doigt touche
lobjectif de lappareil photo.

+ Sile niveau de charge de |a batterie est inférieur a 5 %, chargez la batterie
avant d'utiliser lappareil photo.

« Lesimages de l'appareil figurant dans ce guide de ['utilisateur peuvent étre
différentes de la réalité.

« Ilest possible de visualiser ou de modifier des photos et vidéos a partir de
Galerie. Consultez la section Présentation de la Galerie pour plus de détails.

Changement du mode appareil photo

Vous pouvez sélectionner un mode appareil photo adapté a votre
environnement de prise de vue pour prendre une photo ou enregistrer une
vidéo, de maniére facile et pratique.

Sur [écran appareil photo, appuyez sur +, puis sélectionnez le mode souhaité.
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Passage en mode appareil frontal/arriére

Vous pouvez basculer entre les appareils photo frontal et arriére pour vous
adapter a votre environnement de prise de vue.

Sur [écran appareil photo, appuyez sur & ou faites glisser [écran vers le haut

ou vers le bas, vers la gauche ou vers la droite pour alterner entre lappareil
photo frontal et arriere.

E « Utilisez lappareil photo frontal pour prendre des selfies. Consultez la section
Selfies pour plus de détails.

Passer en mode double appareil photo

Vous pouvez utiliser [appareil photo double (second) a larriere pour prendre
des photos en utilisant [objectif standard ou grand-angle.

Appuyez sur [A ]/ [aw] pour passer entre [objectif standard et le grand-angle.

Zoom avant ou arriere

Vous pouvez utiliser le zoom avant ou arriere de [écran appareil photo tout en
prenant une photo ou en enregistrant une vidéo.

Sur [écran appareil photo, rapprochez ou écartez deux doigts pour faire un
zoom avant ou arriére.

- Lobjectif grand-angle et objectif standard a l‘arriere de lappareil sont alors
automatiguement mis en route pour prendre une photo ou enregistrer
une vidéo.
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Mode simple

Vous pouvez prendre des photos d'une simple pression sur [écran.
1 Sur lécran appareil photo, appuyez sur = >[ |

2 Cadrez votre sujet puis appuyez sur [écran.

Mode auto

Vous pouvez prendre des photos et enregistrer des vidéos en sélectionnant
une variété de modes de prise de vue et doptions.

T Sur lécran appareil photo, appuyez sur ¢ >[ 8

2 Pour prendre une photo, appuyez sur {87} Ou pour enregistrer une vidéo,
appuyez sur [k

Basculer entre
Sélection d'un mode l'objectif grand-angle
appareil photo. et ['objectif standard.

s— Lire la galerie.

Activation ou —m
désactivation du o

flash. B)s— Enregistrer des vidéos.

Alterner entre —eJe
lappareil photo
frontal et arriere.

*— Prendre des photos.

Sélection d'un mode
de prise de vue.
Modification des
options de lappareil
photo.

Retour a [écran
précédent.

Prendre une photo

1 Sélectionnez un mode de prise de vue et appuyez sur le sujet pour que
lappareil photo fasse la mise au point.

2 Appuyez sur [8] pour prendre une photo.
Autrement appuyez sur une touche de volume.

E « Lorsque [écran est éteint ou verrouillé, ouvrez lappareil photo en appuyant
deux fois sur la touche Diminuer le volume (-). Pour activer cette fonction,
appuyez sur (> Paramétres > Général et activez Touche de raccourci.
Pour prendre des photos immédiatement apres louverture de lappareil photo
avec la touche Diminuer le volume (-), activez la fonction Prise de vue rapide.
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Enregistrement vidéo

1 Sélectionnez un mode de prise de vue et appuyez sur le sujet pour que
lappareil photo fasse la mise au point.

2 Appuyez sur[h.
+ Pour prendre une photo tout en enregistrant une vidéo, appuyez sur
o1
- Pour mettre en pause lenregistrement vidéo, appuyez sur | |. Pour
reprendre lenregistrement vidéo, appuyez sur @.

3 Appuyez sur[_] pour arréter lenregistrement vidéo.

Photo encadrée

Vous pouvez prendre une photo ou enregistrer une vidéo avec les objectifs
standard et grand-angle du double appareil photo a larriere de lappareil pour
prendre les scenes comme si elles se trouvaient dans le cadre. Les scénes qui
saffichent dans le petit écran frontal sont prises avec lobjectif standard et
les scénes qui saffichent dans le grand écran arriere sont prises avec lobjectif
grand-angle. Modifiez [écran frontal en choisissant une autre forme ou en
appliquant différents effets pour prendre une photo ou filmer une vidéo avec
des effets.

71 Enmode auto, appuyez sur MODE >[I}
2 Appuyez sur \/ et sélectionnez la disposition souhaitée.

3 Sélectionner des effets :

- &) : Application d'un effet de lentille convergente a la zone capturée
par lappareil photo grand-angle.

. : Application d'une échelle de gris a la zone capturée par lappareil
photo grand-angle.

+ [O]: Assombrissement des bords de la zone capturée par lappareil photo
grand-angle.

+ [O]:Floutage de la zone capturée par lappareil photo grand-angle.
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A Appuyez sur [©] pour prendre une photo. Pour enregistrer une vidéo,
appuyez sur[_H

Multi-View

Vous pouvez prendre plusieurs photos ou vidéos sous la forme d'un collage,
en utilisant les appareils photo frontal et arriere. Vous pouvez enregistrer les
photos et les vidéos avec différentes dispositions.

7 Enmode auto, appuyez sur MODE >H ]
2 Appuyez sur \/ et sélectionnez une disposition.
3 Appuyez sur (8] pour prendre des photos en suivant les instructions a

[cran. Pour enregistrer une vidéo, appuyez sur [}

+ Appuyez sur [} pour enregistrer un court clip vidéo.

- Pour alterner entre les appareils photo frontal et arriere (standard ou
grand-angle), faites glisser vers le haut ou vers le bas, ou vers la gauche
ou vers la droite.

- Pour faire des prises de vue continues (photos ou vidéos) a intervalles
définis, maintenez le doigt appuyé sur (8] ou[ L.

- Appuyez sur @) / ) pour prendre des photos ou enregistrer des
vidéos simultanément ou tour a tour.
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Snap vidéo
Vlous pouvez enregistrer de courts clips vidéos et les assembler en un court film de
60 secondes.

1 Sur [écran appareil photo, appuyez sur MODE > 54,

2 Appuyez sur[h.
+ Appuyez une fois sur licdne pour enregistrer un clip vidéo de trois
secondes. Maintenez le doigt appuyé sur l'icéne pour créer un clip vidéo
plus long (longueur maximale : une minute).

Sélectionner la
disposition multivues.

Supprimer lextrait
Voir [extrait sélectionné.

sélectionné.

Barre de durée. Enregistrer la vidéo.

Supprimer tous les
extraits.

Lire tous les extraits.

3 Appuyez sur ENREG.

Panorama

Vous pouvez prendre une photo panoramique en balayant la scene dans un
sens ; lappareil photo juxtaposera les prises de vue continues.

7 Enmode auto, appuyez sur MODE > <4

7 Appuyez sur [Q] et déplacez lentement lappareil photo dans un sens.
- Déplacez lappareil en suivant le sens de la fleche dans les recommandations.

3 Appuyez sur [_] pour arréter la prise de vue.
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Vidéo au ralenti

Vous pouvez créer une vidéo amusante en modifiant les vitesses de
déplacement de vos sujets dans votre vidéo. Cette fonction vous permet
denregistrer une vidéo a une vitesse plus rapide, puis de la lire a la vitesse
normale, si bien qu'elle parait alors ralentie.

1 Enmode auto, appuyez sur MODE > (.
2 Appuyez sur [} et enregistrez une vidéo.

3 Appuyez sur [_]pour arréter lenregistrement vidéo.

Time-lapse
Vous pouvez prendre une série de prises de vue a intervalles fixes pour

enregistrer des modifications qui se produisent lentement dans le temps,
comme les mouvements des nuages, des étoiles, du trafic et plus encore.

1 Enmode auto, appuyez sur MODE > (.

2 Appuyez sur [} et enregistrez une vidéo.
- Pour régler la vitesse de lecture de |a vidéo, appuyez sur \/.

3 Appuyez sur [_]pour arréter lenregistrement vidéo.

E « Lors de lenregistrement d'une vidéo en intervalle de temps (time-lapse), les
VoiX Ne sont pas enregistrées.
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Rafale
Vous pouvez prendre des photos en rafale pour créer une image en mouvement.
En mode auto, maintenez le doigt appuyé sur [Q]
- Les photos en rafale sont prises a vitesse rapide tant que vous gardez le
doigt appuyé sur [0}

E « Vous pouvez prendre jusquia trente (30) photos en continu.

Connexion a des appareils photo compatibles LG

Vous pouvez raccorder l'appareil a un autre appareil photo pour visualiser les
photos ou vidéos enregistrées sur lappareil photo.

E « Cette fonction est disponible en prise de vue multivue ou en prise de vue simple.

« Les appareils photo LG Friends qui peuvent étre connectés a lappareil sont
des accessoires en option. Consultez le centre de service client LG pour
acheter des articles.

+ Cette fonction peut ne pas étre prise en charge ou certaines options peuvent
étre différentes, en fonction de la région et de lopérateur de téléphonie.

Personnalisation des options de l'appareil photo

Vous pouvez personnaliser de nombreuses options de lappareil photo selon
vos préférences.

En mode auto, appuyez sur §63.

E « Les options disponibles varient en fonction de lappareil photo sélectionné
(frontal ou arriére) et du mode de prise de vue sélectionné.
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Sélectionnez un format d'image pour les photos ou une qualité
d'image pour les vidéos.

Obtenez des photos ou des vidéos aux couleurs vives et aux effets
équilibrés, méme si vous les prenez a contre-jour. Ces fonctions sont

AuTo assurées par la technologie HDR (High Dynamic Range) embarquée
dans lappareil photo de votre appareil.
Application deffets de film aux photos.
\\r\ Réglage du minuteur pour la prise automatique de photos aprés un
OFF

certain laps de temps.

Prise de photos avec des commandes vocales.
(Choix disponibles : cheese, smile, whisky, kimchi, LG)

g@‘:t: / Agg;

Réduisez le flou cinétique lors de |a prise d'une photo ou de
lenregistrement d'une vidéo :

- & - Enregistrement d'une vidéo stable lorsque vous bougez ou marchez.

@ Utilisez cette fonction pour réduire le léger flou lorsque vous
prenez une photo ou enregistrez une vidéo.

£

Affichage d'un quadrillage pour prendre des photos ou enregistrer des
vidéos sur la base de lignes de référence horizontales et verticales.

£1/€]

Définissez les emplacements dans lesquels vous souhaitez enregistrer
des photos et des vidéos. Ces options apparaissent lorsqu’une carte
mémoire extérieure est insérée.

- b ]: Enregistrement sur la mémoire interne.
- £7: Enregistrement sur la carte mémoire externe.

[0]/[¥]

Personnalisation des parametres de prise de vue automatique. Ces
options apparaissent lorsque vous utilisez lappareil photo frontal.

+ [®]: Prendre la photo en utilisant la fonctionnalité Prise de photo avec geste.
« [¥]:Prendre la photo lorsque appareil photo détecte un visage.

/5

Choisissez d'utiliser Gesture View pour afficher la photo prise
immédiatement apres la prise de vue. Ces options apparaissent
lorsque vous utilisez lappareil photo frontal.

- [ : Activation de Vue Gesture.

- [s8%) : Désactivation de Vue Gesture.

gel/ g

Flip images. Ces options apparaissent lorsque vous utilisez appareil
photo frontal.

« 4] Ne pas faire pivoter limage.
« ][ : Faire pivoter limage horizontalement.

Applications utiles 86



Application d'effets de film

Vous pouvez appliquer a vos photos des filtres de différentes couleurs.
1 Enmode auto ou manuel, appuyez sur §3 > [T,

2 Sélectionnez leffet souhaité.

Mode manuel

De nombreuses fonctionnalités avancées vous permettent de créer des
photos daspect professionnel. Réglez la balance des blancs, la mise au point,
la luminosité, SO, la vitesse dobturation et d'autres options.

1 Sur lécran appareil photo, appuyez sur & >[Z=]

7 Personnalisez les options de prise de vue.

Ajuster la balance des 41 I— Ajuster le niveau
blancs. dexposition.
. Ajuster la vitesse
Ajuster la mise au ; ;
point. dobturation.
Ajuster la luminosité.

Ajuster la sensibilité
1SO.

3 Appuyez sur [6] pour prendre la photo.
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Selfies

Vous pouvez utiliser lappareil photo frontal pour voir votre visage sur [écran
et prendre des selfies.

E « Lorsque vous utilisez lappareil photo frontal, vous pouvez modifier dans les
options de lappareil photo, la maniére de prendre les selfies. Consultez la
section Personnalisation des options de [appareil photo, pour plus de détails.

Prise de photo avec geste

Vous pouvez prendre des selfies en effectuant des gestes.

Montrez la paume de votre main a la caméra frontale puis serrez votre poing.
+ Une photo est prise dans les trois secondes.

m’

E « Afin d'utiliser cette fonction, assurez-vous que l'icone [@est sélectionnée
dans les options de lappareil photo.

+ Une autre fagon de prendre des photos avec geste consiste a serrer votre
poing puis a louvrir en direction de appareil photo frontal.

+ Veillez a ce que votre paume et votre poing se trouvent au niveau de la ligne
de référence pour que lappareil photo puisse les détecter.

« lacces a certaines fonctions peut-étre limité en prise de vue multivue.
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Intervalle de prises de vue
Vous pouvez prendre plusieurs selfies a la suite.
En mode appareil photo frontal, maintenez le doigt appuyé sur [O].
Autrement, montrez la paume de votre main a l'appareil photo puis serrez
votre poing deux fois rapidement.

+ Quatre photos sont prises a intervalles denviron deux secondes.

Prise de selfies

Vous pouvez utiliser la fonction de détection de visage pour prendre des

selfies de maniére facile et pratique. Vous pouvez régler lappareil de maniere

a ce que lorsque vous regardez [écran, lappareil photo frontal détecte votre

visage et prenne un selfie automatiquement.

+ Quand lappareil photo détecte votre visage, le cadre devient blanc. Sivous

arrétez de bouger, le cadre devient bleu et l'appareil photo frontal prend
une photo.

E - Appuyez sur §83, puis sur [®]jusqua ce que [ '] s'affiche, pour activer la
fonction de selfie automatique.
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Vue Gesture

Apres avoir pris un selfie avec lappareil photo frontal, vous pouvez afficher
un apercu du selfie immédiatement en plagant [écran a proximité de votre
visage.

E « Afin d'utiliser cette fonction, assurez-vous que l'icone sest sélectionnée
dans les options de l'appareil photo.

« Un seul apergu est disponible chaque fois qu'une photo est prise.

« Sivous faites pivoter [appareil sur [écran apercu, [écran passe en mode
appareil photo.

Galerie

Présentation de la Galerie

Vous pouvez visualiser et gérer les photos et vidéos enregistrées sur votre
appareil

T Appuyez sur Q>

- Les photos et vidéos enregistrées sont affichées par dossier.
2 Appuyez sur un dossier; puis sélectionnez un fichier.

« Affichez le fichier sélectionné en mode plein écran.

- Faites glisser vers la gauche ou vers la droite la photo affichée ou
[écran vidéo pour afficher le fichier précédent ou suivant.
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E « Certains formats de fichiers peuvent ne pas étre pris en charge en fonction
du logiciel installé.

+ Un encodage peut empécher louverture de certains fichiers.

« Les fichiers qui dépassent |a taille limite peuvent causer une erreur.

Affichage des photos

Retour a [écran —¢

VNGNS — Accéder aux options

précédent. @ - supplémentaires.
Supprimer des
Ajout ou suppression —J - images.
de favoris.

Partager des images.

Ouvrir [appareil
photo
Modifier des images.

Modification des photos

1 Pendant que vous prenez une photo, appuyez sur /2.

2 Utilisez les nombreux effets et outils pour modifier la photo.
3 Appuyez sur \/ pour enregistrer les modifications.

4 Appuyez sur ENREGISTRER pour enregistrer les modifications.
- Les modifications sont écrasées dans le fichier dorigine.

- Pour enregistrer la photo modifiée sous un autre fichier, appuyez sur
> Enregistrer une copie.
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Lecture d'une vidéo

Ouverture avec

QSlide.
Ajout ou suppression —=e} e— Accéder aux options
de favoris. supplémentaires.
]— Modifier la vidéo.

oWe _ \errouiller ou

Ajustez le volume — S .
déverrouiller [écran.

sonore.

Retour rapide. Avance rapide.

Suspendre ou lire la
vidéo.

E « Pour régler le volume sonore, faites glisser le coté droit de [écran vidéo vers
le haut ou vers le bas.

« Pour régler la luminosité, faites glisser le c6té gauche de [écran vidéo vers le
haut ou vers le bas.

Modification des vidéos
T Sur lécran dapercu vidéo, appuyez sur /.
2 Utilisez les nombreux effets et outils pour modifier la photo.

Créer
automatiquement un

clipvidéode 15 s.

Sélectionner une
section pour modifier
: la vitesse de lecture.
SR —————r— Modifier la durée de
lavidéo.

>

3 Appuyez sur ENREGISTRER pour enregistrer les modifications.
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Suppression de fichiers
Pour supprimer des fichiers, utilisez ['une des options suivantes :

+ Appuyez sur un fichier de la liste de facon prolongée, puis appuyez sur
Supprimer.

« Appuyez sur [ sur la liste de fichiers, puis sélectionnez des fichiers.

Partage de fichiers
Pour partager des fichiers, utilisez 'une des options suivantes :

- Pendant le visionnage d'une photo ou d'une vidéo, appuyez sur o< pour
partager le fichier a laide de la méthode de votre choix.

- Appuyez sur o< sur la liste de fichiers pour sélectionner des fichiers et les
partager selon la méthode de votre choix.

Calculatrice

Vous pouvez effectuer vos calculs a laide d'une calculatrice ordinaire ou
scientifique.

1 Appuyez sur O > Outils > Calculatrice.

2 Utilisez le clavier pour effectuer un calcul.

- Pour utiliser la calculatrice scientifique, appuyez sur + > Calculatrice
scientifique.

- Pour afficher I'historique des calculs, appuyez sur ¢ > Historique des
calculs.
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Météo
Vous pouvez afficher la météo d'une zone particuliére.
1 Appuyez sur O > Outils > Météo.

2 Appuyez sur -} et ajoutez la ville de votre choix.
- Sur [écran météo détaillée, appuyez sur £ />, ou faites glisser [écran
vers la gauche ou vers la droite afin d'afficher la météo dautres villes.

Téléchargements

Vous pouvez afficher, supprimer ou partager des fichiers téléchargés via
Internet ou des applications.

Appuyez sur > Outils > Téléchargements.
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Horloge

Alarme

Vous pouvez définir une alarme pour quelle se déclenche a une heure précise.
1 Appuyez sur > Outils > Horloge > Alarme.

2 Appuyez sur @ pour ajouter une nouvelle alarme.

3 Configurez les paramétres de lalarme et appuyez sur ENREGISTRER.

5 « Sivous sélectionnez une alarme précédemment réglée, vous pouvez la
modifier.

« Pour supprimer une alarme, appuyez SUFE]I_ en haut de [écran. Autrement,
maintenez le doigt appuyé sur lalarme.

Fuseaux horaires

Vous pouvez voir 'heure actuelle dans dautres villes du monde.
1 Appuyez sur O > Outils > Horloge > Fuseaux horaires.

2 Appuyez sur @ et ajoutez une ville.

Minuteur

Vous pouvez régler le minuteur pour déclencher une alarme lorsque le délai
défini slest écoulé.

1 Appuyez sur > Outils > Horloge > Minuteur.

2 Définissez lheure et appuyez sur Démarrer.

« Pour suspendre le minuteur, appuyez sur Arréter. Pour relancer le
minuteur, appuyez sur Reprendre.

+ Pour remettre le minuteur a zéro, appuyez sur Réinitialiser.

3 Appuyez sur Arréter pour arréter lalarme du minuteur.
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Chronométre
Vous pouvez utiliser le chronometre pour enregistrer un temps par tour.
1 Appuyez sur > Outils > Horloge > Chronométre.
2 Appuyez sur Démarrer pour lancer le chronomeétre.
+ Pour enregistrer un temps par tour, appuyez sur Tour.
3 Appuyez sur Arréter pour suspendre le chronomeétre.
« Pour relancer le chronometre, appuyez sur Reprendre.

+ Pour supprimer tous les enregistrements du chronometre, appuyez sur
Réinitialiser.

Dictaphone

\ous pouvez enregistrer votre voix ou celle dautres personnes lors
dévénements importants Les fichiers audio peuvent ensuite étre lus ou
partagés.
1 Appuyez sur O > Outils > Dictaphone.
2 Appuyez sur (=),

- Pour mettre en pause lenregistrement, appuyez sur ().
3 Appuyez sur (=) pour arréter lenregistrement.

- Le fichier est enregistré automatiquement et un écran de pré-écoute

apparait.

A Appuyez sur (») pour écouter lenregistrement.

5 « Pour enregistrer des informations sur le lieu de enregistrement, appuyez
sur Position.
« Pour taguer des informations au sujet d'un événement actuel sur
lenregistrement, appuyez sur Evénement. Sélectionnez ensuite [événement
souhaité.

« Sivous appuyez sur @ les fichiers denregistrements audio apparaissent.
Vous pouvez écouter un fichier audio enregistré de |a liste.
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Musique

Vous pouvez écouter et gérer des fichiers audio enregistrés sur votre appareil.
1 Appuyez sur O > LG > Musique.

2 Sélectionnez une catégorie.

3 Sélectionnez un fichier de musique.

Passage a la playlist.

Retour a [écran précédent j

e — Accéder aux options
supplémentaires.

Ajout de —33K
Jout ou suppreszion c& Chercher des fichiers audio.

favoris.

e— Sélectionner un mode
répétition.

Lire de facon aléatoire. —¢

Ajustez le volume sonore. — <t} E— Définir des effets sonores

Appuyer pour lire le fichier

Appuyer pour lire le fichier actuel depuis suivant/Appuyer et maintenir

le début/Appuyer deux fois pour lire le pour une avance rapide.
fichier précédent/Appuyer et maintenir
pour un retour rapide. Pause/lecture

E - Certains formats de fichiers peuvent ne pas étre pris en charge en fonction
du logiciel installé.
Les fichiers qui dépassent la taille limite peuvent causer une erreur.

« Les fichiers musicaux peuvent appartenir a leurs détenteurs et étre
protégés par les lois internationales sur les droits dauteur. Lobtention
d'une autorisation [égale peut-étre nécessaire avant la copie d'un fichier de
musique. Avant de télécharger ou de copier un fichier de musique, prenez
connaissance de la loi sur les droits dauteur applicable dans le pays.

+ Cemodele prend en charge la lecture audio haute fidélité. Une icone Hi-Fi
figure sur les fichiers audio haute fidélité.
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Email

Présentation de la messagerie électronique

Vous pouvez enregistrer un compte de messagerie électronique sur votre
appareil pour pouvoir ensuite consulter et envoyer des e-mails.

E « Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

Enregistrement de comptes de messagerie

Enregistrez votre compte de messagerie lors de votre premiere utilisation de

lapplication e-mail

1 Appuyez sur O > LG > Email.

2 Sélectionnez un fournisseur de services de messagerie.

3 Saisissez votre adresse e-mail et votre mot de passe puis appuyez sur
SUIVANT pour enregistrer votre compte.

« Pour enregistrer manuellement un compte de messagerie ou
enregistrer plusieurs comptes de messagerie ne figurant pas sur la
liste, appuyez sur CONFIGURATION MANUELLE.

Gestion des comptes de messagerie

Pour afficher ou modifier les parametres de votre compte de messagerie,
appuyez sur : > Paramétres.

+ Pour ajouter un compte, appuyez sur Ajouter un compte.
- Pour supprimer un compte, appuyez sur : > Supprimer le compte.

Ouverture d'un autre compte de messagerie

Si plusieurs comptes de messagerie sont enregistrés et si vous souhaitez
consulter un autre compte, appuyez sur == et sélectionnez-en un autre a
partir de la liste des comptes.
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Consultation des e-mails
T Appuyez sur = et sélectionnez une boite de messagerie.

2 Sélectionnez un e-mail sur la liste des e-mails.
+ Le message e-mail apparait.

Envoi d'e-mails
1 Appuyez sur @.
7 Saisissez ladresse e-mail d'un destinataire.

3 Entrez un objet et rédigez votre message.
- Pour joindre des fichiers, appuyez sur (&=.
- Pour accéder a des éléments de menu optionnels, appuyez sur .

4 Appuyez sur B> pour envoyer le-mail

Répertoire

Présentation du répertoire
\ous pouvez enregistrer et gérer vos contacts.
Appuyez sur O > LG > Répertoire.

Ajout de contacts

Ajout de nouveaux contacts
T Surlécran de la liste de contacts, appuyez sur +-.

7 Entrez les coordonnées du contact et appuyez sur ENREGISTRER.
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Importation de contacts
Vous pouvez importer des contacts depuis un autre périphérique de stockage.

T Surlécran de la liste de contacts, appuyez sur : > Gérer les contacts >
Importer.

7 Sélectionnez les emplacements source et cible du contact a importer, puis
appuyez sur OK.

3 Sélectionnez des contacts, puis appuyez sur IMPORTER.

Ajout de contacts a la liste de numérotation rapide
T Surlécran de la liste de contacts, appuyez sur : > Numéros rapides.
2 Appuyez sur Ajouter un contact a partir d'un numéro rapide.

3 Sélectionnez un contact.

Recherche de contacts
Vous pouvez rechercher des contacts en utilisant ['une des options suivantes :

- Sur [écran de la liste de contacts, saisissez le nom d'un contact dans la
zone de recherche.

- Faites défiler la liste de contacts vers le haut ou vers le bas.

- Depuis lindex de [écran de a liste de contacts, tapez la premiére lettre du
nom du contact.

Liste de contacts

Modification des contacts
1 Sélectionnez un contact sur lécran de la liste de contacts.

2 Sur lécran des coordonnées du contact, appuyez sur /2 et modifiez ses
coordonnées.

3 Appuyez sur ENREGISTRER pour enregistrer les modifications.
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Suppression de contacts

1 Maintenez le doigt appuyé sur un contact sur [écran de la liste de
contacts.

2 Appuyez sur Supprimer le contact.

Ajout de favoris

Vous pouvez enregistrer les contacts que vous appelez fréquemment dans
vos favoris.

1 Sélectionnez un contact sur [écran de la liste de contacts.

2 Sur lécran des coordonnées du contact, appuyez sur ¥.

Création de groupes

T Surlécran de la liste de contacts, appuyez sur Groupes > : > Nouveau
groupe.

2 Saisissez un nom pour ce nouveau groupe.

3 Appuyez sur Ajouter des membres, sélectionnez des contacts, puis
appuyez sur AJOUTER.

4 Appuyez sur ENREGISTRER pour enregistrer le nouveau groupe.

Agenda

Présentation du calendrier
Vous pouvez utiliser le calendrier pour gérer vos taches et événements.

Ajout d'événements
T Appuyez sur O > Agenda.
7 Sélectionnez une date et appuyez sur €.

3 Entrez les détails de [événement et appuyez sur ENREGISTRER.

+ Sides événements sont déja enregistrés a la date choisie, une fenétre
contextuelle contenant |a liste des événements apparait. Appuyez sur
un événement dans la fenétre contextuelle pour en afficher les détails.
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Synchronisation des événements

Appuyez sur + > Calendrier  afficher > ¢ > Calendriers pour
synchroniser, puis sélectionnez un calendrier a synchroniser.

E + Quand vos événements sont enregistrés depuis votre appareil vers votre
compte Google, ils sont également automatiquement synchronisés avec
le calendrier Google. Vous pouvez ensuite synchroniser d'autres appareils
avec le calendrier Google pour que ces appareils comportent les mémes
événements que votre appareil et pour pouvoir gérer ces événements sur
ces appareils également.

Boite a événement
Vous pouvez utiliser la boite a événement pour créer un événement.

Appuyez sur & pour ouvrir la bolte a événement, puis faites glisser le
contenu vers une date sur le calendrier.
+ (@) : Gestion des images, du texte, des notes et des événements

enregistrés temporairement. Vous pouvez également partager du
texte, des images et des notes provenant d'une autre application et les
enregistrer dans la boite a événement. Si vous appuyez sur DOSSIER lors
de la création d'un événement, [événement est enregistré temporairement
dans la bolte a événement.

(@ : Ajout d'un compte Facebook pour afficher les informations relatives
aux événements Facebook. Certains appareils ne prennent pas en charge
la fonction d'information sur les événements Facebook.

: Affichez des informations touristiques sur les environs, comme les
restaurants et adresses utiles, ou planifiez un événement.

+ (%) :Gestion des tAches sans délai comme des événements.
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Gest. de fichiers

Vous pouvez afficher et gérer des fichiers enregistrés sur votre appareil ou le
Cloud.

1 Appuyez sur O > Outils > Gest. de fichiers.

2 Appuyez sur =, puis sélectionnez lemplacement de stockage souhaité.

Taches

Vous pouvez enregistrer des taches sur votre appareil pour gérer facilement
les planifications.

1 Appuyez sur Q> Outils > Taches.
2 Appuyez sur @ pour ajouter une tache.
3 Entrez les détails de la tache et appuyez sur ENREGISTRER.

Evernote

Vous pouvez saisir et collecter des informations importantes puis les
partager avec dautres appareils compatibles Evernote.

Appuyez sur O > Recommandé > Evernote.

Message de diffusion

Vous pouvez visualiser les messages diffusés en temps réel sur les situations
d'urgence, comme les typhons, les inondations et les tremblements de terre.

Appuyez sur Q> Outils > Message de diffusion.
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Radio FM

Vous pouvez écouter la radio FM.
Appuyez sur O > Outils > Radio FM.

E « Pour utiliser cette application, branchez d'abord un casque sur lappareil. Le
casque fait alors office dantenne radio.

- Cette fonction peut ne pas étre prise en charge selon la zone.

LG Backup

Vous pouvez sauvegarder, restaurer et déplacer des données enregistrées sur
votre appareil.

T Appuyez sur O > Gestion > LG Backup.
Ou bien, appuyez sur O > Paramétres > Général > Sauvegarder &
Réinitialiser > LG Backup.

2 Suivez les instructions a [écran pour sélectionner de sauvegarder les
données dans le dossier de sauvegarde prédéfini sur lappareil ou de copier
ces données vers dautres appareils.

A « Les fichiers de sauvegarde enregistrés sur la mémoire interne peuvent étre
supprimés en cas de réinitialisation. Pour limiter la perte de données, copiez
les fichiers de sauvegarde importants du dossier LG Backup de la mémoire
interne vers un ordinateur ou un périphérique de stockage extérieur.

E « Les données du compte Google ne seront pas sauvegardées. Lorsque vous
synchronisez votre compte Google, vos applications Google, vos contacts
Google, votre calendrier Google ou votre bloc-notes Google, les données et
applications téléchargées sur le Play store sont automatiquement stockées
dans lapplication Drive.

Les fichiers de sauvegarde sont enregistrés avec lextension de fichier *.|bf
dans le dossier LG Backup sur la carte mémoire ou la mémoire interne.

+ Rechargez completement la batterie avant de procéder a la sauvegarde ou
restauration des données afin déviter une mise hors tension involontaire
durant le processus.

Applications utiles 104



RemoteCall Service

Votre appareil peut étre diagnostiqué a distance pour la résolution des
problemes. Appelez dabord le centre de service client LG comme suit :

T Appuyez sur O > Gestion > RemoteCall Service.
2 Appelez le centre de service client LG.

3 Une fois la communication établie, suivez les instructions de lassistant
pour entrer un numéro d'acces a six chiffres.
« Votre appareil est alors connecté et le service dassistance a distance
commence.

E « Pour utiliser cette fonction, vous devez dabord accepter [utilisation de la
fonction.

« Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

SmartWorld

Vous pouvez télécharger de nombreux jeux, contenus audio, applications et

polices de caracteres fournis par LG Electronics. Personnalisez votre appareil
selon vos préférences en utilisant les thémes daccueil, les themes de clavier
et les polices de caractere.

T Appuyez sur Q> LG > SmartWorld.
7 Entrez votre identifiant et mot de passe puis connectez-vous.

3 Sélectionnez et téléchargez du contenu.

Téléchargement de l'application Smart\World

Si lapplication SmartWorld nest pas installée, procédez comme suit pour la
télécharger.

1 Appuyez sur O > Paramétres > Général > A propos du téléphone >
Centre de mises a jour > Mise a jour des applications.

2 Surlaliste, sélectionnez SmartWorld et appuyez sur Télécharger.
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E - Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

« Cette fonctionnalité peut ne pas étre prise en charge en fonction de la
région ou de lopérateur de téléphonie.

Applications Google

Vous pouvez utiliser des applications Google en paramétrant un

compte Google. La fenétre denregistrement de compte Google apparalt
automatiquement lorsque vous utilisez une application Google pour la
premiere fois. Si vous n'avez pas de compte Google, créez-en un a partir de
votre appareil. Pour plus d'informations sur ['utilisation d'une application,
consultez [Aide dans l'application.

E « Certaines applications peuvent ne pas fonctionner selon la région ou
lopérateur de téléphonie.

Chrome

Connectez-vous sur Chrome et importez les onglets, favoris et données de
barre d'adresse d'un ordinateur vers votre téléphone.

Docs

Créer des documents ou modifier des documents créés en ligne ou depuis un
autre appareil. Partager et modifier des documents avec dautres personnes.
Drive

Télécharger, enregistrer, ouvrir, partager et organiser des fichiers depuis votre
appareil. Les fichiers accessibles depuis des applications sont disponibles
n'importe ou, y compris dans des environnements en ligne et hors ligne.
Gmail

Enregistrer votre compte de messagerie Google sur votre appareil pour
consulter et envoyer des e-mails.

Google

Utilisez la fonction de recherche de Google pour rechercher des sites \Web et
des fichiers enregistrés sur votre appareil en saisissant des mots-clés ou au
moyen du systeme vocal.
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Hangouts

Echanger des messages. Emettre un appel vidéo avec une personne ou un
groupe.

Maps
Trouver votre position ou rechercher un lieu sur la carte. Afficher des
informations géographiques.

Google Photos
Afficher ou partager des photos ou albums enregistrés sur votre appareil.

Play Films et séries

Utiliser votre compte Google pour louer ou acheter des films. Achetez du
contenu et lisez-le n'importe ou.

Play Musique

Acheter des fichiers de musique sur Play Store. Lisez les fichiers de musique
enregistrés sur votre appareil.

Sheets

Créer des feuilles de calcul ou modifier des feuilles de calcul créées en ligne
ou depuis un autre appareil. Partager et modifier des feuilles de calcul avec
d'autres personnes.

Slides

Créer des présentations ou modifier des présentations créées en ligne ou
sur un autre appareil. Partager et modifier des présentations avec dautres
personnes.

Recherche vocale

Recherchez des informations sur Google en prononcant un mot-clé, au lieu
de le taper.

YouTube

Rechercher et lire des vidéos. Téléchargez des vidéos sur YouTube pour les
partager avec dautres personnes dans le monde entier.
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Paramétres

Vous pouvez personnaliser les paramétres de [appareil, en fonction de vos
préférences.

Appuyez sur O > Paramétres.

E - Appuyez sur Q_ et saisissez un mot clé dans la zone de recherche pour
accéder a un parametre

- Appuyez sur + pour modifier le mode daffichage. Nous partons du principe
dans ce manuel que vous utilisez le Vue Onglets.

Réseaux

Wi-Fi
Vous pouvez vous connecter a des appareils se trouvant a proximité par le
biais d'un réseau Wi-Fi.

Connexion a un réseau Wi-Fi
7 Sur [écran paramétres, appuyez sur Réseaux > Wi-Fi.
7 Faites glisser (3 pour lactiver.
+ Les réseaux Wi-Fi disponibles apparaissent automatiquement.
3 Sélectionnez un réseau.
« Il peut vous étre demandé dentrer le mot de passe du réseau Wi-Fi.

+ Vous en serez dispensé toutefois si vous avez déja accédé a ce
réseau Wi-Fi précédemment. Si vous ne souhaitez pas étre connecté
automatiquement a un réseau \Wi-Fi donné, maintenez le doigt appuyé
sur le réseau en question, puis appuyez sur Retirer le réseau.
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Paramétres du réseau Wi-Fi
Sur [écran parametres, appuyez sur Réseaux > Wi-Fi.

- Passer en données mobiles: Si la fonction de connexion de données
mobiles est activée mais que appareil ne peut pas se connecter a Internet
par le Wi-Fi, l[appareil se connecte automatique a Internet via la connexion
de données mobiles.

+ :Personnalisation des parametres du réseau Wi-Fi.

Wi-Fi Direct

Vlous pouvez connecter votre appareil a dautres appareils compatibles Wi-Fi
Direct pour partager des données directement avec eux. Vous navez pas
besoin de point dacces. Vlous pouvez vous connecter a plus de deux appareils
a laide de Wi-Fi Direct.

1 Sur [écran paramétres, appuyez sur Réseaux > Wi-Fi> : > Paramétres
Wi-Fi avancés > Wi-Fi Direct.

« Les appareils compatibles Wi-Fi Direct apparaissent automatiquement.
2 Sélectionnez un appareil
+ La connexion est établie lorsque l'appareil accepte la demande de

connexion.
 —
e
=
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E « Le niveau de batterie peut baisser rapidement lors de utilisation de la
fonction Wi-Fi Direct.
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Bluetooth

Vous pouvez connecter votre appareil a des appareils compatibles Bluetooth
se trouvant a proximité pour échanger des données avec eux. Connectez
votre appareil a un casque et a un clavier Bluetooth. Cela rend plus facile le
controle de lappareil.

Appairage avec un autre appareil

1 Sur[écran parametres, appuyez sur Réseaux > Bluetooth.

7 Faites glisser (3 pour lactiver.
« Les appareils disponibles apparaissent automatiquement.
- Pour actualiser la liste des appareils, appuyez sur RECHERCHER.

E « Seuls les appareils dont loption recherche est activée apparaissent sur la
liste.

3 Sélectionnez un appareil sur la liste.
4 Suivez les instructions a [écran pour procéder a lauthentification.

E « Cette étape est ignorée pour les appareils auxquels vous avez acces
précédemment.

Envoi de données via Bluetooth

1 Sélectionnez un fichier,
« Vous pouvez envoyer des fichiers multimédias ou des contacts.

7 Appuyez sur < > Bluetooth.

3 Sélectionnez un appareil cible pour le fichier.
- Le fichier est envoyé dés que lappareil cible laccepte.

E « Les processus de partage peuvent varier en fonction du type de fichier.
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Données mobiles

Vous pouvez activer ou désactiver la connexion de données mobiles. \ious
pouvez également gérer ['utilisation des données mobiles.

Activation de la connexion de données mobiles

1 Sur[écran parameétres, appuyez sur Réseaux > Données mobiles.

7 Faites glisser (3 pour lactiver.

Personnalisation des paramétres de données mobiles
T Sur lécran parametres, appuyez sur Réseaux > Données mobiles.

2 Personnalisez les parameétres suivants :

- Données mobiles: Réglage pour utiliser les connexions de données sur
les réseaux mobiles.

- Limiter l'usage des données mobiles: Définissez une limite
d'utilisation des données mobiles.

: :Personnalisez les parameétres de données mobiles.

Appels

Vous pouvez personnaliser les parametres d'appel, comme les options
d'appels audio et dappels internationaux.

1 Sur[écran parameétres, appuyez sur Réseaux > Appels.

7 Personnalisez les paramétres.

E - Certaines fonctionnalités peuvent ne pas étre prises en charge en fonction
de la région ou de [opérateur de téléphonie.
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NFC

Vous pouvez utiliser votre appareil comme titre de transport ou carte de
crédit. Vlous pouvez aussi partager des données avec un autre appareil.

1 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >
NFC.
7 Faites glisser (3 pour lactiver.

« Touchez votre appareil avec un autre appareil qui prend en charge le
protocole NFC pour permettre le partage de données.

« Lemplacement de lantenne NFC peut varier en fonction de lappareil

Antenne NFC
(intégrée)

Android Beam

Vous pouvez partager des fichiers en touchant un autre appareil avec le dos
de votre appareil. Vous pouvez aussi partager des fichiers, notamment de la
musique, des vidéos ou des contacts et ouvrir une page Web ou lancer une
application a partir de cet autre appareil.

1 Sur[écran parameétres, appuyez sur Réseaux > Partage et connexion >
Android Beam.
2 Touchez le dos de l'appareil avec un autre appareil.

E « Lemplacement de lantenne NFC peut varier en fonction de lappareil.
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Partage de fichiers

Vous pouvez envoyer et recevoir des fichiers entre votre appareil et dautres

appareils ou une tablette LG.

1 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >

Partage de fichiers.
2 Personnalisez les parameétres suivants :
+ G5 SE: Modification du nom de lappareil.

+ Enregistrer dans: Définition du dossier de destination pour
lenregistrement des fichiers envoyés depuis dautres appareils.

- Partage de fichiers: Permission de réception de fichiers envoyés
depuis d'autres appareils.

- SmartShare Beam: Partage de fichiers avec dautres appareils via
SmartShare Beam.

E « Consultez la section Envoi ou réception de fichiers pour plus de détails.

Serveur multimédia

Vous pouvez partager le contenu multimédia de votre appareil avec des
appareils compatibles DLNA a proximité.

1 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >

Serveur multimédia.

7 Personnalisez les parameétres suivants :

- Partage de contenu: Partage du contenu multimédia de votre appareil

avec des appareils a proximité.
+ G5 SE: Définition du nom de votre appareil.

+ Mes contenus partagés: Sélection du type de contenu multimédia a

partager avec dautres appareils.

- Appareils autorisés: Affichage d'une liste dappareils autorisés a
accéder a votre contenu.

- Appareils non autorisés: Affichage d'une liste d'appareils non
autorisés a accéder a votre contenu.
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Partage décran

Vous pouvez lire [écran et le son de [appareil sur un autre appareil, comme un
téléviseur, qui prend en charge la fonction Miracast.

1 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >
Partage d'écran.

7 Faites glisser (3 pour lactiver.

3 Sélectionnez un appareil sur la liste les appareils a proximité.

« Silappareil désiré napparait pas, appuyez sur RECHERCHER pour
réactualiser la liste.

+ Une fois la connexion établie, [écran de votre téléphone apparait sur le
téléviseur.

5 « Le partage décran est automatiquement désactivé si aucun appareil
compatible ne se trouve a proximité.

LG AirDrive

Vous pouvez utiliser votre compte LG pour gérer les fichiers enregistrés sur
lappareil depuis un ordinateur. Vous navez pas besoin de connexion USB.

7 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >
LG AirDrive.

2 Utilisez un seul compte LG pour vous identifier sur LG Bridge sur
lordinateur et LG AirDrive sur lappareil.

+ Pour télécharger le logiciel LG Bridge, rendez-vous sur www.lg.com.

3 Gérez depuis lordinateur les fichiers se trouvant sur votre téléphone.
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Impression

Vous pouvez connecter votre appareil a une imprimante Bluetooth et
imprimer des photos ou documents enregistrés sur lappareil

1 Sur [écran paramétres, appuyez sur Réseaux > Partage et connexion >
Impression.

5 « Silimprimante souhaitée ne figure pas dans |a liste, installez le pilote
d'imprimante a partir de la boutique d'applications.

7 Faites glisser (3 pour lactiver.

3 Sélectionnez une imprimante sur la liste qui apparait a [écran.

- Pour ajouter une imprimante, appuyez sur = > Ajouter des
imprimantes.

- Pour rechercher une imprimante, appuyez sur + > Recher.
- Appuyez sur = > Paramétres sur [écran ol apparait la liste
d'imprimantes.
/ Sélectionnez un fichier et appuyez sur * > Imprimer.
+ Le document est imprimé.

E « Sivous navez pas de compte Google, appuyez sur AJOUTER UN COMPTE
pour en créer un.
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Partager connexion USB

Vous pouvez connecter [appareil a un autre appareil via USB et partager des
données mobiles.

1 Connectez votre appareil a dautres appareils a laide du cable USB.

2 Sur écran des paramétres, appuyez sur Réseaux > Partage de
connexion > Partager connexion USB, puis faites glisser (J# pour
lactiver.

@

e

3

E « Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Lorsque vous connectez appareil a un ordinateur; téléchargez le pilote USB
sur le site wwwi.lg.com et installez-le.

« Vous ne pouvez pas envoyer ou recevoir des fichiers entre votre appareil
et votre ordinateur lorsque le partage de connexion via USB est activé.
Désactivez le partage de connexion via USB pour envoyer ou recevoir des
fichiers.

« Les systemes dexploitation qui prennent en charge le partage de connexion
sont Windows XP et les versions ultérieures, et Linux.

Parametres du téléphone 117



Hotspot Wi-Fi

Vous pouvez définir votre appareil comme routeur sans fil pour que les autres
appareils puissent se connecter a Internet a laide des données mobiles de
votre appareil.

7 Sur [écran des paramétres, appuyez sur Réseaux > Partage de
connexion > Hotspot Wi-Fi, puis faites glisser (J# pour lactiver.

2 Appuyez sur Configurer le hotspot (point d'accés Wi-Fi partagé), puis
saisissez ['ID Wi-Fi (SSID) et le mot de passe.

3 Activez le Wi-Fi sur lautre appareil, puis sélectionnez le nom du réseau de
lappareil dans la liste Wi-Fi.

4 Entrez le mot de passe réseau.

ell@|)).2

E « Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Pour plus d'informations, rendez-vous sur ce site Web :
http//www.android.com/tether#wifi
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Partage de connexion Bluetooth

Un appareil connecté via Bluetooth peut se connecter a Internet a laide des
données mobiles de votre appareil.

1 Sur [écran des paramétres, appuyez sur Réseaux > Partage de
connexion > Partage de connexion Bluetooth, puis faites glisser (i
pour lactiver.

2 Activez le Bluetooth sur les deux appareils et jumelez-les.

E « Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Pour plus d'informations, rendez-vous sur ce site Web :
http//www.android.com/tether#Bluetooth_tethering

Aide
Vous pouvez consulter [aide en ligne au sujet des modems affiliés et des
hotspots.

Sur [écran parametres, appuyez sur Réseaux > Partage de connexion >
Aide.

Mode Avion

Vous pouvez désactiver les fonctions d'appel et de données mobiles. Lorsque
ce mode est activé, les fonctions n'utilisant pas de données, comme des jeux
et la musique, restent disponibles.

1 Sur [écran paramétres, appuyez sur Réseaux > Plus > Mode Avion.
7 Appuyez sur ACTIVER sur lécran de confirmation.
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Réseaux mobiles
Vous pouvez personnaliser les parametres de données mobiles.
1 Sur[écran parameétres, appuyez sur Réseaux > Plus > Réseaux mobiles.

2 Personnalisez les parameétres suivants :
- Données mobiles: Activation ou désactivation de la connexion de
données mobiles.

Itinérance de données: Surfer sur Internet, envoyer des MMS et
utiliser la messagerie électronique ainsi que dautres services de
données a [étranger.

+ Mode réseau: Sélection d'un type de réseau.

- Noms des points d'acces: Affichage ou modification du point
dacces pour ['utilisation des services de données mobiles. Pour une
modification, sélectionnez le point d'acces de votre choix sur la liste.

+ Opérateur réseau: Recherche des opérateurs de réseau pour une
connexion automatique.

VPN

\ous pouvez vous connecter a un réseau virtuel sécurisé, comme un IntraNet.
Vous pouvez également gérer des réseaux privés virtuels connectés.

Ajout d'un VPN

1 Sur [écran paramétres, appuyez sur Réseaux > Plus > VPN.

A « Attention :si le verrouillage de [écran est désactivé, toutes les informations
sur le VPN enregistrées sur votre appareil sont effacées.

7 Appuyez sur Ajouter un réseau VPN.

E « Cette fonctionnalité nest disponible que lorsque le verrouillage de [écran
est activé. Un écran de notification apparait si le verrouillage de [écran est
désactivé. Appuyez sur REGLAGE sur [écran de notification pour activer le
verrouillage de [écran. Consultez la section Configuration des parametres
de verrouillage de [écran pour plus de détails

3 Saisissez les informations sur le VPN, puis appuyez sur ENREGISTRER.
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Configuration des paramétres du VPN

1
2

Appuyez sur un VPN sur la liste VPNS.

Entrez les informations sur le compte utilisateur VPN et appuyez sur

ACCEDER.

+ Pour enregistrer les informations sur le compte, cochez la case
Enregistrer les informations du compte.

Son et Notification

Vous pouvez personnaliser les parametres de sonnerie, vibreur et notification.

Sur [écran parametres, appuyez sur Son et Notification et personnalisez les
parametres suivants :
- Profil des sons: Choisissez le mode sonore ; son, silencieux ou vibreur

uniguement.

- Volume: Réglez le volume sonore pour différents éléments.

- Sonnerie: Sélection d'une sonnerie pour les appels entrants. Ajout ou

suppression de sonneries.

- Ring ID: Créez une sonnerie pour les appels entrants d'un contact en

particulier. Consultez la section Ring /D pour plus de détails.
Puissance du vibreur: Ajustement de l'intensité du vibreur.

+ Son avec vibration: Activation du vibreur en plus de la sonnerie.

- Type de vibration: \ous pouvez sélectionner un type de vibration ou créer

votre propre type de vibration.

Ne pas déranger: Définition de 'heure, du type de notification et du type
d'application pour la réception de messages de notification. Réception

de messages de notification uniqguement certains jours de la semaine.
Consultez la section Ne pas déranger pour plus de détails.

- Ecran de verrouillage: Affichage ou masquage d'un message de

notification sur [écran de verrouillage. Vous pouvez aussi masquer les
informations confidentielles.

- Applications: Sélectionnez les applications qui peuvent afficher leurs

messages de notification a [écran, puis définissez les priorités de ces
applications pour ce qui concerne les notifications.
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- LED de notification: Indication de état de lappareil par une LED.

- Plus> Son de notification: Sélection d'une sonnerie de notification.
Définition d'une musique enregistrée sur lappareil en tant que sonnerie de
notification.

+ Plus > Vibration lorsqu'on appuie: Activation du vibreur associé a
l'utilisation des fonctions tactiles.

« Plus > Effets sonores: Sélection d'un effet sonore lorsque vous utilisez
le clavier de numérotation, sélectionnez une option ou verrouillez/
déverrouillez [écran.

- Plus > Notifications vocales de messages et d'appels: Configuration
de lappareil pour qu'il lise a haute voix les informations de lappelant ou le
contenu du message.

Ecran

Vous pouvez personnaliser des paramétres détaillés pour chaque type décran.
Sur lécran paramétres, appuyez sur Ecran et personnalisez les paramétres
suivants :

- Ecran d'accueil: Personnalisation des paramétres pour lécran daccueil
Consultez la section Parametres de [écran daccueil, pour plus de détails.
Ecran de verrouillage: Personnalisation des paramétres de [écran de
verrouillage Consultez la section Parametres de [écran de verrouillage
pour plus de détails

- Touches tactiles: Réorganisation des touches tactiles de [écran d'accueil
ou modification de leur couleur darriere-plan. Masquage des touches
tactiles de [écran d'accueil a [écran.

Type de police: Changement de la police de caractere.

Taille de police: Changement de la taille de la police.
- Texte en gras: Mise en gras du texte a [écran.
+ Luminosité: Utilisez le curseur pour régler la luminosité de [écran de lappareil.

- Auto:Réglez l'appareil pour que la luminosité de [écran soit
automatiquement ajustée en fonction de l'intensité lumineuse ambiante.

+ Always-on display: Informations toujours affichées, comme la date,
I'heure et les notifications, méme lorsque [écran est éteint. Pour plus de

détails, consultez la section Always On Display.
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- Rotation automatique de l"écran: Rotation automatique de [écran en
fonction de lorientation de lappareil.

Mise en veille de "écran: Désactivation automatique de [écran quand
[appareil reste inactif pendant une période donnée.

- Plus> Ecran de veille interactif: Affichage d'un écran de veille lorsque
lappareil est connecté au support ou en charge. Sélection d'un écran de
veille.

Plus > Calibration des capteurs de mouvement: Correction de langle
et de la vitesse du détecteur de mouvement pour améliorer la précision
d'inclinaison et la vitesse du capteur.

E « Assurez-vous de poser dappareil sur une surface plane pour corriger le
réglage du détecteur de mouvements. Autrement, vous pourriez rencontrer
des problémes avec les fonctions du détecteur de mouvement, comme la
rotation automatique de [écran.

Geénéral

Langue et clavier

Vous pouvez personnaliser les paramétres de langue et de clavier de votre
appareil.

1 Sur [écran paramétres, appuyez sur Général > Langue et clavier.

7 Personnalisez les parametres suivants :
+ Langue: Sélectionnez une langue a utiliser pour lappareil.

Clavier actuel: Affichage du type de clavier actuellement utilisé.

Sélection d'un clavier pour la saisie de texte.

« Clavier LG: Personnalisation des parametres du clavier LG.

- Google voice typing: Configurez les options de dictée de texte par
Google.

- Parameétres de la synthése vocale: Configurez les parametres de
synthese vocale.

- Vitesse du curseur: Réglage de la vitesse du pointeur de la souris ou

du pavé tactile.
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- Inverser les boutons:Inversion du bouton droit de la souris pour les
manipulations directes de base.

Position
Vous pouvez personnaliser ['utilisation de vos informations de position par
des applications données.
1 Surlécran parameétres, appuyez sur Général > Position.
7 Personnalisez les parameétres suivants :
+ Mode: Sélection d'une méthode de transmission de votre position.

+ Mes endroits: Activation de lanalyse des endroits fréquemment visités
pour que lappareil reconnaisse automatiquement votre domicile.

- DEMANDE RECENTE DE POSITION: Affichage des applications
ayant récemment demandé des informations de position.

- Position géographique permettant l'estimation de la basse

consommation: Estimation de la position géographique en mode
basse consommation.

Appareil Photo: Enregistrement de la position géographique lors de la
prise de photos ou lenregistrement de vidéos.

- Historique des positions Google: Configurez les parametres
d'historique de position géographique Google.

Comptes et synchronisation

\lous pouvez ajouter ou gérer des comptes, y compris un compte Google.
Vous pouvez également synchroniser automatiquement certaines
applications ou des informations utilisateur.

1 Sur[écran parametres, appuyez sur Général > Comptes et
synchronisation.
2 Personnalisez les parameétres suivants :

- Synchronisation automatique: Synchronisation automatique de tous
les comptes enregistrés.

- COMPTES: Affichage d'une liste des comptes enregistrés. Appuyez sur
un compte pour afficher ou le modifier.

+ AJOUTER UN COMPTE: Ajout de comptes.
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Cloud

Vous pouvez enregistrer un compte Cloud et consulter du contenu enregistré
sur votre ordinateur ou dans le Cloud depuis votre appareil.

1 Sur [écran paramétres, appuyez sur Général > Cloud.

7 Personnalisez les parametres.

Utilisateurs
Vous pouvez ajouter des utilisateurs avec lesquels partager votre appareil.
1 Sur[écran parameétres, appuyez sur Général > Utilisateurs.

7 Personnalisez les paramétres.

Accessibilité

Vous pouvez gérer les plug-ins d'accessibilité installés sur votre appareil.
7 Sur [écran paramétres, appuyez sur Général > Accessibilité.

2 Personnalisez les parameétres suivants :

« Vision > TalkBack: Configuration de lappareil pour délivrer des
messages vocaux sur [état de [écran ou des actions.

- Vision > Notifications vocales de messages et d'appels:
Configuration de lappareil pour qu'il lise a haute voix les informations
de lappelant ou le contenu du message.

- Vision > Taille de police: Changement de la taille de la police.
- Vision > Texte en gras: Mise en gras du texte a [écran.

Vision > Zoom tactile: Zoom avant ou arriere avec trois pressions sur
[&cran.

- Vision > Inversion des couleurs de écran: Amélioration du contraste
des couleurs pour les personnes malvoyantes.

« Vision > Ajustement des couleurs de ['écran: Réglage de la couleur
daffichage.

- Vision > Niveaux de gris: Ecran en mode échelle de gris.

« Vision > Mettre fin aux appels a l'aide de la touche Marche/Arrét:
Raccrocher avec la touche Marche-Arrét/Verrouillage.
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+ Mode de reproduction sonore > Légende: Activation du service
de sous-titrage lors de la lecture vidéo pour les personnes
malentendantes.

+ Mode de reproduction sonore > LED de notification:Indication de
[état de lappareil par une LED.

- Mode de reproduction sonore > Alertes flash: Configuration de
lappareil pour faire clignoter le flash lors des appels entrants et
notifications.

Mode de reproduction sonore > Désactiver tous les sons:
Désactivez tous les sons et réduisez le volume du récepteur.

- Mode de reproduction sonore > Type de son: Sélection du type de
son.

- Mode de reproduction sonore > Balance du son: Ajustement de la
balance de sortie du son. Modifiez la balance a laide du curseur.

+ Motricité et cognition > Touch assistant: Activation du panneau
tactile pour accéder facilement aux actions les plus courantes.
Motricité et cognition > Durée de l'appui long: Ajustement du temps
de saisie tactile.

+ Motricité et cognition > Maintenez enfoncé pour les appels:
Réponse ou rejet des appels en maintenant le bouton d'appel appuyé
au lieu de le faire glisser.

+ Motricité et cognition > Mise en veille de écran: Désactivation
automatique de [écran quand lappareil reste inactif pendant une
période donnée.

+ Motricité et cognition > Zones de commande tactile: Limitation des
commandes tactiles a une zone de [écran.

« Raccourci vers les fonctions d'accessibilité: Acces rapide a une
fonction fréquemment utilisée en appuyant sur O

- Rotation automatique de 'écran: Changement automatique de
lorientation de [écran en fonction de la position physique de lappareil.
Switch Access: Création de combinaisons de touches pour
commander votre appareil.
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Touche de raccourci

Vous pouvez utiliser les touches de volume pour ouvrir directement des
applications lorsque [écran est éteint ou verrouillé.

7 Sur [écran paramétres, appuyez sur Général > Touche de raccourci.

7 Faites glisser (3 pour lactiver.

+ Appuyez deux fois sur la touche Diminuer le volume (-) pour ouvrir
lapplication Photo lorsque [écran est verrouillé ou éteint. Appuyez
deux fois sur la touche Augmenter le volume (+) pour ouvrir
Capturer+.

« Activez Prise de vue rapide si vous voulez prendre des photos
immeédiatement apres avoir appuyé sur la touche Diminuer le volume
(-) pour ouvrir lappareil photo.

Google service

Vous pouvez utiliser les parametres Google pour gérer vos applications
Google et les parameétres de votre compte.

Sur [écran parametres, appuyez sur Général > Google service.

Empreintes digitales & sécurité

1 Sur [écran paramétres, appuyez sur Général > Empreintes digitales &
sécurité.

7 Personnalisez les parameétres suivants :

- Empreintes digitales: Utilisation de votre empreinte digitale pour
déverrouiller [écran ou du contenu. Consultez la section Présentation
de la reconnaissance digitale pour plus de détails.

+ Verrouillage du contenu: Configuration de la méthode de verrouillage
des fichiers dans Galerie ou QuickMemo+.

« Crypter la carte SD: Cryptage de la carte mémoire pour empécher
toute utilisation sur un autre appareil. Consultez la section Cryptage de
la carte mémoire, pour plus de détails.
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- Configurer verrouillage SIM: Verrouillage ou déverrouillage de la carte
USIM ou modification du mot de passe (PIN).

+ Mot de passe visible: Affichage du mot de passe lors de la saisie.

- Administrateurs de l'appareil: Attribution de priviléges pour limiter le
controle et ['utilisation de l'appareil pour des applications données.

+ Sources inconnues: Autorisation de linstallation d'applications ne
provenant pas du Play Store.

- Vérifier les applications: Blocage de linstallation dapplications
nuisibles. Affichage d'un message davertissement lors de l'installation
d'une application nuisible.

Protection des données d'identification: Affichage du type de

stockage pour lenregistrement du certificat de sécurité.

- Gestion des certificats: Gestion du certificat de sécurité enregistré
sur lappareil.

« Trust agents: Affichage et utilisation des agents de confiance installés

sur lappareil.

Epinglage de Iécran: Epinglage de [écran dapplication pour une

utilisation de l'application actuellement active uniquement.

+ Acces d'utilisation pour les apps: Affichage des informations
relatives a ['utilisation des applications sur [appareil
Smart settings
Vous pouvez modifier automatiquement les paramétres de votre appareil en
fonction de votre mode d'utilisation et de votre position.

E « Pour utiliser Smart settings, veillez a entrer adresse de votre domicile.
Consultez la section Position pour plus de détails.

T Surlécran parameétres, appuyez sur Général > Smart settings.

2 Activez les éléments dont vous souhaitez modifier les paramétres
automatiquement.
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Date et heure

Vous pouvez personnaliser les parametres de date et d'heure de votre
appareil

1 Sur [écran paramétres, appuyez sur Général > Date et heure.

7 Personnalisez les parametres.

Stockage et USB

Vous pouvez afficher et gérer la mémoire interne de lappareil et lespace de
stockage de la carte mémoire.

1 Sur [écran paramétres, appuyez sur Général > Stockage et USB.

7 Personnalisez les parametres suivants :

- Mémoire de stockage interne: Affichage de lespace de stockage total
et possibilité de libérer de lespace sur la mémoire interne de lappareil.
Affichage de la liste des applications utilisées et de la capacité de
stockage de chacune.

- STOCKAGE PORTABLE: Affichage de l'espace de stockage total et
possibilité de libérer de lespace sur la carte mémoire. Cette option
n‘apparait que lorsqu’une carte mémoire est insérée. Pour démonter la
carte mémoire, appuyez sur A

Batterie et économie dénergie

Vous pouvez afficher les informations relatives a la batterie ou activer le

mode économie dénergie.

1 Surlécran parameétres, appuyez sur Général > Batterie et économie
dénergie.

7 Personnalisez les parametres suivants :

- Utilisation batterie: Affichage des informations relatives a ['utilisation
de la batterie. Pour afficher des informations complémentaires,
sélectionnez [élément qui vous intéresse.

- Pourcentage de la batterie dans la barre d'état: Affichage du
pourcentage du niveau de la batterie dans la barre détat.
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- Economie d‘énergie: Economie dénergie de la batterie a travers la
réduction de certains parametres, comme la luminosité de laffichage, la
vitesse et lintensité des vibrations. La barre détat affiche W lorsque le
mode économie dénergie est activé.

- Optimiseur pour les jeux: Ajustement de la qualité vidéo dans les jeux
afin déconomiser la batterie.

Mémoire
Vous pouvez afficher la quantité moyenne de mémoire utilisée sur une
période donnée et la mémoire occupée par une application.

1 Sur[écran parameétres, appuyez sur Général > Mémoire.

2 Appuyez sur + pour définir la période de recherche des données.

Smart cleaning

Vous pouvez nettoyer les fichiers temporaires ou applications qui ne sont plus
utilisées afin de libérer de lespace de stockage.

Sur [écran parametres, appuyez sur Général > Smart cleaning.

E + Consultez la section Smart cleaning pour plus de détails.

Applications

Vous pouvez afficher une liste des applications installées. Fermez ou
supprimez des applications si nécessaire.

1 Sur[écran parameétres, appuyez sur Général > Applications.

2 Sélectionner une application et procédez.

Paiement sans contact

Vous pouvez utiliser votre appareil a la place d'une carte de crédit pour
effectuer des paiements.

Sur [écran parametres, appuyez sur Général > Paiement sans contact.
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Sauvegarder & Réinitialiser

Vous pouvez sauvegarder les données enregistrées sur votre téléphone sur

un autre appareil ou compte. Réinitialisez lappareil si nécessaire.

7 Sur [écran paramétres, appuyez sur Général > Sauvegarder &
Réinitialiser.

2 Personnalisez les parameétres suivants :

+ LG Backup: Sauvegarde et restauration des données enregistrées sur
votre appareil. Consultez la section LG Backup pour plus de détails.

- Sauvegarder mes données: Sauvegarde de vos données d'application,
mot de passe Wi-Fi et autres parametres sur le serveur Google.

- Compte de sauvegarde: Affichage du compte actuellement utilisé
pour la sauvegarde.

+ Restaurer automatiquement: Restauration automatique des parametres
et données sauvegardés lors de la réinitialisation d'une application.

- Réinitialiser les paramétres réseaux: Réinitialisation du Wi-Fij,
Bluetooth et dautres parametres réseau.

- Réinitialiser valeurs d'usine: Réinitialisation de tous les parametres de
lappareil et suppression des données.

E « Toutes les données enregistrées sur votre appareil seront supprimées en
cas de réinitialisation. Saisissez a nouveau le nom de appareil, votre compte
Google et dautres informations initiales.

A propos du téléphone

Vous pouvez afficher des informations sur lappareil, comme le nom, [état, la
version logicielle et les informations [égales.

Sur lécran parameétres, appuyez sur Général > A propos du téléphone et
visualisez les informations.

Réglementations et sécurité

Vous pouvez afficher les marques réglementaires et les informations
connexes sur votre appareil.

Sur [écran parametres, appuyez sur Général > Réglementations et sécurité.
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Parameétres de langue LG

Sélectionnez une langue a utiliser sur votre appareil.

- Appuyez sur O > Paramétres > Général > Langue et clavier > Langue et
sélectionnez une langue.

LG Bridge

Présentation de LG Bridge

LG Bridge est une application qui vous permet de gérer les photos, chansons,
vidéos et documents enregistrés sur votre smartphone LG, depuis votre
ordinateur, et de maniére pratique. Vous pouvez sauvegarder vos contacts,
photos et bien plus encore sur lordinateur ou mettre a jour le logiciel de
lappareil.

E « Consultez aide en ligne de LG Bridge, pour plus de détails.
« Les fonctionnalités prises en charge peuvent varier en fonction de lappareil.

« Vous avez besoin du pilote LG USB pour connecter votre smartphone LG a
lordinateur Il s'installe lors de l'installation de LG Bridge.

Fonctions de LG Bridge
- Gérez les fichiers sur lappareil depuis un ordinateur, par le biais d'une
connexion Wi-Fi ou d'une connexion de données mobiles.

+ Sauvegardez les données depuis lappareil sur un ordinateur ou restaurez
les données depuis un ordinateur sur lappareil, par le biais d'une connexion
par cable USB.

Mettez le logiciel de lappareil a jour depuis un ordinateur par le biais d'une
connexion par cable USB.
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Installation de LG Bridge sur un ordinateur
1 Rendez-vous sur www.lg.com depuis votre ordinateur.
2 Dans la barre de recherche, saisissez le nom de votre appareil

3 Cliquez sur Download Centre > LG Bridge, puis téléchargez le fichier de
configuration.
+ Cliquez sur Détails pour consulter les exigences minimales requises
pour l'installation de LG Bridge.

Mise a jour du logiciel du téléphone

Mise a jour du logiciel LG Mobile Phone a partir

d'Internet

Pour des informations complémentaires sur 'utilisation de cette fonction,
consultez le site http//www.lg.com/common/indexjsp et sélectionnez votre
pays et votre langue.

Cette fonction vous permet de mettre a jour le micrologiciel sur votre appareil
et de télécharger la version la plus récente depuis Internet, sans faire appel a
un centre de services. Cette fonction sera disponible uniquement si LG fournit
une version plus récente du micrologiciel pour votre téléphone.

La mise a jour du micrologiciel du téléphone mobile requiert lattention
complete de ['utilisateur pendant toute la durée du processus. Assurez-vous
de bien lire toutes les instructions et remarques qui saffichent a chaque
étape avant de continuer. Attention :retirer le cable USB durant la mise a
niveau peut gravement endommager votre téléphone mobile.

E + LG seréserve le droit de mettre a disposition les mises a jour micrologicielles
de certains modeles uniquement, et ce a son entiere discrétion, et ne
garantit pas la disponibilité de versions micrologicielles plus récentes pour
lensemble de ses modeles de téléphones portables.
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Mise a jour du logiciel LG Mobile Phone par liaison
radio (OTA, Over-the-Air)

Cette fonction vous permet de mettre a jour le logiciel de votre téléphone
et de télécharger la version la plus récente via OTA, sans utiliser de cable de

données USB. Cette fonction sera disponible uniquement si LG fournit une
version plus récente du micrologiciel pour votre téléphone.

Commencez par vérifier la version du logiciel installée sur votre téléphone
mobile :

Paramétres > Général > A propos du téléphone > Centre de mises a jour
> Mise a jour logicielle > Rechercher les mises a jour maintenant.

E + Vos données personnelles enregistrées sur le téléphone, y compris les
informations relatives a votre compte Google et a tout autre compte,
les données et parametres systeme et d'application, ainsi que toutes les
applications téléchargées et vos licences DRM, peuvent étre perdues lorsque
vous mettez a jour le logiciel de votre appareil. Par conséquent, LG vous
recommande de sauvegarder vos données personnelles avant de mettre
ajour le logiciel de votre téléphone. LG ne peut étre tenu responsable de
toute perte de données personnelles.

- Cette fonctionnalité peut ne pas étre prise en charge en fonction de la
région ou de lopérateur de téléphonie.
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FAQ

Ce chapitre répertorie quelques-uns des problemes que vous pouvez
rencontrer lors de [utilisation de votre téléphone. Certains dentre eux
nécessitent que vous appeliez votre opérateur, mais vous pouvez facilement
en résoudre la plupart par vous-méme.

message

Causes possibles

Actions correctives possibles

Erreur carte
SIM

Aucune carte SIM nlest
insérée dans le téléphone, ou
cette derniere est insérée de
facon incorrecte.

Vérifiez que la carte SIM est
correctement insérée.

Le signal est faible ou vous
vous trouvez hors de portée
du réseau de votre opérateur.

Déplacez-vous vers une fenétre
ou une zone en plein air. Vérifiez la
carte de couverture de lopérateur
réseau.

Aucune
C(,mne)j;”‘ Vérifiez que la carte SIM na pas
(rjese/au alsse plus de 6a 12 mois. Si cest le
U reseau Lopérateur a appliqué de cas, changez la carte SIM ou
NOuveaux services. USIM dans lagence de votre
opérateur réseau. Contactez votre
fournisseur de services.
Pour changer un code
de sécurité, confirmez le
Codes non nouveau FOde en le saisissant | 5jyous oubliez le code, contactez
une deuxieme fois. également votre prestataire de
concordants )
Les deux codes que vous services.
avez saisis ne sont pas les
mémes.
Aucune .
. Non pris en charge par le .
application ) ! Contactez votre fournisseur de
N fournisseur de services ou .
ne peut étre ) ) services.
. enregistrement requis.
configurée.
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message Causes possibles Actions correctives possibles
1. Appuyez sur () > Paramétres.
Contactez pPay O 3
votre Supprimez [application 8 Appgyez.sur Général>
fournisseur de pp pp! - Applications.
services. 3. Appuyez sur 'application >
Désinstaller.
Erreur de numérotation Nouveau réseau non autorisé.
Vous avez inséré une - -
Vérifiez les nouvelles restrictions.
nouvelle carte SIM.
Appels
indisponibles Contactez votre fournisseur de
Limite de |a carte prépayée services ou redéfinissez votre
atteinte. limite de facturation a laide du
code PIN2.
Vous avez appuyé trop Appuyez sur la touche Marche/
brievement sur la touche Arrét pendant au moins deux
Impossible Marche/Arrét. secondes.
dallumer le
téléphone - .| Rechargez la batterie. Vérifiez
La batterie nest pas chargée. | |, o
lindicateur de charge sur [écran.
La batterie nest pas chargée. | Rechargez la batterie.
, Chargez votre téléphone dans
La température externe est gezve phoné
o des conditions de températures
trop élevée ou trop basse.
normales.
Vérifiez le chargeur et sa
Probléme de contact . 1t
Erreur de connexion au téléphone.
chargement
. Branchez le chargeur sur une
Absence de tension )
autre prise.
Chargeur défectueux Remplacez le chargeur.
N'utilisez que des accessoires de
Chargeur incorrect
marque LG.
Numéro non La fonction Numéro fixe est | Vérifiez le menu des réglages et
autorisé. activée. désactivez la fonction.
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message

Causes possibles

Actions correctives possibles

Impossible
de recevoir/
denvoyer des
SMS et des
photos

Mémoire pleine

Supprimez certaines données (des
applications ou des messages, par
exemple) pour libérer de lespace
sur votre appareil.

Les fichiers ne
souvrent pas

Format de fichier non pris
en charge

Vérifiez les formats de fichiers pris
en charge.

Sivous utilisez un étui ou un film

Lécran ne de protection, vérifiez qu'il ne
sallume pas Probléme lié au capteur de couvre pas la zone située autour
lorsque je recois | proximité du capteur de proximité. \érifiez
un appel. que la zone entourant le capteur

de proximité est propre.

Vérifiez les parametres dans le

) menu Son pour vous assurer que

Aucun son Mode Vibreur P q

vous nétes pas en mode Vibreur
ou Sans interruptions.

Le téléphone
raccroche ou se
bloque

Probleme logiciel
intermittent

Si lécran se bloque ou sile
téléphone cesse de répondre a
VoS pressions sur [écran, retirez la
batterie et remettez-(a en place.
Redémarrez ensuite le téléphone.

ou

Module de batterie incorrect

Reportez-vous a Installation de la
batterie pour plus d'informations.
Les spécifications de l'appareil
peuvent varier en fonction

Vérifier le inséré. de la région et de lopérateur

module de Module endommagé inséré | de téléphonie. Pour lachat

batterie ou module non correctement | de modules de batterie

inséré supplémentaires ou déléments
facultatifs compatibles, contactez
un centre de services LG
Electronics pour une assistance.
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Guide contre le vol

Configurez votre appareil pour empécher dautres personnes de ['utiliser
sans votre autorisation s'il a été réinitialisé avec les parametres d'usine.
Par exemple, si votre appareil est perdu, volé ou effacé, seule une personne
disposant des informations relatives a votre compte Google ou au
verrouillage de [écran peut ['utiliser.

Il vous suffit de vous assurer que votre appareil est protégé comme suit :

Définissez un écran de verrouillage :si votre appareil est perdu ou volé
mais que vous avez défini un verrouillage décran, il n'est pas possible de
leffacer depuis le menu Parametres sauf si [écran est déverrouillé.

Ajouter votre compte Google sur votre appareil : si votre appareil est
effacé mais qu'il est doté de votre compte Google, le processus de
configuration ne peut se terminer sur lappareil tant que vos informations
de compte Google ne sont pas saisies a nouveau.

Une fois votre appareil protégé, vous devrez soit déverrouiller [écran, soit
saisir le mot de passe de votre compte Google si vous avez besoin de faire
une réinitialisation d'usine. La réinitialisation ne peut donc étre réalisée que
par vous-méme ou une personne en laquelle vous avez confiance.

E - Noubliez pas lidentifiant et le mot de passe du compte Google que vous
avez saisis sur lappareil avant deffectuer la réinitialisation d'usine. Si vous
ne pouvez pas fournir les informations du compte pendant le processus de
configuration, vous ne pourrez pas utiliser lappareil apres avoir effectué la
réinitialisation des données d'usine.
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En savoir plus

Informations sur les logiciels libres

Pour obtenir le code source sous la licence publique générale, la licence
publique générale limitée, a licence publique Mozilla ou les autres licences
libres de ce produit, rendez-vous sur http.//opensource.lge.com.

En plus du code source, tous les termes de la licence, ainsi que les exclusions
de responsabilité et les droits dauteur, sont disponibles au téléchargement.
LG Electronics propose de vous fournir le code open source sur CD-ROM
en échange des colits couvrant cet envoi, notamment le co(it du support,
des frais de port et de prise en charge, une fois la demande recue par LG
Electronics a ladresse suivante : opensource@lge.com. La validité de cette
offre est de trois (3) ans a partir de la date d'achat du produit.

Infos réglementaires

Pour connaitre les informations concernant la réglementation et la sécurité,
aller a Parametres > Général > Réglementations et sécurité sur votre
téléphone.

Marques commerciales
+ Copyright ©2016 LG Electronics, Inc. Tous droits réservés. LG et le logo LG
sont des marques déposées de LG Group et de ses entités apparentées.
- Google™, Google Maps™, Gmail™, YouTube™, Hangouts™ et Play Store™
sont des marques commerciales de Google, Inc.

Bluetooth® est une marque déposée de Bluetooth SIG, Inc. dans le monde
entier.

Wi-Fi® et le logo Wi-Fi sont des marques déposées de Wi-Fi Alliance.
Tous les autres marques commerciales et droits dauteurs sont la propriété
de leurs propriétaires respectifs.
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poley Aupio  [XI1DOLBY AUDIO"

Fabriqué sous licence de Dolby Laboratories. Dolby, Dolby Audio et le symbole
double-D sont des marques commerciales de Dolby Laboratories.

Avertissement relatif au laser

Attention !

Ce produit utilise un systeme Laser. Pour garantir une utilisation conforme

du produit, veuillez lire attentivement le manuel utilisateur et conservez-le
afin de pouvoir vous y référer ultérieurement. Si lunité nécessite un entretien,
contactez un centre de réparation agréé.

Lutilisation de commandes, de réglages ou de procédures autres que ceux
spécifiés dans ce document peut provoquer une exposition a des rayons
dangereux.

Pour éviter toute exposition directe aux rayons laser, n'essayez pas douvrir le
couvercle ou dentrer directement en contact avec le laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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DECLARATION DE CONFORMITE

Par la présente, LG Electronics déclare que le produit LG-H840 est
conforme aux exigences fondamentales et aux autres dispositions
pertinentes de la directive 1999/5/EC.

Consultez la Déclaration de conformité sur
http//wwwi.lg.com/global/declaration

Contactez notre service pour connaitre les normes
auxquelles ce produit est conforme

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)
Ce périphérique peut étre utilisé dans tous les pays européens.

Les bandes de fréquences 5150 - 5350 MHz sont réservées a un usage en
intérieur uniquement.

AT |BE | BG|CH|HR|CY |CZ DK|EE| FI |FR|DE|GRHU| IE | IT | LI | LV
LT [LU |MT|NO|NL|PL|PT |RO|SK| SI |[ES|SE|GB] IS |ME /RS |TR |MK
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Recyclage de votre ancien appareil

1. Ce symbole de poubelle barrée d'une croix indique que votre
équipement électrique et électronique (EEE) ne doit pas étre jeté
avec les ordures ménageéres. Il doit faire [objet d'un tri et d'une collecte
sélective séparée.

2. Les équipements électriques que vous jetez peuvent contenir des
substances dangereuses. Il est donc important de les jeter de facon
appropriée afin déviter des impacts négatifs sur lenvironnement et la
santé humaine. Léquipement que vous jetez peut également contenir
des pieces réutilisables pour la réparation dautres produits ainsi que des
matériaux précieux pouvant étre recyclés pour préserver les ressources
de la planete.

3. Vous pouvez rapporter votre appareil au commergant qui vous |a
vendu ou contacter votre collectivité locale pour connaitre les points de
collecte de votre EEE. Vous trouverez également des informations a jour
concernant votre pays en allant sur www.quefairedemesdechets.fr

Recyclage des batteries/accumulateurs usagés

1. Ce symbole peut étre associé aux symboles chimiques du mercure
(Hg), du cadmium (Cd) ou du plomb (Pb) si la batterie contient plus de
0,0005 % de mercure, 0,002 % de cadmium ou 0,004 % de plomb.

2. Les batteries/accumulateurs doivent étre jetés séparément, dans les
déchetteries prévues a cet effet par votre municipalité ou étre rapportés
dans un magasin de téléphonie mobile.

3. La mise au rebut de vos batteries/accumulateurs dans une poubelle
appropriée ou dans un magasin de téléphonie mobile aidera a réduire les
risques pour environnement et votre santé.

4. Pour plus d'informations concernant le recyclage de vos batteries/
accumulateurs, veuillez contacter votre mairie, le service des ordures
ménageres ou encore le magasin ol vous avez acheté ce produit.
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. DEUTSCH
Uber dieses Benutzerhandbuch

Vielen Dank, dass Sie sich fur dieses LG Produkt entschieden haben.
Lesen Sie dieses Benutzerhandbuch vor der erstmaligen Verwendung
des Gerats sorgfaltig durch, um die sichere und ordnungsgemafe
Verwendung zu gewahrleisten.

- Verwenden Sie ausschlief3lich Originalzubehdr von LG. Die
mitgelieferten Artikel sind nur fir die Verwendung mit diesem Gerat
vorgesehen und sind maglicherweise nicht mit anderen Geraten
kompatibel.

+ Dieses Gerat ist aufgrund der Touchscreen-Tastatur nicht fir Personen
mit Sehschwache geeignet.

- Die Beschreibungen basieren auf den Standardeinstellungen des
Gerats.

+ StandardmaRig auf dem Gerat vorinstallierte Apps unterliegen
Aktualisierungen. Méglicherweise werden diese Apps ohne vorherige
Ankindigung nicht mehr untersttzt. Sollten Sie Fragen zu einer auf
dem Gerat vorinstallierten App haben, wenden Sie sich bitte an ein LG
Servicezentrum. Bei benutzerinstallierten Apps wenden Sie sich bitte
an den entsprechenden Netzanbieter.

+ Das Verandern des Betriebssystems des Gerats oder das Installieren
von Software von inoffiziellen Quellen kann zu Schaden am Gerat
und zu Beschadigung oder Verlust von Daten fiihren. Derartige
Handlungen stellen VerstoRe gegen lhre Lizenzvereinbarung mit LG
dar und haben das Erl6schen der Garantie zur Folge.

+ Einige Inhalte und lllustrationen unterscheiden sich je nach Gebiet,
Netzanbieter, Softwareversion oder Betriebssystemversion
moglicherweise von lhrem Gerat und kénnen ohne vorherige
Ankindigung geandert werden.

- Software, Audiodateien, Hintergrundbilder, Bilder sowie andere
Medien auf diesem Gerat unterliegen einer Lizenzvereinbarung fir die
eingeschrankte Nutzung. Wenn Sie diese Materialien fir gewerbliche
oder sonstige Zwecke extrahieren und verwenden, stellt dies
maglicherweise einen Verstof? gegen Urheberrechtsgesetze dar. Als
Benutzer tragen Sie die volle Verantwortung bei illegaler Verwendung
von Medien.



Es konnen zusatzliche Kosten fir Datendienste wie den Versand
von Nachrichten, das Hochladen und Herunterladen von Inhalten,
die automatische Synchronisation oder die Verwendung von
Standortdiensten anfallen. Wahlen Sie einen lhren Anforderungen
entsprechenden Datentarif aus, um zusatzliche Kosten zu
vermeiden. Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere
Informationen wiinschen.

Dieses Benutzerhandbuch wurde in den Hauptsprachen jeden Landes
verfasst. Je nach Sprache kann der Inhalt teilweise voneinander
abweichen.

Gebrauchshinweise

A WARNUNG: Situationen, die zu Verletzungen des Benutzers und Dritter
fihren konnen

ACHTUNG: Situationen, die zu kleineren Verletzungen oder Schaden am
Gerat fuhren konnen

E HINWEIS: Hinweise oder weitere Informationen

Uber dieses Benutzerhandbuch
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Richtlinien fiir den sicheren und
effizienten Gebrauch

Lesen Sie diese einfachen Richtlinien sorgfaltig durch. Die Nichtbeachtung dieser
Richtlinien kann gefahrlich oder gesetzeswidrig sein. Sollte eine Stérung auftreten,
sorgt ein in lhrem Gerat integriertes Software-Tool daftir, dass ein Fehlerprotokoll
erstellt wird. Dieses Tool erfasst nur Informationen tber die aufgetretene Storung
wie z. B. Signalstarke, Cell ID Position bei plétzlichem Gesprachsabbruch und
geladene Apps. Das Protokoll dient ausschlieRlich dazu, die Ursache der Storung
zu bestimmen. Die Protokolle sind verschliisselt und kénnen nur von einem
autorisierten LG-Reparaturzentrum abgerufen werden, falls Sie Ihr Gerat zur
Reparatur geben miissen.

Sicherheitshinweis (iber die Einwirkung

elektromagnetischer Energie im Radiofrequenzbereich

Informationen zur Einwirkung elektromagnetischer Felder und zur Spezifischen
Absorptionsrate (SAR).

Das Mobiltelefon LG-H840 entspricht den geltenden Sicherheitsbestimmungen
hinsichtlich der Einwirkung elektromagnetischer Felder. Diese Bestimmungen
basieren auf wissenschaftlichen Richtlinien, die auch Sicherheitsabstande
definieren, um eine gesundheitliche Gefahrdung von Personen (unabhangig von
Alter und allgemeinem Gesundheitszustand) auszuschlieRen.

+ In den Richtlinien hinsichtlich der Einwirkung elektromagnetischer Felder
wird eine MaReinheit verwendet, die als Spezifische Absorptionsrate (SAR)
bezeichnet wird. Der SAR-Wert wird mit standardisierten Testmethoden
ermittelt, bei denen das Telefon in allen getesteten Frequenzbandern mit der
héchsten zuldssigen Sendeleistung betrieben wird.

+ Auch wenn Unterschiede zwischen den SAR-Werten verschiedener LG-
Telefonmodelle bestehen, entsprechen sie in jedem Fall den geltenden
Richtlinien hinsichtlich der Einwirkung elektromagnetischer Felder.

+ Der von der Internationalen Kommission fiir den Schutz vor nichtionisierenden
Strahlen (International Commission on Non-lonizing Radiation Protection,
ICNIRP) empfohlene SAR-Grenzwert liegt bei 2 \W/kg gemittelt Gber zehn (10)
Gramm Gewebe.

+ Der hochste fir dieses Telefonmodell ermittelte SAR-Wert bei Verwendung am
Ohr liegt bei 0,981 W/kg (10 g) bzw. 1,440 W/kg (10 g), wenn das Gerat am
Korper getragen wird.



« Dieses Gerat entspricht den Sicherheitsstandards hinsichtlich der
Strahlenbelastung bei normaler Verwendung am Ohr oder wenn der Abstand
vom Korper mindestens 5 mm betragt. Tragetaschen, Girtelclips oder
Vorrichtungen zum Tragen des mobilen Gerats am Korper durfen kein Metall
enthalten und mussen das Gerat in einem Abstand von mindestens 5 mm vom
Korper halten. Um Dateien oder Nachrichten tbertragen zu kdnnen, benotigt
dieses Gert eine gute Netzverbindung. In einigen Fallen wird die Ubertragung
von Dateien und Nachrichten verzogert, bis die Netzverbindung entsprechend
qgut ist. Stellen Sie sicher, dass der oben genannte Abstand eingehalten wird, bis
die Ubertragung abgeschlossen ist.

Pflege und Wartung des Telefons

+ Verwenden Sie immer original LG-Akkus, -Ladegerate und -Zubehorteile,
die fur die Verwendung mit genau diesem Mobiltelefon zugelassen sind. Die
Verwendung anderer Teile kann zum Erlschen der Zulassungen oder Garantien
fur dieses Mobiltelefon fihren und kann gefahrlich sein.

- Einige Inhalte und Abbildungen weichen maglicherweise von Ihrem Gerat ab und
unterliegen Anderungen ohne Vorankindigung.

- Offnen Sie dieses Mobiltelefon nicht. Sollten Reparaturen erforderlich sein,
wenden Sie sich an einen qualifizierten Kundendienstmitarbeiter.

+ LG ist berechtigt, bei Reparaturen im Rahmen der Garantie neue oder tiberholte
Ersatzteile oder Platinen zu verwenden, sofern diese Gber den gleichen
Funktionsumfang verfiigen wie die zu ersetzenden Teile.

+ Benutzen Sie dieses Mobiltelefon nicht in der Nahe elektrischer Gerate (z. B.
Fernsehgerate, Radios, PCs).

+ Halten Sie das Telefon von Warmequellen wie Heizungen oder Herdplatten fern.

+ Lassen Sie das Telefon nicht fallen.

+ Setzen Sie das Telefon keinen starken Erschitterungen oder StoRen aus.

+ Schalten Sie das Telefon aus, wenn dies aufgrund von jeweils geltenden
Bestimmungen erforderlich ist. Verwenden Sie Ihr Telefon beispielsweise nicht in
Krankenhausern, da andernfalls die Funktionalitat empfindlicher medizinischer
Gerate beeintrachtigt werden kann.

- Fassen Sie das Telefon wahrend des Ladevorgangs nicht mit nassen Handen an.
Dadurch kann es zu einem Stromschlag oder einer schweren Beschadigung des
Telefons kommen.

- Laden Sie das Telefon nicht in der Nahe von entflammbarem Material auf, da das
Telefon heil werden kann und somit eine Brandgefahr darstellt.
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+ Reinigen Sie das Gerat auRen mit einem trockenen Tuch (verwenden Sie keine
Losungsmittel wie Benzin, Verdinner oder Alkohol).

+ Legen Sie das Telefon beim Aufladen nicht auf Polstermébel.
+ Das Telefon sollte in einer gut beltfteten Umgebung aufgeladen werden.

+ Bewahren Sie das Telefon nicht in sehr verrauchten oder staubigen
Umgebungen auf.

+ Bewahren Sie das Telefon nicht in der Nahe von Gegenstanden mit
Magnetstreifen (Kreditkarten, Flugtickets usw.) auf, da andernfalls die auf dem
Magnetstreifen gespeicherten Informationen beschadigt werden konnten.

+ Berihren Sie das Display nicht mit spitzen oder scharfen Gegenstanden;
andernfalls kann das Telefon beschadigt werden.

+ Setzen Sie das Telefon keiner Feuchtigkeit oder Nasse aus.

+ Verwenden Sie Zubehorteile (wie z. B. Kopfhorer) immer mit der erforderlichen
Sorgfalt. Bertihren Sie die Antenne nicht unnétig.

+ Berthren, entfernen oder reparieren Sie nicht zerbrochenes oder gesprungenes
Glas. Schaden am Glas-Display aufgrund von Missbrauch fallen nicht unter die
Garantiebedingungen.

- |hr Telefon ist ein elektronisches Gerat, das sich bei normalem Betrieb erhitzt.
Besteht anhaltender;, direkter Hautkontakt ohne angemessene Beliftung, kann
es zu Beschwerden oder leichten Verbrennungen kommen. Gehen Sie daher
wahrend und direkt nach dem Betrieb vorsichtig mit Ihrem Telefon um.

« Wenn Ihr Telefon nass wird, missen Sie es sofort vom Netzstrom trennen,
ausschalten und vollstandig trocknen lassen. Versuchen Sie nicht, das Trocknen
mit einer externen Heizquelle, wie Ofen, Mikrowelle oder Haartrockner, zu
beschleunigen.

+ Inlhr Telefon eingedrungene Flissigkeit andert die Farbe der
Produktkennzeichnung im Gerat. Ein Gerateschaden, der aufgrund
des Eindringens von Flissigkeiten entsteht, fallt nicht unter die
Garantiebedingungen.
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Effiziente Verwendung des Telefons

Elektronische Gerate

Bei Mobiltelefonen kann es zu Interferenzen kommen, die die Leistung
beeintrachtigen kénnen.
- Verwenden Sie das Mobiltelefon nicht unerlaubt in der Nahe medizinischer
Gerate. \Wenn Sie einen Herzschrittmacher tragen, bewahren Sie das Telefon
nicht in der Nahe des Herzschrittmachers (z. B. in der Brusttasche) auf.

- Einige Horhilfen konnen durch Mobiltelefone beeintrachtigt werden.

+ Bei Fernsehgeraten, Radios, PCs usw. kénnen ebenfalls leichte Interferenzen
auftreten.

- Verwenden Sie |hr Telefon nur bei Temperaturen zwischen 0 °C und 35 °C.
Die Verwendung bei besonders niedrigen oder hohen Temperaturen kann zu
Beschadigungen, Fehlfunktionen oder sogar zu einer Explosion fiihren.

Sicherheit im Straenverkehr

Erkundigen Sie sich Uber die jeweils geltenden Gesetze und Bestimmungen Uber
die Verwendung von Mobiltelefonen in Fahrzeugen.

- Bedienen oder halten Sie wahrend der Fahrt kein Mobiltelefon.
+ Richten Sie lhre ganze Aufmerksamkeit auf den StraRenverkehr.

+ Parken Sie ggf. zuerst das Fahrzeug, bevor Sie Anrufe tatigen oder
entgegennehmen.

+ Elektromagnetische Strahlen kénnen u.U. elektronische Systeme in lhrem
Fahrzeug stéren, wie beispielsweise das Autoradio oder Sicherheitssysteme.

+ Falls Ihr Fahrzeug mit einem Airbag ausgestattet ist, achten Sie darauf, das
Telefon nicht auf bzw. vor dem Airbag abzulegen und die Freisprecheinrichtung
nicht in der Nahe des Airbags zu installieren. Andernfalls kann die
Funktionsweise des Airbags beeintrachtigt werden, was zu schweren
Verletzungen fihren kann.

- Wenn Sie Musik héren, wahrend Sie unterwegs sind, stellen Sie sicher, dass die
Lautstarke auf ein angemessenes MaR eingestellt ist, sodass Sie Ihre Umgebung
wahrnehmen. Dies ist vor allem dann wichtig, wenn Sie sich in der Nahe einer
StrafRe befinden.
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Vermeiden von Horschaden
Um einer Schadigung des Gehdrs vorzubeugen, sollten Sie nicht Gber
einen [angeren Zeitraum mit hoher Lautstarke horen.

\Wenn Sie langere Zeit einem hohen Gerduschpegel ausgesetzt sind, kénnen
Horschaden auftreten. Wir empfehlen deshalb, dass Sie das Telefon beim Ein- und
Ausschalten nicht ans Ohr halten. Es empfiehlt sich auRerdem, die Lautstarke von
Musik und Anrufen auf ein angemessenes MaR einzustellen.
+ Reduzieren Sie die Lautstarke bei der Verwendung von Kopfhdrern, wenn Sie die
Stimmen von Personen in lhrer Nahe nicht horen kénnen oder wenn die Person
neben Ihnen lhre Musik héren kann.

E - UbermaRige Lautstarke und tibermaRiger Druck der Ohrhérer und
Kopfhorer kénnen zu Horverlust fiihren.

Glasteile

Einige Teile Ihres mobilen Gerats bestehen aus Glas. Das Glas kann zerbrechen,
wenn lhr Gerat herunterfallt oder wenn es einen kraftigen StoR oder Schlag
erfahrt. Sollte das Glas zerbrechen, beriihren Sie es nicht und versuchen Sie nicht,
es zu entfernen. Verwenden Sie das Gerat erst wieder, wenn das Glas von einem
autorisierten Dienstanbieter ersetzt wurde.

Sprenggebiete

Benutzen Sie das Telefon nicht in Sprenggebieten. Beachten Sie die
Einschrankungen, und befolgen Sie alle geltenden Vorschriften und Regeln.

Explosionsgefahrdete Orte
- Verwenden Sie das Telefon nicht an Tankstellen.
+ Verwenden Sie das Telefon nicht in der Nahe von Kraftstoffen oder Chemikalien.

« Transportieren und lagern Sie keine brennbaren Flissigkeiten, Gase oder
Explosivstoffe im selben Raum des Fahrzeugs, in dem sich auch das
Mobiltelefon oder Mobiltelefonzubehdr befindet.
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In Flugzeugen
In einem Flugzeug konnen Telefone zu Interferenzen fihren.
+ Schalten Sie daher Ihr Mobiltelefon aus, bevor Sie in ein Flugzeug steigen.

+ Verwenden Sie es auch nicht wahrend des Aufenthalts auf dem
Flughafengelande, sofern dies nicht ausdrticklich vom Personal erlaubt wurde.

Kinder

Bewahren Sie das Mobiltelefon an einem sicheren Ort auRerhalb der Reichweite
von Kleinkindern auf. Es enthalt Kleinteile, die verschluckt oder eingeatmet werden
konnten.

Notrufe

Notrufe sind méglicherweise nicht in allen Mobilfunknetzen maglich. Verlassen
Sie sich daher bei Notrufen nie ausschlieRlich auf ein Mobiltelefon. Weitere
Informationen dazu erhalten Sie von Ihrem Dienstanbieter.

Hinweise zum Akku und zur Pflege des Akkus

- Esist nicht erforderlich, den Akku vor dem Laden vollstandig zu entladen.
Anders als bei herkommlichen Akkus tritt bei diesem Akku kein Memory-Effekt
auf, der die Leistung vermindert.

+ Verwenden Sie ausschlieRlich Akkus und Ladegerate von LG. Ladegerate von LG
sind so ausgelegt, dass die Lebensdauer des Akkus optimiert wird.

- Offnen Sie nicht den Akku und schlieRen Sie ihn nicht kurz.
- Achten Sie darauf, dass die Kontakte des Akkus sauber sind.

« Tauschen Sie den Akku aus, wenn die Leistung nicht mehr zufriedenstellend ist.
Ein Akku kann mehrere hundert Mal aufgeladen werden, bevor er ausgetauscht
werden muss.

+ Wenn Sie den Akku langere Zeit nicht verwendet haben, laden Sie ihn erneut
auf, um maximale Leistung zu erzielen.

+ Setzen Sie das Ladegerat keiner direkten Sonneneinstrahlung oder hoher
Luftfeuchtigkeit (z. B. in einem Badezimmer) aus.

+ Bewahren Sie den Akku nicht in sehr heiRen oder sehr kalten Raumen auf, da
dies die Leistung beeintrachtigen kann.
+ Bei Austausch des Akkus mit einem ungeeigneten Akkutyp besteht

Explosionsgefahr. Entsorgen Sie unbrauchbar gewordene Akkus gemaR den
Anweisungen.

Richtlinien fur den sicheren und effizienten Gebrauch 10



- Wenn Sie den Akku ersetzen miissen, wenden Sie sich an einen autorisierten LG
Electronics Service Point oder Handler in Ihrer Nahe.

- Entfernen Sie das Ladegerat immer aus der Steckdose, wenn das Telefon voll
aufgeladen ist. So vermeiden Sie, dass das Ladegerat unnétig Strom verbraucht.

- Die tatsachliche Akkulaufzeit ist abhangig von der Netzwerkkonfiguration, den
Produkteinstellungen, dem Gebrauch und den Umgebungsbedingungen.

« Stellen Sie sicher, dass keine spitzen Gegenstande wie Tierzahne oder Nagel in
Kontakt mit dem Akku kommen. Dies kdnnte ein Feuer verursachen.

+ Stromverbrauch (Stand-by-Modus im Netzwerk): 0,32 W
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Benutzerdefinierte
Funktionen



Modularer Aufbau

Der modulare Aufbau des Gerats ermdglicht die Verwendung der
Funktionen diversen Zubehérs.

Ziehen Sie das Modul aus dem Moduleinschub des Gerats. So konnen
Sie nur den Akku ersetzen oder ein anderes Zubehor im Moduleinschub
installieren, um seine spezifischen Funktionen zu nutzen.

E « Weitere Informationen finden Sie unter Akku entfernen und Akku
einsetzen.

- Verfligbares Zubehor unter der Bezeichnung LG Friends ist optional.

- Wenden Sie sich an ein LG Servicezentrum, um optionales Zubehor zu
erwerben.

« Das verfiighare Zubehér kann je nach Gebiet oder Netzanbieter

unterschiedlich sein.

«—— Modul

Always On Display

Sie kénnen das Datum, die Uhrzeit, lhre Signatur und andere Informationen auch
dann auf dem Bildschirm anzeigen, wenn der Hauptbildschirm ausgeschaltet

ist. ,Always-on Display” ist eine niitzliche Funktion, mit der Sie regelmaRig die
Uhrzeit tiberpriifen und Ihre Signatur anzeigen konnen.

5 + Der Akku kann schneller leer sein, wenn Sie die Funktion ,Always-

on Display” verwenden. Deaktivieren Sie diese Funktion, um die
Akkulaufzeit zu verlangern.
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1 Tippen Sie auf O > Einstellungen > Anzeige > Always-on display
und ziehen Sie dann (3 nach rechts, um die Funktion zu aktivieren.

E + Diese Funktion ist moglicherweise bereits beim Kauf des Gerats
aktiviert.

+ Die Standardeinstellung kann je nach Gebiet und Netzanbieter variieren.

7 Tippen Sie auf Legen Sie die Anzeige fest und wahlen Sie Elemente aus, die
auf dem ausgeschalteten Bildschirm angezeigt werden sollen.
« Zeit: Die aktuelle Zeit auch anzeigen, wenn der Bildschirm
ausgeschaltet ist.
- Signatur: Anstelle der aktuellen Zeit lhre Signatur auf dem
ausgeschalteten Bildschirm anzeigen. Vlerwenden Sie die Option Signatur
festlegen, um eine Signatur einzugeben und die Schriftart zu andern.

E « Stellen Sie sicher, dass lhre Signatur nicht die zulassige Zeichenanzahl
im Eingabefeld tberschreitet.

Tageslichtmodus

Verwenden Sie die erweiterte IPS Quantum Display-Funktion, um den
Bildschirm auch bei hellem Sonnenlicht klar und deutlich zu sehen.
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135°-Weitwinkelobjektiv

Sie konnen das Weitwinkelobjektiv verwenden, um Fotos von einem
Motiv aufzunehmen, das breiter ist als das eigentliche Sichtfeld. Diese
Funktion ist nutzlich, wenn Sie ein Foto oder Video von einer Landschaft
oder einem breiten Motiv aus einem schmalen Blickwinkel aufnehmen
mochten. Sie konnen damit eine ausgedehnte Skyline, ein Konzert im
Stadion, einen kompletten Strand oder nahezu alles, was Sie sehen
konnen, aufnehmen.

E + Weitere Informationen finden Sie unter Zur Dual-Kamera wechseln.

Dual-Kameras

Sie kénnen mit den Dual-Kameras auf der Riickseite des Gerats

eine Vielzahl von Fotos und Videos von Nahaufnahmen bis zu
Landschaftsszenen aufnehmen. Bewegen Sie dazu einfach die Finger auf
dem Bildschirm auseinander oder zusammen.

E « Weitere Informationen finden Sie unter Zur Dual-Kamera wechseln.
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Bild aus Bild

Sie konnen ein Foto so aussehen lassen, als ob es in einem Rahmen ware:
Nehmen Sie dazu gleichzeitig ein normales und Weitwinkelfoto auf. Lassen Sie
das Foto aus diesen vier Hintergrundrahmeneffekten heraustreten: Fischauge,
Schwarz-weil3, Vignette und Unschérfe.

E + Weitere Informationen finden Sie unter Bild aus Bild.

Verwacklungsfrei aufnehmen

Mit der Funktion ,Verwacklungsfrei aufnehmen” kdnnen Sie extreme
Bewegungsunscharfe beim Aufnehmen eines Fotos oder Videos minimieren.
Mit dieser Funktion wird das Foto oder Video automatisch stabilisiert,
wahrend Sie sich bewegen. Tippen Sie auf ‘%, um diese Funktion zu aktivieren.

Smart Bulletin

Sie kdnnen einen Startbildschirm hinzufiigen, auf dem nutzliche Informationen
gesammelt und angezeigt werden.

Auf dem Smart Bulletin kénnen Sie wichtige Neuigkeiten im Uberblick anzeigen.
Es ist nicht erforderlich, ein zusatzliches Widget hinzuzufligen oder eine App
auszufthren.
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1 Tippen Sie auf O > Einstellungen > Anzeige > Homescreen > Smart
Bulletin und ziehen Sie dann (33 nach rechts, um die Funktion zu
aktivieren.

- Sie finden das Smart Bulletin auf der Seite ganz links auf dem
Startbildschirm.

2 Konfigurieren Sie das Smart Bulletin mithilfe der verfigbaren

MenUelemente.

- Wenn Sie die Mentelemente auf dem Smart Bulletin neu anordnen
maochten, bertihren und halten Sie das Symbol == und ziehen Sie es
dann nach oben oder unten.

+ Um ein Mentelement auf dem Smart Bulletin ein- oder
auszublenden, ziehen Sie (33 nach rechts.

E - Tippen Sie zum Andern der Smart Bulletin-Konfiguration auf dem Smart
Bulletin auf §83.

Smart Notice

Mit Smart Notice konnen Sie niitzliche Informationen fir Ihre Zeit

und lhren Standort erhalten. Mithilfe dieses Widgets werden |hre
Umgebung und taglichen Nutzungsmuster analysiert, um Informationen
bereitzustellen, die zu einer bestimmten Zeit und an einem bestimmten
Standort nitzlich sind.

Nutzen Sie ,Smart Notice’ um

+ automatische Erinnerungen zum Hinzufligen von haufig verwendeten,
nicht gespeicherten Rufnummern zu Kontakten zu erhalten.

automatische Erinnerungen fur Ruckrufe bei Rufnummern zu erhalten,
an die Sie eine Abweisungsnachricht gesendet haben.

automatische Erinnerungen zu Geburtstagen von Kontakten zu
erhalten, die im Kalender und in der Kontaktliste gespeichert sind.

+ automatische Erinnerungen zum Loschen von temporaren Dateien,
heruntergeladenen Dateien und Apps, die tber einen bestimmten
Zeitraum nicht mehr genutzt wurden, zu erhalten.
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+ automatische Erinnerungen zum Anpassen der Gerateeinstellungen

entsprechend dem Gebrauch und dem Ort, an dem Sie das Gerat
verwenden, zu erhalten.

+ automatische Erinnerungen zum Energiesparen zu erhalten, wenn der

Akku einen hohen Stromverbrauch aufweist.

Smart Notice aktivieren

Sie konnen das Smart Notice-Widget hinzuftigen, wenn es nicht
standardmaRig hinzugeftigt oder vom Startbildschirm geléscht wurde. Gehen
Sie zum Hinzufligen des Widgets wie folgt vor.

1

2

Bertihren und halten Sie auf dem Startbildschirm eine freie Stelle und
tippen Sie anschlieend auf Widgets.

Bertihren und halten Sie Smart Notice und ziehen Sie das Widget
dann an eine andere Position auf dem Startbildschirm.

+ Das Smart Notice-Widget wird auf dem Startbildschirm angezeigt und

bietet zunachst eine Ubersicht iiber die zugehérigen automatischen
Erinnerungsfunktionen.

Tippen Sie auf dem Widget-Bildschirm auf €3, um die Einstellungen
fur Smart Notice nach lhren Wuinschen zu andern oder die
Elemente auszuwahlen, fir die Sie mit Smart Notice automatische
Erinnerungen erhalten mochten.

- Die Smart Notice-Funktion ist méglicherweise bereits beim Kauf des
Gerats aktiviert.

+ Die Standardeinstellung kann je nach Gebiet oder Netzanbieter anders
sein.
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Smart Doctor

Sie konnen die Funktion ,Smart Doctor” verwenden, um eine Diagnose
Uber den Zustand des Gerats zu erstellen und das Gerat zu optimieren.

1 Tippen Sie auf O > Einstellungen > Allgemein > Smart Doctor.

2 Verwenden Sie die gewunschten Funktionen.

€ ———

E— -

-~

J

- Telefon optimieren: Derzeit nicht verwendete Apps schlie3en und
temporare Dateien l6schen, um die Gerateleistung zu verbessern.

- Diagnose: Den Akku, die mobilen Daten, die Apps, den
Mobilnetzstatus und die Nutzungsmuster analysieren, um
Informationen zur Gerateverwaltung anzuzeigen.
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Quick Share

Sie kénnen ein Foto oder Video direkt nach der Aufnahme mit der
gewdlnschten App teilen.

1 Tippen Sie auf > @) und nehmen Sie dann ein Foto oder Video auf.

7 Ziehen Sie das nach der Aufnahme eines Fotos oder Videos
angezeigte Quick Share-Symbol und wahlen Sie eine App zum Teilen
aus.

Sie kdnnen auch das nach dem Aufnehmen eines Fotos oder Videos
angezeigte Vorschausymbol bertihren und halten und es zum Quick
Share-Symbol ziehen.

E « Die vom Quick Share-Symbol angezeigte App kann je nach Typ der Apps
und der Haufigkeit des Zugriffs auf diese Apps variieren.
- Diese Funktion ist nur verfiigbar, wenn Sie im automatischen Modus ein
Foto oder Video aufnehmen. Weitere Informationen finden Sie unter
Automatischer Modus.
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Quick Help

Sie konnen die wichtigsten Funktionen des Gerats, haufig gestellte
Fragen oder das Benutzerhandbuch anzeigen. Sie kénnen Stichworter
zu Problemen, die nach dem Kauf aufgetreten sind, oder sonstige
Fragen eingeben, um nitzliche Informationen einschlieBlich Antworten
auf haufig gestellte Fragen oder Anleitungen im Benutzerhandbuch
anzuzeigen.

1 Tippen Sie auf O > Quick Help.

2 Geben Sie Anfragen in das Suchfeld ein, um nach Informationen zu
suchen.

E « Diese Funktion wird regelmaRig unter Berticksichtigung des Benutzer-
Feedbacks aktualisiert.

« Die verfiigbaren Mentielemente konnen je nach Gebiet oder Netzanbieter
unterschiedlich sein.

QuickRemote

Ubersicht: QuickRemote

Sie kénnen zahlreiche elektronische Gerate an verschiedenen Standorten
steuern, indem Sie das Gerat als Fernbedienung verwenden.

E - Diese Funktion nutzt Infrarotsignale (IR) und funktioniert ahnlich wie
eine Fernbedienung. Wenn Sie die QuickRemote-Funktion verwenden,
stellen Sie sicher, dass der Infrarotsensor rechts oben am Gerat frei
bleibt.

« Diese Funktion wird je nach Gebiet, Netzanbieter oder Geratehersteller
maglicherweise nicht unterstitzt.
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Ein Gerat fiir die Fernbedienung registrieren

Sie konnen ein Gerat registrieren, das Sie mit lhrem Gerat fernsteuern
mochten.

1
2

Tippen Sie auf O > LG > QuickRemote.

Tippen Sie auf =, um Standorte festzulegen, an denen Sie die
Fernbedienung verwenden mochten.

Tippen Sie auf + und wahlen Sie den Typ und Hersteller des Gerats,
das Sie fernsteuern mochten, aus.

Befolgen Sie die Anweisungen auf dem Bildschirm, um sicherzustellen,
dass die QuickRemote-Funktion auf dem Gerat ordnungsgemar
funktioniert.

Universalfernbedienung einrichten

\Wenn das mit Ihrem Gerat zu steuernde Gerat nicht in der Liste
vorhanden ist, kdnnen Sie eine angepasste universelle Fernbedienung
erstellen, indem Sie die haufig verwendeten Tasten wie gewtinscht
anordnen.

1
2

Tippen Sie auf O > LG > QuickRemote.

Tippen Sie auf =, um Standorte festzulegen, an denen Sie die
Fernbedienung verwenden mochten.

Tippen Sie auf ++ > Universal Fernbedienung.

Geben Sie einen Namen flr die Fernbedienung ein und tippen Sie auf
OK.

Berthren und halten Sie die gewtinschte Schaltflache und ziehen Sie
sie dann an die gewtinschte Position.

Tippen Sie auf WEITER.

Befolgen Sie die Anweisungen auf dem Bildschirm, um die Tasten zu
registrieren, und tippen Sie anschlieRend auf SPEICH.
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QuickMemo+

Ubersicht: QuickMemo+

Mit den verschiedenen Optionen dieser erweiterten Editorfunktion
konnen Sie kreative Notizen erstellen. Zu diesen Optionen gehdren
Bildverwaltung und Screenshots, die vom herkémmlichen Editor nicht
unterstitzt werden.

Notiz erstellen
1 Tippen Sie auf O > QuickMemo+.
2 Tippen Sie auf @, um eine Notiz zu erstellen.
« v :Notiz speichern.
+ € :Letzte Aktion riickgangig machen.
« (> Zuletzt rickgangig gemachte Aktion erneut ausfihren.
+ T :Notiz mithilfe des Tastenfelds eingeben.
-/ :Handschriftliche Notizen erstellen.
- & :Handschriftliche Notizen radieren.

« {73 Teile einer handschriftlichen Notiz vergroRern oder verkleinern,
drehen oder radieren.

< AUf zusatzliche Optionen wie das Teilen und Sperren von
Notizen, das Andern des Editorstils und das Einfligen von Inhalten
zugreifen.

3 Tippen Sie auf \/, um die Notiz zu speichern.

Notizen auf einem Foto erstellen
1 Tippen Sie auf O > QuickMemo+.

2 Tippen Sie auf (3} um ein Foto aufzunehmen, und anschlieRend auf
oK.

- Das Foto wird automatisch in den Editor eingeftgt.
3 Schreiben Sie nach Belieben Notizen auf das Foto.

A Tippen Sie auf \/, um die Notiz zu speichern.
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Notizen auf einem Screenshot erstellen

1 Ziehen Sie auf dem Bildschirm, von dem Sie einen Screenshot erstellen
mochten, die Statusleiste nach unten und tippen Sie dann auf
Capture+

« Der Screenshot erscheint als Hintergrunddesign des Editors.
Memotools werden oben auf dem Bildschirm angezeigt.

7 Machen Sie Notizen auf dem aufgenommenen Bildschirm.

+ Tippen Sie zum Zuschneiden und Speichern eines Teils des
Bildschirms auf[,]und legen Sie mit dem Zuschneidetool einen
Ausschnitt fest.

+ Um dem Editor einen Screenshot hinzuzufiigen, tippen Sie auf .

3 Tippen Sie auf \/ und speichern Sie die Notizen am gewiinschten
Ort.

- Gespeicherte Notizen kdnnen entweder tber QuickMemo+ oder
Galerie angezeigt werden.

+ Um Notizen immer am selben Ort zu speichern, aktivieren Sie das
Kontrollkastchen StandardmaRig fiir diese Aktion verwenden
und wahlen Sie eine App aus.

Ordner verwalten
Sie konnen Notizen nach ihrer Art gruppiert anzeigen.
1 Tippen Sie auf O > QuickMemo+.

2 Tippen Sie oben auf dem Bildschirm auf == und wahlen Sie eines der
folgenden Menielemente aus:

- Alle Notizen: Alle in QuickMemo+ gespeicherten Notizen
anzeigen.

+ Meine Notizen: Mit QuickMemo+ erstellte Notizen anzeigen.
- Foto-Notiz: Mit [O] erstellte Notizen anzeigen.

- Capture+: Mit Capture+ erstellte Notizen anzeigen.

- Papierkorb: Geloschte Notizen anzeigen.

- Neue Kategorie: Kategorien hinzuftgen.

. Kategorien neu anordnen, hinzuftigen oder loschen. Tippen Sie
zum Andern des Namens einer Kategorie auf die entsprechende
Kategorie.
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- Einige Ordner werden beim erstmaligen Starten von QuickMemo+ nicht
angezeigt. Deaktivierte Ordner werden aktiviert und angezeigt, wenn sie
mindestens eine relevante Notiz enthalten.

QSlide

Mit QSlide konnen Sie Apps starten, wahrend andere Apps ausgefiihrt
werden. Sie kdnnen beispielsweise den Rechner oder Kalender verwenden,
wahrend ein Video wiedergegeben wird.

Wenn eine App ausgefihrt wird, tippen Sie auf = > QSlide.

E « Diese Funktion wird von einigen Apps mdglicherweise nicht unterstttzt.

- I 1:QSlide-Modus deaktivieren, um in den Vollbildschirmmodus zu
wechseln.

=) :Deckkraft des QSlide-Fensters anpassen. Ist das QSlide-Fenster
transparent, reagiert es nicht auf Touch-Eingaben.

- X :QSlide-Fenster schlieRen.
+ A :GroRe des QSlide-Fensters anpassen.
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LG Health
Ubersicht: LG Health

Sie konnen lhren Gesundheitszustand iberwachen und sich gute
Trainingsgewohnheiten aneignen, indem Sie lhre korperlichen Aktivitaten
erfassen.

Erste Schritte mit LG Health

Sie konnen LG Health konfigurieren, wenn Sie die App erstmals starten
oder nachdem Sie sie gedffnet haben.

1 Tippen Sie auf O > LG Health.
2 Befolgen Sie die Anweisungen auf dem Bildschirm, um die
Konfiguration durchzufthren.

LG Health verwenden

Sie kdnnen wichtige Informationen in LG Health abrufen und den
Umfang der korperlichen Aktivitaten und die Gesundheitsinformationen
verwalten.

1 Tippen Sie auf O > LG Health.
7 Es stehen die folgenden Optionen zur Verfligung:

- =2
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- = :Trainingsprotokoll firr den gewiinschten Tag anzeigen.

- Q :Korperliche Aktivitat erfassen. Die Route und der Umfang lhrer
korperlichen Aktivitaten fur jede Art von absolviertem Training
werden aufgezeichnet.

-+ :Tagliche Trainingsziele einschlieRlich Kalorien und Schritte oder
verschiedene Einstellungen fir LG Health festlegen.

E - Uber LG Health bereitgestellte Gesundheitsinformationen dienen dem
Benutzerkomfort und kdnnen nicht zur Verhiitung, Behandlung und
Diagnose von Krankheiten oder sonstigen medizinischen Problemen
genutzt werden.

+ LG Health kann je nach Land und Netzanbieter variieren oder ist
moglicherweise nicht verftigbar. Die verfligbaren LG Health-Funktionen
und die Apps, die LG Health hinzugeftgt werden konnen, kénnen je
nach Land variieren. Dies liegt an unterschiedlichen Gesetzen und
Vorschriften.

Nicht storen

Sie kdnnen Benachrichtigungen fir einen bestimmten Zeitraum
einschranken oder ausschalten, um Stérungen zu vermeiden.

1 Tippen Sie auf O > Einstellungen > Téne & Benachrichtigungen >
Nicht stéren und ziehen Sie dann (3 nach rechts, um die Funktion
zu aktivieren.

2 Tippen Sie auf Téne und Vibrationen und wahlen Sie den
gewiinschten Modus aus:

Nur mit Prioritdt: Erhalten Sie akustische oder

Vibrationsbenachrichtigungen fur die ausgewahlten Apps. Auch wenn

Nur mit Prioritat aktiviert ist, ertont dennoch ein Alarm.

Véllig lautlos: Téne und Vibration deaktivieren.
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Kontakt-Klingelton

Sie konnen festlegen, dass das Gerdt einen automatisch erstellten Klingelton
wiedergibt, wenn ein Anruf von den ausgewahlten Kontakten eingeht. Diese
Funktion ist nutzlich, da Sie so beim Horen des Klingeltons direkt wissen, wer
Sie anruft.

1 Tippen Sie auf O > Einstellungen > Téne & Benachrichtigungen >
Kontakt-Klingelton und ziehen Sie dann (J# nach rechts, um die
Funktion zu aktivieren.

2 Tippen Sie auf Klingelténe komponieren fiir und wahlen Sie die
gewlnschte Option aus.

E + Der Standardklingelton wird bei eingehenden Anrufen von allen
Kontakten mit Ausnahme des ausgewahlten Kontakts wiedergegeben.

Fingerabdruckerkennung

Ubersicht: Fingerabdruckerkennung
Registrieren Sie zuerst lhren Fingerabdruck auf dem Gerat, bevor Sie die
Fingerabdruckerkennungsfunktion verwenden.
Sie konnen die Fingerabdruckerkennungsfunktion in den folgenden Fallen
verwenden:

+ Zum Entsperren des Bildschirms

+ Zum Anzeigen der gesperrten Inhalte in der Galerie oder in

QuickMemo+

Wenn Sie einen Kauf bestatigen oder sich fir eine App anmelden, kdnnen
Sie sich selbst identifizieren, indem Sie einfach den Fingerabdrucksensor
berthren.
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E « Ihr Fingerabdruck andert sich wahrend Ihres Lebens nicht und jeder
Fingerabdruck ist einzigartig. Aus diesem Grund kann |hr Fingerabdruck
durch das Gerat zur Benutzeridentifizierung genutzt werden. Sehr
ahnliche Fingerabdriicke von unterschiedlichen Benutzern werden
unter Umstanden vom Fingerabdrucksensor als derselbe Fingerabdruck
erkannt. Um die Geratesicherheit zu erhohen, legen Sie fir die
Bildschirmsperre ein Muster, eine PIN oder ein Passwort fest.

+ Wenn Ihr Fingerabdruck nicht erkannt wird oder Sie die Sicherungs-
PIN vergessen haben, bringen Sie Ihr Gerat zum nachsten LG
Servicezentrum. Registrieren Sie auRerdem einen Fingerabdruck und
erstellen Sie eine neue Sicherungs-PIN.

Vorkehrungen fiir die Fingerabdruckerkennung

Die Genauigkeit der Fingerabdruckerkennung kann sich verringern. Um
eine maoglichst genaue Erkennung zu gewahrleisten, sollten Sie vor
Verwendung des Gerats die folgenden Anweisungen befolgen.

- Die Ein-/Aus-/Sperrtaste des Gerats verflgt Uber einen
Fingerabdrucksensor. Stellen Sie sicher, dass die Ein-/Aus-/Sperrtaste
nicht durch einen Metallgegenstand wie eine Minze oder einen
Schlissel beschadigt wird.

+ Wenn sich Wasser, Staub oder ein sonstiger Fremdstoff auf der
Ein-/Aus-/Sperrtaste oder an Inrem Finger befinden, funktioniert
die Fingerabdruckregistrierung oder -erkennung moglicherweise
nicht. Sdubern und trocknen Sie lhren Finger, bevor Sie die
Fingerabdruckerkennung verwenden.

Ein Fingerabdruck wird méglicherweise nicht richtig erkannt, wenn
Ihre Fingeroberflache einen Riss aufweist oder uneben ist, weil sie von
Wasser aufgeweicht wurde.
- Wenn Sie den Finger krimmen oder nur die Fingerkuppe verwenden,
wird der Fingerabdruck maéglicherweise nicht erkannt. Achten
Sie darauf, dass Ihr Finger die gesamte Oberflache der Ein-/Aus-/
Sperrtaste berthrt.
+ Scannen Sie pro Registrierung nur einen Finger. WWenn Sie mehr als
einen Finger scannen, kann dies die Fingerabdruckregistrierung und
-erkennung beeintrachtigen.
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Bei trockener Umgebungsluft erzeugt das Gerat moglicherweise
statische Elektrizitat. Scannen Sie bei trockener Umgebungsluft
keine Fingerabdrucke. Bertihren Sie alternativ vor dem Scannen von
Fingerabdricken einen Metallgegenstand wie eine Miinze oder einen
Schlissel, um statische Elektrizitat abzuleiten.

Fingerabdriicke registrieren
Sie konnen lhren Fingerabdruck im Gerat registrieren und speichern, um
die Fingerabdruckidentifizierung zu verwenden.

1 Tippen Sie auf O > Einstellungen > Allgemein > Fingerabdriicke &
Sicherheit > Fingerabdriicke.

E - Stellen Sie zur Verwendung dieser Funktion sicher; dass die
Bildschirmsperre aktiviert ist. Ist dies nicht der Fall, aktivieren Sie
sie. Weitere Informationen finden Sie unter Einstellungen fiir die
Bildschirmsperre konfigurieren.

2 Berthren Sie mit dem Finger leicht die Ein-/Aus-/Sperrtaste auf der
Riickseite des Gerats, um den Fingerabdruck zu registrieren.

E « Driucken Sie leicht die Ein-/Aus-/Sperrtaste, damit der Fingerabdruck
vom Sensor erkannt werden kann. \Wenn Sie die Ein-/Aus-/Sperrtaste
mit UbermaRiger Kraft driicken, kann die Bildschirmsperrfunktion
aktiviert oder der Bildschirm ausgeschaltet werden.

+ Achten Sie darauf, dass |hr Finger die gesamte Oberflache der Ein-/
Aus-/Sperrtaste berdhrt.
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3 Folgen Sie den Anweisungen auf dem Bildschirm.

- Wiederholen Sie den Scanvorgang des Fingerabdrucks, indem
Sie Ihren Finger nach und nach bewegen, bis der Fingerabdruck
registriert ist.

4 Tippen Sie nach der Registrierung des Fingerabdrucks auf OK.

- Tippen Sie auf WEITERE HINZUFUGEN, um einen weiteren
Fingerabdruck zu registrieren. Wenn Sie nur einen Fingerabdruck
registrieren und sich der entsprechende Finger in keinem guten
Zustand befindet, funktioniert die Fingerabdruckerkennung
maglicherweise nicht gut. Registrieren Sie daher mehrere
Fingerabdricke, um dieser Problematik vorzubeugen.

Fingerabdriicke verwalten
Sie konnen registrierte Fingerabdriicke bearbeiten oder l6schen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Fingerabdriicke &
Sicherheit > Fingerabdriicke.
2 Nutzen Sie zum Entsperren die festgelegte Sperrmethode.

3 Tippen Sie in der Liste der Fingerabdrticke auf einen Fingerabdruck,
um ihn umzubenennen. Tippen Sie zum Ldschen des Fingerabdrucks
auf [ir]

Bildschirm mit einem Fingerabdruck entsperren
Sie kdnnen den Bildschirm mit Ihrem Fingerabdruck entsperren oder die
gesperrten Inhalte anzeigen. So aktivieren Sie die gewtinschte Funktion:

1 Tippen Sie auf O > Einstellungen > Allgemein > Fingerabdriicke &
Sicherheit > Fingerabdriicke.

2 Nutzen Sie zum Entsperren die festgelegte Sperrmethode.

3 Aktivieren Sie auf dem Bildschirm mit den Fingerabdruckeinstellungen
die gewlnschte Funktion:
- Bildschirmsperre: Bildschirm mit einem Fingerabdruck entsperren.

- Inhaltssperre: Inhalte mit einem Fingerabdruck entsperren. Stellen
Sie hierzu sicher, dass die Inhaltssperre aktiviert ist.
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Inhalte teilen

Inhalte lber ein anderes Gerat wiedergeben

Sie konnen auf dem Gerat gespeicherte Fotos, Videos oder Musiktitel auf

einem Fernsehgerat wiedergeben.

1 Verbinden Sie das Fernsehgerat und Ihr Gerat mit demselben WLAN-
Netzwerk.

2 Tippen Sie wahrend der Anzeige von Elementen aus der App Galerie
oder Musik auf &) oder : > Speielen Sie es auf einem anderen
Gerat ab und wahlen Sie dann ein Fernsehgerat aus, mit dem Sie eine
Verbindung herstellen méchten.

E + Um Chromecast verwenden zu konnen, aktualisieren Sie Google Play
auf die aktuellste Version.

Inhalte von Geraten in der Nahe anzeigen

Mithilfe der Apps Galerie oder Musik konnen Sie auf verschiedenen
Geraten wie einem Computer, einem NAS oder einem Mobilgerat
gespeicherte Inhalte anzeigen.

Gerate verbinden

Verbinden Sie Ihr Gerat und das andere Gerat, das die DLNA-Funktion
unterstiitzt, mit demselben drahtlosen Netzwerk.

5 « Stellen Sie sicher, dass die Funktion zum Teilen von Dateien (DLNA)
sowohl auf Ihrem Gerat als auch auf dem verbundenen Gerat aktiviert
ist.

Nach Geréten in der Nahe suchen

Sie konnen eine Liste der mit demselben Netzwerk verbundenen DLNA-
Gerate anzeigen. Wahlen Sie dazu in der jeweiligen App die Registerkarte
Gerate in der Umgebung aus.

Sie konnen auf Geraten in der Nahe gespeicherte Inhalte so nutzen, als
wurden Sie sie auf lhrem eigenen Gerat verwenden.
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Dateien senden oder empfangen

Sie konnen auf lhrem Gerat gespeicherte Dateien mit einem anderen LG
Gerat oder einem Tablet oder Computer teilen.

Dateien senden

Tippen Sie in der App Galerie, Dateimanager oder Musik auf : > Teilen
oder auf das & und wahlen Sie dann ein Gerat aus der Liste zum Teilen
von Dateien aus.

Dateien empfangen

Ziehen Sie die Statusleiste nach unten und aktivieren Sie dann die
Funktion zum Dateiaustausch.

Falls Ihr Gerat die Funktion zum Teilen von Dateien nicht unterstiitzt,
tippen Sie auf O > Einstellungen > Netzwerke > Teilen & Verbinden >
Dateiaustausch > SmartShare Beam.

Dateien an einen Computer senden
Sie konnen groRe Dateien schnell an lhren Computer senden.
1 Installieren Sie LG Bridge auf Inrem Computer.

2 Starten Sie LG Bridge auf dem Computer und melden Sie sich dann
mit lhrem LG Konto an.

3 Tippen Sie auf O > Einstellungen > Netzwerke > Teilen & Verbinden
> LG AirDrive und melden Sie sich anschlieRend mit Ihrem LG Konto
an.

E + Sie konnen LG Bridge von der Website von LG Mobile herunterladen
(wwwilg.com).
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Inhalte aus Ihrer Cloud anzeigen

Sie konnen die in lhrem Cloud-Konto gespeicherten Inhalte direkt
anzeigen, ohne sie auf das Gerat herunterzuladen.

1 Wahlen Sie in der App Galerie, Musik oder Dateimanager =>
Cloud-Dienste aus.

7 Wahlen Sie ein Cloud-Konto aus und melden Sie sich an.

3 Speichern Sie Inhalte in Ihrer Cloud oder geben Sie in der Cloud
gespeicherte Inhalte wieder.

Dual Play

Sie konnen lhren Geratebildschirm auf einem drahtlos verbundenen
Anzeigegerat anzeigen und verschiedene Apps gleichzeitig auf lhrem
Gerat verwenden.

Stellen Sie die Verbindung per Bildschirmfreigabe her.

E + Diese Funktion ist fir einige Inhalte nicht verfiigbar.
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Grundlegende
Funktionen



Geratekomponenten und Zubehor

Vergewissern Sie sich, dass keiner der folgenden Artikel fehlt:

- Gerat -+ USB-Kabel
- Batterie « Ladegerat
- Auswurfstift - Schnellstarthandbuch

- Stereo-Headset

A - Die oben beschriebenen Komponenten sind méglicherweise optional.

« Die im Lieferumfang des Gerats enthaltenen Komponenten und
jegliches verfligbares Zubehdr kdnnen je nach Gebiet oder Netzanbieter
unterschiedlich sein.

« Verwenden Sie ausschlieRlich Originalzubehor von LG Electronics. Das
Verwenden von Zubehor von anderen Herstellern kann die Anrufleistung
Ihres Gerats beeintrachtigen oder Fehlfunktionen verursachen. Dies wird
maglicherweise nicht durch den Reparaturservice von LG abgedeckt.

E - Sollte eine dieser Grundkomponenten fehlen, wenden Sie sich an den
Handler, bei dem Sie das Gerat gekauft haben.

« Wenn Sie zusatzliche Grundkomponenten kaufen mochten, wenden Sie
sich an das LG Servicezentrum.

« Wenn Sie optionale Komponenten kaufen mochten, kontaktieren Sie
das LG Servicezentrum, um eine Handlerliste zu erhalten.

- Einige im Lieferumfang des Gerats enthaltene Komponenten kénnen
sich ohne vorherige Ankiindigung andern.

- Das Aussehen und die Spezifikationen Ihres Gerats kénnen sich ohne
vorherige Ankiindigung andern.
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Ubersicht: Teile
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+ Naherungs-/Umgebungslichtsensor

- Naherungssensor: Der Naherungssensor schaltet bei einem Anruf
den Bildschirm aus und deaktiviert die Touch-Funktionalitat,
wenn sich das Gerat nahe am menschlichen Korper befindet. Der
Bildschirm wird wieder eingeschaltet und die Touch-Funktionalitat
wieder aktiviert, wenn sich das Gerat auRerhalb eines bestimmten
Bereichs befindet.

- Umgebungslichtsensor. Der Umgebungslichtsensor analysiert die
Umgebungslichtintensitat, wenn der Modus fir die automatische
Helligkeitssteuerung aktiviert ist.

- Automatischer Fokus per Lasererkennung

- Ermittelt zum automatischen Fokussieren den Abstand der Kamera
zum Motiv.

- Fokussiert schnell Motive in der Nahe oder Ferne, wenn Sie mit der
hinteren Kamera Fotos aufnehmen.

- Lautstarketasten

- Sie kénnen die Lautstarke fir Klingeltone, Anrufe oder
Benachrichtigungen anpassen.

- Drucken Sie leicht eine Lautstarketaste, um ein Foto aufzunehmen.
Um Fotos in Serie aufzunehmen, bertihren und halten Sie die
Lautstarketaste.

- Driicken Sie zweimal die Taste , Lautstarke verringern” (-), um
die App Kamera zu starten, wenn der Bildschirm gesperrt oder
ausgeschaltet ist. Driicken Sie zweimal die Taste ,Lautstarke
erhéhen” (+), um Capture+ zu starten.

« Ein-/Aus-/Sperrtaste (Fingerabdrucksensor)

- Drticken Sie die Taste kurz, um den Bildschirm ein- oder
auszuschalten.

- Berthren und halten Sie die Taste, wenn Sie eine Option der Ein-/
Aus-/Sperrtaste auswahlen mochten.

- Berthren Sie mit Ihrem Finger leicht die Taste, wenn Sie den
Bildschirm mit Ihrem Fingerabdruck entsperren mochten.
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E « Der Zugriff auf einige Funktionen kann je nach Geratespezifikationen
eingeschrankt sein.

« Auf der Riickseite des Gerats ist eine NFC-Antenne integriert.
Beschadigen Sie die NFC-Antenne nicht.

- Legen Sie keine schweren Gegenstande auf das Gerat und setzen
Sie sich nicht darauf. Anderenfalls kann die Touchscreen-Funktion
beschadigt werden.

- Eine Bildschirmschutzfolie und Zubehor kénnen den Naherungssensor
beeintrachtigen.

- Wenn das Gerat nass ist oder an einem feuchten Ort verwendet wird,
funktionieren der Bertihrungssensor oder die Tasten moglicherweise
nicht richtig.

Ein- oder Ausschalten

Einschalten

Wenn das Gerat ausgeschaltet ist, bertihren und halten Sie die Ein-/Aus-/
Sperrtaste.

- Beim ersten Einschalten des Gerats wird die Erstkonfiguration
durchgefihrt. Der erste Start des Smartphones kann langer als
gewohnlich dauern.

Ausschalten

Berlhren und halten Sie die Ein-/Aus-/Sperrtaste und wahlen Sie
anschlieRend Ausschalten.

Optionen der Ein-/Aus-/Sperrtaste

Berthren und halten Sie die Ein-/Aus-/Sperrtaste und wahlen Sie dann
eine Option aus.
+ Ausschalten: Gerat ausschalten.

- Ausschalten und neu starten: Gerat neu starten.
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+ Flugmodus einschalten: Telekommunikationsbezogene Funktionen
wie Anrufe, Versand und Empfang von Nachrichten und Surfen im
Internet blockieren. Die anderen Funktionen bleiben verfiigbar.

SIM-Karte einlegen

Verwenden Sie die von Ihrem Netzanbieter bereitgestellte SIM-Karte
(Subscriber Identity Module) bestimmungsgemaR.

1 Stecken Sie den Auswurfstift in das Loch im Kartentrager.

7 Ziehen Sie den Kartentrager heraus.
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3 Legen Sie die SIM-Karte mit den goldfarbenen Kontakten nach unten
auf den Kartentrager.

VorsichtsmaRnahmen bei Verwendung einer SIM-Karte
Verlieren Sie lhre SIM-Karte nicht. LG ist nicht fir durch den Verlust
oder die Fremdnutzung der SIM-Karte entstandene Schaden und
sonstige Probleme verantwortlich.

- Achten Sie darauf, die SIM-Karte beim Einsetzen oder Entfernen nicht
zu beschadigen.

E « Das Gerat kann nur mit Nano-SIM-Karten verwendet werden.

+ Fur eine fehlerfreie Leistung sollte das Telefon mit dem richtigen SIM-
Kartentyp verwendet werden. Verwenden Sie ausschlieRlich industriell
hergestellte SIM-Karten des Betreibers.

Grundlegende Funktionen 41



Speicherkarte einlegen

Das Gerat unterstitzt eine microSD-Karte mit bis zu 2 TB. Je nach
Hersteller und Typ der Speicherkarte sind moglicherweise einige
Speicherkarten nicht mit dem Gerat kompatibel.

A + Bestimmte Speicherkarten sind moglicherweise nicht vollstandig
kompatibel mit dem Gerdt. Wenn Sie eine nicht kompatible Karte
verwenden, kann das Gerat oder die Speicherkarte beschadigt oder die
darauf gespeicherten Daten konnen unlesbar werden.

1 Stecken Sie den Auswurfstift in das Loch im Kartentrager.
7 Ziehen Sie den Kartentrager heraus.

3 Legen Sie die Speicherkarte mit den goldfarbenen Kontakten nach
unten auf den Kartentrager.

Speicherkarte

SIM-Karte

4 Schieben Sie den Kartentrager zurtck in den Einschub.
- Die Speicherkarte ist ein optionales Zubehor.

« Durch haufiges Schreiben und Léschen von Daten kann die Lebensdauer
von Speicherkarten verkirzt werden.
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Speicherkarte entnehmen

Werfen Sie die Speicherkarte vor dem Entfernen aus Sicherheitsgriinden
aus.

1 Tippen Sie auf O > Einstellungen > Allgemein > Speicherplatz &
USB>A.

2 Stecken Sie den Auswurfstift in das Loch im Kartentrager.

3 Ziehen Sie den Kartentrager heraus und entfernen Sie die
Speicherkarte.

A - Entfernen Sie die Speicherkarte nicht, wahrend das Gerat Daten
Ubertragt oder darauf zugreift. Sonst konnten Daten verloren gehen
oder unlesbar werden oder die Speicherkarte oder das Gerat kann
beschadigt werden. LG haftet nicht fur Verluste, die aus dem Missbrauch
oder der falschen Verwendung von Speicherkarten resultieren. Dazu
zahlt auch der Verlust von Daten.
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Batterie

Akku entfernen

A + Schalten Sie das Gerat vor dem Entfernen des Akkus aus. Anderenfalls
kann das Gerat beschadigt werden.

1 Drucken Sie die Modulauswurftaste, um das Modul teilweise aus dem
Gerat auszuwerfen.

j@ Modul
Modulauswurftaste JU

7 Fassen Sie das ausgeworfene Modul in der Mitte und ziehen Sie es
aus dem Gerat.
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3 Fassen Sie den Akku und das Modul mit beiden Handen und trennen
Sie sie in Richtung des Pfeils voneinander.

- Biegen Sie den Akku beim Entfernen nicht. Anderenfalls kann die
Kunststoffabdeckung am Akku beschadigt werden.

Akku einsetzen

A « Die Geratespezifikationen kénnen je nach Gebiet und Netzanbieter
variieren. \Wenn Sie zusatzliche Akkus oder kompatible optionale
Komponenten kaufen mochten, wenden Sie sich an ein LG
Servicezentrum.

« Achten Sie darauf, Originalzubehér von LG Electronics zu verwenden.
Das Verwenden von Drittanbieterzubehor kann zu Schaden am Gerat
oder zu Fehlfunktionen fihren.

T Richten Sie die angegebenen Pfeile richtig aufeinander aus und setzen
Sie den Akku in der auf dem Bild dargestellten Reihenfolge in das
Modul ein.
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7 Fassen Sie das Modul am unteren Ende wie in der Abbildung
dargestellt und schieben Sie es dann vorsichtig in das Gerat, bis es
fest eingesetzt ist.

E + Drlcken Sie beim Einsetzen des Moduls in das Gerat keinesfalls die
Modulauswurftaste.

Vorsichtsmafnahmen bei der Verwendung des
Moduls

- Achten Sie beim Einsetzen des Akkus in das Gerat darauf, dass der Akku in
das Modul eingesetzt ist. WWenn Sie den Akku ohne das Modul einsetzen,
kann das Gerat beschadigt werden.

Achten Sie beim Austauschen des Akkus ganz besonders darauf, dass keine

Fremdstoffe oder Wasser ins Gerat gelangen.

- Bewahren Sie das Gerat nicht an einem heiRen oder feuchten Ort auf, wenn
das Akkumodul entfernt wurde.

+ Stellen Sie sicher, dass das Gerateinnere nicht mit einem Metallgegenstand

oder Wasser in Kontakt kommt und nicht beschadigt wird.

\Wenn Sie das Gerat [angere Zeit ohne das Modul aufbewahren, kann sich
das Gerdt verformen oder die metallischen Kontakte kdnnen beschadigt
werden. Dies kann zu Fehlfunktionen des Gerats filhren.

« Entnehmen Sie dem Gerat das Modul niemals, ohne die Modulauswurftaste
zu dricken. Anderenfalls kann das Gerat beschadigt werden.

- Entfernen Sie das Modul niemals, wenn das Gerat verwendet wird.

+ Wenn bei Verwendung des Gerdts ein Spalt zwischen Modul und Gerat
auftritt, setzen Sie das Modul fest in das Gerat ein.
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- \Wenn Sie ein Modul einsetzen, das nicht mit lhrem Mobilfunkanbieter
kompatibel ist, beispielsweise ein Modul, das Sie bei einem anderen
Mobilfunkanbieter oder in einer Region gekauft haben, die nicht von
Ihrem Mobilfunkanbieter abgedeckt wird, funktioniert das Gerat
maglicherweise nicht normal.

+ Achten Sie beim Einsetzen oder Entfernen des Moduls darauf, Ihre
Finger nicht zu verletzen.

Achten Sie darauf, den Akku und das Modul richtig einzusetzen.

Anderenfalls funktioniert das Gerat moglicherweise nicht richtig oder
kann beschadigt werden.

- Die Nichtbeachtung der Anweisungen in diesem Benutzerhandbuch
kann zu Schaden am Gerat fihren.

Akku laden

Laden Sie vor der Verwendung des Gerats den Akku vollstandig auf.
Verbinden Sie ein Ende des Ladekabels mit dem Ladegerat und stecken
Sie das andere Ende des Kabels in den Kabelanschluss. Verbinden Sie
anschlieend das Ladegerat mit einer Steckdose.

A + Achten Sie darauf, das im Lieferumfang enthaltene USB-Kabel zu
verwenden.
+ Achten Sie darauf, von LG zugelassene Ladegerate, Akkus
und Ladekabel zu verwenden. Wenn der Akku mit einem
Drittanbieterladegerat geladen wird, kann der Akku explodieren oder
das Gerat beschadigt werden.

« Das Verwenden des Gerats wahrend des Ladens kann zu Stromschlagen
fuhren. Brechen Sie zum Verwenden des Gerats den Ladevorgang ab.
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E « Dieses Gerat wird mit eingesetztem Akku geliefert. Wenn Sie das Gerat
zum ersten Mal verwenden, Uberpriifen Sie den Akkustand und laden
Sie bei Bedarf den Akku vor der Verwendung des Gerats vollstandig auf.

- Trennen Sie das Ladegerat von der Steckdose, wenn das Gerat
vollstandig geladen ist. So wird ein unndtiger Stromverbrauch
verhindert.

- Eine andere Maglichkeit zum Laden des Akkus besteht darin, das Gerat
Uber ein USB-Kabel mit einem Desktop- oder Laptop-Computer zu
verbinden. Dies kann langer als die Ubliche Ladezeit dauern.

+ Laden Sie den Akku nicht mithilfe eines USB-Hubs, der die
Nennspannung nicht aufrechterhalten kann. Anderenfalls ist das Laden
maglicherweise nicht mdglich oder wird ungewollt abgebrochen.

Akku effizient nutzen

Die Akkulaufzeit kann sich verringern, wenn Sie gleichzeitig und tber
einen langeren Zeitraum zahlreiche Apps und Funktionen ausfthren.

Beenden Sie Hintergrundvorgange, um die Akkulaufzeit zu verlangern.

Befolgen Sie fur einen moglichst geringen Energieverbrauch des Akkus
die folgenden Tipps:
. Deaktivieren Sie die Bluetooth®- oder WLAN-Funktion, wenn Sie sie
nicht verwenden.
- Legen Sie eine moglichst kurze Zeit bis zum automatischen
Ausschalten des Bildschirms fest.

.

Verringern Sie die Bildschirmhelligkeit.

Aktivieren Sie die Bildschirmsperre, wenn das Gerat nicht verwendet
wird.

Uberpriifen Sie zum Verwenden einer heruntergeladenen App den
Akkustand.
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Touchscreen

Sie konnen sich mithilfe von Touchscreen-Gesten mit der Bedienung lhres
Gerats vertraut machen.

Tippen

Tippen Sie mit der Fingerspitze leicht auf eine App oder Option, um sie
auszuwahlen oder auszufthren.

Bertihren und Halten

Durch einige Sekunden langes Bertihren und Halten kénnen Sie eine
versteckte Funktion ausfuhren.
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Zweimal tippen

Durch schnelles zweimaliges Tippen kdnnen Sie die Ansicht auf einer
Webseite oder Karte vergroRern oder verkleinern.

Ziehen

Tippen Sie auf ein Element, etwa eine App oder ein Widget, und bewegen
Sie dann den Finger gezielt an eine andere Position. Mit dieser Geste
konnen Sie ein Element verschieben.

Wischen

Tippen Sie mit dem Finger auf den Bildschirm und fiihren Sie ohne
Unterbrechung eine schnelle Bewegung durch. Mit dieser Geste kdnnen
Sie unter anderem in einer Liste, auf einer \Webseite, durch Fotos oder
zwischen Bildschirmen scrollen.
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Finger zusammen bewegen oder auseinanderziehen
Bewegen Sie zwei Finger zusammen, um die Ansicht zu verkleinern,
beispielsweise auf einem Foto oder einer Karte. Ziehen Sie zum
VergrolRern der Ansicht lhre Finger auseinander.

A - Setzen Sie den Touchscreen keinen tibermaRigen StoRen aus.
Anderenfalls kénnte der Beriihrungssensor beschadigt werden.

E - Eskann zu Fehlfunktionen des Touchscreens kommen, wenn Sie das
Gerat in der Nahe von magnetischen, metallischen oder leitenden
Materialien verwenden.

+ Wenn Sie das Gerdt bei hellen Lichtverhaltnissen wie beispielsweise
direkter Sonneneinstrahlung verwenden, ist der Bildschirm je nach lhrer
Position moglicherweise nicht sichtbar. Verwenden Sie das Gerat an
einem schattigen Standort oder einem Standort mit Umgebungslicht,
das nicht zu hell, aber hell genug zum Lesen von Biichern ist.

« Dricken Sie nicht mit ibermaRiger Kraft auf den Bildschirm.
- Tippen Sie mit der Fingerspitze leicht auf die gewiinschte Option.

« Die Touch-Steuerung funktioniert moglicherweise nicht richtig, wenn
Sie mit einem Handschuh oder der Spitze Ilhres Fingernagels auf den
Bildschirm tippen.

« Die Touch-Steuerung funktioniert moglicherweise nicht richtig, wenn
der Bildschirm feucht oder nass ist.

« Der Touchscreen funktioniert méglicherweise nicht richtig, wenn
das Gerat mit einer Bildschirmschutzfolie oder Zubehdr aus einem
herkdmmlichen Onlineshop oder einem Ladengeschaft ausgestattet ist.
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Startbildschirm

Ubersicht: Startbildschirm

Uber den Startbildschirm haben Sie Zugriff auf verschiedene Funktionen
und Apps auf Ihrem Gerat. Tippen Sie auf einem beliebigen Bildschirm auf
O, um direkt zum Startbildschirm zuriickzukehren.

Sie konnen alle Apps und Widgets auf dem Startbildschirm verwalten.
Wischen Sie den Bildschirm nach links oder rechts, um alle installierten
Apps auf einen Blick anzuzeigen.

Verwenden Sie zur Suche nach einer App die Google-Suche.

Layout des Startbildschirms

Sie konnen alle Apps anzeigen und die Widgets und Ordner auf dem
Startbildschirm organisieren.

Statusleiste — [ HI T

= Seitensymbol
-— Schnellzugriffsbereich
Schaltflachen auf dem — < O |

Startbildschirm

E « Der Startbildschirm kann je nach Netzanbieter und Softwareversion
unterschiedlich sein.

- Statusleiste:In der Statusleiste kdnnen Sie Statussymbole, die Uhrzeit
und den Akkustand anzeigen.

+ Widget: Sie kénnen dem Startbildschirm Widgets hinzufigen, um
schnell auf erforderliche Informationen zuzugreifen, ohne die einzelnen
Apps ausfihren zu missen.
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+ Ordner: Sie kénnen Ordner erstellen, um Apps nach Ihren Winschen zu
gruppieren.
+ Seitensymbol: Sie kénnen die Gesamtanzahl der Startbildschirmseiten und
die aktuell gedffnete Seite (hervorgehoben) anzeigen.
+ Schnellzugriffsbereich: Sie kdnnen wichtige Apps am unteren
Bildschirmrand fixieren, um von einer beliebigen Startbildschirmseite
darauf zuzugreifen.
+ Schaltflachen auf dem Startbildschirm
- <: Zum vorherigen Bildschirm zurtickkehren. Tastenfeld oder Pop-up-
Fenster schlieRen.

- O :Tippen, um zum Startbildschirm zurtickzukehren. Berthren und
halten Sie zum Starten von Google dieses Symbol.

- [:Liste der zuletzt verwendeten Apps anzeigen oder App aus der
Liste ausfiihren. Verwenden Sie die Option Alles l6schen, um alle
zuletzt verwendeten Apps zu l6schen. In einigen Apps konnen Sie durch
Berthren und Halten der Schaltflache auf zusatzliche Optionen zugreifen.

Schaltflachen auf dem Startbildschirm bearbeiten

Sie konnen die Schaltflachen auf dem Startbildschirm neu anordnen oder

haufig verwendete Funktionen als Schaltflachen auf dem Startbildschirm

hinzuftigen.

Tippen Sie auf(Q) > Einstellungen > Anzeige > Bedienungsleiste >

Tastenkombination und passen Sie die Einstellungen an.

+ Es stehen verschiedene Funktionen wie ,QSlide} das

Benachrichtigungsfeld und ,Capture+" zur Verfligung. Es kdnnen bis
zu funf Elemente hinzugeftigt werden.
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Statussymbole

\Wenn eine Benachrichtigung tber eine ungelesene Nachricht, ein
Kalenderereignis oder einen Alarm angezeigt wird, erscheint in der
Statusleiste das entsprechende Benachrichtigungssymbol. Mithilfe der in
der Statusleiste angezeigten Benachrichtigungssymbole kdnnen Sie den
Status lhres Gerats Uberprifen.

+ 7l :Kein Signal

: Daten werden Uber das Netzwerk Ubertragen

© :Alarm eingestellt

a[Jn : Vibrationsmodus aktiviert
€ :Bluetooth aktiviert

1 : Uber USB mit einem Computer verbunden
- Il : Akkustand

- 4~ :Flugmodus aktiviert

+ X :Verpasste Anrufe

- @ :WLAN aktiviert

N : Stummschaltung aktiviert
@ : GPS aktiviert

(49 :Hotspot aktiviert

- B SIM-Karte fehlt

.

E + Je nach Geratestatus werden einige dieser Symbole méglicherweise
anders dargestellt oder Uberhaupt nicht angezeigt. Achten Sie auf die
Symbole der Umgebung, in der Sie das Gerat verwenden.

+ Die angezeigten Symbole kdnnen je nach Region oder Netzanbieter
unterschiedlich sein.
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Benachrichtigungsfeld
Sie konnen das Benachrichtigungsfeld 6ffnen, indem Sie die Statusleiste
nach unten ziehen.
Mithilfe von Schnellzugriffssymbolen im Benachrichtigungsfeld kénnen
Sie ganz leicht und schnell eine Funktion aktivieren oder deaktivieren.
Ziehen Sie in der Liste der Schnellzugriffssymbole nach links oder rechts,
bis das gewiinschte Funktionssymbol ausgewahlt werden kann.

+ Wenn Sie das Symbol bertihren und halten, wird der Bildschirm mit

den Einstellungen fur die entsprechende Funktion angezeigt.

,— Auf die App Einstellungen
zugreifen.

.
09:00 Z @& @e3— Benutzer auswahlen.
Schnellzugriffssymbole —sf & < () B )
anzeigen. - - —
g 2
Gerat zum Teilen des —r— =1 Helligkeit einstellen.
Telefonbildschirms T b 00—
auswahlen. © = ————1— Empfang von Dateien, die
von Geraten in der Nahe

gesendet werden, erlauben.
- Benachrichtigungen

anzeigen. .
l6schen.

Benachrichtigungsfeldeinstellungen

Sie konnen Elemente auswahlen, die im Benachrichtigungsfeld angezeigt

werden sollen.

Tippen Sie im Benachrichtigungsfeld auf /.
+ Berlihren und halten Sie zum Neuanordnen der
Schnellzugriffssymbole ein Symbol und ziehen Sie es dann an eine
andere Position.

+ Wahlen Sie die Symbole aus, die in der Liste erscheinen sollen.

5 - Die verfiigbaren Menielemente konnen je nach Gebiet oder
Netzanbieter unterschiedlich sein.
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Bildschirmausrichtung wechseln

Sie konnen festlegen, dass die Bildschirmausrichtung je nach
Gerateausrichtung automatisch wechselt.

Tippen Sie im Benachrichtigungsfeld in der Liste der
Schnellzugriffssymbole auf Drehung.

Tippen Sie alternativ auf Q) > Einstellungen > Anzeige und aktivieren Sie
Automatisch drehen.

Startbildschirm bearbeiten

Beriihren und halten Sie eine freie Stelle auf dem Startbildschirm und
starten Sie dann die gewlnschte Funktion.

- Wenn Sie die Startbildschirmseiten neu anordnen maochten, bertihren
und halten Sie eine Seite und ziehen Sie sie dann an eine andere
Position.

- Tippen Sie zum Hinzufligen von Widgets zum Startbildschirm auf
Widgets und ziehen Sie ein Widget auf den Startbildschirm.

- Tippen Sie zum Andern der Startbildschirmeinstellungen auf
Homescreen Einstellungen und passen Sie die Optionen an. Weitere
Informationen finden Sie unter Startbildschirmeinstellungen.

- Tippen Sie auf Deinstallierte Apps, um deinstallierte Apps anzuzeigen
oder erneut zu installieren. Weitere Informationen finden Sie unter
Deinstallierte Apps.
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Hintergrunddesign anzeigen

Sie kénnen nur das Hintergrundbild anzeigen, indem Sie Apps und

Widgets auf dem Startbildschirm ausblenden.

Ziehen Sie zwei Finger auseinander, wahrend Sie den Startbildschirm

berihren.

- Bewegen Sie |hre Finger auf dem Startbildschirm zusammen, um
zum urspriinglichen Bildschirm mit angezeigten Apps und Widgets
zuriickzukehren. Sie kénnen auch auf <] tippen.

Nach Apps auf dem Startbildschirm suchen

Sie kdnnen ganz einfach nach auf dem Startbildschirm installierten Apps
suchen, indem Sie den Namen der gewtinschten App im Google-Widget
eingeben.

Die Liste der installierten Apps erscheint auf dem Google-Suchbildschirm.

Apps auf dem Startbildschirm verschieben

Beriihren und halten Sie auf dem Startbildschirm eine App und ziehen Sie
sie dann an eine andere Position.

+ Um haufig verwendete Apps dauerhaft unten auf dem Startbildschirm
zu positionieren, bertihren und halten Sie eine App und ziehen Sie sie
dann unten in den Schnellzugriffsbereich.

+ Um ein Symbol aus dem Schnellzugriffsbereich zu entfernen, ziehen
Sie das entsprechende Symbol auf den Startbildschirm.
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Ordner auf dem Startbildschirm verwenden

Ordner erstellen
Beriihren und halten Sie auf dem Startbildschirm eine App und ziehen Sie
sie dann Uber eine andere App.

+ Es wird ein neuer Ordner erstellt und die Apps werden dem Ordner
hinzugefugt.

Ordner bearbeiten
Tippen Sie auf dem Startbildschirm auf einen Ordner und fihren Sie dann
die gewlnschte Funktion aus.
- Tippen Sie auf einen Ordnernamen, um den Namen und die Farbe des
Ordners zu bearbeiten.
+ Berthren und halten Sie zum Entfernen einer App aus dem Ordner
die entsprechende App und ziehen Sie sie aus dem Ordner. \Wenn
die installierte App die einzige App im Ordner ist, wird der Ordner
automatisch entfernt.

Startbildschirmeinstellungen
Sie konnen die Startbildschirmeinstellungen anpassen.

1 Tippen Sie auf O > Einstellungen > Anzeige > Homescreen.

7 Passen Sie die Einstellungen an:
- Benutzeroberfldache wahlen: Startbildschirmmodus auswahlen.
+ Hintergrund: Hintergrunddesign des Startbildschirms andern.

- Bildschirm-Wischeffekt: Effekt auswahlen, der beim Wechsel von
Startbildschirmseiten angewendet werden soll.

+ Thema: Das anzuwendende Bildschirmdesign auswahlen.

- Apps sortieren nach:: Festlegen, wie Apps auf dem Startbildschirm
sortiert werden.

- Raster: App-Anordnungsmodus fir den Startbildschirm andern.

- Apps ausblenden: Apps auswahlen, die auf dem Startbildschirm
ausgeblendet werden sollen, oder die App-Auswahl aufheben.

- Smart Bulletin: Mit dem Startbildschirm Ihren Anforderungen
entsprechende Informationen anzeigen.
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Bildschirmsperre

Ubersicht: Bildschirmsperre

Der Bildschirm lhres Gerats wird beim Driicken der Ein-/Aus-/Sperrtaste
automatisch ausgeschaltet und gesperrt. Dies geschieht auch dann, wenn
das Gerat flr einen bestimmten Zeitraum nicht verwendet wird.

Wenn Sie die Ein-/Aus-/Sperrtaste drlicken, wenn keine Bildschirmsperre
aktiviert ist, wird sofort der Startbildschirm angezeigt.

Aktivieren Sie die Bildschirmsperre, um die Sicherheit lhres Gerats

zu gewahrleisten und den unerwiinschten Zugriff auf Ihr Gerat zu
vermeiden.

E + Durch die Bildschirmsperre werden unnétige Touch-Eingaben auf dem
Geratebildschirm verhindert und der Energieverbrauch des Akkus
reduziert. Es wird empfohlen, die Bildschirmsperre zu aktivieren, wenn
Sie das Gerat nicht verwenden.

Einstellungen fiir die Bildschirmsperre konfigurieren
Es stehen verschiedene Optionen fur die Konfiguration der Einstellungen
fur die Bildschirmsperre zur Verfigung.

1 Tippen Sie aufQ > Einstellungen > Anzeige > Sperrbildschirm >
Bildschirmsperre auswahlen und wahlen Sie dann die gewlinschte
Methode aus.

7 Passen Sie die Einstellungen zum Sperren des Bildschirms an:

- Keine: Bildschirmsperrfunktion deaktivieren.

- Ziehen: Bildschirm durch Wischen entsperren.

- Knock Code: Bildschirm entsperren, indem Sie in einem
bestimmten Muster auf die entsprechenden Stellen auf dem
Bildschirm tippen.

+ Muster: Bildschirm durch Zeichnen eines Musters entsperren.

PIN: Bildschirm durch Eingabe eines numerischen Passworts

entsperren.

.

Passwort: Bildschirm durch Eingabe eines alphanumerischen
Passworts entsperren.
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E - Um die Bildschirmsperre mittels Muster einzustellen, missen Sie
zunachst ein Google-Konto oder eine Sicherungs-PIN erstellen. \Wenn
Sie hintereinander haufiger als eine festgelegte Anzahl ein falsches
Muster eingeben, kénnen Sie den Bildschirm mit lhrer Sicherungs-PIN
oder Uber Ihr Google-Konto entsperren.

« Wenn die Bildschirmsperre mittels PIN oder Passwort aktiviert ist
und Sie haufiger als eine festgelegte Anzahl eine falsche PIN oder ein
falsches Passwort eingeben, wird die Passworteingabe fiir 30 Sekunden
gesperrt.

Einstellungen zum Sperren des Bildschirms
Sie konnen die folgenden Einstellungen fir die Bildschirmsperre
anpassen.
1 Tippen Sie auf O > Einstellungen > Anzeige > Sperrbildschirm.
7 Passen Sie die Einstellungen an:

« Bildschirmsperre auswahlen: Bildschirmsperrmethode auswahlen.

+ Smart Lock: Vertrauenswiirdige Elemente auswahlen, bei denen das
Gerat automatisch entsperrt wird.

Bildschirmiibergang: Bildschirmibergangseffekte festlegen, die
angewendet werden sollen, wenn der Bildschirm entsperrt ist. Diese
Option wird angezeigt, wenn die Bildschirmsperrmethode auf Ziehen
festgelegt ist.
+ Hintergrund: Hintergrundbild des Sperrbildschirms andern.
« Verkniipfungen: App-Schnellzugriff hinzufiigen und direkt vom
Sperrbildschirm auf die App zugreifen, indem Sie die App aus
dem groRen Kreis ziehen. Diese Option wird angezeigt, wenn die
Bildschirmsperrmethode auf Ziehen festgelegt ist.
+ Wetteranimation: \Wetteranimationen fiir den aktuellen Standort auf
dem Sperrbildschirm anzeigen.
Kontaktinfo fiir verlorenes Telefon: Kontaktinformationen fir den
Notfall auf dem Sperrbildschirm anzeigen.

- Sperr-Timer: Zeit bis zur automatischen Geratesperre festlegen.

- Ein-/Austaste sperrt sofort : Bildschirm sofort sperren, wenn die
Ein-/Aus-/Sperrtaste gedruickt wird.
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E - Die verfligbaren Einstellungen konnen je nach ausgewahlter
Bildschirmsperrmethode unterschiedlich sein.

KnockON

Sie kénnen den Bildschirm ein- oder ausschalten, indem Sie zweimal auf
den Bildschirm tippen.

Bildschirm einschalten
Tippen Sie zweimal auf die Mitte des Bildschirms.

- Wenn Sie oben oder unten auf den Bildschirm tippen, kann sich die
Erkennungsrate verringern.

Bildschirm ausschalten
Tippen Sie zweimal auf eine freie Stelle auf dem Startbildschirm.
Sie kdnnen auch zweimal auf eine freie Stelle in der Statusleiste tippen.

E « Diese Option ist nur auf dem von LG bereitgestellten Startbildschirm
verfuigbar. Bei Verwendung eines herkdmmlichen Startprogramms oder
auf dem vom Benutzer installierten Startbildschirm funktioniert sie
moglicherweise nicht richtig.

- Tippen Sie mit der Fingerspitze auf den Bildschirm, nicht mit dem
Fingernagel.

« Stellen Sie zur Verwendung der KnockOn-Funktion sicher, dass der
Annaherungs-/Lichtsensor nicht durch einen Aufkleber oder einen
sonstigen Fremdkérper verdeckt wird.
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Knock Code

Sie konnen den Bildschirm entsperren, indem Sie einen personlichen
Knock Code erstellen. Wenn der Bildschirm gesperrt ist, konnen Sie direkt
auf den Startbildschirm zugreifen, indem Sie in einer bestimmten Abfolge
auf den Bildschirm tippen.

Knock Code erstellen

1 Tippen Sie auf O > Einstellungen > Anzeige > Sperrbildschirm >
Bildschirmsperre auswahlen > Knock Code.

2 Tippen Sie in einem Muster lhrer Wahl auf die Quadrate, um einen
Knock Code zu erstellen. Tippen Sie anschlieRend auf WEITER.

3 Geben Sie den erstellten Knock Code zur Bestatigung erneut ein und
tippen Sie dann auf BESTATIGEN.

4 Legen Sie eine Sicherungs-PIN fest, die Sie verwenden konnen, falls
Sie den Knock Code vergessen.

Bildschirm mit einem Knock Code entsperren
Sie konnen den Bildschirm durch Eingabe des erstellten Knock Codes
entsperren.

Sie konnen den Knock Code auf dem Touchscreen eingeben, wenn der
Bildschirm ausgeschaltet ist.

E « Sie konnen lhren Knock Code und die KnockOn-Funktion gemeinsam
verwenden.

- Wenn Sie hintereinander haufiger als eine festgelegte Anzahl einen
falschen Knock Code eingeben, missen Sie zum Entsperren lhre
Sicherungs-PIN oder Ihr Google-Konto verwenden.

+ Achten Sie beim Tippen auf den Bildschirm darauf, Ihre Fingerspitze zu
verwenden.
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Sicheres Einschalten

Ubersicht: Sicheres Einschalten

\Wenn Sie das Gerat einschalten, ist der Bildschirm aus
Sicherheitsgriinden gesperrt. Entsperren Sie den Bildschirm mithilfe

der aktuellen Entsperrmethode. Dies kann etwa ein Knock Code, ein
Muster, ein Passwort oder eine PIN sein. Solange der Bildschirm gesperrt
ist, konnen Sie u. a. die meisten Anrufe, Textnachrichten, Alarme und
Benachrichtigungen nicht empfangen.

Vorsichtsmanahmen fiir das sichere Einschalten
- Wenn Sie das Passwort haufiger als eine festgelegte Anzahl falsch
eingeben, wird das Gerat automatisch initialisiert. Sie sollten daher das
Passwort nicht vergessen.

- Wenn Sie das Entschlisselungspasswort vergessen haben, missen
Sie das Gerat initialisieren, um es wieder verwenden zu kénnen. Durch
die Initialisierung werden alle vor der Initialisierung gespeicherten
Daten geldscht.

+ Die Verschlisselung erfolgt, wenn das Gerat nach einer
Initialisierung erstmals gestartet wird. Das vorzeitige Abbrechen
des Verschlisselungsvorgangs kann zur Beschadigung von
Daten fulhren. Beispielsweise sollten Sie den Akku wahrend des
Verschlisselungsvorgangs nicht entfernen oder einsetzen. Warten Sie,
bis die Verschlisselung abgeschlossen ist.
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Verschliisselung der Speicherkarte

Sie konnen auf der Speicherkarte gespeicherte Daten verschliisseln und
schitzen. Von anderen Geraten kann nicht auf die verschlisselten Daten
auf der Speicherkarte zugegriffen werden.

1

2

Tippen Sie auf O > Einstellungen > Allgemein > Fingerabdriicke &
Sicherheit > SD-Karte verschliisseln.

Lesen Sie die auf dem Bildschirm angezeigte Ubersicht tiber
die Speicherkartenverschlisselung und tippen Sie dann auf
FORTFAHREN, um fortzufahren.

Wahlen Sie eine Option aus und tippen Sie auf JETZT
VERSCHLUSSELN:

Neue Daten verschliisseln: Nur Daten verschlisseln, die nach der
Verschlisselung auf der Speicherkarte gespeichert werden.

Komplette Verschliisselung: Alle aktuell auf der Speicherkarte
gespeicherten Daten verschlisseln.

Mediendateien ausschlieRen : Alle Dateien aulRer Mediendateien
wie Musik, Fotos und Videos verschlisseln.

+ Stellen Sie zum Verschliisseln der Speicherkarte sicher; dass die
Bildschirmsperre mittels PIN oder Passwort aktiviert ist.

+ Nach dem Starten der Speicherkartenverschlisselung stehen einige
Funktionen nicht zur Verfiigung.

+ Wenn Sie das Gerat wahrend der Verschliisselung ausschalten, wird der
Verschlisselungsvorgang abgebrochen und es kann zu Beschadigung
einiger Daten kommen. Achten Sie deshalb vor dem Starten der
Verschliisselung darauf, dass der Akkustand ausreichend ist.

« Auf verschlisselte Dateien kann nur von dem Gerat zugegriffen werden,
auf dem die Dateien verschlisselt wurden.

- Die verschlisselte Speicherkarte kann nicht in einem anderen LG Gerat
verwendet werden. Um die verschlisselte Speicherkarte in einem
anderen Mobilgerat zu verwenden, initialisieren Sie die Karte.

- Sie konnen die Speicherkartenverschlisselung auch dann aktivieren,
wenn keine Speicherkarte in das Gerat eingelegt ist. Eine nach
der Verschlisselung eingelegte Speicherkarten wird automatisch
verschlisselt.
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Screenshots erstellen

Sie kdnnen Screenshots vom aktuell angezeigten Bildschirm erstellen.

Uber eine Tastenkombination
Berlhren und halten Sie gleichzeitig die Ein-/Aus-/Sperrtaste und die
Taste ,Lautstarke verringern” (-) fur mindestens zwei Sekunden.

+ Screenshots kénnen im Ordner Screenshots unter Galerie angezeigt
werden.

Uber Capture+

Ziehen Sie auf dem Bildschirm, von dem Sie einen Screenshot erstellen
mochten, die Statusleiste nach unten und tippen Sie dann auf Capture+.

E + Wenn der Bildschirm ausgeschaltet oder gesperrt ist, kénnen Sie durch
zweimaliges Driicken der Taste ,Lautstarke erhéhen” (+) auf Capture+
zugreifen. Tippen Sie zuerst auf (O > Einstellungen > Allgemein und
schalten Sie dann Schnellzugriff-Tasten ein.

+ Weitere Informationen finden Sie unter Notizen auf einem Screenshot
erstellen.
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Text eingeben

Smart Keyboard-Funktion verwenden

Mithilfe der Smart Keyboard-Funktion kénnen Sie Text eingeben und
bearbeiten.

\Wenn Sie die Smart Keyboard-Funktion verwenden, konnen Sie den
Text bei der Eingabe sehen, ohne zwischen dem Bildschirm und einer
herkommlichen Tastatur wechseln zu mussen. So kénnen Sie Fehler bei
der Texteingabe ganz leicht finden und korrigieren.

EI A .
w’me.

LU

Cursor verschieben

Mit der Smart Keyboard-Funktion kénnen Sie den Cursor genau an die gewiinschte
Position verschieben.

Beriihren und halten Sie bei der Texteingabe die Leertaste und ziehen

Sie dann nach links oder rechts, bis sich der Cursor an die gewtinschte
Position im Text bewegt.

<

Smart keyboard >
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E + Diese Option ist nur auf der QWERTY-Tastatur verfiigbar.

Worter vorschlagen

Bei Verwendung der Smart Keyboard-Funktion werden Ihre
Nutzungsmuster automatisch analysiert, um bei der Texteingabe haufig
verwendete Worter vorzuschlagen. Je langer Sie Ihr Gerat verwenden,
umso praziser sind die Vorschlage.

Geben Sie Text ein und tippen Sie dann auf ein vorgeschlagenes Wort
oder ziehen Sie die linke oder rechte Seite der Leertaste leicht nach oben.
+ Das ausgewahlte \Wort wird automatisch eingegeben. Sie mussen
nicht jeden einzelnen Buchstaben des Worts manuell eingeben.

Smartphone Smart Smartphones

Layout der QWERTY-Tastatur andern

Sie konnen die Tasten in der unteren Reihe der Tastatur [6schen oder neu
anordnen oder Tasten hinzuftigen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Sprache und
Tastatur > LG Tastatur > Tastaturhéhe und -Layout > QWERTZ-
Tastatur-Layout.

Sie kdnnen auch auf der Tastatur auf £ und anschlieRend auf
Tastaturhdhe und -Layout > QWERTZ-Tastatur-Layout tippen.
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2 Tippen Sie auf eine Taste in der untersten Reihe und ziehen Sie sie
dann an eine andere Position.

OOONOO000) OO0
0 fD np 0 )

E « Diese Option ist nur auf der QWERTY-, QWERTZ- und AZERTY-Tastatur
verfligbar.

+ Diese Funktion wird moglicherweise nicht in allen Sprachen untersttitzt.

Tastaturh6he anpassen

Sie kénnen die Tastaturhohe fir maximalen Komfort bei der manuellen
Texteingabe anpassen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Sprache
und Tastatur > LG Tastatur > Tastaturhdhe und -Layout >
Tastaturhohe.

Sie kénnen auch auf der Tastatur auf £# und anschlieRend auf
Tastaturhdhe und -Layout > Tastaturhohe tippen.

7 Passen Sie die Tastaturhéhe an.

Grundlegende Funktionen 68



Querformat fur die Tastatur auswahlen

Sie konnen aus mehreren Optionen ein Querformat fur die Tastatur
auswahlen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Sprache und
Tastatur > LG Tastatur > Tastaturhéhe und -Layout > Tastaturtyp
im Querformat.
Sie konnen auch auf der Tastatur auf £ und anschlieRend auf
Tastaturhdhe und -Layout > Tastaturtyp im Querformat tippen.

7 Wabhlen Sie ein Tastaturformat aus.

Tastatur teilen

Wenn der Bildschirm im Querformat angezeigt wird, kdnnen Sie die
Tastatur in der Mitte teilen und jeden Teilbereich auf einer Seite des
Bildschirms positionieren.

Tippen Sie auf O > Einstellungen > Allgemein > Sprache und Tastatur >
LG Tastatur > Tastaturhdhe und -Layout > Geteilte Tastatur.

Sie kénnen auch auf der Tastatur auf £ und anschlieRend auf
Tastaturhohe und -Layout > Geteilte Tastatur tippen.

E + Drehen Sie das Gerat ins Querformat, um die Tastatur auf beide Seiten
aufzuteilen. Bewegen Sie zum Zusammenfiihren oder Teilen der
Tastatur lhre Finger auf der Tastatur zusammen oder auseinander.
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Einhandiger Betriebsmodus

Sie konnen die Tastatur auf eine Seite des Bildschirms verschieben, um die
Tastatur mit einer Hand verwenden zu kénnen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Sprache
und Tastatur > LG Tastatur > Tastaturhdhe und -Layout >
Einhandbedienung.

Sie konnen auch auf der Tastatur auf £ und anschlieRend auf
Tastaturhohe und -Layout > Einhandbedienung tippen.

2 Tippen Sie auf den Pfeil neben der Tastatur, um die Tastatur in die
gewlnschte Richtung zu verschieben.

Text mittels Sprache eingeben

Bertihren und halten Sie auf der Tastatur das Symbol £ und wahlen Sie
dann & aus.

E « Sprechen Sie zur Optimierung der Sprachbefehlserkennung klar und

deutlich mit der richtigen Aussprache und Betonung.

« Um Text per Spracheingabe einzugeben, stellen Sie sicher, dass Ihr Gerat
mit einem Netzwerk verbunden ist.

« Um die Sprache fiir die Spracherkennung auszuwahlen, tippen Sie auf
dem Spracherkennungsbildschirm auf %> Sprachen.

- Diese Funktion wird moglicherweise nicht unterstitzt und die
unterstitzten Sprachen kénnen je nach Mobilfunknetzbereich
unterschiedlich sein.
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Tastatur andern

Sie konnen die Eingabesprache und den Tastaturtyp fir jede Sprache
andern.

1 Tippen Sie auf O > Einstellungen > Allgemein > Sprache und
Tastatur > LG Tastatur > Sprachen auswahlen.

2 Wahlen Sie eine Sprache aus und passen Sie den Tastaturtyp an.

Kopieren und Einfiigen

Sie konnen Text in einer App ausschneiden oder kopieren und den
Text dann in der gleichen App einfligen. Sie kénnen auch andere Apps
ausfuhren und den Text in diese Apps einflgen.

1 Berthren und halten Sie den Bereich rund um den Text, den Sie
kopieren oder ausschneiden mochten.

2 Ziehen Sie @ / Wy, um den zu kopierenden oder auszuschneidenden
Bereich festzulegen.

3 Wahlen Sie entweder AUSSCHNEIDEN oder KOPIEREN aus.

+ Der ausgeschnittene oder kopierte Text wird automatisch der
Zwischenablage hinzugeflgt.

4 Berthren und halten Sie das Texteingabefenster und wahlen Sie
anschlieRend EINFUGEN aus.

5 + Wenn kein Element kopiert oder ausgeschnitten wurde, wird die Option
EINFUGEN nicht angezeigt.
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ZWISCHENABLAGE

\Wenn Sie ein Bild oder Text kopieren oder ausschneiden, wird das Bild
bzw. der Text automatisch in der Zwischenablage gespeichert und kann
jederzeit an einem beliebigen Ort eingefligt werden.

1

Beruhren und halten Sie auf der Tastatur das Symbol £ und wahlen
Sie dann [ aus.

Sie kdnnen auch das Texteingabefenster bertihren und halten und
dann die Option ZWISCHENABLAGE auswahlen.

Wahlen Sie ein Element aus der Zwischenablage aus und fligen Sie

es ein.

+ Eskonnen bis zu 20 Elemente in der Zwischenablage gespeichert
werden.

- Tippen Sie auf ZL um gespeicherte Elemente zu sperren, damit sie
nicht geldscht werden, auch wenn die Hochstanzahl Uberschritten
wurde. Es konnen bis zu zehn Elemente gesperrt werden. Zum
Loschen gesperrter Elemente missen sie zundchst entsperrt
werden.

- Tippen Sie auf [ifj, um die in der Zwischenablage gespeicherten
Elemente zu 6schen.

E - Die Zwischenablage wird méglicherweise von einigen

heruntergeladenen Apps nicht unterstitzt.
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Apps installieren und deinstallieren

Apps installieren
Rufen Sie einen App Store auf, um nach Apps zu suchen und Apps
herunterzuladen.

+ Sie kdnnen SmartWorld, Play Store oder den App Store des
Netzanbieters verwenden.

5 + Einige App-Stores erfordern die Erstellung und Anmeldung mit einem
Konto.

« Einige Apps kénnen Kosten verursachen.

+ Wenn Sie eine mobile Datenverbindung verwenden, konnen je nach Tarif
Kosten fiir die Datennutzung entstehen.

+ SmartWorld wird je nach Gebiet oder Netzanbieter mdglicherweise
nicht untersttzt.

Apps deinstallieren

Sie kénnen Apps von lhrem Gerat deinstallieren, die Sie nicht mehr
verwenden mochten.

E « Einige Apps kénnen vom Benutzer nicht deinstalliert werden.

Durch Beriihren und Halten deinstallieren

Berthren und halten Sie auf dem Startbildschirm die App, die deinstalliert
werden soll, und ziehen Sie sie dann oben auf dem Bildschirm auf die
Option Deinstallieren.
+ Deinstallierte Apps kénnen innerhalb von 24 Stunden nach der
Deinstallation neu installiert werden. Weitere Informationen finden Sie
unter Deinstallierte Apps.

Mithilfe des Meniis ,Einstellungen” deinstallieren

Tippen Sie auf O > Einstellungen > Allgemein > Apps, wahlen Sie eine
App aus und tippen Sie anschlieBend auf Deinstallieren.
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Apps liber den App Store deinstallieren

Rufen Sie zum Deinstallieren einer App den App Store, Uber den Sie die
App heruntergeladen haben, auf und deinstallieren Sie sie.

Deinstallierte Apps

Sie konnen die deinstallierten Apps auf dem Startbildschirm anzeigen. Sie
konnen Apps auch innerhalb von 24 Stunden nach der Deinstallation neu
installieren.

1 Tippen Sie auf O > Deinstallierte Apps.

2 So aktivieren Sie die gewlnschte Funktion:
- Erneut installieren: Ausgewahlte App neu installieren.
- 11 : Deinstallierte Apps endgiltig vom Gerat entfernen.

E + Deinstallierte Apps werden 24 Stunden nach der Deinstallation
automatisch vom Gerat entfernt. Wenn Sie deinstallierte Apps neu
installieren mochten, missen Sie sie erneut aus dem App Store
herunterladen.

« Diese Funktion ist nur auf dem standardmaRigen Startbildschirm
aktiviert. Wenn Sie Apps bei Verwendung des EasyHome-Bildschirms
oder eines anderen Startprogramms deinstallieren, werden die Apps
sofort endgiltig vom Gerat entfernt.

Telefon

Sprachanruf

Sie konnen einen Anruf auf mehrere Arten tdtigen, beispielsweise durch
Eingabe einer Telefonnummer oder aus Ihrer Kontaktliste oder aus der
Liste der letzten Anrufe heraus.

Anruf liber das Tastenfeld tatigen
1 Tippen Sie auf O > (¥ > Wihlen.
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7 Tatigen Sie einen Anruf auf die von Ihnen gewtinschte Art:
- Geben Sie eine Telefonnummer ein und tippen Sie auf .
+ Berthren und halten Sie eine Kurzwahlnummer.

- Geben Sie den Anfangsbuchstaben des Namens eines Kontakts in
der Kontaktliste ein, um nach dem Kontakt zu suchen. Tippen Sie
dann auf @.

E + Wenn Sie einen internationalen Anruf tatigen, geben Sie ,+" ein und
bertihren und halten Sie die 0.

+ Weitere Informationen zum Hinzuftigen von Telefonnummern zur
Kurzwahlliste finden Sie unter Kontakte zur Kurzwabhlliste hinzuftigen.

Anruf aus der Kontaktliste tatigen
1 Tippen Sie auf O > (¥ > Kontakte.

2 Wahlen Sie einen Kontakt aus der Kontaktliste aus und tippen Sie auf

Q.

Anruf beantworten

Um einen Anruf entgegenzunehmen, ziehen Sie bei einem eingehenden
Anruf @ aus dem Kreis.

- Wenn das Stereo-Headset angeschlossen ist, konnen Sie Anrufe tber
die Anruf-/End-Taste am Headset tatigen.

+ Um einen Anruf durch Driicken der Ein-/Aus-/Sperrtaste zu beenden,
tippen Sie auf O > Einstellungen > Netzwerke > Anruf > Anrufe
annehmen und beenden und aktivieren Sie dann Anrufe mit der
Ein-/Aus-Taste beenden.

Anruf abweisen

Um einen eingehenden Anruf abzuweisen, ziehen Sie bei einem
eingehenden Anruf € aus dem Kreis.

+ Um eine Abweisungsnachricht zu senden, ziehen Sie die
Abweisungsnachricht aus dem Kreis.
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Um eine Abweisungsnachricht hinzuzuftigen oder zu bearbeiten,
tippen Sie auf O > Einstellungen > Netzwerke > Anruf > Anrufe
ablehnen und abweisen > Ablehnen mit Nachricht.

+ Drucken Sie bei einem eingehenden Anruf die Lautstarketaste oder die
Ein-/Aus-Taste/Sperrtaste, um den Klingelton stummzuschalten, die
Vibration auszuschalten oder den Anruf zu halten.

Entgangene Anrufe anzeigen

Bei einem entgangenen Anruf wird in der Statusleiste am oberen
Bildschirmrand & angezeigt.

Ziehen Sie die Statusleiste nach unten, um Details zu den entgangenen
Anrufen anzuzeigen. Sie konnen auch auf O > [ > Anrufliste tippen.

Verfiigbare Funktionen wahrend eines Anrufs

Wahrend eines Anrufs kénnen Sie verschiedene Funktionen nutzen,
indem Sie auf folgende Tasten auf dem Bildschirm tippen:

- Kontakte: Zeigt die Kontaktliste wahrend eines Anrufs an.

Ende: Einen Anruf beenden.

Tasten: Wahltastatur anzeigen oder verbergen.

Lautspr.: Freisprechfunktion aktivieren.

Stumm: Mikrofon ausschalten, sodass |hr Gesprachspartner Sie nicht
mehr horen kann.

Bluetooth: Schaltet den Anruf auf ein Bluetooth-Gerat um, das
gekoppelt und verbunden ist.

: :Viele weitere Anrufoptionen.

E - Die verfiigbaren Einstellungen kénnen je nach Gebiet oder Netzanbieter
unterschiedlich sein.

Drei-Teilnehmer-Anruf tatigen
Wahrend eines Anrufs konnen Sie einen anderen Kontakt anrufen.

1 Tippen Sie wahrend eines Anrufs auf : > Anruf hinzufiigen.
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2 Geben Sie eine Telefonnummer ein und tippen Sie auf .
- Die beiden Anrufbildschirme werden gleichzeitig auf dem
Bildschirm angezeigt. Der erste Anruf wird gehalten.
3 Geben Sie eine weitere Telefonnummer auf dem Bildschirm ein, um zu
einem anderen Anruf zu wechseln.
Um eine Konferenzschaltung zu beginnen, tippen Sie auf Konferenz.

E « Jeder Anruf kann Kosten verursachen. Wenden Sie sich an lhren
Netzanbieter, wenn Sie weitere Informationen wiinschen.

Anrufliste anzeigen

Um die letzten Anrufe anzuzeigen, tippen Sie auf O > (8> Anrufliste.
Dann konnen Sie die folgenden Funktionen verwenden:

+ Um detaillierte Anrufinformationen anzuzeigen, wahlen Sie einen
Kontakt aus. Um den ausgewahlten Kontakt anzurufen, tippen Sie auf

(o

- Um die Anrufliste zu l6schen, tippen Sie auf & > Léschen.

E - Die angezeigte Anrufdauer kann von den Anrufgebiihren abweichen.
Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen
winschen.

Anrufoptionen konfigurieren
Sie konnen verschiedene Anrufoptionen festlegen.
1 Tippen Sie auf O > (¥ > Wahlen oder Anrufliste.

2 Tippen Sie auf : > Anrufeinstellungen und legen Sie die Optionen
nach lhren Wiinschen fest.
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Nachrichten

Nachricht senden

Mit der Messaging-App konnen Sie Nachrichten erstellen und an
ausgewahlte oder an alle Kontakte senden.

E « Das Versenden von Nachrichten im Ausland kann zusatzliche Kosten
verursachen. Wenden Sie sich an Ihren Netzanbieter, wenn Sie weitere
Informationen wiinschen.

1 Tippen Sieauf Q>

2 Tippen Sie auf @.

3 Geben Sie einen Empfanger an und erstellen Sie eine Nachricht.
- Um Dateien anzuhangen, tippen Sie auf /7.
- Um optionale Mentielemente zu 6ffnen, tippen Sie auf : .

A Tippen Sie auf Senden, um die Nachricht zu senden.

Nachricht lesen
Sie konnen ausgetauschte Nachrichten pro Kontakt anzeigen.

1 Tippen SieaufO> .
7 Wahlen Sie einen Kontakt aus der Nachrichtenliste aus.

Nachrichteneinstellungen konfigurieren

Sie konnen die Nachrichteneinstellungen nach lhren Winschen andern.
1 Tippen Sieauf Q>

2 Tippen Sie in der Nachrichtenliste auf : > Einstellungen.
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Kamera

Kamera einschalten

Sie kénnen Fotos oder Videos aufnehmen, um besondere Momente
festzuhalten.

Tippen Sie auf O > @)

E - Wischen Sie die Kameralinse mit einem Mikrofasertuch ab, bevor Sie ein
Foto aufnehmen. Wenn |hre Finger die Kameralinse bertihren, kann dies
zu verschwommenen Aufnahmen fihren.

« Laden Sie den Akku auf, wenn der Akkustand weniger als 5% betragt,
bevor Sie die Kamera verwenden.

- Die Bilder in diesem Benutzerhandbuch kénnen vom eigentlichen Gerat
abweichen.

« Unter Galerie konnen Sie Fotos und Videos anzeigen und bearbeiten.
Weitere Informationen finden Sie unter Ubersicht: Galerie.

Kameramodus dndern

Sie konnen einen fur lhre Aufnahmebedingungen geeigneten
Kameramodus auswahlen, um ganz einfach und problemlos ein Foto oder
Video aufzunehmen.

Tippen Sie auf dem Kamerabildschirm auf ¢ und wahlen Sie den
gewdlnschten Modus aus.
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Zwischen Kameras wechseln

Sie konnen entsprechend lhrer Aufnahmebedingungen zwischen der
vorderen und der hinteren Kamera wechseln.

Tippen Sie auf dem Kamerabildschirm auf &1 oder ziehen Sie den

Bildschirm nach oben, unten, rechts oder links, um zwischen der vorderen
und der hinteren Kamera zu wechseln.

E - Verwenden Sie die vordere Kamera, um Selfies aufzunehmen. Weitere
Informationen finden Sie unter Selfies aufnehmen.

Zur Dual-Kamera wechseln

Sie konnen die Dual-Kamera (zweite Kamera) auf der Rickseite
verwenden, um Fotos mit dem normalen oder dem Weitwinkelobjektiv
aufzunehmen.

Tippen Sie auf [A] / [dw]} um zwischen dem normalen und dem
Weitwinkelobjektiv zu wechseln.

Ansicht vergréRern oder verkleinern

Sie konnen die Ansicht auf dem Kamerabildschirm wahrend der Foto-
oder Videoaufnahme vergroern oder verkleinern.

Bewegen Sie zwei Finger auf dem Kamerabildschirm zusammen oder
auseinander, um die Ansicht zu vergroRern oder zu verkleinern.
+ Das Weitwinkelobjektiv und das normale Objektiv auf der Rickseite
des Gerats werden dann automatisch gewechselt, um ein Foto oder

Video aufzunehmen.
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Einfacher Modus
Tippen Sie einfach auf den Bildschirm, um Fotos aufzunehmen.
1 Tippen Sie auf dem Kamerabildschirm auf ¢ >[ |

7 Richten Sie die Kamera so aus, dass sich das Motiv in der Mitte des
Fokusrahmens befindet, und tippen Sie dann auf den Bildschirm.

Automatischer Modus

Sie konnen Fotos oder Videos aufnehmen und dabei zwischen vielen
Aufnahmemodi und Optionen auswahlen.

1 Tippen Sie auf dem Kamerabildschirm auf @ >[§

2 Um ein Foto aufzunehmen, tippen Sie auf [G]. Um ein Video
aufzunehmen, tippen Sie auf 1

Zwischen dem
\Weitwinkelobjektiv
Kameramodus und dem normalen
auswahlen. Objektiv wechseln.

=)— Galerie 6ffnen.

Blitz ein- oder
ausschalten. 2
Zwischen der —gll
vorderen und der
hinteren Kamera

BYs— Videos aufnehmen.

B)s— Fotos aufnehmen.

wechseln.
Aufnahmemodus ]
auswahlen. Zurﬁck zum
omarptcnen — e

Ein Foto aufnehmen

1 Wahlen Sie einen Aufnahmemodus aus und tippen Sie dann auf das
Motiv, um die Kamera darauf zu fokussieren.

2 Tippen Sie auf (@] um ein Foto aufzunehmen.
Sie konnen auch eine Lautstarke-Taste driicken.
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E + Wenn der Bildschirm ausgeschaltet oder gesperrt ist, kénnen Sie die
Kamera durch zweimaliges Driicken der Taste ,Lautstarke verringern”
(-) aktivieren. Tippen Sie zum Aktivieren dieser Funktion aufo >
Einstellungen > Allgemein und aktivieren Sie Schnellzugriff-Tasten.
Um sofort Fotos aufzunehmen, nachdem Sie die Kamera mit der Taste
JLautstarke verringern” (-) aktiviert haben, aktivieren Sie die Funktion
Schnellausloser.

Ein Video aufnehmen

71 Wahlen Sie einen Aufnahmemodus aus und tippen Sie dann auf das
Motiv, um die Kamera darauf zu fokussieren.

2 Tippen Sie auf [k
+ Um ein Foto wahrend einer Videoaufnahme aufzunehmen, tippen
Sie auf [0}
+ Um die Videoaufnahme voriibergehend anzuhalten, tippen Sie auf
|| Um die Videoaufnahme fortzusetzen, tippen Sie auf @.

3 Tippen Sie auf [_] um die Videoaufnahme zu beenden.

Bild aus Bild

Sie konnen Fotos oder Videos sowohl mit dem normalen als auch mit
dem Weitwinkelobjektiv der Dual-Kamera auf der Rickseite des Gerats
aufnehmen. Auf diese Weise werden die Bilder so aufgenommen, als
waren sie im Rahmen platziert. Die Bilder, die auf dem kleinen Bildschirm
im Vordergrund angezeigt werden, werden mit dem normalen Objektiv
aufgenommen. Die auf dem groRen Hintergrundbildschirm angezeigten
Bilder werden mit dem Weitwinkelobjektiv aufgenommen. Andern Sie
die Form des Bildschirms im Vordergrund oder wenden Sie verschiedene
Effekte an, um ein ansprechendes Foto oder Video aufzunehmen.
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1 Tippen Sie im automatischen Modus auf MODUS >[O]
2 Tippen Sie auf \/ und wahlen Sie das gewtinschte Layout aus.
3 Effektauswahl fir Aufnahmen mit dem Weitwinkelobjektiv:

- [&) : Fischauge.

. :Schwarz & Weil2.

+ [D]:Vignette.

+ [0]:Linsenunscharfe.

A Tippen Sie auf [§], um ein Foto aufzunehmen. Um ein Video
aufzunehmen, tippen Sie auf 1

Mehrfachanzeige

Mit der vorderen und hinteren Kamera kénnen Sie mehrere Fotos oder
Videos in Form einer Collage aufnehmen. Fotos und Videos kénnen mit
verschiedenen Layouts gespeichert werden.

1 Tippen Sie im automatischen Modus auf MODUS >H ]
2 Tippen Sie auf \/ und wahlen Sie ein Layout aus.

3 Tippen Sie auf [G] um gemaR den Anweisungen auf dem Bildschirm
Fotos aufzunehmen. Um ein Video aufzunehmen, tippen Sie auf [ q.
« Tippen Sie auf [}, um einen kurzen Videoclip aufzunehmen.

- Um zwischen der vorderen und der hinteren Kamera (normales
oder Weitwinkelobjektiv) zu wechseln, ziehen Sie den Bildschirm
nach oben, unten, links oder rechts.
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+ Um Fotos in Serie oder Videos in bestimmten Intervallen
aufzunehmen, bertihren und halten Sie [©] oder [ k.

- Tippen Sie auf @) / &), um Fotos oder Videos gleichzeitig oder
nacheinander aufzunehmen.

Snap Video

Sie konnen kurze Videoclips aufnehmen und zu einem 60 Sekunden
langen Kurzfilm zusammenfigen.

1 Tippen Sie auf dem Kamerabildschirm auf MODUS > 57

2 Tippen Sie auf [k
- Tippen Sie einmal auf das Symbol, um einen drei Sekunden langen
Videoclip aufzunehmen. Bertihren und halten Sie das Symbol, um
ein langeres Video zu erstellen (maximale Lange: eine Minute).

Mehrfachanzeige-
Layout auswahlen

Ausgewahlten Clip
Vorschau des |6schen.
ausgewahlten Clips

anzeigen.

Zeitachse. Video speichern.

Alle Clips abspielen. Alle Clips [6schen.

3 Tippen Sie auf SPEICH.
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Panorama

Sie konnen eine Panoramaaufnahme erstellen, indem Sie die Kamera in
eine Richtung bewegen, um Fotos in Serie aufzunehmen und diese zu
einem breiten Bild zusammenzuftigen.

1 Tippen Sie im automatischen Modus auf MODUS > <4,

2 Tippen Sie auf [@]und bewegen Sie die Kamera dann langsam in eine
Richtung.

- Bewegen Sie das Gerat in Richtung des Pfeils der Fihrungslinie.

3 Tippen Sie auf [_] um die Aufnahme zu beenden.

Slow Motion-Video

Sie kénnen ein unterhaltsames Video erstellen, indem Sie die
Bewegungsgeschwindigkeit der Motive in lhrem Video andern. Mit
dieser Funktion konnen Sie ein Video mit schnellerer Geschwindigkeit
aufnehmen und es in normaler Geschwindigkeit abspielen, sodass das
Video verlangsamt erscheint.

1 Tippen Sie im automatischen Modus auf MODUS > (.

2 Tippen Sie auf [y und nehmen Sie ein Video auf.

3 Tippen Sie auf [_] um die Videoaufnahme zu beenden.
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Zeitraffer

Sie konnen eine Serie von Einzelbildern in bestimmten Intervallen
aufnehmen, um langsam im Laufe der Zeit auftretende Veranderungen
wie beispielsweise vorbeiziehende Wolken, Bewegungen am Himmel und
Verkehr aufzuzeichnen.

1 Tippen Sie im automatischen Modus auf MODUS > (&%,
2 Tippen Sie auf [y und nehmen Sie ein Video auf.
-+ Um die Wiedergabegeschwindigkeit des Videos anzupassen, tippen
Sie auf \/.
3 Tippen Sie auf [_] um die Videoaufnahme zu beenden.

« Wahrend der Aufnahme eines Zeitraffervideos werden keine Stimmen
aufgezeichnet.

Serienbilder

Sie konnen Fotos in Serie aufnehmen, um bewegte Bilder zu erzeugen.
Beriihren und halten Sie im automatischen Modus [0}

- Die Fotos werden schnell in Serie aufgenommen, wenn Sie [O] halten.

E + Eskonnen bis zu 30 Fotos in Serie aufgenommen werden.

Nitzliche Apps 87



Mit LG Friends-Kameras verbinden

Sie kénnen das Gerat an eine andere Kamera anschlieRen, um Fotos oder
Videos anzuzeigen, die auf der Kamera gespeichert sind.

5

« Diese Funktion ist bei Verwendung der Mehrfachanzeige oder
Momentaufnahme verfligbar.

« Die LG Friends-Kameras, die mit dem Gerdt verbunden werden kénnen,

sind optionales Zubehar. Wenden Sie sich fir den Kauf an ein LG
Servicezentrum.

- Je nach Gebiet oder Netzanbieter wird diese Funktion méglicherweise

nicht unterstttzt. Auch einige Optionen konnen sich unterscheiden.

Kameraoptionen anpassen
Sie konnen eine Vielzahl von Kameraoptionen nach Ihren Wiinschen

festlegen.

Tippen Sie im automatischen Modus auf §63.

5

« Die verfiigbaren Optionen hangen von der ausgewahlten Kamera
(vordere oder hintere Kamera) und dem ausgewahlten Aufnahmemodus

Ein Seitenverhaltnis fir Fotos oder eine Qualitat fir Videos

auswahlen.
Fotos oder Videos in lebendigen Farben erstellen und
Ausgleichseffekte auch dann erzielen, wenn die Fotos oder Videos

bei Gegenlicht aufgenommen werden. Diese Funktionen werden
Uber die HDR-Technologie (High Dynamic Range) der Kamera des
Gerats bereitgestellt.

Filmeffekte auf Fotos anwenden.

Qv\ Timer so einstellen, dass nach einem angegebenen Zeitraum

OFF

automatisch Fotos aufgenommen werden.

Fotos mit Sprachbefehlen aufnehmen.
(Auswahlmoglichkeiten: Cheese, Smile, Whisky, Kimchi, LG)
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Bewegungsunscharfe bei der Aufnahme eines Fotos oder Videos
reduzieren:

- 1% - Stabile Aufnahme eines Videos bei Bewegung oder beim Gehen.

- ‘@ eichte Unscharfe bei der Aufnahme eines Fotos oder Videos
reduzieren.

Bildraster zur Aufnahme von Fotos oder Videos anzeigen, die sich
an den horizontalen und vertikalen Hilfslinien orientieren.

£1/£]

Speicherorte fiir Fotos und Videos festlegen. Diese Optionen
werden angezeigt, wenn eine externe Speicherkarte eingelegt wird.

. E :Im internen Speicher speichern.
. Q :Auf der externen Speicherkarte speichern.

[@1/1%]

Einstellungen fir den automatischen Aufnahmemodus festlegen.
Diese Optionen werden angezeigt, wenn die vordere Kamera
verwendet wird.

« [®]: Aufnahme mit der Gestenaufnahme.
«[¥]: Aufnahme, wenn die Kamera ein Gesicht erkennt.

/8

Festlegen, ob die Gestenansicht verwendet werden soll, um ein
Foto unmittelbar nach der Aufnahme zu betrachten. Diese Optionen
werden angezeigt, wenn die vordere Kamera verwendet wird.

- [ : Gestenansicht einschalten.
- I : Gestenansicht ausschalten.

a19pRa ey

Bilder spiegeln. Diese Optionen werden angezeigt, wenn die vordere
Kamera verwendet wird.

- £]¢] - Das Bild nicht spiegeln.
. @D : Das Bild horizontal spiegeln.
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Filmeffekte anwenden
Sie kénnen verschiedene Farbfilter auf die Fotos anwenden.
1 Tippen Sie im automatischen oder manuellen Modus auf §63 > [T.

2 Wahlen Sie den gewtinschten Filmeffekt aus.

Manueller Modus

Mit vielen erweiterten Funktionen konnen Sie lhre Fotos professionell
gestalten. Stellen Sie den Weil3abgleich, den Fokus, die Helligkeit, den I1SO-
Wert, die Belichtungszeit und weitere Optionen ein.

1 Tippen Sie auf dem Kamerabildschirm auf : >[=]

7 Passen Sie die Aufnahmeoptionen an.

\WeiRabgleich 41 I— Belichtung
einstellen. einstellen.

Fokus einstellen. Belichtungszeit
einstellen.

Helligkeit einstellen. ISO-Empfindlichkeit
einstellen.

3 Tippen Sie auf [, um das Foto aufzunehmen.
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Selfies aufnehmen

Mit der vorderen Kamera kénnen Sie Ihr Gesicht auf dem Bildschirm
anzeigen und Selfies aufnehmen.

E « Bei Verwendung der vorderen Kamera kénnen Sie in den
Kameraoptionen die Methode zum Aufnehmen von Selfies andern.
\Weitere Informationen finden Sie unter Kameraoptionen anpassen.

Gestenaufnahme
Mit Gesten konnen Sie Selfies aufnehmen.

Halten Sie Ihre Handflache in die vordere Kamera und ballen Sie sie dann
zu einer Faust.

+ Nach drei Sekunden wird ein Foto aufgenommen.

m“

E « Stellen Sie zur Verwendung dieser Funktion sicher, dass in den
Kameraoptionen die Option [#] ausgewahlt ist.

- Sie kénnen auch eine Faust ballen und diese dann in Richtung der
Kamera offnen, um die Gestenaufnahme zu verwenden.

- Stellen Sie sicher, dass sich Ihre Handflache und lhre Faust innerhalb der
Hilfslinien befinden, damit sie von der Kamera erkannt werden kénnen.

« Der Zugriff auf einige Funktionen kann bei Verwendung der
Mehrfachanzeige-Aufnahme eingeschrankt sein.
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Intervallaufnahme
Sie konnen mehrere Selfies nacheinander aufnehmen.
Beriihren und halten Sie bei Verwendung der vorderen Kamera [G} Sie
konnen auch lhre Handflache in die Kamera halten und die Finger zweimal
schnell zu einer Faust ballen.
- Im Abstand von je etwa zwei Sekunden werden vier Fotos
aufgenommen.

Selfies automatisch aufnehmen

Mit der Gesichtserkennungsfunktion kénnen Sie Selfies ganz einfach und
problemlos aufnehmen. Sie kdnnen die Gerateeinstellungen so festlegen,
dass die vordere Kamera |hr Gesicht erkennt und automatisch ein Selfie
aufnimmt, wenn Sie den Bildschirm betrachten.
- Wenn die vordere Kamera |hr Gesicht erkennt, wird der Fokusrahmen
weif. Wenn Sie sich dann nicht mehr bewegen, wird der Fokusrahmen
blau und die vordere Kamera nimmt ein Foto auf.
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E « Tippen Sie auf §83 und anschlieRend auf [®] bis [:¥] angezeigt wird, um
die Funktion zum automatischen Aufnehmen von Selfies zu aktivieren.

Gestenansicht

Nachdem Sie mit der vorderen Kamera ein Selfie aufgenommen haben,
konnen Sie sofort eine Vorschau anzeigen, indem Sie den Bildschirm nahe
an Ihr Gesicht bringen.

E « Stellen Sie zur Verwendung dieser Funktion sicher; dass in den
Kameraoptionen die Option l$+) ausgewahlt ist.

+ Nach jeder Aufnahme eines Fotos ist nur eine Vorschau verfiigbar.

+ Wenn Sie das Gerat im Vorschaumodus drehen, wechselt der Bildschirm
in den Kameramodus.

Galerie

Ubersicht: Galerie

Sie konnen Fotos oder Videos, die auf lhrem Gerat gespeichert sind,
ansehen und verwalten.

1 Tippen Sie auf Q> ™.
+ Gespeicherte Fotos und Videos werden in Ordnern angezeigt.
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2 Tippen Sie auf einen Ordner und wahlen Sie eine Datei aus.
+ Sie konnen die ausgewahlte Datei im Vollbildmodus anzeigen.

+ Wischen Sie auf dem angezeigten Foto- oder Videobildschirm nach
links oder rechts, um die vorherige oder nachste Datei anzuzeigen.

5 « Je nach installierter Software kénnen einige Dateiformate nicht
unterstiitzt werden.

- Aufgrund der Codierung kénnen einige Dateien mdglicherweise nicht
gedffnet werden.

« Dateien, die die GroRenbeschrankung tibersteigen, konnen Fehler
verursachen.

Fotos anzeigen

Zuriick zum —e

VACIENIE. — Zusatzliche

vorherigen Optionen 6ffnen.
Bidschirm. Bilder loschen.
Favoriten
hinzufiigen oder Bilder teilen.

[6schen. Kamera einschalten.

Bilder bearbeiten.

Fotos bearbeiten
1 Tippen Sie wahrend dem Anzeigen eines Fotos auf /2.

2 Sie konnen eine Vielzahl von Effekten und Werkzeugen verwenden,
um das Foto zu bearbeiten.

3 Tippen Sie auf 7, um die Anderungen anzuwenden.

/| Tippen Sie auf Speichern, um die Anderungen zu speichern.
- Die urspriingliche Datei wird mit den Anderungen iiberschrieben.

+ Um das bearbeitete Foto als eine andere Datei zu speichern, tippen
Sie auf ¢ > Kopie speichern.
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Ein Video wiedergeben

Mit QSlide offnen.

Favoriten —3)
hinzufiigen oder
l6schen.

e— Zusatzliche

I Optionen &ffnen.

Video bearbeiten.

Lautstarke —}

8fs—— Bildschirm sperren
einstellen.

oder entsperren.
Video zurlickspulen. Video vorspulen.

Video anhalten oder
abspielen.

E - Ziehen Sie die rechte Seite des Videobildschirms nach oben oder unten,
um die Lautstarke anzupassen.

- Ziehen Sie die linke Seite des Videobildschirms nach oben oder unten,
um die Bildschirmhelligkeit anzupassen.

Videos bearbeiten
1 Tippen Sie auf dem Videovorschaubildschirm auf /2.

2 Sie konnen eine Vielzahl von Effekten und Bearbeitungswerkzeugen

verwenden, um das Video zu bearbeiten.
Einen 15 Sekunden
langen Videoclip
automatisch

erstellen.

Abschnitt zum Andern
der Wiedergabege-
- schwindigkeit

auswahlen.

Sa—— Videodauer anpassen.

3 Tippen Sie auf SPEICHERN, um die Anderungen zu speichern.
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Dateien l6schen
Loschen Sie Dateien mit einer der folgenden Optionen:

« Berthren und halten Sie eine Datei aus der Dateiliste und tippen Sie
dann auf Loschen.

- Tippen Sie in der Dateiliste auf {ij und wahlen Sie Dateien aus.

Dateien teilen
Teilen Sie Dateien mithilfe einer der folgenden Optionen:

- Tippen Sie wahrend der Anzeige eines Fotos oder Videos auf &, um
die Datei auf die gewiinschte Weise zu teilen.

- Tippen Sie in der Dateiliste auf o<, um Dateien auszuwahlen und sie
auf die gewlinschte Weise zu teilen.

Rechner

Sie kénnen zwischen zwei Arten von Rechnern wahlen: dem einfachen
Rechner und dem wissenschaftlichen Rechner.

1 Tippen Sie auf O > Extras > Rechner.

2 Uber das Tastenfeld kénnen Sie eine Berechnung vornehmen.

+ Um den wissenschaftlichen Rechner zu verwenden, tippen Sie auf
: > Wissenschaftlicher Rechner.

- Um die letzten Berechnungen anzuzeigen, tippen Sie auf : >
Berechnungsverlauf.
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Wetter

Sie konnen die Wetterinformationen fir eine bestimmte Region anzeigen.
1 Tippen Sie auf O > Extras > Wetter.

2 Tippen Sie auf -+ und geben Sie die gewtinschte Stadt ein.
+ Tippen Sie auf dem Bildschirm mit detaillierten
Wetterinformationen auf € / > oder wischen Sie den Bildschirm
nach links oder rechts, um das Wetter flir andere Stadte
anzuzeigen.

Downloads

Sie konnen Apps und Dateien, die Sie aus dem Internet heruntergeladen
haben, anzeigen, l6schen oder teilen.

Tippen Sie auf (O > Extras > Downloads.

Uhr

Wecker

Sie kénnen einen Alarm einstellen, der zu einer bestimmten Uhrzeit
ausgelost wird.

1 Tippen Sie auf O > Extras > Uhr > Wecker.

2 Tippen Sie auf @), um einen neuen Alarm hinzuzufiigen.
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3 Konfigurieren Sie die Alarmeinstellungen und tippen Sie auf
SPEICHERN.

E + Wenn Sie einen zuvor eingestellten Alarm auswahlen, konnen Sie ihn
bearbeiten.

- Tippen Sie zum Léschen eines Alarms oben auf dem Bildschirm auf E
Sie kénnen den Alarm auch berthren und halten.

Weltzeit

Sie konnen die aktuelle Zeit in Stadten auf der ganzen Welt anzeigen.
1 Tippen Sie auf O > Extras > Uhr > Weltzeit.

2 Tippen Sie auf @ und fligen Sie eine Stadt hinzu.

Timer

Sie kénnen einen Timer einstellen, der nach einer bestimmten Zeit einen
Alarm auslost.

1 Tippen Sie auf O > Extras > Uhr > Timer.

2 Stellen Sie die Zeit ein und tippen Sie auf Starten.

- Um den Timer vortibergehend anzuhalten, tippen Sie auf Anhalten.
Um den Timer fortzusetzen, tippen Sie auf Fortsetzen.

- Tippen Sie auf Zuriicksetzen, um die Timereinstellungen
zuriickzusetzen.

3 Tippen Sie auf Anhalten, um den Timeralarm zu beenden.
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Stoppuhr

Mit der Stoppuhr kénnen Sie eine Rundenzeit aufzeichnen.
1 Tippen Sie auf O > Extras > Uhr > Stoppuhr.

2 Tippen Sie auf Starten, um die Stoppuhr zu starten.
- Um eine Rundenzeit aufzuzeichnen, tippen Sie auf Runde.

3 Tippen Sie auf Anhalten, um die Stoppuhr anzuhalten.
+ Um die Stoppuhr fortzusetzen, tippen Sie auf Fortsetzen.

+ Um alle Stoppuhraufzeichnungen zu [6schen, tippen Sie auf
Zuriicksetzen.

Sprachaufzeichnung

Sie konnen Ihre Stimme oder die Stimme anderer Personen bei wichtigen
Ereignissen aufzeichnen. Aufgezeichnete Sprachaufnahmen kénnen
wiedergegeben oder geteilt werden.

1 Tippen Sie auf O > Extras > Sprachaufzeichnung.

2 Tippen Sie auf (+).
- Um die Aufnahme voriibergehend anzuhalten, tippen Sie auf ().

3 Tippen Sie auf (), um die Aufnahme zu beenden.

- Die Datei wird automatisch gespeichert und der Bildschirm zum
Vorhoren wird angezeigt.

/| Tippen Sie auf (>), um die Sprachaufnahme abzuspielen.

5 + Um die Standortinformationen der Aufzeichnung zu speichern, tippen
Sie auf Standort.

+ Um die Aufzeichnung mit aktuellen Ereignisinformationen zu
kennzeichnen, tippen Sie auf Termin. \Wahlen Sie anschlieRend das
gewUnschte Ereignis aus.

+ Wenn Sie auf@ tippen, werden aufgenommene Sprachdateien
angezeigt. Sie konnen eine aufgenommene Sprachdatei aus der Liste
abspielen.
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Musik

Sie konnen Musikdateien, die auf Ihrem Gerat gespeichert sind,
wiedergeben und verwalten.

1 Tippen Sie auf Q> LG > Musik.

2 Wahlen Sie eine Kategorie aus.

3 Wahlen Sie eine Musikdatei aus.

Zur Wiedergabeliste

wechseln.
fe— Zusatzliche Optionen

i offnen
Favoriten hmzufuglen %der —— A b Nach Musikdateien suchen
6schen. Becton :

Zurlck zum vorherigen
Bildschirm. l

In zufalliger Reihenfolge —§
wiedergeben.

Lautstarke einstellen. —J)

e— Wiederholungsmodus
auswahlen.

E— Soundeffekte festlegen.

J Tippen, um die nachste
Datei

wiederzugeben/Berihren
und halten, um vorzuspulen

Tippen, um die aktuelle Datei von
Beginn an wiederzugeben/Zweimal
tippen, um die vorherige Datei
wiederzugeben/Bertihren und
halten, um zuriickzuspulen. Anhalten oder wiedergeben.

E - Je nach installierter Software kdnnen einige Dateiformate nicht
unterstitzt werden.

Dateien, die die GroRenbeschrankung tbersteigen, kdnnen Fehler
verursachen

+ Musikdateien sind méglicherweise durch internationale Urheberrechte
der Eigentimer oder Urheberrechtsgesetze geschutzt. Maglicherweise
ist eine gesetzliche Erlaubnis vor dem Kopieren einer Musikdatei
erforderlich. Priifen Sie zuerst die Gesetzgebung zum Urheberrecht
des betreffenden Landes, bevor Sie eine Musikdatei herunterladen oder
kopieren.

Dieses Modell unterstutzt die Wiedergabe von Hi-Fi-Audiodateien. Hi-
Fi-Audiodateien sind mit dem Hi-Fi-Symbol gekennzeichnet.
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E-Mail

Ubersicht: E-Mail
Sie kénnen ein E-Mail-Konto auf Inrem Gerat anlegen, um von lhrem
Gerat aus E-Mails zu lesen und zu senden.

E « Bei dieser Option wird eine mobile Datenverbindung verwendet.
Daher kénnen je nach Tarif Kosten fir die Datennutzung entstehen.
Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen
winschen.

E-Mail-Konten anlegen

Wenn Sie die E-Mail-App das erste Mal aufrufen, konnen Sie Ihr E-Mail-

Konto anlegen.

1 Tippen Sie auf O > LG > E-Mail

2 Wahlen Sie einen E-Mail-Anbieter aus.

3 Geben Sie lhre E-Mail-Adresse und Ihr Passwort ein. Tippen Sie dann
auf WEITER, um Ihr Konto anzulegen.

- Tippen Sie auf MANUELLE EINRICHTUNG, um ein E-Mail-Konto
manuell anzulegen oder um E-Mail-Konten anzulegen, die nicht in
der Liste enthalten sind.

E-Mail-Konten verwalten
Um die Einstellungen lhres E-Mail-Kontos anzuzeigen oder zu bearbeiten,
tippen Sie auf : > Einstellungen.

- Um ein Konto hinzuzuftgen, tippen Sie auf Konto hinzufiigen.

- Um ein Konto zu l6schen, tippen Sie auf : > Konto entfernen.

Ein weiteres E-Mail-Konto offnen

Wenn mehrere E-Mail-Konten registriert sind und Sie ein anderes Konto
anzeigen mochten, tippen Sie auf == und wahlen Sie ein anderes Konto
aus der Liste aus.
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E-Mails abrufen

1 Tippen Sie auf = und wahlen Sie ein Postfach aus.

2 Wahlen Sie eine E-Mail aus der E-Mail-Liste aus.
+ Die E-Mail-Nachricht wird angezeigt.

E-Mails senden
1 Tippen Sie auf @.
2 Geben Sie die E-Mail-Adresse des Empfangers ein.

3 Geben Sie einen Betreff und eine Nachricht ein.
+ Um Dateien anzuhangen, tippen Sie auf (=.
- Um optionale Mentelemente zu 6ffnen, tippen Sie auf + .

4 Tippen Sie auf B>, um die E-Mail zu senden.

Kontakte

Ubersicht: Kontakte
Sie kdnnen Kontakte speichern und verwalten.
Tippen Sie auf O > LG > Kontakte.

Kontakte hinzufiigen

Neue Kontakte hinzufiigen
1 Tippen Sie in der Kontaktliste auf +-.
2 Geben Sie Kontaktdetails ein und tippen Sie auf SPEICHERN.
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Kontakte importieren
Sie konnen Kontakte von einem anderen Speichergerat importieren.

1 Tippen Sie in der Kontaktliste auf : > Kontakte verwalten >
Importieren.

7 Wahlen Sie Quell- und Zielverzeichnis des Kontakts aus, den Sie
importieren mochten, und tippen Sie dann auf OK.

3 Wahlen Sie Kontakte aus und tippen Sie auf IMPORTIEREN.

Kontakte zur Kurzwabhlliste hinzufiigen
1 Tippen Sie in der Kontaktliste auf : > Kurzwahl
2 Tippen Sie auf der Kurzwahlnummer auf Kontakt hinzufiigen.

3 Wahlen Sie einen Kontakt aus.

Kontakte suchen
Suchen Sie nach Kontakten mit einer der folgenden Optionen:

- Geben Sie in der Kontaktliste den Namen eines Kontakts in das
Suchfeld ein.

- Scrollen Sie in der Kontaktliste nach oben oder unten.

- Tippen Sie auf den Anfangsbuchstaben eines Kontakts im Verzeichnis
der Kontaktliste.

Kontaktliste

Kontakte bearbeiten
7 Wahlen Sie einen Kontakt aus der Kontaktliste aus.

2 Tippen Sie in den Kontaktinformationen auf £/ und bearbeiten Sie die
Details.

3 Tippen Sie auf SPEICHERN, um die Anderungen zu speichern.
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Kontakte l6schen
1 Berthren und halten Sie einen Kontakt in der Kontaktliste.

2 Tippen Sie auf Kontakt [6schen.

Favoriten hinzufiigen
Sie konnen haufig genutzte Kontakte als Favoriten anlegen.

7 Wahlen Sie einen Kontakt aus der Kontaktliste aus.

2 Tippen Sie in den Kontaktinformationen auf ¢y.

Gruppen erstellen
1 Tippen Sie in der Kontaktliste auf Gruppen > : > Neue Gruppe.
2 Geben Sie einen neuen Gruppennamen ein.

3 Tippen Sie auf Fiigen Sie Mitglieder hinzu, wahlen Sie Kontakte aus
und tippen Sie auf HINZUFUGEN.

A Tippen Sie auf SPEICHERN, um die neue Gruppe zu speichern.

Kalender

Ubersicht: Kalender
Mit dem Kalender kénnen Sie Ereignisse und Aufgaben verwalten.

Ereignisse hinzufiigen
1 Tippen Sie auf Q> Kalender.
2 Wahlen Sie ein Datum aus und tippen Sie auf €.

3 Geben Sie Ereignisdetails ein und tippen Sie auf SPEICHERN.

+ Wenn Sie auf ein Datum im Kalender tippen und dieses Datum ein
Ereignis enthalt, wird ein Pop-up-Fenster mit einer Ereignisliste
angezeigt. Tippen Sie im Pop-up-Fenster auf ein Ereignis, um die
Ereignisdetails anzuzeigen.
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Ereignisse synchronisieren

Tippen Sie auf : > Anzuzeigende Kalender > : > Kalender
synchronisieren und wahlen Sie einen zu synchronisierenden Kalender aus.

E « Wenn Sie die auf Ihrem Gerat gespeicherten Ereignisse in lhrem

Google-Konto speichern, werden diese auch automatisch mit dem
Google-Kalender synchronisiert. Sie kénnen dann andere Gerate mit
dem Google-Kalender synchronisieren, damit die auf Ihrem Gerat
gespeicherten Ereignisse auch auf diesen Geraten gespeichert sind und
Sie Ihre Ereignisse auf diesen Geraten verwalten konnen.

Event Pocket
Mit der Event Pocket konnen Sie Ereignisse erstellen.

Tippen Sie auf &5, um die Event Pocket zu 6ffnen. Ziehen Sie dann Inhalte
auf einen Tag im Kalender.

. @ :Verwalten von Bildern, Texten, Notizen und temporar

gespeicherten Ereignissen. Sie konnen auch Texte, Bilder und Notizen
aus einer anderen App teilen und sie in der Event Box speichern. Wenn
Sie bei der Erstellung eines Ereignisses auf ABLAGE tippen, wird das
Ereignis vortibergehend in der Event Pocket gespeichert.

(%) : Hinzuftigen eines Facebook-Kontos, um Informationen zu
Facebook-Ereignissen anzuzeigen. Einige Gerate unterstutzen die
Informationsfunktion zu Facebook-Ereignissen maglicherweise nicht.

: Anzeigen von touristischen Informationen tber die Umgebung,
wie beispielsweise Restaurants oder andere Einrichtungen, zum
Planen eines Events.

() : Verwalten von unbefristeten Aufgaben, z. B. Ereignisse.
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Dateimanager

Sie konnen die auf Ihrem Gerat oder in der Cloud gespeicherten Dateien
anzeigen und verwalten.

1 Tippen Sie auf O > Extras > Dateimanager.

2 Tippen Sie auf == und wahlen Sie den gewlnschten Speicherort aus.

Aufgaben

Speichern Sie Aufgaben auf Ihrem Gerat, um Zeitplane einfach zu
verwalten.

1 Tippen Sie auf O > Extras > Aufgaben.
2 Tippen Sie auf @, um eine Aufgabe hinzuzufiigen.
3 Geben Sie Aufgabendetails ein und tippen Sie dann auf SPEICHERN.

Evernote

Sie kénnen wichtige Informationen einfiigen und sammeln und sie dann
fur andere Gerate teilen, die Evernote unterstiitzen.

Tippen Sie auf O > Empfohlen > Evernote.

CB-Nachrichten

Sie kénnen Nachrichten (ber Notsituationen, wie Taifune,
Uberschwemmungen und Erdbeben, in Echtzeit anzeigen.

Tippen Sie auf O > Extras > CB-Nachrichten.

Nitzliche Apps 106



Radio

Sie kénnen FM-Radio héren.
Tippen Sie auf ) > Extras > Radio.

5

« Um diese App zu verwenden, miissen Sie Ihr Headset zunachst am

Gerat anschlieRen. Das Headset wird als Radioantenne verwendet.

«Je nach Region wird diese Funktion méglicherweise nicht unterstutzt.

LG Backup

Sie konnen die auf Ihrem Gerat gespeicherten Daten sichern,
wiederherstellen und verschieben.
1 Tippen Sie auf O > Management > LG Backup.

Sie kénnen auch auf O > Einstellungen > Allgemein > Sichern &
zuriicksetzen > LG Backup tippen.

2 Befolgen Sie die Anweisungen auf dem Bildschirm, um festzulegen,
ob Daten im auf dem Gerat vordefinierten Ordner gesichert oder auf
andere Gerate kopiert werden sollen.

A .

Wenn Sie Ihr Gerat initialisieren, kénnen Sicherungsdateien, die

im internen Speicher gespeichert sind, geléscht werden. Um den
Datenverlust zu minimieren, kopieren Sie wichtige Sicherungsdateien
vom LG Sicherungsordner im internen Speicher auf einen Computer
oder ein externes Speichermedium.

+ Daten in einem Google-Konto werden nicht gesichert. \WWenn Sie |hr

Google-Konto synchronisieren, werden lhre Google-Apps, lhre Google-
Kontakte, Inr Google-Kalender, Ihre Google Notizen App-Daten und lhre
aus dem Play Store heruntergeladenen Apps automatisch in der Google
Drive App gespeichert.

« Sicherungsdateien werden mit der Dateierweiterung *.bf im LG

Sicherungsordner auf der Speicherkarte oder im internen Speicher
gespeichert.

- Laden Sie die Batterie vollstandig auf, bevor Sie eine Sicherung

durchfiihren oder Daten wiederherstellen, damit sich das Gerat wahrend
des Vorgangs nicht versehentlich ausschaltet.
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RemoteCall Service

Fur Ihr Gerat kann eine Fernwartung zur Fehlerbehebung durchgeftihrt
werden. Rufen Sie zunachst das LG Servicezentrum an:

1 Tippen Sie auf O > Management > RemoteCall Service.
7 Rufen Sie ein LG Servicezentrum an.

3 Befolgen Sie die Anweisungen des Kundendienstmitarbeiters und
geben Sie eine sechsstellige Zugangsnummer ein.
« |hr Gerat ist per Fernzugriff verbunden und die Fernwartung
beginnt.

E - Um diese Funktion zu verwenden, missen Sie zuerst den
Nutzungsbestimmungen der Funktion zustimmen.

+ Wenn Sie eine mobile Datenverbindung verwenden, konnen je nach Tarif
Kosten fir die Datennutzung entstehen.

SmartWorld

Sie konnen eine Vielzahl von Spielen, Audioinhalten, Apps und
Schriftarten von LG Electronics herunterladen. Passen Sie Ihr Gerat nach
lhren Wiinschen an und verwenden Sie Themen fiir den Startbildschirm
und die Tastatur sowie Schriftarten.

1 Tippen Sie auf O > LG > SmartWorld.
7 Geben Sie lhre ID und Ihr Passwort ein und melden Sie sich an.

3 Wahlen Sie Inhaltselemente aus und laden Sie sie herunter.

SmartWorld-App herunterladen

Wenn die SmartWorld-App nicht installiert ist, befolgen Sie diese
Schritte zum Herunterladen.

1 Tippen Sie auf O > Einstellungen > Allgemein > Uber das Telefon >
Update-Center > App Updates.

2 Wahlen Sie SmartWorld aus der Liste aus und tippen Sie auf
Herunterladen.
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E + Bei dieser Option wird eine mobile Datenverbindung verwendet. Daher
kénnen je nach Tarif Kosten fiir die Datennutzung entstehen.

+ Diese Funktion wird je nach Geratehersteller oder Netzanbieter
moglicherweise nicht unterstitzt.

Google-Apps

Sie konnen Google-Apps verwenden, wenn Sie Uber ein Google-Konto
verfligen. Das Fenster zur Registrierung |hres Google-Kontos wird
automatisch angezeigt, wenn Sie eine Google-App zum ersten Mal
verwenden. Wenn Sie nicht Uber ein Google-Konto verfligen, richten Sie
ein Google-Konto auf Ihrem Gerat ein. Informationen zur Nutzung einer
App finden Sie in der Hilfefunktion der App.

E + Einige Apps sind je nach Gebiet oder Netzanbieter méglicherweise nicht
verfligbar.

Chrome

Bei Chrome anmelden und gedffnete Registerkarten, Lesezeichen
und Daten aus der Adressleiste von einem Computer auf |hr Gerat
importieren.

Docs

Dokumente erstellen oder Dokumente bearbeiten, die online oder auf
einem anderen Gerat erstellt worden sind. Dokumente mit anderen teilen
und bearbeiten.

Google Drive

Dateien auf lhrem Gerat hochladen, sichern, 6ffnen, teilen und
organisieren. Sie konnen auf Dateien, die Uber Apps zuganglich sind,
Uberall zugreifen, auch aus Online- und Offline-Umgebungen.
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Gmail

Ihr Google-E-Mail-Konto auf lhrem Gerat anlegen und E-Mails prifen
oder senden.

Google

Verwenden Sie die Suchfunktion von Google, um nach Websites und
auf lhrem Gerat gespeicherten Dateien zu suchen. Geben Sie dazu
Stichworter per Text- oder Spracheingabe ein.

Hangouts

Nachrichten austauschen. Einen Videoanruf mit einer Person oder einer
Gruppe tatigen.

Maps
Ihren Standort oder den Standort einer Ortlichkeit auf der Karte finden.
Geografische Informationen anzeigen.

Fotos

Fotos oder Alben, die auf lhrem Gerat gespeichert sind, anzeigen oder
teilen.

Play Filme & Serien

Mit Ihrem Google-Konto Filme ausleihen oder kaufen. Inhalte kaufen und
Uberall abspielen.

Play Musik

Musikdateien aus dem Play Store kaufen. Spielen Sie Musikdateien ab,
die auf lhrem Gerat gespeichert sind.

Tabellen

Tabellen erstellen oder Tabellen bearbeiten, die online oder auf einem
anderen Gerat erstellt worden sind. Tabellen teilen und mit anderen
bearbeiten.
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Prasentationen

Prasentationsmaterialien erstellen oder Prasentationsmaterialien
bearbeiten, die online oder auf einem anderen Gerat erstellt worden sind.
Prasentationsmaterialien teilen und mit anderen bearbeiten.

Sprachsuche
Durch Aussprechen eines Stichworts nach Informationen auf Google
suchen, statt ein Stichwort einzugeben.

YouTube
Videos suchen und abspielen. Videos auf YouTube hochladen, um sie mit
Menschen auf der ganzen Welt zu teilen.
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Telefoneinstellungen



Einstellungen

Sie konnen die Gerateeinstellungen nach lhren Winschen anpassen.
Tippen Sie auf O > Einstellungen.

E - Tippen Sie aqu und geben Sie ein Stichwort in das Suchfeld ein, um
auf eine bestimmte Einstellung zuzugreifen.

« Tippen Sie auf , um den Anzeigemodus zu andern. In diesem
Benutzerhandbuch wird angenommen, dass Sie den Modus Tab-
Ansicht verwenden.

Netzwerke

Wi-Fi
Uber ein WLAN-Netzwerk kdnnen Sie eine Verbindung zu Geraten in der
Nahe herstellen.

Verbindung mit einem WLAN-Netzwerk herstellen
1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Wi-Fi.

2 Schieben Sie (31 nach rechts, um die Funktion zu aktivieren.
- Verfigbare WLAN-Netzwerke werden automatisch angezeigt.

3 Wahlen Sie ein Netzwerk aus.

+ Sie mussen moglicherweise ein Passwort fir das WLAN-Netzwerk
eingeben.

« Bei zuvor genutzten WLAN-Netzwerken Uberspringt das
Gerat diesen Vorgang. Wenn Sie nicht mochten, dass Ihr Gerat
automatisch mit einem bestimmten WLAN-Netzwerk verbunden
wird, bertihren und halten Sie das Netzwerk und tippen Sie dann
auf Netzwerk entfernen.
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Einstellungen fiir das WLAN-Netzwerk
Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Wi-Fi.

+ Zu mobilen Daten wechseln: \Wenn die Funktion fir die mobile
Datenverbindung aktiviert ist, sich das Gerat jedoch nicht tber WLAN
mit dem Internet verbinden kann, wird fir die Verbindung des Gerats
mit dem Internet automatisch die mobile Datenverbindung verwendet.

¢ :WLAN-Netzwerkeinstellungen anpassen.

Wi-Fi Direct
Sie kénnen Ihr Gerat mit anderen Geraten verbinden, die Wi-Fi Direct
unterstiitzen, um Daten direkt mit diesen Geraten zu teilen. Ein
Zugangspunkt ist nicht erforderlich. Mithilfe von Wi-Fi Direct kénnen Sie
Ihr Gerat mit mehr als zwei Geraten verbinden.
1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Wi-Fi >
¢ > Erweitertes Wi-Fi > Wi-Fi Direct.
- Gerate in der Nahe, die Wi-Fi Direct unterstiitzen, werden
automatisch angezeigt.
7 Wahlen Sie ein Gerat aus.

- Eine Verbindung wird hergestellt, wenn das Gerat die
Verbindungsanfrage akzeptiert.

=

—
=
A —
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°

=
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E + Der Akku kann sich moglicherweise schneller entladen, wenn Sie Wi-Fi
Direct verwenden.
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Bluetooth

Sie konnen Ihr Gerat mit Geraten in der Nahe verbinden, die Bluetooth
unterstitzen, um Daten mit ihnen auszutauschen. Verbinden Sie Ihr Gerat
mit einem Bluetooth-Headset und einer Tastatur. So kann das Gerat
leichter gesteuert werden.

Pairing mit einem anderen Gerat

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke >
Bluetooth.

2 Schieben Sie (33 nach rechts, um die Funktion zu aktivieren.
- Verfligbare Gerate werden automatisch angezeigt.
- Um die Gerateliste zu aktualisieren, tippen Sie auf SUCHEN.

E + Nur Gerate mit aktivierter Suchoption werden in der Liste angezeigt.

3 Wabhlen Sie ein Gerat aus der Liste aus.
4 Befolgen Sie die Anweisungen auf dem Bildschirm, um die
Authentifizierung durchzufthren.

E + Dieser Schritt wird fir Gerate Uibersprungen, auf die Sie bereits
zugegriffen hatten.

Daten uber Bluetooth senden

1 Wahlen Sie eine Datei aus.
« Sie konnen Multimediadateien und Kontakte senden.

2 Tippen Sie auf «& > Bluetooth.

3 Wahlen Sie ein Zielgerat fur die Datei aus.
- Die Datei wird gesendet, sobald sie das Zielgerat akzeptiert.

E + Die Vorgehensweise zum Teilen von Dateien kann sich je nach Datei
unterscheiden.
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Mobile Daten

Sie kénnen mobile Daten ein- und ausschalten. AuRerdem kénnen Sie die
mobile Datennutzung verwalten.

Mobile Daten einschalten

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Mobile
Daten.

2 Schieben Sie (3 nach rechts, um die Funktion zu aktivieren.

Einstellungen fiir mobile Daten anpassen

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Mobile
Daten.

7 Passen Sie die folgenden Einstellungen an:

- Mobile Daten: Festlegen, dass mobile Datenverbindungen
verwendet werden sollen.

- Grenze fiir Mobilen Datenverbrauch: Legen Sie eine Obergrenze
fur die mobile Datennutzung fest, damit mobile Daten blockiert
werden, sobald diese Grenze erreicht ist.

- ¢ :Einstellungen fur mobile Daten anpassen.

Anruf

Sie konnen Anrufeinstellungen zum Beispiel fir Sprachanrufe sowie
internationale Anrufe anpassen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Anruf.

7 Passen Sie die Einstellungen an.

E + Einige Funktionen werden je nach Geratehersteller oder Netzanbieter
moglicherweise nicht unterstiitzt.
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NFC

Sie konnen das Gerat als Fahr- oder Kreditkarte verwenden. Sie kdnnen
auch Daten mit einem anderen Gerat teilen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > NFC.
2 Schieben Sie (33 nach rechts, um die Funktion zu aktivieren.
- Beruhren Sie Ihr Gerat mit einem anderen Gerat, das NFC
unterstitzt, um das Teilen von Daten zu ermdglichen.
« Je nach Geratetyp kann sich die NFC-Antenne an einer anderen
Stelle befinden.

NFC-Antenne
(integriert)

Android Beam

Sie kénnen Dateien teilen, indem Sie die Rickseite des Gerats mit einem
anderen Gerat berthren. Sie kénnen auch Uber das andere Gerat Dateien
wie Musik, Videos oder Kontakte teilen und eine \Webseite ¢ffnen oder
eine App starten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > Android Beam.

7 Berihren Sie die Riickseite des Gerats mit dem anderen Gerat.

E + Je nach Geratetyp kann sich die NFC-Antenne an einer anderen Stelle
befinden.
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Dateiaustausch
Sie konnen Dateien zwischen lhrem Gerat und anderen LG Geraten oder
Tablets austauschen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > Dateiaustausch.

7 Passen Sie die folgenden Einstellungen an:
- G5 SE: Zur Anderung des Geratenamens.

+ Speichern in: Zielordner zum Speichern von Dateien, die von
anderen Geraten gesendet wurden, festlegen.

- Dateiaustausch: Empfang von Dateien, die von anderen Geraten
gesendet werden, erlauben.

- SmartShare Beam: Dateien mit anderen Geraten Uber SmartShare
Beam teilen.

« Weitere Informationen finden Sie unter Dateien senden oder
empfangen.

Medienserver
Sie konnen auf dem Gerat gespeicherte Medieninhalte mit Geraten in der
Nahe teilen, die DLNA unterstitzen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > Medienserver.
2 Passen Sie die folgenden Einstellungen an:

Inhalte teilen:Inhalte auf lhrem Gerat mit Geraten in der Nahe
teilen.

+ G5 SE: Den Namen Ihres Gerats festlegen.

Geteilte Inhalte festlegen: Den Typ der Medien festlegen, die mit
anderen Geraten geteilt werden sollen.

- Erlaubte Gerate: Eine Liste der Gerate anzeigen, die auf Inhalte auf
lhrem Gerat zugreifen durfen.

+ Nicht-zugelassene Gerate: Eine Liste der Gerdte anzeigen, die
nicht auf Inhalte auf lhrem Gerat zugreifen drfen.
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Screen Share

Sie konnen den Bildschirm und Ton des Gerats auf einem anderen Gerat
wie z. B. einem Fernsehgerat wiedergeben, das die Miracast-Funktion
unterstitzt.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > Screen Share.

2 Schieben Sie (33 nach rechts, um die Funktion zu aktivieren.

3 Wahlen Sie aus der Liste mit Geraten in der Nahe ein Gerat aus.

- Tippen Sie auf SUCHEN, falls das gewiinschte Gerat nicht in der
Liste enthalten ist, um die Liste zu aktualisieren.

- Sobald das Gerat verbunden ist, wird darauf der Bildschirm Ihres
Gerats angezeigt.

E + Die Bildschirmfreigabe schaltet sich automatisch ab, wenn sich kein
kompatibles Gerat in der Nahe befindet.

LG AirDrive

Sie konnen mit lhrem LG Konto auf dem Gerat gespeicherte Dateien auf
einem Computer verwalten. Dazu ist keine USB-Verbindung erforderlich.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden> LG AirDrive.

2 Verwenden Sie ein LG Einzelkonto, um sich bei LG Bridge auf dem
Computer und bei LG AirDrive auf dem Gerat anzumelden.

- Die LG Bridge-Software kann von www.lg.com heruntergeladen
werden.

3 Nun kénnen Sie Dateien auf dem Gerat auf dem Computer verwalten.
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Drucken

Sie konnen Ihr Gerat mit einem Bluetooth-Drucker verbinden und auf
dem Gerat gespeicherte Fotos oder Dokumente ausdrucken.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Teilen &
Verbinden > Drucken.

5 - Wenn sich der gewtinschte Drucker nicht in der Liste befindet,
installieren Sie den Druckertreiber aus dem App Store.

2 Schieben Sie (31 nach rechts, um die Funktion zu aktivieren.

3 Wahlen Sie in der Liste mit Druckern einen Drucker aus.

- Tippen Sie zum Hinzufiigen eines Druckers auf + > Drucker
hinzufiigen.

- Tippen Sie zum Suchen nach einem Drucker auf ¢ > Suche.

- Tippen Sie in der Liste mit Druckern auf : > Einstellungen.
/A Wahlen Sie eine Datei aus und tippen Sie auf : > Drucken.

+ Das Dokument wird gedruckt.

E + Wenn Sie nicht tber ein Google-Konto verfligen, tippen Sie auf KONTO
HINZUFUGEN, um ein Konto zu erstellen.
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USB-Tethering

Sie konnen das Gerat tiber USB mit einem anderen Gerat verbinden und
mobile Daten teilen.

1 Verbinden Sie |hr Gerat lber ein USB-Kabel mit anderen Geraten.

2 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke >
Tethering > USB-Tethering und schieben Sie dann (J# nach rechts,
um die Funktion zu aktivieren.

——

@

@

e

3

E « Bei dieser Option wird eine mobile Datenverbindung verwendet.
Daher kénnen je nach Tarif Kosten fir die Datennutzung entstehen.
Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen
wiinschen.

- Wenn Sie eine Verbindung zu einem Computer herstellen, laden Sie
auf www.lg.com den USB-Treiber auf den Computer herunter und
installieren Sie ihn.

- Sie kénnen keine Dateien zwischen Ihrem Gerat und einem Computer
senden und empfangen, wenn USB-Tethering aktiviert ist. Zum Senden
oder Empfangen von Dateien missen Sie USB-Tethering deaktivieren.

- Zu den Betriebssystemen, die Tethering unterstltzen, gehéren Windows
XP oder hoher und Linux.
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Mobiler Wi-Fi Hotspot

Sie konnen das Gerat als WLAN-Router festlegen, sodass sich andere

Gerate unter Verwendung der mobilen Datenverbindung lhres Gerats mit
dem Internet verbinden kénnen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke >

Tethering > Mobiler Wi-Fi Hotspot und schieben Sie dann (J# nach

rechts, um die Funktion zu aktivieren.

2 Tippen Sie auf Einrichten des mobilen Wi-Fi Hotspots und geben
Sie die WLAN-ID (SSID) und das Passwort ein.

3 Aktivieren Sie WLAN auf dem anderen Gerat und wahlen Sie in der

Liste der WLAN-Netzwerke den Namen des Geratenetzwerks aus.

4 Geben Sie das Netzwerkpasswort ein.

@ (

5 « Bei dieser Option wird eine mobile Datenverbindung verwendet.
Daher kénnen je nach Tarif Kosten fiir die Datennutzung entstehen.

=

%

—

) e,

Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen

winschen.

« Weitere Informationen finden Sie auf dieser \Website:

http//www.android.com/tether#wifi
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Bluetooth-Tethering
Ein Uber Bluetooth verbundenes Gerat kann sich unter Verwendung der
mobilen Datenverbindung lhres Gerats mit dem Internet verbinden.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke >
Tethering > Bluetooth-Tethering und schieben Sie dann (J# nach
rechts, um die Funktion zu aktivieren.

2 Aktivieren Sie Bluetooth auf beiden Geraten. Fihren Sie anschlieRend
das Pairing der Gerate durch.

E + Bei dieser Option wird eine mobile Datenverbindung verwendet.
Daher kénnen je nach Tarif Kosten fiir die Datennutzung entstehen.
Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen
wiinschen.

« Weitere Informationen finden Sie auf dieser Website:
http//www.android.com/tether#Bluetooth_tethering

Hilfe

Sie konnen Hilfe zu Tethering und Hotspots anzeigen.

Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Tethering >
Hilfe.

Flugmodus

Sie kénnen die Funktionen fur Telefonanrufe und mobile Daten
ausschalten. Wenn dieser Modus aktiviert ist, stehen Funktionen, die
keine Datentbertragung erfordern, wie beispielsweise Spiele und Musik,
weiterhin zur Verfligung.
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T Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Mehr >
Flugmodus.

2 Tippen Sie im Bestatigungsbildschirm auf AKTIVIEREN.

Mobilfunknetze

Sie konnen die Einstellungen fiir mobile Daten anpassen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Mehr >
Mobilfunknetze.

2 Passen Sie die folgenden Einstellungen an:
- Mobile Daten: Mobile Daten aktivieren oder deaktivieren.

- Daten-Roaming:Internet, E-Mails, Multimedia-Nachrichten und
andere Datendienste auch im Ausland verwenden.

+ Netzwerkmodus: Netztyp auswahlen.

+ Zugangspunkte: Zugangspunkt zur Verwendung von mobilen
Datendiensten anzeigen oder andern. Treffen Sie zum Andern des
Zugangspunkts eine Auswahl aus der Liste mit Zugangspunkten.

- Netzbetreiber: Nach Netzbetreibern suchen und automatisch eine
Verbindung mit einem Netz herstellen.

VPN

Sie konnen sich auch mit einem sicheren virtuellen Netzwerk wie einem
Intranet verbinden. Auch verbundene VPN-Netzwerke (virtuelle private
Netzwerke) konnen verwaltet werden.

VPN hinzufiigen

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerke > Mehr >
VPN.

A + Wenn der Bildschirm entsperrt wird, werden alle auf dem Gerat
gespeicherten VPN-Informationen geldscht.
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2 Tippen Sie auf VPN Netzwerk hinzufiigen.

E « Diese Funktion ist nur verfligbar, wenn die Bildschirmsperre
aktiviert ist. Beim Deaktivieren der Bildschirmsperre wird
ein Benachrichtigungsfenster angezeigt. Tippen Sie im
Benachrichtigungsfenster auf EINST,, um die Bildschirmsperre zu
aktivieren. Weitere Informationen finden Sie unter Einstellungen fir die
Bildschirmsperre konfigurieren.

3 Geben Sie VPN-Details ein und tippen Sie auf SPEICHERN.

VPN-Einstellungen konfigurieren

1 Tippen Sie in der Liste VPNS auf ein Netzwerk.

7 Geben Sie die Anmeldeinformationen fur das VPN-Benutzerkonto ein
und tippen Sie auf VERBINDEN.

« Aktivieren Sie das Kontrollkastchen Kontoinformationen
speichern, um die Anmeldeinformationen zu speichern.

Tone & Benachrichtigungen

Sie konnen die Einstellungen fur Sound, Vibration und
Benachrichtigungen anpassen.

Tippen Sie auf dem Einstellungsbildschirm auf Tone &
Benachrichtigungen und passen Sie die folgenden Einstellungen an:

- Tonprofil: Andert den Soundmodus in Téne, Lautlos oder Nur
vibrieren.

Lautstarke: Lautstarke flr verschiedene Elemente einstellen.

Klingelton: Zur Auswahl eines Klingeltons fr eingehende Anrufe.
Klingeltdne hinzufiigen oder l6schen.

Kontakt-Klingelton: Klingelton fir eingehende Anrufe von einem
bestimmten Kontakt erstellen. \Weitere Informationen finden Sie unter
Kontakt-Klingelton.

- Vibrationstarke: Vibrationsintensitat andern.
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- Ton mit Vibration: Festlegen, dass das Gerat bei Benachrichtigungen
vibriert und einen Klingelton wiedergibt.

- Vibrationstyp: Sie kdnnen einen Vibrationstyp auswahlen oder ein
eigenes Vibrationsmuster erstellen.

+ Nicht storen: Uhrzeit, Zeitraum und App-Typ zum Empfang von
Benachrichtigungen festlegen. Benachrichtigungen nur an bestimmten
\Wochentagen erhalten. Weitere Informationen finden Sie unter Nicht
stéren.

+ Sperrbildschirm: Benachrichtigungen auf dem Sperrbildschirm
anzeigen oder ausblenden. Personliche Informationen kénnen
ebenfalls ausgeblendet werden.

+ Apps: Apps auswahlen, deren Benachrichtigungen auf dem Bildschirm
angezeigt werden konnen. Sie kdnnen auch festlegen, mit welcher
Prioritat die Benachrichtigungen dieser Apps angezeigt werden sollen.

- Benachrichtigungs-LED: Geratestatus tber die LED anzeigen.

+ Mehr > Benachrichtigungston: Klingelton fiir Benachrichtigungen
auswahlen. Auf dem Gerat gespeicherte Musik als Klingelton far
Benachrichtigungen festlegen.

+ Mehr > Vibrieren beim Tippen: Festlegen, dass das Gerat vibriert,
wenn Sie auf bestimmte Bildschirmelemente tippen.

- Mehr > Sound-Effekte: Einen Soundeffekt auswahlen, der
wiedergegeben wird, wenn Sie auf die Wahltastatur tippen, eine
Option auswahlen oder den Bildschirm sperren oder entsperren.

+ Mehr > Sprachbenachrichtigungen fiir Nachrichten/Anrufe:
Festlegen, dass das Gerat die Anruferinformationen oder
Nachrichteninhalte vorliest.

Anzeige

Sie konnen detaillierte Einstellungen fir jeden Bildschirm anpassen.

Tippen Sie auf dem Einstellungsbildschirm auf Anzeige und passen Sie
die folgenden Einstellungen an:

- Homescreen: Einstellungen flr den Startbildschirm anpassen. Weitere
Informationen finden Sie unter Startbildschirmeinstellungen.
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Sperrbildschirm: Einstellungen zum Sperren des Bildschirms
anpassen. Weitere Informationen finden Sie unter Einstellungen zum
Sperren des Bildschirms.

- Bedienungsleiste: Schaltflachen auf dem Startbildschirm neu
anordnen oder Hintergrundfarben andern. Schaltflachen auf dem
Startbildschirm ausblenden.

Schriftart: Schriftart andern.

SchriftgroRe: SchriftgroRe andern.
Fetter Text: Text auf Bildschirm fett darstellen.

+ Helligkeit: Verwenden Sie den Schieberegler, um die
Bildschirmhelligkeit zu andern.

Automatisch: Legen Sie die Gerateeinstellungen so fest, dass die
Bildschirmhelligkeit entsprechend der Umgebungslichtintensitat
automatisch angepasst wird.

+ Always-on display: Informationen wie Datum, Uhrzeit und
Benachrichtigungen auch anzeigen, wenn der Bildschirm ausgeschaltet
ist. Weitere Informationen finden Sie unter Always On Display.

Automatisch drehen: Bildschirm automatisch entsprechend der

Gerateausrichtung drehen.

- Bildschirmabschaltung: Bildschirm automatisch ausschalten, wenn
das Gerat fur einen bestimmten Zeitraum nicht verwendet wird.

+ Mehr > Tagtraum: Bildschirmschoner anzeigen, wenn das Gerat mit

einer Dockingstation verbunden ist oder geladen wird. Wahlen Sie den
Typ des anzuzeigenden Bildschirmschoners aus.

Mehr > Kalibrierung des Bewegungssensors: \Winkel und
Geschwindigkeit des Bewegungssensors anpassen, um die
Neigungsgenauigkeit und Geschwindigkeit des Sensors zu verbessern.

E « Stellen Sie bei der Justierung des Bewegungssensors sicher; dass das
Gerat auf einer ebenen Flache liegt. Bei Nichtbeachtung kann es zu
Fehlern im Zusammenhang mit den Bewegungssensorfunktionen
kommen, wie beispielsweise bei der automatischen Bildschirmdrehung.
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Allgemein

Sprache und Tastatur
Sie konnen die Einstellungen fur Sprache und Tastatur des Gerats
anpassen.
1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Sprache
und Tastatur.
7 Passen Sie die folgenden Einstellungen an:
« Sprache: Sprache fur das Gerat auswahlen.

- Gegenwartige Tastatur: Derzeit verwendeten Tastaturtyp
anzeigen. Wahlen Sie die zur Texteingabe zu verwendende Tastatur
aus.

+ LG Tastatur: LG Tastatureinstellungen anpassen.

- Google Spracheingabe: Optionen fiir die Google-Funktion zum
Diktieren von Text festlegen.

- Text-zu-Sprache Ausgabe: Einstellungen fir die Text-in-Sprache-
Ausgabe festlegen.

- Zeigergeschwindigkeit: Zeigergeschwindigkeit einer Maus oder
eines Touchpads anpassen.

- Tasten vertauschen: Die wichtigsten direkten Aktionen mit der
rechten statt mit der linken Maustaste durchfthren.

Standort

Sie konnen anpassen, wie Standortinformationen von einzelnen Apps
verwendet werden dirfen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Standort.

7 Passen Sie die folgenden Einstellungen an:

+ Modus: Eine Methode zur Verwendung lhrer Standortdaten
auswahlen.
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+ Mein Ort: Zulassen, dass das Gerat haufig besuchte Orte analysiert,
damit es automatisch eine Wohnadresse erkennen kann.

- KURZLICHE STANDORTABFRAGEN: Apps anzeigen, die kiirzlich
Standortinformationen angefordert haben.

- Standortbestimmung mit niedriger Leistungsaufnahme:
Gerateposition abschatzen, um weniger Strom zu verbrauchen.

- Kamera: Standortinformationen mit Fotos oder Videos speichern.

- Google-Standortverlauf: Einstellungen fir den Google-
Standortverlauf festlegen.

Konten & Synchronisation

Sie konnen Konten hinzuftigen und verwalten, einschlieflich eines
Google-Kontos. AuRerdem kénnen Sie automatisch bestimmte Apps oder
Benutzerinformationen synchronisieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Konten &
Synchronisation.
7 Passen Sie die folgenden Einstellungen an:

- Daten autom. synchronisieren: Alle registrierten Konten
automatisch synchronisieren.

- KONTEN: Eine Liste registrierter Konten anzeigen. Tippen Sie auf
ein Konto, um Details anzusehen oder zu andern.

- KONTO HINZUFUGEN: Konten hinzufiigen.

Cloud-Dienste

Sie konnen ein Cloud-Konto registrieren und auf dem Computer oder in
der Cloud gespeicherte Inhalte auf dem Gerat anzeigen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Cloud-
Dienste.

2 Passen Sie die Einstellungen an.
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Benutzer
Sie konnen Benutzer hinzufligen, mit denen Ihr Gerat geteilt werden soll.
1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Benutzer.

7 Passen Sie die Einstellungen an.

Bedienungshilfen
Sie konnen die auf hrem Gerat installierten Plug-Ins zur erleichterten
Bedienung verwalten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein >
Bedienungshilfen.
7 Passen Sie die folgenden Einstellungen an:

- Sehen > TalkBack: Festlegen, dass das Gerat den Bildschirmstatus
oder Aktionen per Sprache meldet.

+ Sehen > Sprachbenachrichtigungen fiir Nachrichten/Anrufe:
Festlegen, dass das Gerat die Anruferinformationen oder
Nachrichteninhalte vorliest.

- Sehen > SchriftgroRe: SchriftgroRe andern.
- Sehen > Fetter Text: Text auf dem Bildschirm fett darstellen.

+ Sehen > Touch-Zoom: Den Bildschirm durch dreimaliges Tippen
vergroRern oder verkleinern.

- Sehen > Umkehr der Bildschirmfarbe: Bildschirmkontrast fiir
Personen mit Sehschwache erhohen.

- Sehen > Farbeinstellung des Bildschirms: Bildschirmfarben
anpassen.

- Sehen > Graustufen: Bildschirm in den Graustufenmodus
umschalten.

+ Sehen > Anrufe mit der Ein-/Aus-Taste beenden: Gesprach durch
Driicken der Ein-/Aus-/Sperrtaste beenden.

+ Horen > Untertitel: Beim \Wiedergeben von Videos fr
Horgeschadigte den Untertitel-Dienst aktivieren.

+ Horen > Benachrichtigungs-LED: Geratestatus Uber die LED
anzeigen.
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- Horen > Blitz-Benachrichtigungen: Festlegen, dass das Gerat
Sie Uiber eingehende Anrufe und Benachrichtigungen mit einem
Blinklicht informiert.

+ Horen > Alle Tone deaktivieren: Alle Sounds abschalten und die
Lautstarke am Horer verringern.

+ Horen > Audio-Typ: Audiotyp auswahlen.

+ Horen > Klangabgleich: Audioausgangsbalance anpassen.
Verwenden Sie den Schieberegler, um die Balance zu andern.

+ Motorik & Wahrnehmung > Touch assistant: Bedienfeld
aktivieren, damit Schaltflachen und Gesten einfacher zu verwenden
sind.

+ Motorik & Wahrnehmung > Verzégerung beim Beriihren und
halten: Bertihrungsdauer anpassen.

+ Motorik & Wahrnehmung > Fiir Anrufe beriihrt halten: Anrufe
durch Bertihren und Halten der Anruftaste statt durch Ziehen
annehmen oder ablehnen.

+ Motorik & Wahrnehmung > Bildschirmabschaltung: Bildschirm
automatisch ausschalten, wenn das Gerat flr einen bestimmten
Zeitraum nicht verwendet wird.

+ Motorik & Wahrnehmung > Touch-Control-Bereiche: Touch-
Bereich begrenzen, sodass nur ein bestimmter Teil des Bildschirms
durch Touch-Eingabe gesteuert werden kann.

- Bedienungshilfen-Funktionen-Shortcut: Auf haufig verwendete
Funktionen durch dreimaliges Tippen auf O schnell zugreifen.

- Bildschirm automatisch drehen: Bildschirmausrichtung
automatisch entsprechend der Gerateposition andern.

+ Schalterzugriff: Tastenkombinationen zur Steuerung des Gerats
erstellen.
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Schnellzugriff-Tasten
Sie konnen die Lautstarketasten verwenden, um Apps direkt zu starten,
wenn der Bildschirm ausgeschaltet oder gesperrt wird.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein >

Schnellzugriff-Tasten.

2 Schieben Sie (33 nach rechts, um die Funktion zu aktivieren.

- Drticken Sie zweimal die Taste ,Lautstarke verringern” (-), um
die App Kamera zu starten, wenn der Bildschirm gesperrt oder
ausgeschaltet ist. Driicken Sie zweimal die Taste ,Lautstarke
erhohen” (+), um Capture+ zu starten.

- Aktivieren Sie Schnellausléser, wenn unmittelbar nach Einschalten
der Kamera durch Driicken der Taste , Lautstarke verringern” (-)
Fotos aufgenommen werden sollen.

Google-Dienste

Sie konnen lhre Google-Apps und Kontoeinstellungen mit Google-
Einstellungen verwalten.

Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Google-
Dienste.

Fingerabdriicke & Sicherheit

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein >

Fingerabdriicke & Sicherheit.

7 Passen Sie die folgenden Einstellungen an:

- Fingerabdriicke:|hren Fingerabdruck zum Entsperren des
Bildschirms oder von Inhalten verwenden. Weitere Informationen
finden Sie unter Ubersicht: Fingerabdruckerkennung.

- Inhaltssperre: Methode zum Sperren von Dateien in der Galerie
oder QuickMemo+ festlegen.
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- SD-Karte verschliisseln: Speicherkarte verschlisseln, um die
Verwendung auf einem anderen Gerat zu verhindern. Weitere
Informationen finden Sie unter Verschltisselung der Speicherkarte.

« SIM-Sperre einrichten: SIM-Karte sperren oder entsperren oder
Passwort (PIN) andern.

- Passworteingabe sichtbar: Passwort bei der Eingabe anzeigen.

- Gerateadministratoren: Bestimmte Apps durfen die Steuerung
oder Verwendung des Gerats einschranken.

- Unbekannte Quellen:Installation von nicht aus dem Play Store
stammenden Apps erlauben.

- Apps uberpriifen:Installation schadlicher Apps blockieren. Eine
Warnmeldung anzeigen, wenn eine schadliche App installiert wird.

+ Schutz der Benutzerdaten: Typ des Speichers anzeigen, auf dem
das Sicherheitszertifikat gespeichert wird.

Zertifikate Verwaltung: Auf dem Gerat gespeichertes
Sicherheitszertifikat verwalten.

- Trust agents: Auf dem Gerat gespeicherte Trust Agents anzeigen
und verwenden.

- Bildschirm anheften: App-Bildschirm fixieren, sodass nur die
derzeit aktive App verwendet werden kann.

- Apps mit Nutzungsdatenzugriff: Details zur Nutzung von Apps
auf dem Gerat anzeigen.

Smart settings

Gerateeinstellungen konnen je nach Nutzungsmuster und Standort
automatisch geandert werden.

E + Bevor Sie die Smart-Einstellungen verwenden kdnnen, missen Sie
die Wohnadresse festlegen. Weitere Informationen finden Sie unter
Standort.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Smart
settings.

2 Elemente aktivieren, deren Einstellungen automatisch geandert
werden sollen.
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Datum und Uhrzeit
Sie konnen die Einstellungen fir Datum und Uhrzeit des Gerats anpassen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Datum
und Uhrzeit.

7 Passen Sie die Einstellungen an.

Speicherplatz & USB

Sie kénnen den internen Geratespeicher oder den Speicherplatz auf der
Speicherkarte anzeigen und verwalten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein >
Speicherplatz & USB.
7 Passen Sie die folgenden Einstellungen an:
« Interner Speicher: Gesamten Speicherplatz und freien
Speicherplatz im internen Speicher des Gerats anzeigen. Liste der
verwendeten Apps und den Speicherbedarf jeder App anzeigen.

- PORTABLER SPEICHERPLATZ: Gesamten Speicherplatz und
freien Speicherplatz auf der Speicherkarte anzeigen. Diese Option
wird nur angezeigt, wenn eine Speicherkarte eingelegt ist. Tippen
Sie zum Auswerfen der Speicherkarte auf A,

Akku & Energiesparen

Sie konnen aktuelle Akkuinformationen anzeigen oder den

Energiesparmodus aktivieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Akku &
Energiesparen.

7 Passen Sie die folgenden Einstellungen an:

+ Akkuverbrauch: Details zur Akkunutzung anzeigen. Wahlen Sie ein
bestimmtes Element aus, um weitere Informationen anzuzeigen.

- Akkuladung in Prozent in der Statusleiste: Verbleibende
Akkukapazitat in Statusleiste in Prozent anzeigen.
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+ Akkusparmodus: Stromverbrauch durch Einschranken einiger
Gerateeinstellungen wie Anzeigehelligkeit, Taktrate und
Vibrationsintensitat verringern. In der Statusleiste wird W&
angezeigt, wenn der Energiersparmodus aktiviert ist.

- Spiel-Optimierung: Videoqualitat anpassen, um den
Stromverbrauch beim Spielen zu verringern.

Speicher

Sie konnen die durchschnittliche Speichernutzung Uber einen bestimmten
Zeitraum und den von einer App belegten Speicher anzeigen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Speicher.

2 Tippen Sie auf w, um einen Zeitraum zum Abrufen der Daten
festzulegen.

Smart Doctor

Sie kénnen die Funktion ,Smart Doctor” verwenden, um eine Diagnose
Uber den Zustand des Gerdts zu erstellen und das Gerat zu optimieren.

Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Smart
Doctor aus.

E « Weitere Informationen finden Sie unter Smart Doctor.

Apps
Sie konnen eine Liste der installierten Apps anzeigen und Apps bei Bedarf
beenden oder loschen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Apps.
2 Wahlen Sie eine App aus und fiihren Sie Aktionen aus.
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Tippen & Bezahlen

Sie konnen Zahlungen mit hrem Gerat anstelle einer Kreditkarte
vornehmen.

Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Tippen &
Bezahlen.

Sichern & zuriicksetzen

Sie konnen eine auf Ihrem Gerat gespeicherte Datensicherung auf einem
anderen Gerat oder in einem anderen Konto speichern. AuRerdem kénnen
Sie das Gerat bei Bedarf zurlicksetzen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Sichern &
zuriicksetzen.

7 Passen Sie die folgenden Einstellungen an:

.

5

LG Backup: Alle auf dem Gerat gespeicherten Daten sichern
und wiederherstellen. Weitere Informationen finden Sie unter LG
Backup.

Meine Daten sichern: App-Daten, WLAN-Passwort und andere
Einstellungen auf dem Google-Server sichern.

Sicherungskonto: Derzeit zur Datensicherung verwendetes Konto
anzeigen.

Automatische Wiederherstellung: Beim erneuten Installieren
einer App automatisch gesicherte Einstellungen und Daten
wiederherstellen.

Netzwerkeinstellungen zuriicksetzen: WWLAN-, Bluetooth- und
andere Netzwerkeinstellungen zurticksetzen.

Auf Werkszustand zuriick: Alle Einstellungen des Gerats
zurlicksetzen und Daten [6schen.

« Beim Zurlcksetzen des Gerats werden alle darauf befindlichen Daten
geloscht. Geben Sie den Geratenamen, das Google-Konto und andere
Informationen zur Ersteinrichtung erneut ein.
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Uber das Telefon

Sie konnen Informationen zu lhrem Gerat wie Name, Status,
Softwaredetails und rechtliche Informationen anzeigen.

Tippen Sie auf dem Einstellungsbildschirm auf Allgemein > Uber das
Telefon, um diese Informationen zu sehen.

Regulierungen & Sicherheit

Sie konnen Konformitatszeichen und zugeharige Informationen auf dem
Gerat anzeigen.

Tippen Sie auf dem Einstellungsbildschirm auf Allgemein >
Regulierungen & Sicherheit.
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LG Spracheinstellungen

Wahlen Sie eine Sprache fir das Gerat aus.

- Tippen Sie auf O > Einstellungen > Allgemein > Sprache und
Tastatur > Sprache und wahlen Sie eine Sprache aus.

LG Bridge

Ubersicht: LG Bridge

Mit der App ,LG Bridge" konnen Sie die auf lhrem LG Smartphone
gespeicherten Fotos, Musiktitel, Videos und Dokumente bequem auf
Ihrem Computer verwalten. Sie kénnen beispielsweise Kontakte und
Fotos auf dem Computer sichern oder die Geratesoftware aktualisieren.

E « Weitere Informationen finden Sie in der Hilfe zu LG Bridge.
+ Die unterstitzten Funktionen kénnen je nach Gerat unterschiedlich sein.

+ Der LG USB-Treiber ist ein Programm, das flr die Verbindung lhres
LG Smartphones mit einem Computer erforderlich ist und bei der
Installation von LG Bridge installiert wird.

Funktionen von LG Bridge

+ Sie konnen die auf dem Gerat gespeicherten Dateien tiber WLAN oder
eine mobile Datenverbindung auf einem Computer verwalten.

+ Sie koénnen auf dem Gerat gespeicherte Daten Uber eine USB-Kabel-
Verbindung auf einem Computer sichern oder auf einem Computer
gespeicherte Daten auf dem Gerat wiederherstellen.

+ Sie konnen die Geratesoftware mittels USB-Kabel-Verbindung tiber
einen Computer aktualisieren.
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LG Bridge auf einem Computer installieren
T Rufen Sie auf Ihrem Computer www.lg.com auf.
2 Geben Sie in der Suchleiste den Namen des Gerats ein.

3 Klicken Sie auf ANLEITUNGEN & DOWNLOADS > LG Bridge und
laden Sie die Datei herunter.
- Klicken Sie auf Details, um die Mindestanforderungen fir die
Installation von LG Bridge anzuzeigen.

Telefonsoftware-Update

LG Mobile-Telefonsoftware-Update aus dem

Internet

Weitere Informationen zur Verwendung dieser Funktion finden Sie unter
http//www.lg.com/common/index.jsp. Wahlen Sie dort Ihr Land und lhre
Sprache aus.

Mit dieser Funktion kénnen Sie die Firmware des Telefons bequem

Uiber das Internet auf eine neuere Version aktualisieren, ohne ein
Servicezentrum aufsuchen zu mussen. Diese Funktion steht nur zur
Verfligung, wenn LG eine neuere Firmware-Version fur lhr Gerat zur
Verfligung gestellt hat.

Wahrend der Aktualisierung der Firmware eines Mobiltelefons mussen
Sie samtliche Anweisungen und Hinweise, die zu einem Schritt angezeigt
werden, genau Uberprifen, bevor Sie fortfahren. VWenn Sie bei der
Aktualisierung das USB-Kabel abziehen, kann das Mobiltelefon schwer
beschadigt werden.

E « LG behalt sich das Recht vor, Firmware-Updates nach eigenem
Ermessen nur flr ausgewahlte Modelle zur Verfiigung zu stellen.
AuRerdem garantiert LG nicht die Verfligbarkeit einer neueren
Firmware-Version fir alle Telefonmodelle.
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LG Mobile-Softwareupdate iiber Over-the-Air
(OTA)

Mit dieser Funktion kénnen Sie die Software Ihres Telefons bequem auf
eine neue Version aktualisieren, ohne dazu ein USB-Kabel anschlieRen zu
mussen. Diese Funktion steht nur zur Verfligung, wenn LG eine neuere
Firmware-Version fur Ihr Gerat zur Verfligung gestellt hat.

Uberpriifen Sie zunachst die Softwareversion lhres Mobiltelefons:

Einstellungen > Allgemein > Uber das Telefon > Update-Center >
Software Update > Jetzt auf Updates priifen.

E - Ihre personlichen Daten aus dem internen Telefonspeicher -
einschlieRlich Informationen tiber Ihr Google-Konto und alle anderen
Konten, Ihre System-/Anwendungsdaten und -einstellungen,
heruntergeladene Anwendungen und Ihre DRM-Lizenz - konnten bei der
Aktualisierung der Software des Telefons verloren gehen. LG empfiehlt
daher, dass Sie lhre personlichen Daten sichern, bevor Sie die Software
des Telefons aktualisieren. LG Ubernimmt keine Haftung fur den Verlust
von personlichen Daten.

« Diese Funktion hangt vom Gebiet oder Netzanbieter ab.

Haufig gestellte Fragen

In diesem Kapitel werden einige Probleme behandelt, die bei der
Verwendung des Telefons auftreten kénnen. Bei einigen Problemen
mussen Sie lhren Netzanbieter kontaktieren, die meisten konnen Sie
jedoch selbst einfach beheben.
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Fehlermeldung

Mégliche Ursachen

Mégliche AbhilfemaRnahmen

SIM-Kartenfehler

Im Telefon ist keine
SIM-Karte eingelegt
oder die Karte ist
falsch eingelegt.

Vergewissern Sie sich, dass die
SIM-Karte richtig eingelegt ist.

Keine
Netzwerkverbindung/
Verbindung verloren

Das Signal ist schwach
oder Sie befinden

sich auRerhalb des
Netzbetreibernetzes.

Gehen Sie zu einem Fenster
oder ins Freie. Uberpriifen
Sie die Abdeckungskarte des
Netzbetreibers.

Betreiber hat neue
Dienste installiert.

Uberprtifen Sie, ob die SIM-Karte
mehr als 6 bis 12 Monate alt ist.
Ist dies der Fall, tauschen Sie die
SIM- oder USIM-Karte bei der
nachstgelegenen Niederlassung
lhres Netzanbieters aus.
\Wenden Sie sich an den
Netzanbieter.

Codes stimmen
nicht tberein

Zum Andern eines
Sicherheitscodes
mussen Sie den neuen
Code bestatigen,
indem Sie ihn erneut
eingeben.

Die beiden von lhnen
eingegebenen Codes

stimmen nicht Uberein.

\Wenden Sie sich an lhren
Netzbetreiber, falls Sie den Code
vergessen haben.

Anwendungen
kénnen nicht
genutzt werden

\Vom Netzanbieter
nicht unterstitzt
oder Registrierung
erforderlich

Wenden Sie sich an den
Netzanbieter.

Heruntergeladene
Anwendung
verursacht viele
Fehler.

Deinstallieren Sie die
Anwendung.

1. Tippen Sie auf O >
Einstellungen.

2.Tippen Sie auf Allgemein >
Apps.

3.Tippen Sie auf die App >
Deinstallieren.
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Fehlermeldung

Mégliche Ursachen

Mégliche AbhilfemaRnahmen

Anrufe nicht
moglich

Fehler beim Wahlen

Das neue Netz ist unzulassig.

Neue SIM-Karte
eingelegt.

Priifen Sie auf neue
Einschrankungen.

Prepaid-Gebuhrenlimit
erreicht.

\Wenden Sie sich an den
Netzanbieter oder setzen Sie
das Limit mit PIN2 zurtck.

Telefon kann nicht
eingeschaltet
werden

Ein-/Aus-Taste zu kurz
gedrickt.

Driicken Sie die Ein-/Aus-Taste
fur mindestens zwei Sekunden.

Akku ist nicht geladen.

Laden Sie den Akku. Uberpriifen
Sie die Ladeanzeige auf dem
Bildschirm.

Fehler beim Laden

Akku ist nicht geladen.

Laden Sie den Akku.

AuRentemperatur zu
hoch oder niedrig.

Stellen Sie sicher, dass das
Telefon bei normaler Temperatur
geladen wird.

Kontaktproblem

Uberpriifen Sie das Ladegerat
und seine Verbindung mit dem
Telefon.

Keine Spannung

Stecken Sie das Ladegerat in
eine andere Steckdose.

Ladegerat defekt

Ersetzen Sie das Ladegerat.

Falsches Ladegerat

Verwenden Sie nur LG Original-
Zubehor.

Nummer nicht
zulassig.

Die Funktion
JAnrufbegrenzung” ist
aktiviert.

Offnen Sie das Menii
,Einstellungen” und schalten Sie
die Funktion aus.

SMS und Fotos
konnen nicht
empfangen oder
gesendet werden

Speicher voll

Loschen Sie Daten wie
Anwendungen oder Nachrichten
vom Telefon, um mehr Speicher
zur Verfligung zu stellen.
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Fehlermeldung

Mégliche Ursachen

Mégliche AbhilfemaRnahmen

Dateien lassen sich
nicht 6ffnen

Nicht unterstitztes
Dateiformat

Uberprifen Sie die
unterstitzten Dateiformate.

Der Bildschirm
schaltet sich nicht
ein, wenn ein Anruf
eingeht.

Problem mit
Naherungssensor

Wenn Sie eine Schutzhllle
verwenden, darf diese

den Bereich um den
Naherungssensor nicht
bedecken. Stellen Sie sicher,
dass der Bereich um den
Naherungssensor sauber ist.

Kein Sound

Vibrationsmodus

Uberprtifen Sie die
Einstellungen im Menu ,Téne
& Benachrichtigungen” um
sicherzustellen, dass nicht der
Modus ,Nur vibrieren” oder
Nicht storen” aktiv ist.

Telefon hangt sich
auf oder stlrzt ab

Vorlbergehendes
Softwareproblem

Wenn der Bildschirm einfriert
oder das Telefon nicht reagiert,
entfernen Sie den Akku und
setzen Sie ihn wieder ein.
Schalten Sie das Telefon
anschlieBend wieder ein.

Oder versuchen Sie, ein
Softwareupdate Uber die
Website durchzufiihren.

Akkumodul
Uberpriifen

Falsches Akkumodul
eingesetzt.
Beschadigtes Modul
eingesetzt oder
Modul nicht richtig
eingesetzt.

Weitere Informationen finden
Sie unter ,Akku einsetzen”

Die Geratespezifikationen
konnen je nach Gebiet und
Netzanbieter variieren. Wenn
Sie zusatzliche Akkumodule
oder kompatible optionale
Komponenten kaufen
mochten, wenden Sie sich an
ein Servicezentrum von LG
Electronics.
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Diebstahlschutz

Richten Sie Ihr Gerat so ein, dass andere Personen es nicht

mehr verwenden konnen, wenn es ohne lhre Erlaubnis auf die
Werkseinstellungen zurlickgesetzt wird. \Wenn beispielsweise |hr Gerat
verloren geht, gestohlen oder geldscht wird, kann nur jemand mit Ihrem
Google-Konto oder mit Kenntnis der Informationen zum Sperren des
Bildschirms das Gerat verwenden.

Damit stellen Sie sicher, dass |hr Gerat geschutzt ist:

Bildschirmsperre festlegen: \Wenn Sie eine Bildschirmsperre festgelegt
haben und Ihr Gerat verloren geht oder gestohlen wird, kann das
Gerat Uber das Ment ,Einstellungen” nur geldscht werden, wenn der
Bildschirm entsperrt ist.

Dem Gerat Ihr Google-Konto hinzufiigen: Wenn |hr Gerat geloscht
wird und sich darauf ein Google-Konto befindet, kann das Gerat

den Einrichtungsvorgang nur abschlieen, wenn lhre Google-
Kontoinformationen erneut eingegeben werden.

Wenn Ihr Gerat geschitzt ist, missen Sie den Bildschirm entsperren
oder das Passwort |hres Google-Kontos eingeben, um das Telefon auf die
Werkseinstellungen zurlickzusetzen. Dies stellt sicher; dass nur Sie selbst
oder Personen Ihres Vertrauens das Telefon zurticksetzen konnen.

E « Prifen Sie, ob Sie noch die Anmeldeinformationen Ihres Google-Kontos
kennen, das Sie Ihrem Gerat hinzugefiigt haben, bevor Sie es auf die
Werkseinstellungen zurlicksetzen. \Wenn Sie die Kontoinformationen
wahrend der Installation nicht eingeben konnen, ldsst sich das Gerat
nach dem Zuriicksetzen auf die Werkseinstellungen tiberhaupt nicht
mehr verwenden.
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Weitere Informationen

Information: Hinweis beziiglich Open-Source-
Software

Den in diesem Produkt enthaltenen Quellcode unter GPL, LGPL,

MPL sowie weiteren Open-Source-Lizenzen konnen Sie unter
http//opensource.lge.com herunterladen.

Neben dem Quellcode stehen dort noch alle Lizenzbedingungen, auf die
verwiesen wird, Garantieausschlisse sowie Urheberrechtshinweise zum
Download bereit.

LG Electronics stellt Ihnen gegen eine Gebuhr (fur Distribution, Medien,
Versand und Verwaltung) auch den Quellcode auf CD-ROM bereit.
Wenden Sie sich per E-Mail an LG Electronics: opensource@!|ge.com.
Dieses Angebot ist drei (3) Jahre ab Kaufdatum des Produkts giltig.

Informationen zu Bestimmungen

Einzelheiten zu Bestimmungen finden Sie unter Einstellungen >
Allgemein > Regulierungen & Sicherheit auf Ihrem Telefon.
Marken

Copyright ©2016 LG Electronics, Inc. Alle Rechte vorbehalten. LG
und das LG-Logo sind eingetragene Marken der LG Group und deren
zugehoriger Unternehmen.

+ Google™, Google Maps™, Gmail™, YouTube™, Hangouts™ und Play
Store™ sind Marken von Google, Inc.

- Bluetooth® ist eine eingetragene Marke von Bluetooth SIG, Inc.

+ Wi-Fi® und das Wi-Fi-Logo sind eingetragene Marken der Wi-Fi
Alliance.

+ Alle anderen Marken und Urheberrechte sind Eigentum ihrer jeweiligen
Inhaber.
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poLey Aupio  [XI1DOLBY AUDIO”

Hergestellt unter Lizenz von Dolby Laboratories. Dolby, Dolby Audio und
das Doppel-D-Symbol sind Marken von Dolby Laboratories.

Sicherheitshinweise zu Lasern

Achtung!

Dieses Produkt beinhaltet ein Lasersystem. Um den korrekten Umgang
mit diesem Produkt zu gewahrleisten, lesen Sie dieses Benutzerhandbuch
aufmerksam durch und bewahren Sie es zur spateren Verwendung

auf. Sollte das Produkt gewartet werden missen, kontaktieren Sie ein
autorisiertes Service-Center.

Wenn fir die Steuerung, Einstellungen oder bestimmte Vorgange
andere Prozesse verwendet werden als die in diesem Benutzerhandbuch
angegebenen, kann dies zu gesundheitsgefahrdender Strahlenbelastung
fuhren.

Versuchen Sie nicht, das Gehause zu 6ffnen oder den Laser zu berthren,
um sich ihm nicht direkt auszusetzen.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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KONFORMITATSERKLARUNG

LG Electronics erklart hiermit, dass das LG-H840 den wichtigsten
Anforderungen und anderen relevanten Bestimmungen der Richtlinie
1999/5/EC entspricht. Eine Kopie der Konformitatserklarung finden Sie
unter http//www.lg.com/global/declaration

Kontakt fiir Produktkonformitat
LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)
Dieses Gerat kann in allen europdischen Landern verwendet werden.

Der Frequenzbereich von 5150 bis 5350 MHz ist auf die Nutzung in
Innenraumen beschrankt.

AT |BE |BG|CH HR|CY|CZ DK|EE| FI |[FR|DE|GR|HU| IE | IT | LI |LV
LT |LU |MT|NO|NL|PL|PT |RO|SK|SI'|ES|SE|GB| IS |ME RS |TR |MK
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Entsorgung lhrer Altgerate

1. Das durchgestrichene Symbol eines fahrbaren Abfallbehalters weist
darauf hin, dass Elektro- und Elektronik-Produkte (WEEE) getrennt
vom Hausmdull entsorgt werden missen.

B 2 Alte elektrische Produkte kénnen gefahrliche Substanzen enthalten,
die eine korrekte Entsorgung dieser Altgerate erforderlich machen,
um schadliche Auswirkungen auf die Umwelt und die menschliche
Gesundheit zu vermeiden. Ihre ausgedienten Gerate kénnen
wiederverwendbare Teile enthalten, mit denen moglicherweise
andere Produkte repariert werden konnen, aber auch sonstige
wertvolle Materialien enthalten, die zur Schonung knapper
Ressourcen recycelt werden kdnnen.

3. Sie konnen Ihr Gerat entweder in den Laden zurlckbringen, in dem
Sie das Produkt urspringlich erworben haben, oder Sie kontaktieren
lhre Gemeindeabfallstelle fir Informationen tber die nachstgelegene
autorisierte WEEE-Sammelstelle. Die aktuellsten Informationen fiir
Ihr Land finden Sie unter www.lg.com/global/recycling

Entsorgen von alten Akkus

1. Dieses Symbol kann mit den chemischen Symbolen fiir Quecksilber
(Hg), Kadmium (Cd) oder Blei (Pb) kombiniert sein, wenn die Akkus
mehr als 0,0005 % Quecksilber, 0,002 % Kadmium oder 0,004 %
Blei enthalten.

2. Akkus missen immer getrennt vom Hausmdill in staatlichen
oder kommunalen Sammeleinrichtungen und entsprechend den
geltenden Vorschriften entsorgt werden.

3. Durch eine vorschriftsmaRige Entsorgung lhrer alten Akkus kénnen
schadliche Auswirkungen auf Mensch, Tier und Umwelt vermieden
werden.

4. Ausfuhrliche Informationen zur Entsorgung alter Akkus erhalten
Sie bei den lokalen Behorden, der Entsorgungseinrichtung oder dem
Fachhandler, bei dem Sie das Produkt erworben haben.
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[TALIANO

Info sulla qguida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro
e corretto del dispositivo, si prega di leggere con attenzione la guida
per l'utente prima di utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in
dotazione sono progettati esclusivamente per questo dispositivo e
potrebbero non essere compatibili con altri dispositivi.

Il dispositivo non & adatto a persone ipovedenti a causa della
tastiera touchscreen.

Le descrizioni si basano sulle impostazioni predefinite del
dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad
aggiornamenti e il supporto per tali applicazioni puo essere
sospeso senza preawiso. Per eventuali domande relative alle app
preinstallate sul dispositivo, contattare un Centro di assistenza LG.
Per le app installate dall'utente, contattare il provider del servizio di
riferimento.

La modifica del sistema operativo del dispositivo o l'installazione di
software provenienti da fonti non ufficiali potrebbe danneggiare

il dispositivo e causare il danneggiamento o la perdita di dati. Tali
azioni costituiscono una violazione dell'accordo di licenza LG e
annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo
acquistato a seconda dell'area, del provider del servizio, della
versione del software o del sistema operativo e sono soggetti a
modifiche senza preawviso.

| software, audio, gli sfondi, le immagini e gli altri elementi
multimediali forniti con questo dispositivo sono concessi in licenza
per uso limitato. Lestrazione e ['utilizzo di questi materiali per scopi
commerciali o altri scopi potrebbe costituire una violazione delle
leggi sul copyright. La piena responsabilita per ['utilizzo illegale
degli elementi multimediali spetta agli utenti.



- | servizi relativi ai dati, come ad esempio messaggistica,
caricamento e download, sincronizzazione automatica o servizi
di posizionamento, potrebbero comportare costi aggiuntivi. Per
evitare costi aggiuntivi, selezionare un piano dati adeguato alle
proprie esigenze. Per ulteriori informazioni, rivolgersi al proprio
gestore di telefonia mobile.

La presente guida per ['utente & redatta nelle principali lingue
per ogni paese. A seconda della lingua di redazione, i contenuti
potrebbero in parte variare.

Notifiche informative

A AVVERTENZA: situazioni che potrebbero provocare lesioni all'utente
e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o
danni al dispositivo.

E NOTA: awvisi o informazioni aggiuntive.

Info sulla guida per [utente
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di seguito. Il mancato rispetto di tali
indicazioni puo rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un
registro degli errori. Questo strumento raccoglie solo i dati specifici dellerrore
come lintensita del segnale, la “cell ID position” quando la chiamata viene
interrotta e le applicazioni caricate. Il registro viene utilizzato solo per
determinare la causa dellerrore. Questi registri sono crittografati e possono
essere aperti solo nei centri di riparazione LG autorizzati, nel caso sia
necessario restituire il dispositivo per la riparazione.

Esposizione all'energia elettromagnetica a

radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption

Rate) Il modello di telefono cellulare LG-H840 é stato progettato in

conformita ai requisiti di sicurezza vigenti per lesposizione alle onde radio.

Tali requisiti si basano su precise indicazioni scientifiche che definiscono, tra

laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,

indipendentemente dalleta e dalle condizioni di salute.

+ Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di

misura detta SAR, acronimo per Specific Absorption Rate. Le prove relative
ai valori SAR sono state condotte mediante un metodo standardizzato di
trasmissione telefonica al massimo livello di alimentazione certificato, con
qualsiasi banda di frequenza.

+ Anche se si possono riscontrare differenze tra i livelli SAR nei vari modelli
di telefoni cellulari LG, questi sono comunque stati progettati con
unattenzione particolare alle normative vigenti sullesposizione alle onde
radio.

+ La commissione internazionale ICNIRP (International Commission on Non-
lonizing Radiation Protection) raccomanda un limite SAR paria 2 W/kg in
media per dieci grammi di tessuto.

« Il valore SAR pil elevato registrato per questo modello di telefono cellulare
per 'uso vicino allorecchio & stato paria 0,981 W/kg (10 g) e pari a
1,440 W/Kg (10 g) a contatto con il corpo.



+ Questo dispositivo & conforme alle direttive sullesposizione alle
radiofrequenze quando utilizzato nella normale posizione d'uso vicino
allorecchio o posizionato a una distanza di almeno 5 mm dal corpo. Se una
custodia, una clip per cintura o un altro sostegno vengono posizionati a
stretto contatto con il corpo, tali accessori non devono contenere metallo
ed & importante mantenere il dispositivo a una distanza di almeno 5 mm
dal corpo. Il dispositivo richiede una connessione ottimale alla rete per
poter trasmettere file di dati o messaggi. In alcuni casi, la trasmissione di
file di dati o messaggi potrebbe essere ritardata fino a che tale connessione
diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Manutenzione e cura del prodotto

Usare sempre batterie, caricabatteria e accessori originali LG con questo
modello di telefono. Lutilizzo di prodotti di terzi puo risultare pericoloso ma
puo anche rendere nulla la garanzia applicata al telefono.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza
preawiso.

Non smontare lapparecchio. Se & necessaria una riparazione, rivolgersi
presso un centro assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede
nuove o riconvertite, funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere lapparecchio.

Non sottoporre l'apparecchio a scosse, urti o vibrazioni.

Spegnere il telefono nelle aree in cui & specificamente richiesto. Ad
esempio, non utilizzare apparecchio allinterno di ospedali in quanto
potrebbe interferire con il funzionamento di apparecchiature mediche
sensibili.

Non afferrare il telefono con le mani bagnate mentre € in carica.
Cio potrebbe provocare scosse elettriche o danneggiare seriamente
lapparecchio.
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Non ricaricare il telefono vicino a materiali infiammabili che potrebbero
provocare incendi a causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare
solventi come benzene, acquaragia o alcol).

Non caricare il telefono quando si trova su superfici morbide.

|l telefono dovrebbe essere caricato in unarea ben ventilata.

Non esporre lapparecchio a fumo o polvere.

Tenere lontano da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare il display con oggetti appuntiti per evitare di danneggiare il
cellulare.

Non versare liquidi sul cellulare.

Usare gli accessori con attenzione e delicatezza. Non toccare lantenna se
non strettamente necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare
il vetro, né tentare di rimuoverlo o ripararlo. | danni al display in vetro dovuti
ad abuso o utilizzo non corretto non sono coperti dalla garanzia.

Il telefono e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di
un‘adeguata ventilazione possono provocare disagi e piccole bruciature.
Pertanto, & necessario maneggiare con cura il telefono durante o subito
dopo lutilizzo.

Se il telefono si bagna, scollegarlo immediatamente e farlo asciugare
completamente. Non tentare di accelerare il processo di asciugatura con
una fonte di calore esterna, ad esempio un forno, un forno a microonde o
un asciugacapelli.

Il liquido presente nel telefono potrebbe modificare il colore delletichetta
del prodotto presente allinterno del telefono. | danni al dispositivo derivanti
dallesposizione ai liquidi non sono coperti da garanzia.

Indicazioni per un uso sicuro ed efficiente 7



Funzionamento ottimale del telefono cellulare

Dispositivi elettronici

Tutti i telefoni cellulari possono subire interferenze che influiscono sulle
prestazioni.

+ Non utilizzare il telefono in prossimita di apparecchiature mediche senza
autorizzazione. Evitare di posizionare il telefono in corrispondenza di
pacemaker, ad esempio nel taschino della giacca o della camicia.

« Il telefono potrebbe interferire con alcuni tipi di protesi acustiche.

- Il telefono potrebbe interferire con apparecchi televisivi, radio, computer,
ecc.

- Utilizzare il telefono a una temperatura compresa tra 0 °C e 35 °C, se
possibile. Lesposizione del telefono a temperature estremamente alte o
basse puo causare danni, malfunzionamenti o perfino esplosioni.

Sicurezza in automobile

Verificare le leggi e le normative che riguardano 'utilizzo dei cellulari quando si
circola sulla rete stradale.

+ Non utilizzare il telefono durante la guida.
+ Prestare la massima attenzione alla guida.

+ Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di
telefonare o rispondere a una chiamata.

- Lenergia RF puo influire sul sistema elettronico del veicolo, ad esempio
sullo stereo o sulle apparecchiature di sicurezza.

+ Seil veicolo e dotato di airbag, non collocarvi accanto oggetti come
apparecchi wireless portatili o installati per evitare lesioni gravi causate
dallerrato funzionamento dellair bag.

- Durante lascolto della musica tramite il cellulare, assicurarsi che il volume
sia ragionevolmente basso da consentire il rilevamento dei rumori
circostanti. Cio & particolarmente importante in prossimita di strade.
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Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto
volume per lunghi periodi.

L‘udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati
nel tempo. Si consiglia pertanto di non accendere o spegnere il telefono
indossando gli auricolari e di tenere il volume di ascolto delle conversazioni e
della musica a un livello ragionevole.
+ Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a
sentire le persone nelle vicinanze o se il volume ¢ tale da essere udito dalla
persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato puo causare
la perdita dell'udito.

Parti in vetro
Alcune parti del dispositivo mobile sono in vetro. Se il dispositivo viene lasciato

cadere su una superficie rigida o viene sottoposto a un forte impatto, il vetro
potrebbe rompersi. Se cio accade, non toccare o tentare di rimuovere il vetro.
Non utilizzare il dispositivo mobile finché il vetro non viene sostituito da un
provider di servizi autorizzato.

Aree a rischio di esplosione

Non utilizzare il telefono cellulare in aree dove siano in atto operazioni
di detonazione. Rispettare le restrizioni e osservare tutte le norme o i
regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il telefono cellulare in prossimita di stazioni di servizio.
+ Non utilizzare apparecchio in prossimita di combustibili o prodotti chimici.

- Non trasportare né conservare sostanze esplosive, liquidi o gas
infiammabili all'interno dellautovettura in cui si trovano dispositivi cellulari
o i relativi accessori.
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A bordo di aeromobili
L'uso di dispositivi portatili puo causare delle interferenze al velivolo.
- Spegnere il cellulare prima di imbarcarsi su qualsiasi aeromobile.

- Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso
dellequipaggio.

Bambini

Conservare il cellulare in un posto sicuro, fuori dalla portata dei bambini.
l'apparecchio e composto da parti smontabili di piccole dimensioni che, se
ingerite, possono provocare soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti
cellulari. Pertanto, si consiglia di non affidarsi solo al telefono cellulare per
eventuali chiamate di emergenza. Contattare il fornitore di servizi locale per
conoscere la disponibilita dei servizi di emergenza nel proprio paese.

Manutenzione e informazioni sulle batterie

- Non & necessario scaricare completamente la batteria prima di ricaricarla.
A differenza di altri sistemi a batteria, questo cellulare non presenta un
effetto memoria in grado di compromettere le prestazioni della batteria.

« Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per
consentire una maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
- Tenere puliti i contatti metallici della batteria.

- Sostituire la batteria quando le prestazioni non sono pili accettabili. La
batteria puo essere ricaricata centinaia di volte prima che sia necessario
sostituirla.

« Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per
ottimizzarne le prestazioni.

+ Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in
ambienti particolarmente umidi, ad esempio nel bagno.
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Evitare di lasciare la batteria in luoghi con temperature eccessivamente
basse o elevate per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato puo comportare il rischio di esplosioni.
Attenersi alle istruzioni per lo smaltimento delle batterie usate.

Se € necessario sostituire la batteria, recarsi con il prodotto al centro di
assistenza o al punto vendita autorizzato LG Electronics di zona.

Quando il telefono é carico, scollegare sempre il caricabatterie dalla presa di
corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete,
impostazioni del prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come
ad esempio, forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Consumo energetico (modalita standby di rete) : 0,32 W
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Tipo modulare

La funzionalita modulare offerta dal dispositivo puo essere sfruttata
per utilizzare le varie funzioni fornite dai vari accessori.

Rimuovere il modulo dall'apposito slot del dispositivo. A questo punto
& possibile semplicemente sostituire |a batteria oppure installare

un altro accessorio nello slot modulare per utilizzare le funzioni
specifiche che fornisce l'accessorio stesso.

E « Peridettagli, vedere Rimozione della batteria e Installazione della
batteria.

+ Gli accessori disponibili, chiamati LG Friends, sono facoltativi.

« Per acquistare gli accessori facoltativi, contattare un centro di
assistenza clienti LG.

+ Gli accessori disponibili possono variare a seconda dellarea o del provider

del servizio.

+«—— Modulo

Always On Display

E possibile visualizzare sul display la data, lora, la firma o altre informazioni,
anche se lo schermo principale e spento. Always On Display & una funzione
utile per verificare spesso lora e visualizzare la propria firma.

5 - La batteria potrebbe scaricarsi piti velocemente quando si utilizza

Always-on display. Disattivare questa funzione per allungare la
durata di carica della batteria.
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1 Toccare O > Impostazioni > Display > Always-on display e
trascinare (Jmp per attivare la funzione.

E + Questa funzione potrebbe essere attiva quando si acquista il
dispositivo.

» Limpostazione predefinita puo variare a seconda dellarea e del
provider del servizio.

2 Toccare Imposta cosa mostrare e selezionare gli elementi da
visualizzare sullo schermo spento.
- Ora: consente di visualizzare sempre lorario corrente, anche se
lo schermo & spento.
- Firma: consente di visualizzare la propria firma al posto
dellorario corrente sullo schermo spento. Utilizzare lopzione
Imposta firma per immettere una firma e cambiare il carattere.

E - Verificare che la firma non superi in lunghezza il campo di input.

Modalita luce naturale

E possibile utilizzare la funzione avanzata IPS Quantum Display per
visualizzare chiaramente lo schermo anche allaperto e nelle ore in cui
il sole & pit alto.
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Obiettivo grandangolare 135°

E possibile utilizzare lobiettivo grandangolare per scattare foto con
un angolo di campo piti ampio del campo visivo effettivo. Questa
funzione si rivela utile quando si scatta una foto o si registra

un video di un paesaggio o di unarea ampia a partire da unarea
ristretta. E possibile acquisire le immagini di un orizzonte esteso, un
affollatissimo concerto allo stadio, una spiaggia intera e tutto cio che
due occhi possono vedere.

E « Peri dettagli, vedere Passaggio alla doppia fotocamera.

Doppia fotocamera

E possibile utilizzare la doppia fotocamera sul retro del dispositivo per
acquisire diverse foto e video da uno stretto primo piano a un'ampia
scena. E sufficiente avvicinare o allontanare le dita sulla schermata.

E - Peri dettagli, vedere Passaggio alla doppia fotocamera.
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Immagine tridimensionale

E possibile rendere le foto come fossero in cornice: acquisendo una

foto normale e una grandangolare contemporaneamente. Per rendere

tridimensionali le foto, sono disponibili quattro effetti per la cornice
di sfondo: occhio di pesce, bianco e nero, vignetta e offuscamento
dellobiettivo.

E » Per i dettagli, vedere Immagine tridimensionale.

Registrazione ferma

La funzione di registrazione ferma consente di minimizzare leffetto
mosso quando si scattano foto o si registra un video. Questa funzione
stabilizza automaticamente foto o video quando ci si muove. Toccare ‘&
per attivare la funzione.
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Smart Bulletin

E possibile aggiungere una schermata Home su cui siano raccolte e
visualizzate informazioni utili per ['utente.
E possibile visualizzare le notizie principali di Smart Bulletin in un
colpo docchio. Non e necessario aggiungere un ulteriore widget o
eseguire unapp.
1 Toccare O > Impostazioni > Display > Sfondo > Smart Bulletin e
trascinare (Ji per attivare la funzione.
+ Smart Bulletin & collocato nellarea piti a sinistra della schermata
Home.

2 Configurare Smart Bulletin utilizzando le voci di menu disponibili.
« Per riorganizzare le voci di menu visualizzate su Smart Bulletin,
toccare e tenere premuto =, quindi trascinare verso lalto o
verso il basso.

- Per visualizzare o nascondere una voce di menu su Smart
Bulletin, trascinare (J

E + Per modificare la configurazione dello Smart Bulletin, toccare @
nello Smart Bulletin.

Smart Notice

E possibile utilizzare Smart Notice per ricevere informazioni utili
compatibili con lorario e la posizione in cui ci si trova. Questo widget
analizza lambiente e i modelli di utilizzo quotidiano dell'utente al
fine di fornire informazioni che siano utili in base a un orario e in una
posizione specifici.
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Smart Notice pud essere utilizzato sotto forma di:

+ Promemoria automatici per aggiungere ai contatti i numeri
utilizzati piti spesso ma non salvati.

Promemoria automatico per effettuare una chiamata a un numero
che l'utente non ha richiamato in seguito allinvio di un messaggio
di rifiuto.

Promemoria automatico del compleanno di un contatto salvato nel
calendario e nellelenco dei contatti.

Promemoria automatici per eliminare i file temporanei, le app e
i file scaricati che non sono stati utilizzati per un determinato
periodo di tempo.

Promemoria automatici per personalizzare le impostazioni del
dispositivo in base al modello e al luogo di utilizzo del dispositivo.

Promemoria automatici per risparmiare energia quando il consumo
della batteria & alto.

Awvio di Smart Notice

E possibile aggiungere il widget Smart Notice se non & stato aggiunto per
impostazione predefinita o se e stato eliminato dalla schermata Home.
Attenersi ai passaggi seguenti per aggiungere il widget:

T Nella schermata Home, toccare e tenere premuto uno spazio
vuoto, quindi toccare Widget.

2 Toccare e tenere premuto Smart Notice, quindi trascinarlo in
unaltra posizione sulla schermata Home.

+ Sulla schermata Home viene visualizzato il widget Smart Notice e
si awiano le relative funzioni di promemoria automatico, insieme a
una panoramica delle stesse.

+ Toccare £83 sulla schermata del widget per modificare le
impostazioni di Smart Notice in base alle proprie preferenze o
per selezionare gli elementi relativamente ai quali si desidera
che Smart Notice generi dei promemoria automatici.
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E - Lafunzione Smart Notice potrebbe essere attiva quando si acquista
il dispositivo.

« Limpostazione predefinita puo variare a seconda dellarea o del
provider del servizio.

Smart cleaning
E possibile eliminare file temporanei o app che non si utilizzano piil.
1 Toccare O > Impostazioni > Generali > Smart cleaning.

2 Utilizzare le funzioni desiderate.

€ ———

[y —————
[ Se——

oy ——
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Quick Share

E possibile condividere una foto o un video sullapp desiderata subito
dopo averli ripresi.

1 Toccare O > @, quindi scattare una foto o registrare un video.

2 Trascinare l'icona di Quick Share che viene visualizzata dopo aver
scattato una foto o registrato un video, quindi selezionare unapp
per la condivisione.

In alternativa, toccare e tenere premuta licona di anteprima
visualizzata dopo aver scattato una foto o registrato un video,
quindi trascinarla sullicona di Quick Share.

E - Lapp visualizzata sull'icona di Quick Share puo variare a seconda del
tipo e della frequenza di accesso delle app installate sul dispositivo.
+ Questa funzione puo essere utilizzata solamente quando si scatta
una foto o si registra un video nella modalita automatica. Per i
dettagli, vedere Modalita automatica.
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QuickRemote

Informazioni generali su QuickRemote

E possibile controllare molti dispositivi elettronici situati in luoghi
diversi utilizzando il proprio dispositivo come telecomando.

E + Questa funzione si serve dei segnali infrarossi (IR) e funziona
in maniera analoga a un telecomando. Durante [utilizzo di
QuickRemote, tenere scoperto il sensore IR situato nella parte
superiore destra del dispositivo.

+ Questa funzione potrebbe non essere supportata a seconda
dellarea, del provider del servizio o del produttore del dispositivo.

Registrazione di un dispositivo per il
telecomando

E possibile registrare un dispositivo che si desidera controllare in
modalita remota con il proprio dispositivo.

1 Toccare O > LG > QuickRemote.

2 Toccare = per specificare i luoghi in cui si desidera utilizzare il
telecomando.

3 Toccare + e selezionare il tipo e il produttore del dispositivo che
intende controllare in modalita remota.

4 Sequire le istruzioni visualizzate sullo schermo per assicurarsi ch
la funzione QuickRemote funzioni correttamente sul dispositivo.

Funzioni personalizzate
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Creazione di un telecomando universale

Se il dispositivo da controllare con il proprio non esiste nellelenco,
e possibile creare un telecomando universale personalizzato
sistemandovi i pulsanti usati di frequente in base alle proprie
preferenze.

1 Toccare O > LG > QuickRemote.

2 Toccare == per specificare i luoghi in cui si desidera utilizzare il
telecomando.

3 Toccare 4 > Telecomando universale.

N

Immettere un nome per il telecomando e toccare OK.

5 Toccare e tenere premuto il pulsante desiderato, quindi trascinarlo
nella posizione desiderata.

6 Toccare AVANTI

7 Seguire le istruzioni visualizzate sullo schermo per registrare i
pulsanti, quindi toccare SALVA.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni
su questa funzione avanzata del blocco note, come ad esempio la
gestione immagini e gli screenshot, che non sono supportati dal
blocco note tradizionale.
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Creazione di una nota
1 Toccare O > QuickMemo+.
2 Toccare @ per creare una nota.
+ . consente di salvare una nota.
:consente di annullare ['ultima azione.

:consente di ripetere ['ultima azione annullata.
:consente di immettere una nota utilizzando la tastiera.

:consente di scrivere delle note a mano.

_d2NHYV

:consente di cancellare le note scritte a mano.

e
H

{3 :consente di eseguire lo zoom avanti o indietro, ruotare o
cancellare parte di una nota scritta a mano.

-+ consente di accedere a opzioni aggiuntive, tra cui la
condivisione e il blocco delle note, la modifica dello stile del
blocco note e l'inserimento di contenuti.

3 Toccare «/ per salvare la nota.

Scrittura di note su una foto
1 Toccare O > QuickMemo-+.

2 Toccare [O] per scattare una foto, quindi toccare OK.
- La foto e allegata automaticamente al blocco note.

3 Scrivere liberamente delle note sulla foto.

A Toccare N/ per salvare la nota.

Funzioni personalizzate
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Scrittura di note su uno screenshot
T Mentre sivisualizza una schermata che si desidera acquisire,
trascinare la barra di stato verso il basso, quindi toccare Capture+.
- Lo screenshot viene visualizzato come tema di sfondo del
blocco note. Nella parte superiore dello schermo vengono
visualizzati gli strumenti di promemoria.
2 Aggiungere note sulla schermata acquisita.

- Per ritagliare e salvare una porzione della schermata, toccare [ /]
e specificare una porzione con lo strumento di ritaglio.

« Per allegare uno screenshot al blocco note, toccare T

3 Toccare / e salvare le note nella posizione desiderata.

- Le note salvate possono essere visualizzate in QuickMemo+ o
in Galleria.

- Per salvare le note sempre nella stessa posizione, selezionare la
casella di controllo Usa come predefinita per questa azione. e
selezionare unapp.

Gestione delle cartelle
E possibile visualizzare le note raggruppate per tipologia.

1 Toccare O > QuickMemo+.
2 Nella parte superiore dello schermo, toccare = e selezionare una
voce di menu:

- Tutti i memo: consente di visualizzare tutte le note salvate in
QuickMemo+.

- | miei memo: consente di visualizzare le note create da QuickMemo+.
- Foto memo: consente di visualizzare le note create da [0}

- Capture+: consente di visualizzare le note create da Capture+.
+ Cestino: consente di visualizzare le note eliminate.

- Nuova categoria: consente di aggiungere delle categorie.

- §6 : consente di riorganizzare, aggiungere o eliminare delle
categorie. Per modificare il nome di una categoria, toccare la
categoria.
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E « Alcune cartelle non vengono visualizzate al primo awvio di
QuickMemo+. Le cartelle disabilitate vengono abilitate e
visualizzate quando contengono almeno una relativa nota.

QSlide

E possibile awviare le app utilizzando QSlide per esequirle
simultaneamente ad altre. Ad esempio, si puo utilizzare la calcolatrice
0 il calendario durante la riproduzione di un video.

Mentre unapp & in esecuzione, toccare : > QSlide.

E + Questa funzione potrebbe non essere supportata da alcune app.

- I J:consente di disattivare la modalita QSlide per passare alla
modalita schermo intero.

- =) :consente di regolare lopacita della finestra Qslide. Se la
finestra QSlide e trasparente, non reagisce agli input tattili.

« X :consente di chiudere la finestra Qslide.
- A consente diregolare la dimensione della finestra Qslide.

Funzioni personalizzate 25



LG Health

Informazioni generali su LG Health

E possibile gestire il proprio stato di salute e mantenere buone
abitudini di fitness monitorando lesercizio fisico svolto.

Informazioni preliminari su LG Health

E possibile configurare LG Health al primo awvio dellapp o dopo averla
inizializzata.

7 Toccare O > LG Health.

2 Seguire le istruzioni visualizzate sullo schermo per completare la
configurazione.

Utilizzo di LG Health

E possibile visualizzare le informazioni principali su LG Health e
gestire la quantita di esercizio fisico e le informazioni sullo stato di
salute.

1 Toccare O > LG Health.
2 Utilizzare le sequenti funzioni:

- =2

+ = :consente di visualizzare il registro del proprio esercizio fisico
nel giorno che si desidera monitorare.
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- Q :consente diiniziare a monitorare una sessione di esercizio
fisico. Il percorso e la quantita di esercizio fisico svolto vengono
registrati per ciascuna tipologia di esercizio.

-+ :consente di impostare gli obiettivi giornalieri di esercizio
fisico, compresi i passi e le calorie, oppure di configurare diverse
impostazioni di LG Health.

5 + Le informazioni relative alla salute fornite da LG Health sono
studiate per la comodita dell'utente e non possono essere utilizzate
a scopo di prevenzione, trattamento e diagnosi di malattie né per
altri scopi medici.

+ LG Health potrebbe variare o potrebbe non essere disponibile a

seconda del paese e del provider del servizio. Le funzioni di LG
Health disponibili e le app che possono essere abbinate a LG Health
possono variare a seconda del paese. Le variazioni sono dovute alle
diverse leggi e normative vigenti.

Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di
essere disturbati per un determinato periodo di tempo.

1 Toccare O > Impostazioni > Suono & Notifica > Non disturbare

e trascinare per () attivare la funzione.

7 Toccare Suoni e vibrazioni e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con
vibrazione per le app selezionate. Anche se e attiva la modalita Solo
priorita, le sveglie suonano comunque.

- Silenzio totale: consente di disabilitare sia laudio che la
vibrazione.
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Suoneria contatto

E possibile impostare la riproduzione di una suoneria composta
automaticamente per ciascuna chiamata in arrivo dai contatti selezionati.
Questa funzione e utile perché consente di sapere chi sta chiamando
semplicemente sentendo la suoneria.

1 Toccare O > Impostazioni > Suono & Notifica > Suoneria
contatto e trascinare (i per attivare la funzione.

2 Toccare Componi suonerie per e selezionare lopzione desiderata.

E + La suoneria predefinita viene riprodotta per le chiamate in arrivo da
tutti i contatti ad eccezione del contatto selezionato.

Riconoscimento delle impronte
digitali

Informazioni generali sul riconoscimento delle
impronte digitali
Prima di utilizzare la funzione di riconoscimento delle impronte
digitali, & necessario registrare la propria impronta sul dispositivo.
La funzione di riconoscimento delle impronte digitali puo essere
impiegata nei casi seguenti:

+ Per sbloccare lo schermo

+ Per visualizzare i contenuti bloccati in Galleria o QuickMemo+
Nel caso della conferma di un acquisto o dellaccesso a unapp, &
possibile identificarsi toccando semplicemente il sensore di impronte
digitali.
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5 « Limpronta digitale rimane immutata per tutta la vita, e ciascuno &
dotato di un'impronta univoca. Per questo motivo l'impronta puo
essere utilizzata dal dispositivo per il riconoscimento dell'utente.
Impronte digitali molto simili appartenenti a utenti diversi
potrebbero essere riconosciute dal sensore di impronte come la
stessa impronta. Per massimizzare la sicurezza del dispositivo,
impostare il blocco schermo con una sequenza, un PIN o una
password.

- Se limpronta digitale dell'utente non viene riconosciuta o se si
dimentica il PIN di backup, recarsi con il dispositivo presso il centro
di assistenza clienti LG pil vicino e provvedere sia alla registrazione
di un'impronta digitale che alla creazione di un nuovo PIN di backup.

Precauzioni per il riconoscimento delle impronte
digitali

L'accuratezza del riconoscimento delle impronte digitali potrebbe
diminuire. Per massimizzarla, eseguire le seguenti verifiche prima
dell'utilizzo del dispositivo.

Il tasto di accensione/blocco del dispositivo e dotato di un sensore
di impronte digitali. Assicurarsi che il tasto di accensione/blocco
non venga danneggiato da un oggetto metallico, come ad esempio
una moneta o una chiave.

Nel caso in cui sul tasto di accensione/blocco o sul dito siano
presenti acqua, polvere o altre sostanze estranee, la registrazione
o il riconoscimento dellimpronta potrebbero non avere

esito positivo. Pulire e asciugare il dito prima di procedere al
riconoscimento dellimpronta.

Il riconoscimento dellimpronta potrebbe non andare a buon fine
se la superficie del dito ha una cicatrice oppure non e liscia a causa
dellimmersione in acqua.

Se si piega il dito o si usa solamente la punta del dito, il
riconoscimento dellimpronta potrebbe non avere esito positivo.
Assicurarsi che il dito copra l'intera superficie del tasto di
accensione/blocco.
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Eseguire la scansione di un solo dito per ciascuna registrazione.
La scansione di pit di un dito potrebbe compromettere la
registrazione e il riconoscimento dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria
circostante e secca. Se laria circostante e secca, evitare la
scansione delle impronte digitali o toccare un oggetto metallico,
quale ad esempio una moneta o una chiave, prima di eseguire la
scansione delle impronte al fine di eliminare lelettricita statica.

Registrazione delle impronte digitali

E possibile registrare e salvare la propria impronta digitale sul
dispositivo per utilizzare l'identificazione tramite impronta digitale.

1

Toccare O > Impostazioni > Generali > Impronte digitali &
sicurezza > Impronte digitali.

E « Per utilizzare questa funzione, assicurarsi che il blocco schermo

sia impostato. Se non & stato impostato un blocco schermo,

provvedere a impostarlo. Per i dettagli, vedere Configurazione delle

impostazioni del blocco schermo.

2 Individuare la posizione del tasto di accensione/blocco sul retro

del dispositivo e appoggiarvi il dito con delicatezza per registrare

limpronta digitale.

E « Premere delicatamente il tasto di accensione/blocco in modo che

il sensore possa riconoscere limpronta digitale dell'utente. Se si
preme il tasto di accensione/blocco con forza eccessiva, potrebbe
awviarsi la funzione di blocco schermo o potrebbe spegnersi lo
schermo.

del tasto di accensione/blocco.
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3 Seguire le istruzioni visualizzate sullo schermo.
+ Ripetere la scansione dellimpronta digitale muovendo
leggermente il dito fino alla registrazione dellimpronta digitale.
4 Una volta completata la registrazione dellimpronta, toccare OK.

+ Toccare AGGIUNGI ALTRO per registrare unaltra impronta
digitale. Se si registra solo un'impronta digitale e il dito
corrispondente non e in condizioni ottimali, il riconoscimento
dellimpronta potrebbe non funzionare correttamente. Per
prevenire l'insorgere di questo tipo di situazione, & consigliabile
registrare piti impronte digitali.

Gestione delle impronte digitali
E possibile modificare o eliminare le impronte digitali registrate.

1 Toccare O > Impostazioni > Generali > Impronte digitali &
sicurezza > Impronte digitali.

7 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un'impronta digitale per
rinominarla. Per eliminarla, toccare {ii].
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Sblocco dello schermo con un’impronta digitale

E possibile sbloccare lo schermo e visualizzare i contenuti bloccati
utilizzando la propria impronta digitale. Attivare la funzione
desiderata:

1 Toccare O > Impostazioni > Generali > Impronte digitali &
sicurezza > Impronte digitali.
7 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare
la funzione desiderata:

- Blocco schermo: consente di sbloccare lo schermo con
un'impronta digitale.

+ Blocco del contenuto: consente di sbloccare un contenuto
con un'impronta digitale. A questo scopo, assicurarsi che sia
impostato il blocco contenuto.

Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo

E possibile riprodurre foto, video o canzoni salvate sul proprio
dispositivo da una TV.

1 Connettere [aTV e il dispositivo alla stessa rete Wi-Fi.

2 Mentre si visualizzano gli elementi dellapp Galleria o Musica,
toccare 2o : > Riproduci su un altro dispositivo, quindi
selezionare la TV a cui si desidera connettersi.

» Per Chromecast, & consigliabile che Google Play services sia
aggiornato.
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Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad
esempio un computer, un dispositivo NAS o un dispositivo mobile,
utilizzando le app Galleria o Musica.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado
di supportare la funzione DLNA alla stessa rete wireless.

« Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel
dispositivo mittente che nel dispositivo connesso.

Ricerca di dispositivi vicini

E possibile visualizzare un elenco di dispositivi DLNA connessi alla
stessa rete selezionando la scheda Dispositivi nelle vicinanze in
ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se li si stesse
utilizzando sul proprio dispositivo.

Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro
dispositivo LG, oppure un tablet o un computer.

Invio di file

Nellapp Galleria, File Manager o Musica, toccare : > Condividi 0 <,
quindi selezionare un dispositivo nellelenco condivisione file.

Ricezione di file

Trascinare verso il basso la barra di stato, quindi attivare la
Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione
file, toccare O > Impostazioni > Reti > Condividi & Connetti >
Condivisione File > SmartShare Beam.
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Invio di file a un computer

E possibile inviare rapidamente file di grandi dimensioni al proprio
computer.

1 Installare LG Bridge sul proprio computer.

2 Awviare LG Bridge sul computer, quindi effettuare laccesso
utilizzando il proprio account LG.

3 Toccare Q> Impostazioni > Reti > Condividi & Connetti > LG
AirDrive, quindi effettuare l'accesso utilizzando il proprio account
LG.

+ LG Bridge puo essere scaricato dal sito \Web LG Mobile
(www.lg.com).

Visualizzazione di contenuti dal cloud

E possibile visualizzare direttamente i contenuti salvati nel proprio
account sul cloud senza scaricarli sul dispositivo.

1 Dallapp Galleria, Musica o File Manager, selezionare = > Cloud.
2 Selezionare un account cloud ed effettuare l'accesso.

3 Salvare o riprodurre contenuti sul proprio cloud.

Dual Play

E possibile visualizzare lo schermo del proprio dispositivo su un
dispositivo di visualizzazione connesso tramite una rete wireless e
utilizzare contemporaneamente diverse app sul proprio dispositivo.

Utilizzare una Condivisione schermo per la connessione.

5 + Questa funzione non & disponibile per alcuni contenuti.
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Componenti e accessori del
prodotto

Assicurarsi che siano presenti tutti i seguenti elementi:

- Dispositivo - Cavo USB
- Batteria - Caricabatteria
+ Spillo di espulsione + Guida introduttiva

- Auricolare stereo

A .

+ Gli elementi forniti in dotazione con il dispositivo ed eventuali

Gli elementi descritti sopra possono essere facoltativi.

accessori disponibili possono variare a seconda dellarea e del
provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di
accessori di altri produttori puo influire sulle prestazioni di chiamata
del dispositivo o causare malfunzionamenti. Il servizio di riparazione
LG potrebbe non coprire simili situazioni.

In mancanza di uno di questi elementi di base, contattare il
rivenditore presso cui é stato acquistato il dispositivo.

« Per acquistare altri elementi di base, contattare il centro di

assistenza clienti LG.

« Per acquistare elementi facoltativi, contattare il centro di assistenza

clienti LG per verificare la disponibilita presso i rivenditori.

Alcuni elementi contenuti nella confezione del prodotto sono
soggetti a modifica senza preawviso.

- Laspetto e le specifiche del dispositivo sono soggetti a modifica

senza prea\/viso.
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Panoramica delle parti

Microfono

Sensore IR

Altoparlante auricolare ———————— 1— Jack stereo per auricolare
.

Obiettivo fotocamera —7=0@ @ —==;
anteriore ]

Sensore di prossimita/
luminosita ambientale

Tasti volume (+/-) —

Indicatore LED

Tasto di espulsione del
modulo —|

Modulo —=\\ /J

Touchscreen

~— Alloggiamento scheda
SIM/scheda di memoria

L porta per

caricabatteria/cavo USB

Flash

) —
Sensore RGB l l
070
Obiettivo fotocamera )9 (o3

posteriore (normale) ]
Messa a fuoco automatica —

con rilevamento laser Q') ‘

Obiettivo fotocamera
posteriore (grandangolare)

Tasto di accensione/blocco
(Sensore di impronte)

Antenna NFC (integrata)

Microfono
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+ Sensore di prossimita/luminosita ambientale

- Sensore di prossimita: Nel corso di una chiamata, il sensore di
prossimita spegne lo schermo e disattiva la funzionalita touch
quando il dispositivo si trova molto vicino al corpo umano.
Riaccende lo schermo e attiva la funzionalita touch quando il
dispositivo si trova al di fuori di un campo specifico.

- Sensore di luminosita ambientale: il sensore di luminosita
ambientale analizza lintensita della luce ambientale quando &
attiva la modalita di controllo automatico della luminosita.

+ Messa a fuoco automatica con rilevamento laser

- Rileva la distanza tra la fotocamera e il soggetto per la messa a
fuoco automatica.

- Mette a fuoco rapidamente oggetti pil vicini o pitl lontani
quando si utilizza la fotocamera posteriore per scattare foto.

- Tasti volume

- Consentono di regolare il volume delle suonerie, delle chiamate o
delle notifiche.

- Premere delicatamente un tasto volume per scattare una foto.
Per scattare in maniera continua, tenere premuto il tasto volume.

- Quando lo schermo & spento o bloccato, premere il tasto volume
giti (-) due volte per awviare lapp Fotocamera. Premere due
volte il tasto volume su (+) per awviare Capture+.

- Tasto di accensione/blocco (Sensore di impronte)

- Premere brevemente il tasto se si desidera accendere o
spegnere lo schermo.

- Tenere premuto il tasto se si desidera selezionare unopzione di
alimentazione.

- Appoggiare delicatamente il dito sul tasto se si desidera
sbloccare lo schermo con limpronta digitale.
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E - Laccesso ad alcune funzioni potrebbe essere limitato a seconda
delle specifiche del dispositivo.

« Sulla parte posteriore del dispositivo e integrata unantenna NFC.
Non danneggiare lantenna NFC.

+ Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso
contrario, la funzione touchscreen potrebbe danneggiarsi.

- La pellicola o accessori di protezione dello schermo potrebbero
interferire con il sensore di prossimita.

+ Se il dispositivo & bagnato o viene utilizzato in un luogo
umido, il sensore touch o i pulsanti potrebbero non funzionare
correttamente.

Accensione o spegnimento del
prodotto

Accensione del prodotto

Quando il prodotto & spento, tenere premuto il tasto di accensione/
blocco.

+ Quando si accende il dispositivo per la prima volta, viene awviata la
configurazione iniziale. La durata del primo awvio dello smartphone
potrebbe essere pit lunga di quella abituale.

Spegnimento del prodotto

Tenere premuto il tasto di accensione/blocco, quindi selezionare
Spegni.

Opzioni di alimentazione
Toccare e tenere premuto il tasto di accensione/blocco, quindi

selezionare unopzione.
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- Spegni: consente di spegnere il dispositivo.
- Spegni e riavvia: consente di riavviare il dispositivo.

- Attiva modalita aereo: consente di bloccare le funzioni legate
alle telecomunicazioni, comprese le chiamate, l'invio di messaggi
e la navigazione in Internet. Le altre funzioni continuano a essere
disponibili.

Installazione della scheda SIM

Utilizzare correttamente la scheda SIM (Subscriber Identity Module)
fornita dal proprio provider del servizio.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della

scheda.

2 Estrarre lalloggiamento della scheda.
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3 Posizionare la scheda SIM sullalloggiamento con i contatti color
oro rivolti verso il basso.

Precauzioni per l'utilizzo della scheda SIM

+ Non perdere la scheda SIM. LG non & responsabile di eventuali
danni e altri problemi causati dalla perdita o dal trasferimento di
una scheda SIM.

+ Fare attenzione a non danneggiare la scheda SIM durante le
operazioni di inserimento e rimozione.

E + Dei vari tipi di scheda SIM, solo le schede Nano SIM funzionano con
il dispositivo.
» Affinché non si verifichino problemi di prestazioni, si consiglia di
utilizzare il telefono con il tipo corretto di scheda SIM. Utilizzare
sempre una scheda SIM realizzata in fabbrica, fornita dalloperatore.
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Inserimento della scheda di
memoria

Il dispositivo supporta una microSD fino a 2 TB. Alcune schede di
memoria potrebbero risultare non compatibili con il dispositivo, a
seconda del produttore e del tipo di scheda di memoria.

A + Alcune schede di memoria potrebbero risultare non completamente
compatibili con il dispositivo. Lutilizzo di una scheda incompatibile
potrebbe causare il danneggiamento del dispositivo o della scheda
di memoria, oppure la corruzione dei dati salvati al suo interno.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della
scheda.

2 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sullalloggiamento con i contatti
color oro rivolti verso il basso.

Scheda di memoria

Scheda SIM

4 Inserire nuovamente lalloggiamento nello slot.

+ La scheda di memoria e un elemento opzionale.

« Operazioni frequenti di cancellazione e scrittura dei dati possono
ridurre la durata delle schede di memoria.
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Rimozione della scheda di memoria
Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
1 Toccare O > Impostazioni > Generali > Archiviazione & USB> A.
2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.
3 Estrarre lalloggiamento e rimuovere la scheda di memoria.
A + Non rimuovere la scheda di memoria mentre il dispositivo sta
trasferendo o accedendo a informazioni. In caso contrario,
potrebbe verificarsi la perdita o la corruzione dei dati, oppure il
danneggiamento della scheda di memoria o del dispositivo. LG non

& responsabile di eventuali perdite causate dall'abuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Rimozione della batteria

A - Spegnere il dispositivo prima di rimuovere la batteria. In caso
contrario, il dispositivo potrebbe danneggiarsi.

1 Premere il tasto di espulsione del modulo per espellere
parzialmente il modulo dal dispositivo.

=—— Modulo

Tasto di espulsione del modulo Q
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2 Afferrare la parte centrale del modulo espulso ed estrarla dal
dispositivo.

3 Tenere la batteria e il modulo con entrambe le mani e separarli
l'una dallaltro nella direzione della freccia.

+ Non piegare la batteria durante la rimozione. La copertura di
plastica sulla batteria potrebbe danneggiarsi.

Iy

Installazione della batteria

A « Le specifiche del dispositivo possono variare a seconda dellarea o
del provider del servizio. Per acquistare ulteriori batterie o elementi
opzionali compatibili, contattare un centro di assistenza clienti LG.

« Assicurarsi di utilizzare accessori originali forniti da LG Electronics.
L'utilizzo di accessori di terze parti potrebbe danneggiare il
dispositivo o causare malfunzionamenti.
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1 Allineare correttamente le frecce indicate e inserire la batteria nel
modulo seguendo lordine illustrato nellimmagine.

2 Afferrare la parte inferiore del modulo come mostrato nella figura
sottostante, quindi farla slittare gentilmente nel dispositivo fino ad
assicurarla saldamente.

E + Non premere mai il tasto di espulsione del modulo quando si
inserisce il modulo nel dispositivo.
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Precauzioni per 'utilizzo del modulo

- Quando si inserisce la batteria nel dispositivo, assicurarsi che la
batteria sia fissata al modulo. Inserendo la batteria senza che
questa sia fissata al modulo e possibile danneggiare il dispositivo.
Durante la sostituzione della batteria, prestare particolare

attenzione affinché non penetrino nel dispositivo sostanze
estranee 0 acqua.

Non collocare il dispositivo in un luogo caldo e umido dopo aver
rimosso la batteria.

Assicurarsi che l'interno del dispositivo non venga a contatto con
oggetti metallici o acqua e che non subisca danni.

Lasciare il dispositivo con il modulo separato per un periodo di
tempo prolungato pud causare una deformazione del dispositivo o
danneggiare i contatti metallici. Di conseguenza si puo verificare un
malfunzionamento del dispositivo.

Non separare mai il modulo dal dispositivo senza aver premuto
il tasto di espulsione del modulo. In caso contrario, il dispositivo
potrebbe danneggiarsi.

Non rimuovere mai il modulo quando il dispositivo & in uso.

Se si crea uno spazio vuoto tra il modulo e il dispositivo mentre il
dispositivo & in uso, inserire con decisione il modulo nel dispositivo.

Se si inserisce un modulo che non e compatibile con il gestore del
servizio, ad esempio un modulo acquistato da un altro gestore o/in
una zona non coperta dal proprio gestore, il dispositivo potrebbe
non funzionare normalmente.

Prestare attenzione a non ferirsi alle dita durante l'inserimento o la
rimozione del modulo.

Assicurarsi di inserire correttamente la batteria e il modulo. Se li si
inserisce in maniera errata, il dispositivo potrebbe non funzionare
correttamente o potrebbe danneggiarsi.

+ Ilmancato rispetto delle istruzioni contenute nella guida per lutente
potrebbe portare al danneggiamento del dispositivo.
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Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.

Collegare un'estremita del cavo di caricamento al caricabatteria,
inserire laltra estremita del cavo nellapposita porta del dispositivo,
quindi inserire il caricabatteria in una presa di corrente.

Assicurarsi di utilizzare il cavo USB fornito come accessorio di base.

>

Assicurarsi di utilizzare caricabatteria, batteria e cavo di caricamento
approvati da LG. Se la batteria viene caricata con un caricabatteria di
terze parti, la batteria potrebbe esplodere o danneggiarsi.

L'utilizzo del dispositivo durante il caricamento potrebbe causare
scosse elettriche. Per utilizzare il dispositivo, interrompere il
caricamento.

E + Questo dispositivo viene fornito con la batteria inserita. Al primo
utilizzo del dispositivo, verificare il livello di carica della batteria e, se
necessario, caricarla completamente prima di utilizzare il dispositivo.

» Rimuovere il caricabatteria dalla presa di alimentazione una volta
completato il caricamento del dispositivo. In questo modo si evita
un inutile consumo di corrente.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra
il dispositivo e un computer desktop o portatile. Questo metodo
puo richiedere piti tempo rispetto al caricamento della batteria nel
modo tradizionale.

+ Non caricare la batteria con un hub USB non in grado di mantenere
la tensione nominale. Il caricamento potrebbe non riuscire o
arrestarsi inavvertitamente.
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Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in
esecuzione diverse app e funzioni contemporaneamente e in maniera
continuativa.

Annullare le operazioni in background per aumentare la durata della
batteria.

Per ridurre al minimo il consumo della batteria, seguire questi
suggerimenti:

- Disattivare la funzione Bluetooth® o rete Wi-Fi quando non le si
utilizza.

- Impostare lo spegnimento dello schermo su un lasso di tempo il
pili breve possibile.

+ Ridurre al minimo la luminosita dello schermo.

+ Impostare un blocco schermo quando il dispositivo non € in uso.

« Per utilizzare unapp scaricata, verificare il livello della batteria.

Touchscreen

E possibile imparare a conoscere le modalita di controllo del
dispositivo mediante ['utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire
unapp o unopzione.
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Tenere premuto

Tenere premuto per diversi secondi per eseguire una funzione nascosta.

Toccare due volte

Toccare rapidamente due volte per eseguire o zoom avanti o indietro
su una pagina Web o su una mappa.

Trascinamento

Toccare un elemento, ad esempio un'app o un widget, quindi spostare
il dito in unaltra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.
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Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E
possibile utilizzare questo gesto per scorrere un elenco, una pagina
Web, delle foto, delle schermate e altro ancora.

Awvicinare e allontanare le dita

Awvicinare due dita per eseguire lo zoom indietro, ad esempio su una
foto o una mappa. Per esequire lo zoom avanti, allontanare le dita.

?

7,

A + Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch
potrebbe danneggiarsi.
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E - Se il dispositivo viene utilizzato vicino a materiale magnetico,
metallico o conduttore, potrebbe verificarsi un guasto del
touchscreen.

» Se si utilizza il dispositivo sotto luci intense come la luce solare
diretta, lo schermo potrebbe non essere visibile a seconda della
posizione. Utilizzare il dispositivo in una posizione ombreggiata o
con una luce ambiente non troppo intensa, ma sufficientemente
luminosa da consentire la lettura.

+ Non premere lo schermo applicando una forza eccessiva.

« Toccare delicatamente lopzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si
tocca lo schermo indossando un guanto o con la punta dell'unghia.

+ Il controllo touch potrebbe non funzionare correttamente se lo
schermo e umido o bagnato.

« Il touchscreen potrebbe non funzionare correttamente se sul
dispositivo e applicata una pellicola o un accessorio di protezione
dello schermo acquistati da un comune negozio online o da un
negozio fisico.

Schermata Home

Informazioni generali sulla schermata Home

La schermata Home e il punto di partenza per accedere a diverse
funzioni e app sul dispositivo. Toccare O su qualsiasi schermata per
passare direttamente alla schermata Home.

Sulla schermata Home & possibile gestire tutte le app e i widget.
Scorrere sulla schermata verso sinistra o destra per visualizzare in un
colpo docchio tutte le app installate.

Per cercare un‘app, utilizzare la ricerca di Google.
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Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle
sulla schermata Home.

Barra di stato —¢ [ R X

Icona della pagina

Pulsanti touch della (% E O Q e— Area di accesso rapido

schermata Home —|

E « La schermata Home puo variare a seconda del provider del servizio
o della versione del software.

Barra di stato: consente di visualizzare le icone di stato, lorario e il
livello della batteria.

Widget: é possibile aggiungere widget alla schermata Home per
accedere rapidamente a informazioni necessarie senza dover
esequire le app una per una.

Cartella: e possibile creare cartelle per raggruppare le app in base
alle proprie preferenze.

Icona della pagina: consente di visualizzare il numero totale di aree
della schermata Home e larea attualmente visualizzata, che e
evidenziata.

Area di accesso rapido: & possibile fissare le app principali nella
parte inferiore dello schermo in modo che siano accessibili da
qualsiasi area della schermata Home.
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+ Pulsanti touch della schermata Home

- <] :consente di tornare alla schermata precedente. Consente
inoltre di chiudere la tastiera o le finestre popup.

- (O :toccare per tornare alla schermata Home. Per awviare
Google, tenere premuto.

- [ consente di visualizzare un elenco di app utilizzate di recente
0 eseguire unapp dallelenco. Utilizzare lopzione Cancella tutto
per eliminare tutte le app utilizzate di recente. In alcune app,
tenendo premuto il pulsante si accede a opzioni aggiuntive.

Modifica dei pulsanti touch della schermata

Home
E possibile riorganizzare i pulsanti touch della schermata Home o
aggiungere le funzioni utilizzate piti spesso a questi pulsanti.
Toccare O > Impostazioni > Display > Pulsanti a sfioramento
anteriori > Combinazione di tasti e personalizzare le impostazioni.
- Sono disponibili diverse funzioni, tra cui Qslide, il pannello notifiche
o Capture+. E possibile aggiungere un massimo di cinque elementi.
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Icone di stato

Quando e presente una notifica relativa a un messaggio non letto,
un evento del calendario o una sveglia, nella barra di stato viene
visualizzata l'icona di notifica corrispondente. Verificare lo stato del
dispositivo visualizzando le icone di notifica presenti nella barra di
stato.

aill - nessun segnale

:trasmissione di dati tramite la rete in corso
® :svegliaimpostata

i[Jn : modalita vibrazione attiva

€ :Bluetooth attivo

1 : collegato a un computer tramite USB
B : livello batteria

4 :modalita offline attiva

X4 :chiamate senza risposta

- @ Wi-Fi attivo

N : modalita silenziosa attiva

@ :GPS attivo

(4 : Hotspot attivo

- B nessuna scheda SIM

E + Alcune di queste icone potrebbero apparire in modo diverso o
non apparire affatto a seconda dello stato del dispositivo. Fare
riferimento alle icone in base allambiente effettivo in cui si utilizza
il dispositivo.
+ Leicone visualizzate possono variare a seconda dellarea o dei
provider dei servizi.
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Pannello notifiche

E possibile aprire il pannello notifiche trascinando la barra di stato
verso il basso.

Utilizzando le icone di accesso rapido presenti nel pannello notifiche &
possibile attivare o disattivare una funzione in maniera facile e veloce.
Scorrere verso destra o verso sinistra sullelenco delle icone di accesso
rapido per selezionare l'icona della funzione desiderata.

- Tenendo premuta licong, viene visualizzata la schermata delle
impostazioni relative alla funzione in questione.

—— Consente di accedere allapp
o0 ‘ Impostazioni.
) 7 B ®e— Consente di selezionare un
Consente divisualizzarele — g o 3 utente.
icone di accesso rapido. — @ . ®
v *
Consente di selezionare un —s—; -
dispositivo per la condivisione _! I— — Consente diregolare la
della schermata del telefono. Znaus % Saue luminosita.
Consente di visualizzare le — '° sl Consente di autorizzare la
notifiche. ricezione di file da dispositivi

vicini.

Consente di eliminare le
notifiche.

Impostazioni del pannello notifiche
E possibile selezionare gli elementi da visualizzare nel pannello
notifiche.
Toccare ¢ nel pannello notifiche.
« Per riorganizzare le icone di accesso rapido, tenere premuta
un'icona, quindi trascinarla in un‘altra posizione.

- Selezionare le icone che si desidera visualizzare nellelenco.

5 + Le voci del menu disponibili possono variare a seconda dellarea o
del provider del servizio.
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello
schermo in base allorientamento del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di
accesso rapido.

In alternativa, toccare O > Impostazioni > Display e attivare
Rotazione automatica.

Modifica della schermata Home
Nella schermata Home, toccare e tenere premuto uno spazio vuoto,
quindi awviare la funzione desiderata.
+ Per ridisporre le aree della schermata Home, toccare e tenere
premuta unarea e trascinarla in unaltra posizione.
- Per aggiungere widget alla schermata Home, toccare Widget e
trascinare un widget nella schermata Home.

+ Per modificare le impostazioni della schermata Home, toccare
Imposta schermata home e personalizzare le opzioni. Per i
dettagli, vedere Impostazioni della schermata Home.

- Per visualizzare o reinstallare le app disinstallate, toccare App
disinstallate. Per i dettagli, vedere App disinstallate.
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Visualizzazione del tema di sfondo

Nella schermata home, & possibile visualizzare solo limmagine di
sfondo nascondendo app e widget.

Allontanare due dita tenendo premuto sulla schermata Home.

- Per tornare alla schermata originale con la visualizzazione di app e
widget, awicinare le dita sulla schermata Home o toccare <]

Ricerca di app sulla schermata Home

E possibile cercare con facilita le app installate sulla schermata Home
immettendo il nome della app desiderata nel widget di Google.

Lelenco delle app installate viene visualizzato nella schermata di
ricerca di Google.

Spostamento di app sulla schermata Home

Nella schermata Home, toccare e tenere premuta unapp, quindi
trascinarla in unaltra posizione.
- Perinserire le app utilizzate pit spesso nella parte inferiore
della schermata Home, toccare e tenere premuta unapp, quindi
trascinarla nellarea di accesso rapido nella parte inferiore.
+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella
schermata Home.
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Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta unapp, quindi
trascinarla su unaltra app.

- Viene creata una nuova cartella e le app vengono aggiunte al suo
interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella e quindi eseguire la
funzione desiderata.

- Per modificare il nome e il colore della cartella, toccare il nome
della cartella.

+ Per rimuovere unapp dalla cartella, toccare e tenere premuta lapp,
quindi trascinarla allesterno della cartella. Se lapp rimossa & ['unica
esistente nella cartella, viene rimossa automaticamente anche la
cartella.

Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.
1 Toccare O > Impostazioni > Display > Sfondo.

2 Personalizzare le impostazioni:

Seleziona Launcher: consente di selezionare una modalita per
la schermata Home.

Sfondo: consente di cambiare il tema di sfondo della schermata
Home.

Effetto scorrimento schermo: consente di selezionare un
effetto da applicare quando si passa a unaltra area della
schermata Home.

Tema: Selezionare il tema della schermata da applicare.

Ordina le app per:Impostare la modalita di ordinamento delle
app sulla schermata Home.
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- Griglia: consente di madificare la modalita di disposizione delle
app nella schermata Home.

- Nascondi applicazioni: consente di selezionare o deselezionare
le app da nascondere nella schermata Home.

- Smart Bulletin: consente di utilizzare la schermata Home per
visualizzare informazioni personalizzate in base alle proprie
esigenze.

Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di
accensione/blocco. Il blocco awiene anche quando il dispositivo viene
lasciato inattivo per un determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un
blocco schermo, viene immediatamente visualizzata la schermata Home.
Per maggiore sicurezza e per impedire l'accesso indesiderato al
dispositivo, impostare un blocco schermo.

E - Il blocco schermo impedisce inutili input tocco sul\lo schermo
del dispositivo e riduce il consumo della batteria. E altamente
consigliabile attivare il blocco schermo mentre non si usa il
dispositivo.

Configurazione delle impostazioni del blocco

schermo
Per la configurazione delle impostazioni del blocco schermo sono
disponibili varie opzioni.

1 Toccare O > Impostazioni > Display > Blocco schermo >
Seleziona il blocco dello schermo, quindi selezionare il metodo
preferito.
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Personalizzare le impostazioni di blocco:
- Nessuno: consente di disattivare la funzione di blocco schermo.

- Trascina: consente di scorrere un dito sullo schermo per
sbloccarlo.

+ Knock Code: consente di sbloccare lo schermo toccando gli
spazi dello schermo in base a una determinata sequenza.

- Sequenza: consente di disegnare una sequenza per sbloccare
lo schermo.

+ PIN: consente di immettere una password numerica per
sbloccare lo schermo.

- Password: consente di immettere una password alfanumerica
per sbloccare lo schermo.

E + Perimpostare il blocco schermo in modo da dover utilizzare una
sequenza, creare prima un account Google o un PIN di backup.
Se si immette una sequenza non corretta per un numero di volte
consecutive superiore a quello specificato, e possibile sbloccare lo
schermo utilizzando il PIN di backup o laccount Google.

+ Se e impostato un blocco schermo che prevede ['utilizzo di un PIN o
una password e siimmette un PIN o una password non corretta per
un numero di volte superiore a quello specificato, limmissione della
password viene bloccata per 30 secondi.

Impostazioni della schermata di blocco

E possibile personalizzare le sequenti impostazioni della schermata
di blocco.

1 Toccare O > Impostazioni > Display > Blocco schermo.

7 Personalizzare le impostazioni:
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- Seleziona il blocco dello schermo: consente di selezionare un
metodo di blocco schermo.
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- Smart Lock: consente di selezionare condizioni attendibili,
in modo tale che se una di queste condizioni si verifica, il
dispositivo venga automaticamente sbloccato.

- Effetto scorrimento schermo: consente di impostare effetti di
transizione da applicare quando lo schermo e sbloccato. Questa
opzione viene visualizzata se il metodo di blocco schermo e
impostato su Trascinamento.

- Sfondo: consente di cambiare limmagine di sfondo della
schermata di blocco.

+ Collegamenti: consente di aggiungere un collegamento rapido
a unapp e di accedere direttamente allapp dalla schermata
di blocco trascinandola allesterno del cerchio grande. Questa
opzione viene visualizzata se il metodo di blocco schermo e
impostato su Trascinamento.

- Animazione meteo: consente di visualizzare le animazioni
meteo relative alla posizione attuale sulla schermata di blocco.

- Informazioni di contatto per telefono perso: consente di
visualizzare le informazioni di contatto di emergenza sulla
schermata di blocco.

+ Blocco timer: consente di impostare il lasso di tempo
di inattivita trascorso il quale il dispositivo si blocca
automaticamente.

- Blocco istantaneo con tasto accensione: consente di bloccare
istantaneamente lo schermo quando si preme il tasto di
accensione/blocco.

E - Le voci di impostazione disponibili possono variare a seconda del
metodo di blocco schermo selezionato.
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KnockON

E possibile accendere o spegnere lo schermo toccandolo due volte.

Accensione dello schermo
Toccare due volte il centro dello schermo.

- Se si tocca la parte superiore o inferiore dello schermo, la velocita
di riconoscimento potrebbe essere pill bassa.

Spegnimento dello schermo
Toccare due volte uno spazio vuoto nella schermata Home.
In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

E - Questa opzione e disponibile solo sulla schermata Home fornita
da LG. Potrebbe non funzionare correttamente su un launcher
personalizzato o sulla schermata Home installata dall'utente.

+ Quando si tocca lo schermo, utilizzare la punta di un dito. Non
utilizzare un'unghia.

- Per utilizzare la funzione KnockON, assicurarsi che il sensore di
prossimita/luminosita non sia ostruito da un adesivo o da un‘altra
sostanza estranea.

Knock Code

E possibile sbloccare lo schermo creando un codice Knock Code
personale. Quando lo schermo e bloccato, si potra accedere
direttamente alla schermata Home toccando lo schermo secondo la
sequenza specificata.

Creazione di un codice Knock Code

1 Toccare O > Impostazioni > Display > Blocco schermo >
Seleziona il blocco dello schermo > Knock Code.

7 Toccare i quadranti in base a una sequenza di propria scelta per
creare il codice Knock Code, quindi toccare AVANTI.
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3 A scopo di verifica, immettere di nuovo il codice Knock Code
creato, quindi toccare CONFERMA.

A |Impostare un PIN di backup da utilizzare nel caso in cui il codice
Knock Code venga dimenticato.

Sblocco dello schermo con un codice Knock Code

E possibile sbloccare lo schermo immettendo il codice Knock Code
creato.

Immettere il proprio codice Knock Code sul touchscreen quando lo
schermo & spento.

5 - E possibile utilizzare il codice Knock Code insieme alla funzione
KnockOn.
+ Se siimmette un codice Knock Code per un numero di volte
consecutive superiore a quello specificato, eseguire lo sblocco
utilizzando il PIN di backup o laccount Google.

+ Quando si tocca lo schermo, assicurarsi di utilizzare la punta di un
dito.

Avwvio sicuro

Informazioni generali sullAvvio sicuro

Allaccensione del dispositivo, lo schermo e bloccato per ragioni di
sicurezza. Sbloccare lo schermo immettendo il metodo di sblocco
corrente, come ad esempio un codice Knock Code, una sequenza, una
password o un PIN. Fino allo sblocco dello schermo non & possibile
ricevere la maggior parte delle chiamate, i messaggi, le sveglie, le
notifiche e altro ancora.
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Precauzioni per l'Avvio sicuro
- Se siimmette una password non corretta per un numero di volte

superiore a quello specificato, il dispositivo verra automaticamente
inizializzato. Assicurarsi di ricordare la password.

- Se si dimentica la password di decodifica, € necessario inizializzare

il dispositivo per poterla utilizzare di nuovo. Eseguendo
linizializzazione, verranno eliminati tutti i dati salvati in precedenza.

- La crittografia awiene quando il dispositivo viene avviato per la

prima volta dopo un'inizializzazione. Se si arresta la crittografia
prima del completamento, i dati potrebbero danneggiarsi. Ad
esempio, non rimuovere o inserire la batteria mentre la crittografia
e in corso. Attendere il completamento della crittografia.

Crittografia della scheda di
memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di
memoria. Laccesso ai dati crittografati sulla scheda di memoria non
sara possibile da un altro dispositivo.

1

2

Toccare O > Impostazioni > Generali > Impronte digitali &
sicurezza > Cripta la Scheda SD.

Leggere le informazioni generali sulla crittografia della scheda di
memoria visualizzate sullo schermo, quindi toccare CONTINUA
per continuare.

Selezionare unopzione e toccare CODIFICA ORA:

- Crittografia del nuovo file: consente di crittografare solo i dati
salvati sulla scheda di memoria dopo la crittografia.
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- Crittografia completa: consente di crittografare tutti i dati
attualmente salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad
eccezione di quelli multimediali come musica, foto e video.

E » Per crittografare una scheda di memoria, assicurarsi che sia
impostato un blocco schermo che prevede 'utilizzo di un PIN o una
password.

+ Una volta awiata |a crittografia di una scheda di memoria, alcune
funzioni non sono disponibili.

- Se il dispositivo si spegne mentre la crittografia e in corso, il
processo di crittografia non riuscira e alcuni dati potrebbero
danneggiarsi. Occorre percio assicurarsi che il livello della batteria sia
sufficiente prima di avviare la crittografia.

« Laccesso ai file crittografati & possibile solo dal dispositivo in cui i
file sono stati crittografati.

+ La scheda di memoria crittografata non puo essere utilizzata
su un altro dispositivo LG. Per utilizzare la scheda di memoria
crittografata su un altro dispositivo mobile, inizializzare la scheda.

- E possibile attivare la crittografia della scheda di memoria anche
se nel dispositivo non ¢ installata alcuna scheda di memoria.
Qualsiasi scheda di memoria installata dopo la crittografia verra
automaticamente crittografata.

Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta
visualizzando.

Tramite un collegamento rapido

Tenere premuti contemporaneamente il tasto di accensione/blocco e
il tasto volume giti (-) per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots in
Galleria.
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Tramite la funzione Capture+
Nella schermata di cui si desidera acquisire uno screenshot, trascinare
verso il basso la barra di stato, quindi toccare Capture+.

E + Quando lo schermo e spento o bloccato, e possibile accedere alla
funzione Capture+ premendo due volte il tasto volume su (+).
Innanzitutto, toccare O > Impostazioni > Generali e attivare Tasto
di scelta rapida.

« Peri dettagli, vedere Scrittura di note su uno screenshot.

Immissione di testo

Utilizzo della tastiera Smart

E possibile utilizzare la tastiera Smart per immettere e modificare
testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita,
senza dover passare dalla schermata a una tastiera tradizionale e
viceversa. In questo modo e possibile trovare e correggere con facilita
gli eventuali errori durante la digitazione.

Funzioni di base 66



Spostamento del cursore

Con la tastiera Smart e possibile spostare il cursore esattamente
nella posizione desiderata.

Quando si digita un testo, toccare e tenere premuta la barra
spaziatrice, quindi trascinarla verso sinistra o destra fino a quando il
cursore non si sposta alla posizione desiderata all'interno del testo.

< Smart keyboard >

I_;'] + Questa opzione ¢ disponibile solo sulla tastiera QWERTY.

Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo

dell'utente per suggerire le parole utilizzate pit spesso durante

la digitazione. Quanto piu si utilizza il dispositivo, tanto piu precisi

saranno i suggerimenti.

Immettere un testo, quindi toccare una parola suggerita o trascinare

delicatamente verso lalto il lato sinistro o destro della barra spaziatrice.

- La parola selezionata viene inserita automaticamente. Non e
necessario digitare manualmente ogni lettera della parola.
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Smartphone Smart Smartphones

Modifica del layout della tastiera QUWERTY
E possibile aggiungere, eliminare o ridisporre i tasti sulla fila inferiore della
tastiera.

1 Toccare O > Impostazioni > Generali > Lingua e tastiera
> Tastiera LG > Altezza e layout della tastiera > Layout
QWERTY.
In alternativa, toccare £# sulla tastiera e quindi Altezza e layout
della tastiera > Layout QWERTY.

2 Toccare un tasto sulla fila inferiore, quindi trascinarlo in unaltra
posizione.

OOOO00000] OO0
0 'D m | ]

E + Questa opzione e disponibile solo sulle tastiere QWERTY, QWERTZ
e AZERTY.

+ Questa funzione potrebbe non essere supportata per alcune lingue.
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Personalizzazione dell’altezza della tastiera

E possibile personalizzare l'altezza della tastiera per una maggiore
comodita delle mani durante la digitazione.

1

Toccare (O > Impostazioni > Generali > Lingua e tastiera >
Tastiera LG > Altezza e layout della tastiera > Altezza della
tastiera.

In alternativa, toccare £¥ sulla tastiera e quindi Altezza e layout
della tastiera > Altezza della tastiera.

2 Regolare laltezza della tastiera.

Selezione di una modalita di tastiera orizzontale

E possibile selezionare una modalita di tastiera orizzontale scegliendo
fra varie opzioni.

1

Toccare O > Impostazioni > Generali > Lingua e tastiera >
Tastiera LG > Altezza e layout della tastiera > Tipo di tastiera
orizzontale.

In alternativa, toccare £¥ sulla tastiera e quindi Altezza e layout
della tastiera > Tipo di tastiera orizzontale.

Selezionare una modalita di tastiera.
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Divisione della tastiera

Quando lo schermo e in modalita orizzontale, e possibile dividere la
tastiera a meta e posizionare le due parti ai lati della schermata.
Toccare O > Impostazioni > Generali > Lingua e tastiera > Tastiera
LG > Altezza e layout della tastiera > Dividi tastiera.

In alternativa, toccare £ on sulla tastiera e quindi Altezza e layout
della tastiera > Dividi tastiera.

E + Ruotare il dispositivo in modalita orizzontale per dividere la tastiera
su entrambi i lati. Per unire o dividere la tastiera, avvicinare o
allontanare due dita sulla tastiera.

Modalita operativa con una sola mano

E possibile spostare la tastiera su un lato dello schermo in modo da

poterla utilizzare con una sola mano.

1 Toccare O > Impostazioni > Generali > Lingua e tastiera > Tastiera
LG > Altezza e layout della tastiera > Utilizzo con una mano.
In alternativa, toccare £¥ sulla tastiera e quindi Altezza e layout
della tastiera > Utilizzo con una mano.

2 Premere la freccia visualizzata accanto alla tastiera per spostarla
nella direzione desiderata.
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Immissione di testo tramite voce
Sulla tastiera, toccare e tenere premuto £, quindi selezionare .

I_;'] « Per ottimizzare il riconoscimento dei comandi vocali, esprimerli in
modo chiaro con la pronuncia e laccento corretti.

« Per immettere testo con la voce, assicurarsi che il dispositivo sia
connesso a una rete.

- Per selezionare la lingua per il riconoscimento vocale, toccare %% >
Lingue sulla schermata del riconoscimento vocale.

+ Questa funzione potrebbe non essere supportata o le lingue
supportate potrebbero variare a seconda della zona di copertura
del servizio.

Modifica della tastiera

E possibile cambiare la lingua di input e il tipo di tastiera per ogni
lingua.

1 Toccare O > Impostazioni > Generali > Lingua e tastiera >
Tastiera LG > Seleziona lingua.

7 Selezionare una lingua e personalizzare il tipo di tastiera.

Copia e incolla

E possibile tagliare o copiare del testo da un‘app, quindi incollarlo nella
stessa app. E anche possibile esequire altre app e incollare il testo al
loro interno.

1 Toccare e tenere premuta larea attorno al testo che si desidera
copiare o tagliare.

2 Trascinare @/ Wy per specificare area da copiare o tagliare.

3 Selezionare TAGLIA o COPIA.

- Il testo tagliato o copiato viene aggiunto automaticamente agli
Appunti.
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/A Toccare e tenere premuta la finestra di inserimento del testo,
quindi selezionare INCOLLA.

« In assenza di un elemento copiato o tagliato, lopzione INCOLLA
non verra visualizzata.

APPUNTI

Quando si copia o si taglia unimmagine o un testo, tali elementi
vengono salvati automaticamente in Clip Tray e possono essere
incollati ovunque in qualsiasi momento.

T Sulla tastiera, toccare e tenere premuto £, quindi selezionare (i
In alternativa, toccare e tenere premuta la finestra di inserimento
del testo, quindi selezionare APPUNTI.

2 Selezionare e incollare un elemento in Clip Tray.

- E possibile salvare in Clip Tray fino a un massimo di 20 elementi.

Toccare &3 per bloccare gli elementi salvati al fine di non
eliminarli anche quando la quantita massima viene superata.
E possibile bloccare fino a un massimo di dieci elementi. Per
eliminare gli elementi bloccati, & prima necessario sbloccarli.

Toccare ] per eliminare gli elementi salvati in Clip Tray.

E + Gli Appunti potrebbero non essere supportati da alcune app
scaricate dall'utente.
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App utili



Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito
dal proprio gestore di telefonia mobile.

E « Alcuni store di app potrebbero richiedere la creazione di un account
e la registrazione.

« Alcune app potrebbero essere a pagamento.

+ Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a
seconda del proprio piano tariffario.

SmartWorld potrebbe non essere supportato a seconda dellarea o
del provider del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

E « Alcune app non possono essere disinstallate dagli utenti.

Disinstallazione con il gesto di tocco e pressione lunga

Nella schermata Home, toccare e tenere premuta 'app da disinstallare,
quindi trascinarla su Disinstalla nella parte superiore dello schermo.

- Se le app sono state disinstallate nelle ultime 24 ore, e possibile
reinstallarle. Per i dettagli, vedere App disinstallate.

Disinstallazione tramite il menu delle impostazioni

Toccare O > Impostazioni > Generali > Applicazioni, selezionare
un‘app, quindi toccare Disinstalla.

Disinstallazione di app dallo store di app

Per disinstallare unapp, accedere allo store di app da cui e stata
scaricata e disinstallarla.
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App disinstallate

E possibile visualizzare le app disinstallate sulla schermata Home. E
inoltre possibile reinstallare le app che sono state disinstallate nelle
ultime 24 ore.

1 Toccare O > App disinstallate.
2 Attivare la funzione desiderata:
- Reinstalla: consente di reinstallare 'app selezionata.

- [ : consente di rimuovere definitivamente dal dispositivo le app
disinstallate.

5 - Le app disinstallate vengono rimosse automaticamente dal
dispositivo 24 ore dopo la disinstallazione. Se si desidera
reinstallare le app disinstallate, & necessario scaricarle nuovamente
dallo store di app.

« Questa funzione e attiva solamente sulla schermata Home.
Se si disinstallano delle app mentre si utilizza la schermata
EasyHome o un altro launcher, queste vengono immediatamente e
definitivamente rimosse dal dispositivo.

Telefono

Chiamata vocale

Per esequire una chiamata vocale, utilizzare uno dei metodi disponibili,
ad esempio immettere un numero di telefono o selezionarlo
dallelenco dei contatti o dallelenco delle chiamate recenti.
Esecuzione di una chiamata dal tastierino numerico

1 Toccare O > (9> Componi.

2 Eseguire la chiamata utilizzando un metodo a scelta:
- Immettere un numero di telefono e toccare @.
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- Toccare e tenere premuto un numero di composizione veloce.

- Cercare un contatto toccando la lettera iniziale del relativo
nome nellelenco dei contatti, quindi toccare @.

E + Perimmettere “+" quando si esegue una chiamata internazionale,
toccare e tenere premuto il numero 0.

« Per i dettagli su come aggiungere numeri di telefono allelenco
di composizione veloce, vedere Aggiunta di contatti allelenco di
composizione veloce.

Esecuzione di una chiamata dall'elenco dei contatti
1 Toccare O > [®> Rubrica.

2 Dallelenco dei contatti, selezionare un contatto e toccare Q...

Risposta a una chiamata
Per rispondere a una chiamata, trascinare @ allesterno del cerchio
sulla schermata della chiamata in arrivo.
- Se e collegato un auricolare stereo, & possibile esequire le chiamate
utilizzando il pulsante di chiamata/fine sullauricolare.
+ Per terminare una chiamata premendo semplicemente il tasto
di accensione /blocco, toccare O > Impostazioni > Reti >
Impostazioni chiamate > Rispondi e termina chiamate, quindi
attivare Termina le chiamate con il tasto di accensione.

Rifiuto di una chiamata
Per rifiutare una chiamata in arrivo, trascinare €) allesterno del
cerchio sulla schermata della chiamata in arrivo.
« Perinviare un messaggio di rifiuto, trascinare il messaggio di rifiuto
allesterno del cerchio.

- Per aggiungere o modificare un messaggio di rifiuto, toccare O >
Impostazioni > Reti > Impostazioni chiamate > Rifiuta e respingi
chiamate > Rifiuta con messaggio.
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- Quando si riceve una chiamata, premere il tasto del volume
o il tasto di accensione/blocco per disattivare la suoneria o la
vibrazione oppure per mettere in attesa il chiamante.

Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte
superiore dello schermo viene visualizzato .

Per visualizzare i dettagli della chiamata persa, trascinare la barra di
stato verso il basso. In alternativa, toccare O > (8 > Chiamate.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni
toccando i pulsanti visualizzati sullo schermo:

- Rubrica: consente di visualizzare 'elenco di contatti durante una
chiamata.

Fine: consente di terminare una chiamata.

Tastiera: consente di mostrare o nascondere la testiera del
telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa
essere udita dall'interlocutore.

- Bluetooth: consente di passare la chiamata a un dispositivo
Bluetooth associato e connesso.

-+ :consente di accedere a molte opzioni di chiamata.

E - Le voci delle impostazioni disponibili possono variare a seconda
dellarea e del provider del servizio.
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Esecuzione di una chiamata a tre vie

E possibile esequire una chiamata a un altro contatto nel corso di una
chiamata.

1 Durante una chiamata, toccare : > Aggiungi.

2 Immettere un numero di telefono e toccare @.
« Le due chiamate vengono visualizzate contemporaneamente
sullo schermo e la prima chiamata viene messa in attesa.
3 Per passare a unaltra chiamata, toccare un altro numero sullo
schermo.
Per avviare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio
provider del servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate
Per visualizzare i record delle chiamate recenti, toccare O > (¥4 >
Chiamate. E quindi possibile utilizzare le sequenti funzioni:

Per visualizzare i record dettagliati delle chiamate, selezionare un
contatto. Per eseguire una chiamata a un contatto selezionato,
toccare Q..

Per eliminare i record delle chiamate, toccare : > Elimina.

E + Ladurata visualizzata delle chiamate potrebbe essere diversa da
quella addebitata. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.

1 Toccare O > (¥ > Componi o Chiamate.

2 Toccare : > Impostazioni chiamate e quindi configurare le opzioni
in base alle proprie preferenze.
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Messaggqi

Invio di un messaggio

E possibile creare e inviare messaggi ai contatti selezionati o a tutti i
contatti utilizzando l'app di messaggistica.

E - Linvio di messaggi allestero potrebbe essere soggetto a ulteriori
costi. Rivolgersi al proprio provider del servizio per ulteriori
informazioni.

1 Toccare Q>
2 Toccare €.

3 Specificare un destinatario e creare un messaggio.
« Per allegare file, toccare Z.
« Per accedere alle voci di menu opzionali, toccare .

4 Toccare Invia per inviare il messaggio.

Lettura di un messaggio

E possibile visualizzare i messaqgi scambiati organizzati per singolo
contatto.

1 Toccare Q> .

7 Selezionare un contatto dallelenco dei messaggi.

Configurazione delle impostazioni dei messaggi

E possibile modificare le impostazioni dei messaqggi in base alle
proprie preferenze.

1 Toccare Q> .

2 Toccare : > Impostazioni dallelenco dei messaggi.

App utili 79



Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare i
momenti memorabili.

Toccare O > @.

E + Prima di scattare una foto, pulire lobiettivo della fotocamera con un
panno in microfibra. Se si tocca lobiettivo della fotocamera con le
dita, le foto potrebbero risultare offuscate.
Se il livello della batteria & inferiore al 5%, caricare |a batteria prima
di utilizzare la fotocamera.
+ Le immagini incluse nella presente guida potrebbero essere diverse
da quelle effettive del dispositivo.

- Le foto e i video possono essere modificati da Galleria. Per i
dettagli, vedere Informazioni generali su Gallery.

Modifica della modalita della fotocamera

E possibile selezionare una modalita che sia adatta allambiente
circostante per scattare una foto o registrare un video in maniera
semplice e comoda.

Nella schermata della fotocamera, toccare : e selezionare la modalita
desiderata.
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Passaggio dalla fotocamera posteriore a quella

anteriore e viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e
vice versa in base allambiente in cui si scatta la foto.

Nella schermata della fotocamera, toccare &} o trascinare la
schermata in alto, in basso, a sinistra o a destra per passare dalla
fotocamera posteriore a quella anteriore e viceversa.

E - Utilizzare la fotocamera anteriore per scattare i selfie. Per i dettagli,
vedere Scatto di selfie.

Passaggio alla doppia fotocamera

E possibile utilizzare la doppia (seconda) fotocamera posteriore per
scattare foto mediante lobiettivo normale o grandangolare.

Toccare [A]/ [d4] per passare dallobiettivo normale a quello
grandangolare e viceversa.

Zoom avanti o indietro

E possibile esequire lo zoom avanti o indietro della schermata della
fotocamera mentre si scatta una foto o si registra un video.

Nella schermata della fotocamera, awvicinare o allontanare due dita
per eseqguire o zoom avanti o indietro.
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- Lobiettivo grandangolare e quello normale sul retro del dispositivo
vengono quindi accesi automaticamente per scattare una foto o
registrare un video.

Modalita semplice
E possibile scattare foto toccando semplicemente lo schermo.
T Nella schermata della fotocamera, toccare ¢ >[ |

2 Inquadrare il soggetto, quindi toccare lo schermo.

Modalita automatica

E possibile scattare foto o registrare video selezionando varie
modalita e opzioni di ripresa.

T Nella schermata della fotocamera, toccare = >[_§

7 Per scattare una foto, toccare (G} Per registrare un video, toccare
invece [k

Consente di passare

dallobiettivo
Selezionare una grandangolare a quello
modalita di normale e viceversa.
fotocamera.
Attivare o disattivare : Zpt— Consente di awiare la
iflash & Galleria.
Consente di passare g)s— Consente di registrare
dalla fotocamera © video.

anteriore a quella
posteriore e viceversa.
Selezionare una
modalita di scatto.

5 Consente di scattare
foto.

Consente di tornare

alla schermata
Modificare le opzioni precedente.

della fotocamera.

Scatto di una foto

1 Selezionare una modalita di scatto e toccare il soggetto su cui
mettere a fuoco la fotocamera.

2 Toccare [Q] per scattare una foto.
In alternativa, premere un tasto volume.

App utili 82



5 + Quando lo schermo e spento o bloccato, awiare la fotocamera
premendo due volte il tasto volume su (+). Per attivare questa
funzione, toccare O > Impostazioni > Generali e attivare Tasto di
scelta rapida. Per scattare foto subito dopo lawvio della fotocamera
con il tasto volume giti (-), attivare la funzione Scatto rapido.

Registrazione di un video

1 Selezionare una modalita di scatto e toccare il soggetto su cui
mettere a fuoco la fotocamera.
2 Toccare[h
+ Per scattare una foto mentre si registra un video, toccare [0}
« Per mettere in pausa |a registrazione del video, toccare | |. Per
riprendere la registrazione del video, toccare @.

3 Toccare [] per terminare la registrazione del video.

Immagine tridimensionale

E possibile scattare una foto o registrare un video utilizzando sia
lobiettivo normale che quello grandangolare della doppia fotocamera
sul retro del dispositivo per riprendere le scene come se fossero
incorniciate. Le scene visualizzate nella schermata piccola anteriore
vengono riprese utilizzando lobiettivo normale, mentre le scene
visualizzate nella schermata grande di sfondo vengono riprese
utilizzando lobiettivo grandangolare. E possibile cambiare la forma
della schermata frontale o applicare diversi effetti per rendere pit
interessante la foto o il video.

T Nella modalita automatica, toccare MODO >[&]
2 Toccare \/ e selezionare il layout desiderato.

3 Selezionare gli effetti:

- &) : consente di applicare un effetto di obiettivo convesso
allarea acquisita dalla fotocamera grandangolare.
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. :consente di applicare gradazioni di grigio allarea acquisita dalla
fotocamera grandangolare.

+ [O]: consente di scurire i bordi dellarea acquisita dalla fotocamera
grandangolare.

+ [0]:consente di sfocare larea acquisita dalla fotocamera
grandangolare.

4 Toccare [B] per scattare una foto. Per registrare un video, toccare

[

Multi-view

E possibile riprendere piti foto o video sotto forma di collage
utilizzando la fotocamera anteriore e quella posteriore. Le foto e i
video possono essere salvati con layout diversi.

T Nella modalita automatica, toccare MODO >H"]

2 Toccare \/ e selezionare un layout.

3 Toccare [Q] per scattare le foto sequendo le istruzioni visualizzate
sullo schermo. Per registrare un video, toccare [}
+ Toccare [ 1 per registrare una breve clip video.

« Per passare dalla fotocamera anteriore a quella posteriore
(normale o grandangolare) e viceversa, trascinare in alto, in
basso, a sinistra o a destra.

« Per riprendere scatti di foto o video continui a intervalli specifici,
toccare e tenere premuto [0]0 [k
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- Toccare @) / @) per scattare foto o registrare video
contemporaneamente o in sequenza.

Snap Video
E possibile registrare brevi clip video e montarle insieme creando un
cortometraggio di 60 secondi.
T Nella schermata della fotocamera, toccare MODO > 54,
2 Toccare[k
- Toccare una volta licona per registrare un video clip di tre

secondi. Toccare e tenere premuta licona per creare un video
clip di durata maggiore (lunghezza massima: un minuto).

Consente di —
selezionare il layout p il

Multi-view.
Consente di eliminare
Consente di | la clip selezionata.
visualizzare in - ]
anteprima la clip _
selezionata.
Sequenza temporale.

I— Consente di salvare il
video.

Consente di riprodurre Consente di eliminare
tutte le clip. tutte le clip.

3 Toccare SALVA.
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Panorama

E possibile creare una foto panoramica spostando la fotocamera nella direzione
da fotografare e unire gli scatti continui per ottenere una vista ampia.

T Nella modalita automatica, toccare MODO > =]

2 Toccare [Q] quindi spostare lentamente la fotocamera in una sola
direzione.

- Spostare il dispositivo sequendo |a direzione della freccia sulla linea di
riferimento.

3 Toccare [ ] per terminare la ripresa.

Video al rallentatore

E possibile creare un video divertente cambiando la velocita di
movimento dei soggetti del video. Questa funzione consente di
registrare un video con una velocita superiore e poi riprodurlo alla
velocita normale, in modo che il video risulti rallentato.

T Nella modalita automatica, toccare MODO > (.
2 Toccare [} e registrare un video.

3 Toccare [ ] per terminare la registrazione del video.
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Time-lapse

E possibile acquisire una sequenza di fotogrammi a intervalli
prestabiliti per registrare i cambiamenti che avvengono lentamente
nel tempo, come ad esempio i movimenti delle nuvole, i moti celesti, il
traffico e altri ancora.

1 Nella modalita automatica, toccare MODO > (&

2 Toccare [ K e registrare un video.
« Perregolare la velocita di riproduzione, toccare \/.

3 Toccare [] per terminare la registrazione del video.

E - Mentre si registra un video time-lapse, le voci non vengono
registrate.

Scatto continuo

E possibile riprendere scatti continui di foto per creare immagini in
movimento.

Nella modalita automatica, toccare e tenere premuto [0}

- Gli scatti continui vengono ripresi a rapida velocita mentre si tiene
premuto [0}

E - E possibile scattare fino a trenta (30) foto continue.
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Collegamento alle fotocamere LG di amici

E possibile collegare il dispositivo a unaltra fotocamera per
visualizzare foto e video salvati nella fotocamera.

E + Questa funzione e disponibile quando si utilizza la funzione Multi-
view o Snap.

+ Le fotocamere LG Friends che possono essere connesse al
dispositivo sono accessori opzionali. Rivolgersi al centro di
assistenza clienti LG se si & interessati allacquisto.

- Questa funzione potrebbe non essere supportata o alcune opzioni
potrebbero variare a seconda dellarea o del provider del servizio.

Personalizzazione delle opzioni della fotocamera